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Chapter 1 Introduction

1.1 Overview

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing
applications for the RA microcontroller series.

1.2 How to Read this Manual

For help getting started with the FSP, see:
e Starting Development
To learn about the FSP architecture and about board and chip-level support included in the FSP, see:

e FSP Architecture
e MCU Board Support Package

For user guides describing the FSP modules, see:
e Modules
For shared interface APl documentation, see:

e |nterfaces

1.3 Documentation Standard

Each module user guide outlines the following:

e Features: A bullet list of high level features provided by the module.

e Configuration: A description of module specific configurations available in the configuration
tool.

e Usage Notes: Module specific documentation and limitations.

e Examples: Example code provided to help the user get started.

¢ APl Reference: Usage notes for each APl in the module, including the function prototype and
hyperlinks to the interface documentation for parameter definitions.

Interface documentation includes typed enumerations and structures-including a structure of
function pointers that defines the API-that are shared by all modules that implement the interface.

Introduction to FSP

Purpose

The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide
easy to use, scalable, high quality software for embedded system design. The primary goal is to

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 7 /1,444
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provide lightweight, efficient drivers that meet common use cases in embedded systems.
Quality

FSP code quality is enforced by peer reviews, automated requirements-based testing, and
automated static analysis.

Ease of Use

The FSP provides uniform and intuitive APIs that are well documented. Each module is supported
with detailed user documentation including example code.

Scalability

FSP modules can be used on any MCU in the RA family, provided the MCU has any peripherals
required by the module.

FSP modules also have build time configurations that can be used to optimize the size of the module
for the feature set required by the application.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 8/1,444
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Chapter 2 Starting Development

2.1 Starting Development Introduction

The Renesas Flexible Software Package (FSP) provides a host of efficiency enhancing tools for
developing projects targeting the Renesas RA series of MCU devices. e2 studio provides a familiar
development cockpit from which the key steps of project creation, module selection and
configuration, code development, code generation, and debugging are all managed. FSP runs within
e2 studio and enables the module selection, configuration, and code generation steps. FSP uses a
Graphical User Interface (GUI) to simplify the selection, configuration, code generation and code
development of high level modules and their associated Application Program Interfaces (APIs) to
dramatically accelerate the development process.

The wealth of resources available to learn about and use e2 studio and FSP can be overwhelming on
first inspection, so the following section provides a Getting Started Guide with a list of the most
important first steps. Following these highly recommended first 10 steps will bring you up to speed
on the development environment in record time. Even experienced developers can benefit from the
use of this guide, to learn the terminology that might be unfamiliar or different from previous
environments.

2.1.1 Getting Started with e2 studio and FSP

This section describes how to use Renesas e2 studio to develop applications with the Renesas
Flexible Software Package (FSP). Here is the recommended sequence for quickly Getting Started with
using e2 when developing with the RA MCU Family:

1. Read over the section What is e2 studio?, up to but not including e2 studio Prerequisites.
This will provide a description of the various windows and views to use e2 to create a
project, add modules and threads, configure module properties, add code, and debug a
project. It also describes how to use key coding 'accelerators' like Developer Assist (to drag
and drop parameter populated API function calls right into your code), a context aware
Autocomplete (to easily find and select from suggested enumerations, functions, types, and
many other coding elements), and many other similar productivity enhancers.

2. Read over the FSP Architecture sections FSP Architecture, FSP Modules and FSP Stacks.
These provide the basic background on how FSP modules and stacks are used to construct
your application. Understanding their definitions and the theory behind how they combine
will make it easier to develop with FSP.

3. Read over a few "Module User Guide" sections to see how to use API function calls,
structures, enumerations, types and callbacks. These user guides provide the information
you will use to implement your project code. (Much of the details are provided with
Developer Assistance, covered in step 5, below.

4. If you don't have a kit. you can order one using the link included in the e2 studio
Prerequisites section. Then, if you haven't yet downloaded and installed e2 studio and FSP,
use the link included in the e2 studio Prerequisites section to download the tools. Then you
can build and debug a simple project to prove out you installation, tool flow, and the kit.
The simple "Blinky" project, that blinks an LED on and off, is located in the Tutorial: Your
First RA MCU Project - Blinky section. Follow the instructions for importing and running this
project. It will use some of the key steps for managing projects within e2 and is a good way
to learn the basics.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 9/1,444
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5. Once you have successfully run Blinky you have a good starting point for using FSP for more
complex projects. The Watchdog Timer hands-on lab, available in the Tutorial: Using HAL
Drivers - Programming the WDT section, shows how to create a project from scratch and
use FSP API functions, and demonstrates the use of some of the coding efficiency tools like
Developer Assistance and Autocomplete. Run through this lab to establish a good starting
point for developing custom projects.

6. The balance of the FSP Architecture sections, those not called out in step 2 above, contain
additional reference material that may be helpful in the future. Scan them over so you know
what they contain, in case you need them.

7. The balance of the e2 studio User Guide, starting with the What is a Project? section up to
Writing the Application section, provides a detailed description of each of the key steps,
windows, and entries used to create, manage, configure, build and debug a project. Most of
this will be familiar after doing the Blinky and WDT exercises from steps 4 and 5 above.
Skim over these references so you know to come back to them when questions come up.
Make sure you have a good grasp of what each of the configuration tabs are used for since
that is where the bulk of the project preparation work takes place prior to writing code.

8. Read over the Writing the Application section to get a short introduction to the steps used
when creating application code with FSP. It covers both RTOS-independent and RTOS-
dependent applications. The Tutorial: Using HAL Drivers - Programming the WDT section is
a good introduction to the key steps for an RTOS-independent application. Make sure you
have run through it at least once before doing a custom project.

9. Scan the Debugging the Project section to see the steps required to download and start a
debug session.

10. Explore the additional material available on the following web pages and bookmark the
resources that look most valuable to you:
a. RA Landing Page: https://www.renesas.com/ra
b. FSP Landing Page: https://www.renesas.com/fsp

2.2 e2 studio User Guide

2.2.1 What is e2 studio?

Renesas e2 studio is a development tool encompassing code development, build, and debug. e2
studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling
(CDT).

When developing for RA MCUs, e2 studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management
of modules and threads, to easily implement complex applications. The time saving tools available in
e2 studio and FSP include the following:

* A Graphical User Interface (GUI) (see Adding Threads and Drivers) with numerous wizards
for configuring and auto-generating code

* A context sensitive Autocomplete (see Tutorial: Using HAL Drivers - Programming the WDT)
feature that provides intelligent options for completing a programming element

e A Developer Assistance) tool for selection of and drag and drop placement of API functions
directly in application code

e A Smart Manual provides driver and device documentation in the form of tooltips right in
the code

e An Edit Hover feature to show detailed descriptions of code elements while editing

e A Welcome Window with links to example projects, application notes and a variety of other
self-help support resources

e An Information Icon, from each module, is provided in the graphic configuration viewer that
links to specific design resources, including code 'cheat sheets' that provide useful starting

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 10/ 1,444
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points for common application implementations.

RENESAS

e’ studio

v7.6.0

Loading org.eclipse.oomph.setup.ui £ BUILTON

|
Figure 1: e2 studio Splash Screen

e2 studio organizes project work based on Perspectives, Views, Windows, Panes, and Pages
(sometimes called Tabs). A window is a section of the e2 studio GUI that presents information on a
key topic. Windows often use tabs to select sub-topics. For example, an editor window might have a
tab available for each open file, so it is easy to switch back and forth between them. A window Pane
is a section of a window. Within a window, multiple Panes can be opened and viewed simultaneously,
as opposed to a tabbed window, where only individual content is displayed. A memory-display
Window, for example, might have multiple Panes that allow the data to be displayed in different
formats, simultaneously. A Perspective is a collection of Views and Windows typical for a specific
stage of development. The default perspectives are a C/C++ Perspective, an FSP Configuration
Perspective and a Debug Perspective. These provide specific Views, Windows, Tabs, and Panes
tailored for the common tasks needed during the specific development stage. These three default
perspectives are each illustrated in the below screen shots, along with graphic indicators helpful in
identifying example Views, Windows, Tabs and Panes.

File Edit Mavigate Search Project RenesasViews Run Window Help

D684 [&] (][] [Foms

| om | Rece. 5 RA Configuration Quick Access
[ Project Explorer 53 = B ) &k [Blinky] RA Configuration 53 = EI\ % Package 53 [CRCIEAN: R - = EI\

|| [ Blinky Debug (1) v

& -

. Bl s Summary [+ L2 3 a4 s & 7 s »
v Blinky Generate Project Content] R 7 - p S —— -

&l Includes i

Bra Project Summary A & [Fuos | pacz | paos | paos || p2oe || pace || Pzxs |ssusgusaDe| peos |2

& ragen RENESAS < [pusz | pace (0 | wa0s (lpaor | paso [ pace | mogy | mesz [l meez [ €

(S src Board: Custom User Board (Any Device)

= ra_cfg Device: RIFAGM1AD2CLY o (e | pazs | pase | paos (lrese |[pese | pace | ees | vss [ wee [0

(= seript Toolchain: GCC ARM Embedded © [ vee || Peuo || Pee ||Puis [[PLas [P0 [l Pasd | pess | p2as

2 Blinky Debug (1).Jaunch
5% configurationxml

2 R7FABMIAD2CL).pincfg
() Developer Assistance

Toolchain Version: 8.3.1.20190703 Project Configuration
FSP Version: 0.8.0 Editor

£ | e | vss || poe | eeon || peco (| ez || pace

& |pags | pos | 107 || esos |[esos || esce |[poce

Selected software components Fiot | Paoe | Paos || Prco

Custom Board Support Files v0.8.0 * |paca | psme | vas | poes v [ Foce Pan || Pooe
VG Port w080 e [ s | vee [ e mare s [ e [ o |
. Board Support Package Common Files v0.8.0 . < — — =
Project Arm CMSIS Version 5 - Core (M) v5.5.1 )
Explorer Board support package for RTFAGM1AD2CLY V0.0 "‘ RIFA6M1Asod J - 100LGA (Top View)
View Connection status:

@ %:r:(m [ Jwerrirg
YoufT® ﬁ Package
- Support A = View

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Components

. A Pk /
Figure 2: Default Perspective

In addition to managing project development, selecting modules, configuring them and simplifying

User’s Manual
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code development, e2 studio also hosts the engine for automatically generating code based on
module selections and configurations. The engine continually checks for dependencies and
automatically adds any needed lower level modules to the module stack. It also identifies any lower
level modules that require configuration (for example, an interrupt that needs to have a priority
assigned). It also provides a guide for selecting between multiple choices or options to make it easy
to complete a fully functional module stack.

The Generate Project Content function takes the selected and configured modules and automatically
generates the complete and correct configuration code. The code is added to the folders visible in
the Project Explorer window in e2 studio. The configuration.xml file in the project folder holds all
the generated configuration settings. This file can be opened in the GUI-based configuration editor to
make further edits and changes. Once a project has been generated, you can go back and
reconfigure any of the modules and settings if required using this editor.

15 Project Explorer £3 ]

& -

=

~ 1% MyProject [Debug]
3 Binaries
5l Includes
= ra
2 ra_gen
8 src
= Debug

= ra_cfg

= script
4k configurationaml

=| MyProject Debug,jlink
= R7FAGM3AH3CFC.pincfg
=/ ra_cfgixt

= RABM3-EK.pincfg

(7) Developer Assistance

Figure 3: Project Explorer Window showing generated folders and configuration.xml file

2.2.2 e2 studio Prerequisites

2.2.2.1 Obtaining an RA MCU Kit

To develop applications with FSP, start with one of the Renesas RA MCU Evaluation Kits. The Renesas
RA MCU Evaluation Kits are designed to seamlessly integrate with the e2 studio.

Ordering information, Quick Start Guides, User Manuals, and other related documents for all RA MCU
Evaluation Kits are available at https://www.renesas.com/ra.

2.2.2.2 PC Requirements
The following are the minimum PC requirements to use e2 studio:

e Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX

e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)

e Minimum 250-GB hard disk
2.2.2.3 Installing e2 studio, platform installer and the FSP package
Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e2 studio to ensure that the e2 studio
version supports the selected FSP version. The starting version of the installer includes all features of

the RA MCUs.

2.2.2.4 Choosing a Toolchain

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 12/1,444
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e2 studio can work with several toolchains and toolchain versions such as the GNU ARM compiler,
AC6. A version of the GNU ARM compiler is included in the e2 studio installer and has been verified
to run with the FSP version.

2.2.2.5 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

2.2.3 What is a Project?

In e2 studio, all FSP applications are organized in RA MCU projects. Setting up an RA MCU project
involves:

1. Creating a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects
already, after you launch e2 studio and select a workspace, all projects previously saved in the
selected workspace are loaded and displayed in the Project Explorer window. Each project has an
associated configuration file named configuration.xml, which is located in the project's root directory.

15 Project Explorer £3 ]

& -

=S
~ 1% MyProject [Debug]

3 Binaries

5l Includes

= ra

2 ra_gen

8 src

= Debug

= ra_cfg

= script
507 configuration.xml

=| MyProject Debug,jlink
= R7FAGM3AHICFC.pincfg
=/ ra_cfgixt

= RABM3-EK.pincfg

(7) Developer Assistance

Figure 4: e2 studio Project Configuration file

Double-click on the configuration.xml file to open the RA MCU Project Editor. To edit the project
configuration, make sure that the RA Configuration perspective is selected in the upper right hand
corner of the e2 studio window. Once selected, you can use the editor to view or modify the
configuration settings associated with this project.

£ | B8 C/C++ {5 RA Configuration

Figure 5: e2 studio RA Configuration Perspective

Note
Whenever the RA project configuration (that is, the configuration.xml fil€) is saved, a verbose RA Project Report
file (ra_cfg.txt) with all the project settings is generated. The format allows differences to be easily viewed using a
text comparison tool. The generated file islocated in the project root directory.
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[ Project Explorer 32 = (a5 =| ra_cfg.tat 52
=) ﬁl gy = i § RA Configuration
Gt 2 Board "EK-RAGM3"
< z
e 1 MyProject [Debug] 3 R7FAGMBAHICFC
i, Binaries 4 part_number: R7FAGM3AHICFC
[ Includes 5 rom_size bytes: 2897152
B ra 6 ram_size bytes: 65536@
2 ra_gen 7 data_flash_size_bytes: 65536
@ 5 package_style: LQFP
ste package_pins: 176
(= Debug
(= ra_cfg RAGM3
[ script series: g

{5 configurationxml
= MyProject Debug.jlink

|=| RAGM3-EK.pincfg
(?) Developer Assistance

RAGM3 Family

OFS@ register settings:
OFS@ register settings:
OF5@ register settings:

i 5 OFS@ register settings: Independent WDT: Start Mod
TFABM3AHICFC.pincfg OFS® register settings: Independent WDT: Timeout P
= OFS@ register settings: Independent WDT: Dedicated

Independent WDT: Window En
Independent WDT: Window St
Independent WDT: Reset Int

OF5@ register settings:
OF5@ register settings:
OFS@ register settings:
24 OFS@ register settings:
25 OF5@ register settings:
< > <

Independent WDT: Stop Cont
WDT: Start Mode Select: St
DT: Timeout Period: 16334
DT: Clock Frequency Divis
WDT: Window End Position:

Figure 6: RA Project Report

The RA Project Editor has a number of tabs. The configuration steps and options for individual tabs
are discussed in the following sections.

Note
The tabs available in the RA Project Editor depend on the e2 studio version.

18} [MyProject] RA Configuration 52 imal=:

Summary Generate Project Content
Project Summary ;
RENESAS X
Board: EK-RABGM3
Device: R7FABM3AH3ICFC
Toolchain: GCC ARM Embedded
Toolchain Version: = -2 &=Z%
FSP Version: LI |

Selected software components

RAGM3-EK Board Support Files P 15
Simple application that blinks an LED. No RTOS included LR i
Arm CMSIS Version 5 - Core (M) -

IO Port LI )
Board Support Package Common Files iy T3
Board support package for RTFAGM3AH3ICFC Foelw?

1Summary BSP | Clocks | Pins | Interrupts | Event Links Staclcs'ComponentsI

Figure 7: RA Project Summary tabs

e Click on the YouTube icon to visit the Renesas FSP playlist on YouTube
e Click on the Support icon to visit RA support pages at Renesas.com
¢ Click on the user manual (owl) icon to open the RA software package User's Manual

2.2.4 Creating a Project

During project creation, you specify the type of project, give it a project name and location, and
configure the project settings for version, target board, whether an RTOS is included, the toolchain
version, and the beginning template. This section includes easy-to-follow step-by-step instructions
for all of the project creation tasks. Once you have created the project, you can move to configuring
the project hardware (clocks, pins, interrupts) and the parameters of all the modules that are part of
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your application.
2.2.4.1 Creating a New Project
For RA MCU applications, generate a new project using the following steps:

1. Click on File > New > RA C/C++ Project.

B Workspace - &¥ studio
File Edit Mavigate Search Project RenesasVWiews Run Window Help

New Alt+Shift+N > = RA C/C++ Project

Open File... % Project...
() Open Projects from File System... % Eample.
Close Ctrl+W % Other.. Ctri+N

Figure 8: New RA MCU Project

Then click on the type of template for the type of project you are creating.

Mew RA C/C++ Project ul X

Templates for New RA C/C++ Project

Renesas RA C Executable Project
C/C++ == A C Brecutable Project for Renesas RA.

Renesas RA C Library Project
=== A C Library Project for Renesas RA.

Renesas RA C Project Using RA Librar
) 9 ¥
F== Creates o C application project which uses an existing RA library project

Renesas RA C++ Executable Project
FE A C++ Executable Project for Renesas RA.

enesas ++ LiDrar roj
R RA C++ Library Project
== A C++ Library Project for Renesas RA.

Renesas RA C++ Project Using RA Librar
] 9 Y
FSZ Creates o C++ applicatior. project which uses an existing RA library project

@' < Back Mext > Einish Cancel

Figure 9: New Project Templates

2. Select a project name and location.
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ﬁ e stucio - Project Configuratior (RA C Executable Project) [m] *
e2 studio - Project Configuration (RA C Executable Project) —
Specify the new project details.
Praject Toolchains
Projectname | MyProject GCC ARM Embedded
Use default location
D:\FSPAFSP_Workspace\MyProject Browse.
default
@ < Back Next » Finish Cancel

Figure 10: RA MCU Project Generator (Screen 1)

3. Click Next.
2.2.4.2 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.
2. Select the Board for your application. You can select an existing RA MCU Evaluation Kit or
select Custom User Board for any of the RA MCU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection.
Only change the Device when using the Custom User Board (Any Device) board
selection.

. To add threads, select RTOS, or No RTOS if an RTOS is not being used.

. The Toolchain selection defaults to GCC ARM Embedded.

. Select the Toolchain version. This should default to the installed toolchain version.

. Select the Debugger. The J-Link ARM Debugger is preselected.

<o u b

8. Click Next.
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B8 <2 studio - Praject Configuration (RA € Executable Project) m] X

e2 studio - Project Configuration (RA C Executable Project)
Select the board support that you require,

Device Selection

FSP version: | 0.8.0-rc.0 Eoard Dctalty

et TR

Device: R7FABM3IAH3ICFC

RTOS: No RTOS &0
Select Tools Available Tools
Toolchain: GCC ARM Embedded ~ GCC ARM Embedded
Toolchain version: | 8.3.1.20190703 ~ 831 2019070

7.3.1.20180622

Debugger: J-Link ARM s 7.2.1.20170904
4.9.3.20150529

w Debuggers
J-Link ARM

w Smart Manual
10 Registers Supported
Software Manual Supported

@ Help < Back MNext > Finish Cancel

Figure 11: RA MCU Project Generator (Screen 2)

Click on the Help icon (?) for user guides, RA contents, and other documents.

2.2.4.3 Selecting a Project Template

In the next window, select a project template from the list of available templates. By default, this
screen shows the templates that are included in your current RA MCU pack. Once you have selected
the appropriate template, click Finish.

Note
If you want to devel op your own application, select the basic template for your board, Bare Metal - Minimal.

e studio - Project Configuration (RA C Executable Project) O X

e2 studio - Project Configuration (RA C Executable Project)
Select the type of project you wish to create.

Project Template Selection

O] 4. Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will
initialize clocks, pins, stacks, and the C runtime environment.

[Renesas.RA0.8.0-rc.0.pack]
® (} Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and
the C runtime environment.

[Renesas.RA.0.8.0-rc.0.pack]

Code Generation Settings
Use RA Code Formatter

':?’\,‘ MNext > Finish Cancel
Figure 12: RA MCU Project Generator (Screen 3)

When the project is created, e2 studio displays a summary of the current project configuration in the
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RA MCU Project Editor.

{8 [MyProject] RA Configuration 33 )

Summar
y Generate Project Content

Project Summary

RENESAS ~
Board: EK-RAGM3
Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: = -0 &=%
FSP Version: =1

Selected software components

RABM3-EK Board Support Files Tt 1

Simple application that blinks an LED. No RTOS included. =Huaz

Arm CMSIS Version 5 - Core (M) .

/O Port LI ) S

Board Support Package Common Files Pl " s o
Board support package for RTFABM3AH3CFC ol

lSummary BSP | Clocks Pins | Interrupts | Event Links | Stacks Cumpunentsl

Figure 13: RA MCU Project Editor and available editor tabs

On the bottom of the RA MCU Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each
port pin.

e With the Stacks tab, you can add FSP modules for non-RTOS applications and configure the
modules. For each module selected in this tab, the Properties window provides access to
the configuration parameters, interrupt priorities, and pin selections.

* With the Interrupt tab, you can add new user events/interrupts.

e With the Event Links tab, you can configure events used by the Event Link Controller.

e The Components tab provides an overview of the selected modules. You can also add
drivers for specific FSP releases and application sample code here.

The functions and use of each of these tabs is explained in detail in the next section.
2.2.5 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the
configuration editor window. Importantly, the initial configuration of the MCU after reset and before
any user code is executed is set by the configuration settings in the BSP, Clocks and Pins tabs.
When you select a project template during project creation, e2 studio configures default values that
are appropriate for the associated board. You can change those default values as needed. The
following sections detail the process of configuring each of the project elements for each of the
associated tabs.
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18} [MyProject] RA Configuration 53

Summary

Project Summary

Board: EK-RAGM3

Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: = -0 &=%

FSP Version: =1

Selected software components

]

Generate Project Content

RENESAS

RABM3-EK Board Support Files Tt 1
Simple application that blinks an LED. No RTOS included. =Huaz
Arm CMSIS Version 5 - Core (M)

/O Port LI ) S
Board Support Package Common Files Pl " s
Board support package for RTFABM3AH3CFC [ 5

1Summary BSP | Clocks Pins | Interrupts | Event Links | Stacks Compunentsl

~

Figure 14: RA MCU Project Editor and available editor tabs

2.2.5.1 Configuring the BSP with e2 studio

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in
the lower left of the Project Configurations view as shown below.

Note

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

EK-RAGM3
Settings Property Value
~ R7FAGM3AH3CFC
part_number RTFABM3IAH3ICFC
rom_size_bytes 2097152
ram_size_bytes 655360
data_flash_size_bytes 65336
package_style LOFP
package_pins 176
~ RAEM3
series 6
~ RABM3 Family
OFS0 register settings
OF51 register settings
MPU
~ RA Common
Main stack size (bytes) 0400

Heap size (bytes) - A minimum of 4K 0

MCU Vee (mV)
Parameter checking
Assert Failures

3300
Disabled
Return FSP_ERR_ASSERTION

Error Log Mo Error Log

ID Code Mode Unlocked (Ignore ID}

ID Code (32 Hex Characters) ~ FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Soft Reset Disabled

PFS Protect Enabled

Main Oscillator Wait Time 32768 us

Main Oscillator Clock Source Crystal or Resonator

Subclock Populated Populated

Figure 15: Configuration BSP tab

The Properties view shows the configurable options available for the BSP. These can be changed
as required. The BSP is the FSP layer above the MCU hardware. e2 studio checks the entry fields to
flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written
to ra_cfg/fsp_cfg/bsp/bsp_cfg.h
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This file is created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.2 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in
red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock HOCO has been changed so the resulting clock frequency is 24
MHz instead of the required 48 MHz. This parameter is colored red.

{5 *IMyProject] RA Configuration 53

Clocks Configuration

PLL Sre: XTAL v > pCLKA Div /2 < —{ pcLia 120mH:z

PLL Div /2 t - > PCLKE Div /4 w —{pcLi somtz

PLL Mul xZO.i(’) v > pCLIC Div /4 N
[ USBMCLK 24MHz | | [PLL2sombz ! Clock Sre: PLL « <= PCLKD Div /2 v—s{pakp oM
HOCO 20MHz v SDCLKout On —{ spcLkout 120MHz

"= FCLK Div /4 ~ —)| FCLK 60MHz

CLKOUT Disabled ~ —= CLKOUT Div /1 v —>| CLKOUT 0Hz
Summary | BSP Pins | Interrupts | Event Links Stacks  Components

Figure 16: Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written
to: ra_gen/bsp_clock _cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.3 Configuring Pins

The Pins tab provides flexible configuration of the MCU's pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note
If the Package view window is not open in €2 studio, select Window > Show View > Pin Configurator > Package
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from the top menu bar to open it.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the RA6M3, some peripherals connected on the board

are preselected.

8% *[MyProject] RA Configuration 2

Pins Configuration

Select pin configuration

RAGM3-EK.pincfg

Pin Selection
Hpeﬁ\tertaxt & | B

v« Connectivity:5Cl A
sCio
sCi
sCI2

v SCI3
5Cl4
SCIs
SCIE

v SCI7
sCia
sCIg

i CannactnineSl Y

<

Summary | BSP | & Clocks Interrupts | Event Links | Stacks | Compeonents

<

Generate data:

Pin Configuration

Module name:

Usage:
Pin Group Selection:
Operation Mode:

Input/Qutput

£

=

g_bsp_pin_cfg

scI7

When using Simple 12C mode, ensure port ¢
open drain.

When switching between 12C and other mo
_Conly ~

Asynchronous UART ~

v 613

v (PRl

- |[%; Pin Conflicts 52

Figure 17: Pins Configuration

&1 Package 32

The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P611 is already used by the CAC, and the attempt to connect this
port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this

error, select another port from the pin drop-down list or disable the CAC in the Pin Selection pane
on the left side of the tab.
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{8} *[MyProject] RA Configuration 52 -

Pins Configuration
g Generate Project Content

Select pin configuration Pins Tutorial & ~ &),

RABM3-EK.pincfg » Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration
type filker text i | H
~ B Connectivity:5CI ~ Operation Mode: Simple 5P| v &
5CI0
scn Input/Qutput
5CI2
R TXD_MOSE: ¥ | P613 > C“>:
SCI4 RAD_MISO: v |P614 ¥ =
5CI5 |
s SCK: v |PB12 > =d
B scr €S TS 55 mERel T ed
5CI8 i .
scio L None
v Connectivity:SPI MNone V’
Connecti
v <

e sl

Summary |BSP | & Clocks | @ Pins| Interrupts | Event Links | Stacks | Components |

Figure 18: e2 studio Pin configurator

The pin configurator also shows a package view and the selected electrical or functional
characteristics of each pin.

&1 Package 3 ‘._ﬂvlﬁv@vl:'ﬁl
Connection Status
Drive Capacity

§HEEEEE
v
0aag q Mode

Output Type
Pull Up

RIFAGM3AwaFC
176LOFP

[Top View)

Figure 19: e2 studio Pin configurator package view

When you click the Generate Project Content button, the pin configuration contents are written
to: ra_gen\bsp_pin_cfg.h

This file will be created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 22 /1,444
Mar.25.20



Flexible Software Package User’s Manual

Starting Development > e2 studio User Guide > Configuring a Project > Configuring Pins

To make it easy to share pinning information for your project, e2 studio exports your pin
configuration settings to a csv format and copies the csv file to ra_gen/<MCU package>.csv.

2.2.5.4 Configuring Interrupts

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt
priority. Select the driver in the Stacks pane to view and edit its properties.

{é} *[MyProject] RA Configuration &3 =0

Stacks Configuration
g Generate Project Content

Threads 4| Mew Thread ]  HAL/Common Stacks 4] Mew Stack > | Remove
v ¢ HAL/Common = = ’ ~
4 g_ioport /0 Port Driver on r_ioport & g_lupurt (o] Fur:t 42 g_ellc ELC Driver on 4 g_uart) UART Driver on r_sci_uart
river on r_icpo r_elc
4 g_elc ELC Driver on r_elc A e
4 g_uart0 UART Driver on r_sci_uart @ @ @
ry
I I
4 g_transferl Transfer 4 g_transfer! Transfer
Objects &) New Object » Driver on r_dtc 1 Driver on r_dtc 0
@ @
v
Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components
% Pin Conflicts 4 MCU Package [ Console | [ Properties 52 P |

g_uart0 UART Driver on r_sci_uart

Mag

B e BlE0 Tignerl eyl

Settings
Receive Interrupt Priority Priority 2
Transmit Data Empty Interrupt Priority Priority 2
Transmit End Interrupt Priority Priority 2
Error Interrupt Priority Priority 2
Figure 20: Configuring Interrupt on the Stacks tab
Interrupts

In the Interrupt tab, the user can bypass a peripheral interrupt and have user-defined ISRs for the
peripheral interrupt. This can be done by adding a new event with the user define tab (New User
Event).

8 *[MyProject] RA Configuration % ==

Interrupts Configuration
P g Generate Project Content

User Events 4| New User Event > |5
Event ISR
Allocations
Interrupt Event ISR
(1] SCI0 RXI (Receive data full) sci_uart_rxi_isr
1 SCI0 TXI (Transmit data empty) sci_uart_t_isr
2. SCID TEI (Transmit end) sci_uart_tei_isr
3 SCI0 ERI (Receive error) sci_uart_eri_isr

Summary:BSP:C\ucks PmsStacks Cumponents:
Figure 21: Configuring interrupt in Interrupt Tab
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& *[MyProject] RA Configuration 33 brc > |Package 33
. . EDMAC ]
Interrupts Configuration Genel Iore g
EPTPC >
User Events 1.| 4] New User Eve | Ecu N
Event ISR CLEDE ?
GPT >
Icu >
c >
IOPORT 3
IWDT )
Allocations JPEG >
Interrupt Event . SCID RXI (Receive data full) I[3. scio B
0 SCIORXI (Receive data full) SCI0 TXI (Transmit data empty) sci >
1 SCID TXI (Transmit data empty) SCIO TEI (Transmit end) SCl2 >
2 SCID TEI (Transmit end) SCID ERI (Receive error) SCI3 >
3 SCIOERI (Receive error) SCI0 AM (Address match event) sCl4 »
SCI0 RX| OR ERI (Receive data full/Receive) SCI5 b3
Sﬁmmary ES‘P C“Io(‘k;‘f‘liins'Intarrupts.Staéks.;“Componentif. ) QsPI > sCle >
) RTC > scr7 >
- scE > s >
2. 5CI By sCig >
SDHIMMC >
<ol 3 {

Figure 22: Adding user-defined event

Enter the name of ISR for the new user event.

B New User Event x ‘

Enter the name of the ISR for the new user event:

| user_dE‘ﬁned_sm_uart_rxl_\srl ‘

Cancel
Figure 23: User-defined event ISR

48k *[MyProject] RA Configuration 53 = O

Interrupts Configuration
P g Generate Project Content

User Events 4] New User Event » 3

Event ISR

SCI0 RXI (Receive data full) user_defined_sci_uart_rxi_isr
Allocations

Interrupt Event ISR

D SCID RXl (Receive data full) user_defined_sci_uart_nxi_isr I

1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr

2 SCID TEI (Transmit end) sci_uart_tei_isr

3 SCID ERI (Receive error) sci_uart_eri_isr

:‘:ummary;éS’P ;C\oéls jli\ns Interrupts | Stacks| tbmponer;ts'

Figure 24: Using a user-defined event

2.2.5.5 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.
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9% [Blinky] RA Configuration §3 = 0
0

Event Links Configuration ;
Generate Project Content

Allocations

Peripheral Function Event

, A)} No allocation
GPT (B) No allocation

GPT (C) Mo allocation
GPT (D) No allocation
GPT (E) No allocation
GPT (F) No allocation
GPT (G) No allocation
GPT (H) No allocation
ADC12A0 No allocation
ADC12B0 No allocation
ADC12A1 No allocation

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 25: Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can
be defined by clicking the relevant New User Event button.

Note
When selecting an ELC event to receive for a module (or when manually defining an event link), only the events
that are made available by the modules configured in the project will be shown.

2.2.6 Adding Threads and Drivers

Every FreeRTOS-based RA Project includes at least one RTOS Thread and a stack of FSP modules
running in that thread. The Stacks tab is a graphical user interface which helps you to add the right
modules to a thread and configure the properties of both the threads and the modules associated
with each thread. Once you have configured the thread, e2 studio automatically generates the code
reflecting your configuration choices.

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Stacks pane, which e2 studio populates with the selected modules and module
options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread
includes the driver for I/0 control (IOPORT). The default stack is shown in the HAL/Common Stacks
pane. The default modules added to the HAL/Common driver are special in that the FSP only requires
a single instance of each, which e2 studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following
sections:

e Adding and Configuring HAL Drivers
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Once you have added a module either to HAL/Common or to a new thread, you can access the
driver's configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.
You can find details about how to configure threads here: Configuring Threads
Note

Driver and module selections and configuration options are defined in the FSP pack and can therefore change

when the FSP version changes.

2.2.6.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to
HAL/Common Stacks.

{85 *[MyProject] RA Configuration 2 i
Click here to add )
Stacks Configuration
g newmodiile Generate Project Content
Threads i ; 5 = HAL/Common Stacks 47| New Stack > s %] Remove
v g HAL/Common
& g_ioport /0 Port Driver an r_ioport 4 g_ioport [/0 Port & g_wdt) Watchdog o g_cgch CGC Driver on

M Di t Drivi dt
4 g_wdt0 Watchdog Driver on r_wdt i itk e

= g_cgch CGC Driver on r_cge

Objects

Summary.BSP Clocks | Pins | Interrupts Eventhk; Components

Figure 26: e2 studio Project configurator - Adding drivers

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.
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45 “[MyProject] RA Configuration 53 = B | gPackage X

Stacks Configuration
9 Generate Project Content

Threads = HAL/Commoen Stacks 4] New Stack >
v & HAL/Common - - Amazon FreeRTOS >
47 g_ioport /0 Port Driver on r_ioport & [gl_rlssrﬂ:nhr?nzﬂnr:t Arm > HEJ
Driver > Analog >
Middleware > CapTouch >
SEGGER > Connectivity iy
& Search.. Graphics »
Input >
Monitoring »
Network »
Power ?
Storage »
Objects System >
RTC Driver on r_rtc Timers >
»

Timer Driver on r_agt Transfer

(¢ @ ¢

Timer Driver on r_gpt

Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 27: Select a driver
4. Select the driver module in the HAL/Common Modules pane and configure the driver
properties in the Properties view.
e2 studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the ra/fsp directory

e The main() function and configuration structures and header files for your application as
shown in the table below.

File Contents Overwritten by Generate
Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called, the BSP already has
Initialized the MCU.

ra_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

ra_gen/hal_data.h Header file for HAL driver only | Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:
ra_cfg/fsp_cfg

2.2.6.2 Adding Drivers to a Thread and Configuring the Drivers
For an application that uses the RTOS, you can add one or more threads, and for each thread at least
one module that runs in the thread. You can select modules from the Driver dropdown menu. To add

modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.
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48 *[Blinky] RA Configuration £3 al e -0

Stacks Configuration

Threads | & Mew Thread | 3] Remove [=]  Mew Thread Stacks 4] New Stack> =

v g‘si‘ HAL/Common f @k Add RA stacks to the selected thread by using the 'Mew Stack »' toolbar button (above), or

42 g ioport 1O Port Driver on r_ioport /
2 Mew Thread

Generate Project Content

¥' by pasting here from the clipboard.

Objects 4| New Object >

Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components

I#] Problems =) Tasks [E) Console | [T Properties 2% |3 Call Hierarchy @ Smart Browser Memory Usage

New Thread
- Property Value
Scting: » Common
w Thread

Symbol new threadd Enter the name of your thread
MName [New Thread | here example: My Thread
Stack size (bytes) 1024
Priority 1

<

Figure 28: Adding a new RTOS Thread on the Stacks tab

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive
name and symbol for the new thread.

Note
e2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers.
HAL-level drivers can be added here.

8% *[MyProject] RA Configuration 2 = O  §&lPackage 2

Stacks Configuration
g Generate Project Content

Threads 42 New Thread #| Remove []  Mew Thread Stacks 4] New Stack
Amazon FreeRTOS >
v & ;F{';L*’Cummorn i "‘-‘ Adbd RA s:ackshto tI;a sel:;tadl.thbreaddby using the 'T Arm > ) —
" I‘\Jejjr\;f:a:h(] Port Driver on r_ioport LW or by pasting here from the clipboard. Drees 5 e 3
M CapTouch »
& 12C Master Driver on r_iic_master Connectivity »
@ 12C Slave Driver on r_iic_slave Graphics ¥
& 125 Driver on r_ssi Input »
“  SP| Driver on r_spi Monitoring »
Objects ‘a Mew Object » @ UART Driver on r_sci_uart Power »
Storage >
System »
Timers »
Transfer >

Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components

Figure 29: Adding Modules and Drivers to a thread

4. Select a module or driver from the list.

5. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
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highlighted in the Threads pane.

48 [MyProject] RA Configuration I3

Stacks Configuration

Threads

v & HAL/Common

47 g_ioport /O Port Driver on r_ioport
w i New Thread

4 g_wdt) Watchdog Driver on r_wdt

Objects 4| Mew Object >

4] New Thread 2] Remove |5

g_wdt0 Watchdog Driver on r_wdt Stacks &) New Stack >

4 g wdtD Watchdog
Driver on r_wdt

@

Summary | BSP | Clocks | Pins | Interrupts | Stacks

["’m Pin Conflicts & Console | [T Properties 3

g_wdt0 Watchdog Driver on r_wdt

Property
Common
v Module g_wdt) Watchdog Driv
Name

Settings

Timeout

Clock Division Ratio
Window Start Position
Window End Position
Reset Control

Stop Control

MMI Callhack

Components

Value

g_wdt0

16,384 Cycles

PCLK/8192

100% (Window Position Not Specified)
0% (Window Position Not Specified)
Reset Qutput

WDT Count Disabled in Low Power Mode
NI

=]

Generate Project Content

i Remove

Figure 30: Configuring Module or Driver properties

6. If needed, add another thread by clicking New Thread in the Threads pane.

When you press the Generate Project Content button for the example above, e2 studio creates

the files as shown in the following table:

File Contents

Overwritten by Generate

Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have

initialized the MCU.

ra_gen/my_thread.c Generated thread "my_thread" |Yes
and configuration structures for

modules added to this thread.

Header file for thread Yes

"my_thread"

ra_gen/my_thread.h

ra_gen/hal _data.c Configuration structures for HAL | Yes

Driver only modules.

ra_gen/hal_data.h Header file for HAL Driver only |Yes

modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.

src/my_thread_entry.c User entry point for thread No
"my_thread". Add your code

here.
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The configuration header files for all included modules and drivers are created or overwritten in the

following folders: ra_cfg/fsp_cfg/<header files>

2.2.6.3 Configuring Threads

If the application uses the FreeRTOS, the Stacks tab can be used to simplify the creation of

FreeRTOS threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memory Allocation
Co-routines
Timers
Optienal Functions
v Thread

Symbol new_thread
Mame Mew Thread
Stack size (bytes) 1024
Priority L

Figure 31: New Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this

particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can
be easily configured. e2 studio checks that the entries in the property field are valid. For example, it
will verify that the field Priority, which requires an integer value, only contains numeric values

between 0 and 9.

To add FreeRTOS resources to a Thread, select a thread and click on New Object in the Thread
Objects pane. The pane takes on the name of the selected thread, in this case My Thread Objects.

48% *[Blinky] RA Configuration &2 | [£] hal_entry.c

Stacks Configuration

Threads & New Thread | Remove [5]  Mew Thread Stacks 4] New Stack >

v & HAL/Common

4% g_ioport /0 Port Driver on r_iopol
v i New Thread

45 g_timerD Timer Driver on r_gpt @

4 g_timerD Timer Driver
onr_gpt

Click to add new Thread

o 5 Objects to New Thread

Objects s
T i tiew Dbicel @  Event Groups

@ g_new_event flagsOEve @& Mutex |
@ g new_queued Queve! @ Queue |

— | @ Semaphore I
Summary | BSP | Clacks | Pins Iﬁmﬁ's{ai‘k‘s‘”wrments
[ Properties £
g_new_queue0 Queue
Settings Property Yalue
Name MNew Queue I
Symbol g_new_queued
Item Size (Bytes) 4
Queue Length (items) 20

Figure 32: Configuring Thread Object Properties

=

Generate Project Content

%] Remove
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Make sure to give each thread object a unique name and symbol by updating the Name and
Symbol entries in the Properties view.

2.2.7 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all RA MCU projects are preselected (for example: BSP > BSP >
Board-specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the
modules selected in the Stacks tab are included automatically. You can include or exclude

additional modules by ticking the box next to the required component.

{8 [MyProject] RA Configuration 33

Components Configuration

Component

w rabm2

w @ rabm3
[¥] device
[@] device
7| device
] device
device
device

device
] device
[F] device
| device
7| device
¥ fsp
~ @ty CMSIS
v @ CMSISS
[¥] CoreM
v ¥ Common
v @ all
¥| fsp_commen
v gty HAL Drivers
w @ all
[ r_acmplp

Summary |BSP | Clocks Pins.\nterrupts Sta{k

Version

0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0

0.6.0

0.6.0

0.6.0

Description

Board support package for RTFAGM3IAHICFC
Board support package for RAGM3

Board support package for RTFAGM3IAF2CBG
Board support package for RFTFAGM3IAFZCLK

Board support package for RTFAGM3IAFICFB

Board support package for RFFAGM3IAF3CFC

Board support package for RTFAGM3IAFICFP

Board support package for RTFABM3AH2CBG
Board support package for RTFAGM3IAH2ZCLK
Board support package for RFTFAGM3IAHICFB
Board support package for RTFAGM3IAH3CFP
Board support package for RAGM3

Arm CMSIS Version 5 - Core (M)

Board Support Package Common Files

Low Power Analog Comparator

Figure 33: Components Tab

Variant

R7FAGM3AH3CFC

R7FAEM3AFZCBG
R7FAGM3AFZCLK
R7FAGM3AF3CFB
R7FAGM3AF3CFC
R7FAGM3AF3CFP
R7FA6M3AHZCBG
R7FAEM3AHZCLK
R7FAGM3AH3CFB
R7FAGM3AHICFP

While the components tab selects modules for a project, you must configure the modules
themselves in the other tabs. clicking the Generate Project Content button copies the .c and .h
files for each component for a Pack file into the following folders:

* ra/fsp/inc/api
 ra/fsp/inc/instances

e ra/fsp/src/bsp

» ra/fsp/src/<Driver_ Name>

e2 studio also creates configuration files in the ra_cfg/fsp_cfg folder with configuration options
included from the remaining Stacks tabs.

2.2.8 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Stacks tab,
you can add the application code that calls the Modules and drivers.

Note

To check your configuration, build the project once without errors before adding any of your own application code.
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2.2.8.1 Coding Features

e2 studio provides several efficiency improving features that help write code. Review these features
prior to digging into the code development step-by-step sections that follow.

Edit Hover

e2 studio supports hovers in the textual editor. This function can be enabled or disabled via Window
> Preferences > C/C++ > Editor > Hovers.

BH Preferences

type filter text

Code Style

Core Build Toolchains

Debug

v Editor

Content Assist
Encrypted Files
Folding
Hovers
Mark Occurrences
Save Actions
Scalability
Syntax Coloring
Templates
Typing

File Types

Indexer

Language Mappings

New C/C++ Project Wizard

Property Pages Settings

Renesas

Task Tags

Template Default Values

@ @

Hovers

Expand vertical ruler icons upon hovering [does not affect open editors)
Text Hover key modifier preferences:
Pressed Key Modifier While Hoverin:

Text Hover Name
[+] Combined Hover

J Debugger

:l Renesas |O Register Help

:l RenesasCDocHover

|| Problem Description

J Documentation

j Macro Expansion

7] Source Shift
:l Annotation Description

Pressed key modifier while hovering:‘
Description:

Tries the hovers in the sequence listed below and uses the one which fits best
for the selected element and the current context.

Restore Defaults Apply

Apply and Close Cancel

Figure 34: Hover preference

To enable hover, check Combined Hover box. To disable it, uncheck this box. By default, it is
enabled. The Hover function allows a user to view detailed information about any identifiers in the
source code by hovering the mouse over an identifier and checking the pop-up.

bsp_leds_t leds;

/* LED state variable */
ioport_level_t level = IOPORT_LEVEL_HIGH;

A SELR- B AR
4 hal_data.h
& hal_entry(void)

[* Get LED information for this board */

R_BSP LedsGet(&leds);

Name: R_BSP_LedsGet

| & Prototype: ssp err tR BSP LedsGet (bsp leds t *p leds)
| Description:
. ._': Return information about the LEDs on the current board.
| £ z ] . 2 . :
| 55 Structure with LED information. p_leds Pointer to structure where LED info is stored.
|
| £
| &2
i I J
| G

63 {
| S level = IOPORT_LEVEL_LOW;
| }

Figure 35: Hover Example
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Welcome Window

The e2 studio Welcome window displays useful information and common links to assist in
development. Check out these resources to see what is available. They are updated with each
release, so check back to see what has been added after a new release.

RA_Workspace - Blinky/src/hal_entry.c - € studio - O X
File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help
5' (@) Welcome 31 ] fafEH=-~
s
il RENESAS Welcome to e2 studio >
Workbench
Create a new e2 studio C/C++ project Get an overview of the features
Import existing e studio projects from the Go through tutorials

filesystem or archive

Try out the samples
Review the IDE's most fiercely contested ¥ B

preferences

Find out what is new
Open a file from the filesystem

M1 aiways show Welcome at start up

B

Figure 36: Welcome window

Cheat Sheets

Cheat sheets are macro driven illustrations of some common tasks. They show, step-by-step, what
commands and menus are used. These will be populated with more examples on each release.
Cheat Sheets are available from the Help menu.
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RA_Workspace - Blinky/src/hal_entry.c - € studio - m} X
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
Q%] 45 Debug v || £ Blinky Debug v ) Welcome
O~ ME DS B L Q@™ 4 i 48 ~ &5l v @ HelpContents
%’ Search
- Show Contextual Help
[ Project Explorer 53 = G| & Y = B {8 [Blinky] RA Configuration
e o ) . ] Show Active Keybindings... Ctrl+Shift
v [ Blinky [Debug] A 1 #include ) )
w1l Includes [ 2 #include ' Tips and Tricks...
@ ra #include ' & Report Bug or Ephgncement...
(£ ra_gen — 5 void R BSI Cheat Sheets...
v G src 5 -
| hal_entry.c @ * The RA RA Helpdesk
= ra_cfg void _hﬂ_‘ R RenesasRulz Community Forum
(= script

47 Add Renesas Toclchains

B Blinky Debug.launch w Perform Setup Tasks...

48 configurationxml }
-| RVFA6M3AH3CFC.pincfg % Check for Updates
5 ra_cfg.bt v - i _T,h'_l, Spf: (g Install New Software...
< > < Renesas e2 studio feedback
[T] Properties 52 : > : > = B8 [:Q Pin Conflic' §& |AR Embedded Workbench plugin manager...
B 3 B v |Qitems B About e studio
Property Value Descrip!ion o L L}

Figure 37: Cheat Sheets

Developer Assistance

FSP Developer Assistance provides developers with module and Application Programming Interface
(API) reference documentation in e2 studio. After configuring the threads and software stacks for an
FSP project with the Configuration Editor, Developer Assistance quickly helps you get started writing
C/C++ application code for the project using the configured stack modules.

1. Expand the project explorer to view Developer Assistance
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JL
d
q
0
(I

iy Project Explorer &3 B <
v 15 Blinky
m) Includes
2 ra
(2 ra_gen
(2 src
= ra_cfg
(= script
2| Blinky Debug.launch
&% configuration.xml
=] R7TFABM3AH3CFC.pincfg
= ra_cfg.bd
) RASM3-EK pincig

v (2) Developer Assistance
v % HAL/Common
& g_ioport /O Port Driver on r_ioport
47 g_elc ELC Driver onr_elc
4 g_adc0 ADC Driver on r_adc

Figure 38: Developer Assistance

2. Expand a stack module to show its APIs

v (@ DevelnparAssist;nce
v gt HAL/Common

42 g_joport |70 Port Driver on r_ioport
47 g_elc ELC Driver on r_elc
w & g_adch ADC Driver on r_adc

~ @ fsp_err t R_ADC_Open(adc_ctrl_t *p_ctrl, ade_cfg_t const *const p_cfg)
| Call R_ADC_Open()

v @ fsp_err t R_ADC ScanCfg(ade_ctrl_t *p_ctrl, adc_channel_cfg_t const *const p_channel_cfg)
|2 Call R_ADC ScanCfg()

v @ fsp_err t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
[t Call R_ADC InfoGet()

v @ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)
|23 Call R_ADC ScanStart()

v @ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl}
|23 Call R_ADC_ScanStop()

v @ fsp_err t R_ADC StatusGet{adc_ctrl_t *p_ctrl, ade_status_t *p_status)
|24 Call R_ADC_StatusGet()

~ @ fsp_err t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t *const p_data)
[t3 Call R_ADC_Read()

~ @ fon errtR ADNC Read32(ade ctrl t *n ctrl ade channel t const ren id uint3? + *const 0 datal

Figure 39: Developer Assistance APIs

]

3. Dragging and dropping an API from Develop Assistance to a source file helps to write source

code quickly.
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~ [(7) Developer Assistance
v g HAL/Common
4 g_iopert I/0 Port Driver on r_ioport
48 g_elc ELC Driver on r_elc
v & g_adc0 ADC Driver on r_adc

v @ fsp_em_t R_ADC_Open(adc_ctrl_t *p_ctrl, adc_cfg_t const "const p_cfg)
b= Call R_ADC_Openi)

v @ fsp_em_t R_ADC_ ScanCfg(adc_ctrl_t *p_ctr, adc_channel_cfg_t const *const p_channel_cfg)
b= Call R_ADC_ScanCfg()

v @ fsp_em_t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
= Call R_ADC InfoGet()

v @ fsp_em_t R_ADC_ ScanStart(adc_ctrl_t "p_ctrl)
[z Call R_ADC_ScanStart()

v @ fsp_em_t R_ADC_ ScanStop(adc_ctrl_t "p_ctrl)
bz Call R_ADC_ScanStop()

v @ fsp_em_t R_ADC StatusGet(adc_ctrl_t *p_ctrl, adc_status_t *p_status)
= Call R_ADC_StatusGet()

v @ fsp_em_t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t “const p_data)
= Call R_ADC_Read()

~ @ fan err t R ANC Read3?fade ctrl + *n ctrl ade channel t conct rea id uint3? t “conet o datal a2

<

Figure 40: Dragging and Dropping an API in Developer Assistance

Information Icon

Information icons are available on each module in the thread stack. Clicking on these icons opens a
module folder on GitHub that contains additional information on the module. An example information
Icon is shown below:

47 g_ioport 1/0 Port

\ Driver on r_ioport
D

Figure 41: Information icon

Smart Manual

Smart Manual is the view that displays information (register information/search results by keyword)
extracted from the hardware user's manual. Smart Manual provides search capability of hardware
manual information (register information search and keyword search result) and provides a view
displaying result.

You can open Smart Manual view by selecting the menu: Renesas Views > Solution Toolkit >
Smart Manual. Register search and Keyword search are both available by selecting the appropriate
tab.
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(%3 Pin Conflicts I} Smart Manual i3 S @ v = 8

Register Search Keyword Search

port v|I Go ]Device:RA6M

No search results available.

< >

Figure 42: Smart Manual

2.2.8.2 RTOS-independent Applications

To write application code:

1. Add all drivers and modules in the Stacks tab and resolve all dependencies flagged by e2
studio such as missing interrupts or drivers.

2. Configure the drivers in the Properties view.

3. In the Project Configuration view, click the Generate Project Content button.

4. In the Project Explorer view, double-click on the src/hal_entry.c file to edit the source file.

]
£

[y Project Explorer 3 = =
-
~

125 Blinky
T FSP_project
w 15 MyProject [Debug]

#éb.

[ Includes
Era
(= ra_gen
v B src
[€ hal_entry.c
(= Debug
(= ra_cfg
(= script
=| A2A1-TBB.pincfg

Binaries

Note

All configuration structures necessary for the driver to be called in the application are initialized in
ra_gen/hal_data.c.
Warning

Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

5. Add your application code here:
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[€] hal_entry.c 52 | §5% [MyProject] RA Configuration

1 #include "hal Hata.h”

2 #include "bsp_pin_cfg.h"

3 #include "r_ioport.h"

5 void R_BSP_WarmStart(bsp warm start ever
8 @ * The RA Configuration tool generates n

11 wvoid hal_entry({void)
12 {

=13 £¥ : add your own code here */
- ' \

Add your own code here

Figure 43: Adding user code to hal_entry.c

6. Build the project without errors by clicking on Project > Build Project.

The following tutorial shows how execute the steps above and add application code: Tutorial: Using
HAL Drivers - Programming the WDT.

The WDT example is a HAL level application which does not use an RTOS. The user guides for each
module also include basic application code that you can add to hal_entry.c.

2.2.8.3 RTOS Applications
To write RTOS-aware application code using FreeRTOS, follow these steps:

1. Add a thread using the Stacks tab.

2. Provide a unique name for the thread in the Properties view for this thread.

3. Configure all drivers and resources for this thread and resolve all dependencies flagged by
e2 studio such as missing interrupts or drivers.

4. Configure the thread objects.

5. Provide unique names for each thread object in the Properties view for each object.

6. Add more threads if needed and repeat steps 1 to 5.

7. In the RA Project Editor, click the Generate Project Content button.

8. In the Project Explorer view, double-click on the src/my_thread_1_entry.c file to edit the
source file.

[y Project Explorer 3 = 8

& -
~ 15 RA_RTOS_Application [Debug]  ~
[ Includes
Era
v 8 ra_gen
[.g] blinky_thread.c
blinky_thread.h
bsp_clock_cfg.h
bsp_pin_cfg.h
[€] common_data.c
comrmon_data.h
lg] hal_data.c
hal_data.h
] main.c
1€ my_thread_1.c
rmy_thread_1.h
€] pin_data.c
|.g] vector_data.c
vector_data.h
2] ABM3-PK.csv
v B src

lg] blinky_thread_entry.c
lg] hal_entry.c
l.g] my_thread_1_entry.c

(= ra_cfg

(= script

= ABM3-PK.pincfg

& configurationxml

=| RTFABM3AH3CFC.pincfg

< >

Figure 44: Generated files for an RTOS application
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Note
All configuration structures necessary for the driver to be called in the application are initialized in

ra_gen/my thread_1.c and my thread 2.c

Warning
Do not modify the files in the directory ra_gen. These files are overwritten every

time you push the Generate Project Content button.

9. Add your application code here:

ﬁh [RA_RTOS_Application] RA Configuration S(s’l \€] my_thread_1_entry.c 3% |

R N f{"‘,‘i“?:’;Z‘git[P.A_RTOs_i\pp|icatwf‘n_-'ccnﬁguratim.xnﬂ |
4 void my_thread_1_entry{void *pvParameters)

{
s);

/ : add your own code here */
while (1)

wTaskDelay (1);
]

[

Figure 45: Adding user code to my_thread_1.entry

10. Repeat steps 1 to 9 for the next thread.
11. Build your project without errors by clicking on Project > Build Project.

2.2.9 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to
the board and execute it.

To debug an application follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

R MY =

[E7] 1 FSP_project Debug
Debug As >
Debug Configurations...

Organize Favorites...

2. In the Debug Configurations view, click on your project listed as MyProject Debug.
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Debug Configurations X
Create, manage, and run configurations ﬁ\.
X[ E - MName: [ MyProject Debug |
type filter text [£] Main . %5 Debugger| B» Startup| (] Common 1/ Source

[] C/C++ Application

[] C/C++ Remote Applicatic
EASE Script | MyProject Browse...

[] GDB Hardware Debuggin: || ¢/C++ Application:

[ ] GDB OpenOCD Debuggin

GDE Simulator Debuggin
Java Applet Variables... Search Project... Browse...
Java Application

R Launch Group

= Launch Group (Deprecate Build Configuration: | Use Active A
Remote Java Application

Project:

[ Debug/MyProject.clf

Build (if required) before launching

v [7] Renesas GDB Hardware D (O Enable aute build () Disable aute build
[£¥] MyProject Debug (®) Use workspace settings Configure Workspace Settings...
Renesas Simulater Debug
< >
Revert Appl,
Filter matched 14 of 16 items B2 s
@ Close

3. Connect the board to your PC via either a standalone Segger J-Link debugger or a Segger J-
Link On-Board (included on all RA EKs) and click Debug.

Note
For details on using J-Link and connecting the board to the PC, see the Quick Start Guide included in the RA MCU
Kit.

2.2.10 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for
example, to change optimization level of the compiler or add a library to the linker). Such
modifications can be made from within e2 studio through the menu Project > Properties >
Settings when the project is selected. The following screenshot shows the settings dialog for the
GNU ARM toolchain. This dialog will look slightly different depending upon the toolchain being used.
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Properties for Blinky

Resource

Builders

C/C++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Editer

C/C++ General

MCu

Project References

Renesas QE

<

Settings R =

Configuration: | Debug [ Active ] ~ | | Manage Configurations...

i Tool Settings i3 Toolchain # Build Steps Build Artifact [m Binary Parsers @3 Error Parsers

(22 Target Processor
(2 Optimization
(# Wamings
(2 Debugging
~ 5 GNU ARM Cross Assembler

ARM family cortex-m#4 %
Architecture Toolchain default &

Instruction set Thumb (-mthumb) ~

Run/Debug Settings
Task Repository
Task Tags
Validation

e
@

Figure 46:

(£2 Preprocessor

(22 Includes

(2 Warnings

(£ Miscellaneous

GMNU ARM Cross C Compiler
(£2 Preprocessor

(22 Includes

(2 Optimization

(2 Warnings

(£ Miscellaneous

GMNU ARM Cross C Linker
(2 General

(£ Libraries

(£ Miscellaneous

GMNU ARM Cross Create Flash Image
(2 General

[[] Thumb interwork (-mthumb-interwork)

Endianness Toolchain default

Float ABI FP instructions (hard)

FPU Type fpvd-sp-d16

Unaligned access | Toolchain default
Generic (-mcpu=generic)
Toolchain default
Toolchain default
Toolchain default

Enabled {+simd)

Small (-mcmedel=small)

Apply and Close

e2 studio Project toolchain settings

Cancel

The scope for the settings is project scope which means that the settings are valid only for the

project being modified.

The settings for the linker which control the location of the various memory sections are contained in
a script file specific for the device being used. This script file is included in the project when it is
created and is found in the script folder (for example, /script/aém3.Id).

2.2.11 Importing an Existing Project into e2 studio

1. Start by opening e2 studio.
2. Open an existing Workspace to import the project and skip to step d. If the workspace
doesn't exist, proceed with the following steps:

a. At the end of e2 studio startup, you will see the Workspace Launcher Dialog box as
shown in the following figure.

H Eclipse Launcher

Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

RIS ETEWEC \Users\\ < user_namele2studio\workspace]

[] Use this as the default and do not ask again

» Recent Workspaces

Figure 47: Workspace Launcher dialog

w Browse...
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b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the
following figure. e2 studio creates a new workspace with this name.

E Eclipse Launcher

*
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts,

IR ET N Users\ <username > \e2studiol\new workspace] Browse...

[] Use this as the default and de not ask again

b Recent Workspaces

Cancel
Figure 48: Workspace Launcher dialog - Select Workspace

c. Click Launch.

d. When the workspace is opened, you may see the Welcome Window. Click on the

Workbench arrow button to proceed past the Welcome Screen as seen in the
following figure.

RENESAS Welcome to e2 studio (=)

Workbench

Figure 49: Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu
in the menu bar, as shown in the following figure.

File Edit Source Refactdr Mavigate ° e Menu Bar
@J @ .,E. e Tool Bar

G- @@ it G

Figure 50: Menu and tool bar

4. Click Import on the File menu or in the menu bar, as shown in the following figure.
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File Edit Source Refactor Navigate

New
Open File...

(3 Open Projects from File System...

Close
Close All

Save
Save As...
Save All
Revert
Move...
Rename...
Refresh

Convert Line Delimiters To

Print...

B

7 Import.
Export...

Properties

Search Project Renesa

1 Web Browser [tool-support.renesas.c...]

Switch Workspace
Restart
Exit

Alt+Shift+N »

Ctrl+W

Ctrl+ Shift+ W

Ctrl+5

Ctrl+Shift+5

Ctrl+P

Alt+Enter

Figure 51: File drop-down menu

5. In the Import dialog box, as shown in the following figure, choose the General option, then
Existing Projects into Workspace, to import the project into the current workspace.

Existing Projects into Workspace" option selected"

6. Click Next.

7. To import the project, use either Select archive file or Select root directory.

a. Click Select archive file as shown in the following figure.

ﬁ Import

Select

Create new projects from an archive file or directory.

Select an import wizard:

type filter text

v = General

I Archive File
&) CMSIS Pack
&) CMSIS Pack
- Existing Projects into Workspace
(= File System
[T Preferences
() Projects from Folder or Archive

=% Rename & Import Existing C/C++ Project into Workspace

oy

< Back Next >

E

Cancel

Figure 52: Project Import dialog with
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B import O x
Import Projects o
Select a directory to search for existing Eclipse projects, / A,'
(0 Select root directo ny Browse..
I@ Select archive file: I | | ~ |I Browse... I
Projects:
Select All
Deselect All
Refresh
Options

Search for nested projects
Copy projects into workspace

[[] Hide projects that already exist in the workspace

Working sets

[JAdd project to working sets Mew...
Sele

=

@ < Back et Finish Cance)

Figure 53: Import Existing Project dialog 1 - Select archive file

b. Click Select root directory as shown in the following figure.

B8 import m] X
Import Projects ¥ *\
Select a directory to search for existing Eclipse projects. / ‘
I@ Select root directory: I‘ ‘ ~ |I Browse... |
() Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options

[[15earch for nested projects
Copy projects into workspace
[[IHide projects that already exist in the workspace

Working sets

[[] Add project to working sets New...
Selec

@ < Back Mo > e T

Figure 54: Import Existing Project dialog 1 - Select root directory

. Click Browse.

. For Select archive file, browse to the folder where the zip file for the project you want to
import is located. For Select root directory, browse to the project folder that you want to
import.

10. Select the file for import. In our example, it is CAN_HAL MG_AP.zip or CAN_HAL MG _AP.

O 00
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11. Click Open.

12. Select the project to import from the list of Projects, as shown in the following figure.

Projects:

CAN_HAL_MG_AP (CAN_HAL_MG_AP/)
Figure 55: Import Existing Project dialog 2

13. Click Finish to import the project.

2.3 Tutorial: Your First RA MCU Project - Blinky

2.3.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the
steps of creating a simple application using e2 studio and running that application on an RA MCU
board.

2.3.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microcontrollers. If the LED blinks you know that:

e The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.

e The microcontroller is alive, the clocks are running, and the memory is initialized.

The Blinky example application used in this tutorial is designed to run the same way on all boards
offered by Renesas that hold the RA microcontroller. The code in Blinky is completely board
independent. It does the work by calling into the BSP (board support package) for the particular
board it is running on. This works because:

e Every board has at least one LED connected to a GPIO pin.

e That one LED is always labeled LED1 on the silk screen.

e Every BSP supports an API that returns a list of LEDs on a board, and their port and pin
assignments.

2.3.3 Prerequisites

To follow this tutorial, you need:
e Windows based PC
e e2 studio

e Flexible Software Package
e An RA MCU board kit

2.3.4 Create a New Project for Blinky
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The creation and configuration of an RA MCU project is the first step in the creation of an application.
The base RA MCU pack includes a pre-written Blinky example application that is simple and works on

all Renesas RA MCU boards.

Follow these steps to create an RA MCU project:

1. In e2 studio, click File > New > RA Project and select Renesas RA C Executable

Project.

2. Assign a name to this new project. Blinky is a good name to use for this tutorial.

3. Click Next. The Project Configuration window shows your selection.

H 2 studio - Project Configuration (RA C Executable Project) m]

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details.

Project Toolchains

Project name | Blinky GCC ARM Embedded

Use default location

D:\FSPAFSP_Workspace\Blinky

=
=]
i

default

':?)' <Back | Mext > Finish Cancel

Figure 56: e2 studio Project Configuration window (part 1)

4. Select the board support package by selecting the name of your board from the Device

Selection drop-down list and click Next.
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e studio - Project Configuration (RA C Executable Project) O X

e2 studio - Project Configuration (RA C Executable Project) p—
Select the board support that you require.

Device Selection

FSP version: |0.8.0-rc.0 Fosid Detalk

Board: ~

Device: RYFABM3IAHICFC

RTOS: No RTOS ~
Select Tools Available Tools
Toolchain: GCC ARM Embedded ~ GCC ARM Embedded
Toolchain version: | 8.3.1.20190703 ~ ol

7.3.1.20180622

Debugger: J-Link ARM ~ 7.2.1.20170904
4.9.3.20150529

v Debuggers
J-Link ARM

~ Smart Manual
10 Registers Supported
Software Manual Supported

(?) < Back Next > Finish Cancel

Figure 57: e2 studio Project Configuration window (part 2)

5. Select the Blinky template for your board and click Finish.

E e2 studio - Project Configuration (RA C Executable Project] m] X

22 studio - Project Configuration (RA C Executable Project) —
Select the type of project you wish to create.

Project Template Selection

@ .. Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will
initialize clocks, pins, stacks, and the C runtime environment.

[Renesas.RA.0.8.0-re.0.pack]

O (;} Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks,
and the C runtime environment.

[Renesas.RA0.8.0-rc.0.pack]

Code Generation Settings
Use RA Code Formatter

) e S Conc

Figure 58: e2 studio Project Configuration window (part 3)

Once the project has been created, the name of the project will show up in the Project
Explorer window of e2 studio. Now click the Generate Project Content button in the top
right corner of the Project Configuration window to generate your board specific files.
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{8% [Blinky] RA Configuration 52 S =
SUmmary Generate Project Content

Project Summary ) A

RENESAS

Board: EK-RAGM3

Device: R7FABM3AH3CFC

Toolchain: GCC ARM Embedded

Toolchain Version: 8.3.1.20190703

FSP Version: 0.8.0-rc.0

Selected software components L¥

Figure 59: e2 studio Project Configuration tab

Your new project is now created, configured, and ready to build.

2.3.4.1 Details about the Blinky Configuration

The Generate Project Content button creates configuration header files, copies source files from
templates, and generally configures the project based on the state of the Project Configuration
screen.

For example, if you check a box next to a module in the Components tab and click the Generate
Project Content button, all the files necessary for the inclusion of that module into the project will
be copied or created. If that same check box is then unchecked those files will be deleted.

2.3.4.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e2 studio for the Blinky application.
The clock configuration tab (see Configuring Clocks) shows the Blinky clock configuration. The Blinky
clock configuration is stored in the BSP clock configuration file (see BSP Clock Configuration).
2.3.4.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e2 studio
for the Blinky application. The pin configuration tab shows the pin configuration for the Blinky
application (see Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file
(see BSP Pin Configuration).

2.3.4.4 Configuring the Parameters for Blinky Components

The Blinky project automatically selects the following HAL components in the Components tab:

e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the
HAL window for the respective driver (see Adding and Configuring HAL Drivers).

2.3.4.5 Where is main()?
The main function is located in < project >/ra_gen/main.c. It is one of the files that are generated
during the project creation stage and only contains a call to hal_entry(). For more information on

generated files, see Adding and Configuring HAL Drivers.

2.3.4.6 Blinky Example Code
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The blinky application is stored in the hal_entry.c file. This file is generated by e2 studio when you
select the Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:
1. Get the LED information for the selected board by bsp_leds_t structure.
2. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.
3. Get the selected system clock speed and scale down the clock, so the LED toggling can be
observed.
4. Toggle the LED by writing to the GPIO pin with R_BSP_PinWrite((bsp_io_port_pin_t) pin,
pin_level);
2.3.5 Build the Blinky Project
Highlight the new project in the Project Explorer window by clicking on it and build it.
There are three ways to build a project:
a. Click on Project in the menu bar and select Build Project.

b. Click on the hammer icon.

c. Right-click on the project and select Build Project.

R s Views Run Window

B workspace - & studio

File Edit Navigate Searc

a. Project->Build Project

b. Click hammer icon

¢. Right click->Build Project

Figure 60: e2 studio Project Explorer window

Once the build is complete a message is displayed in the build Console window that displays the
final image file name and section sizes in that image.

2 = [ Console &2
COT Build Console [Blinky]

"Finished building: ../ra/board/raém3_ek/board_leds.c’
"Finished building: ../ra/board/raém3_ek/board_init.c’

*Finished building: ../ra/board/raém3_ek/board_gspi.c’

'Building target: Blinky.elf'
"Invoking: GNU ARM Cross C Linker'
arm-none-eabi-gcc @"Blinky.elf.in"
"Finished building target: Blinky.elf'

"Invoking: GNU ARM Cross Create Flash Image'
arm-none-eabi-objcopy -0 srec "Blinky.elf™ "Blinky.srec™
"Invoking: GNU ARM Cross Print Size'
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4248 8 1152 5488 1518 Blinky.elf
"Finished building: Blinky.srec'
"Finished building: Blinky.siz'

11:5@:45 Build Finished. @ errors, @ warnings. (took 19s.268ms)

Figure 61: e2 studio Project Build console
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2.3.6 Debug the Blinky Project

2.3.6.1 Debug prerequisites
To debug the project on a board, you need
e The board to be connected to e2 studio
e The debugger to be configured to talk to the board

e The application to be programmed to the microcontroller

Applications run from the internal flash of your microcontroller. To run or debug the application, the
application must first be programmed to the microcontroller's flash. There are two ways to do this:

e |JTAG debugger
¢ Built-in boot-loader via UART or USB

Some boards have an on-board JTAG debugger and others require an external JTAG debugger
connected to a header on the board.

Refer to your board's user manual to learn how to connect the JTAG debugger to e2 studio.
2.3.6.2 Debug steps
To debug the Blinky application, follow these steps:

1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run | Window Help

B Tracex >
B  Tracealyzer >
@, Run Ctrl+F11
&, Debug F11
Run History >
Run As >
Run Configurations...
Debug History >
Debug As >
Debug Cenfigurations... I
Q, External Tools >

Figure 62: e2 studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger
Configurations ...

e Qi

Debug As >
Debug Configurations...

Organize Favorites.

Figure 63: e2 studio Debugger Configurations selection option

2. Select your debugger configuration in the window. If it is not visible then it must be created
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by clicking the New icon in the top left corner of the window. Once selected, the Debug

Configuration window displays the Debug configuration for your Blinky project.

E Debug Cenfigurations X

Create, manage, and run configurations

S XR|[B 3~ | Name: [ Blinky Debug |

type filter text B Main ﬁDahugge? i Startup | B Source| [} Common

[T] C/C++ Application

[E] C/C++ Remote Applicz

= EASE Script | Blinky Browse...

[€] GDB Hardware Debugg || | ¢/ Application:

c | GDB OpenOCD Debuge =

g GDB S\:’w\ator Debuggg- | DEDug/Blinky:clt
Java Applet Variables... Search Project... Browse...
Java Application

 Launch Group

@ Launch Group (Deprec: Build Configuration: | Use Active bl
Remote Java Applicatio

Project:

Build (if required) before launching

« [E¥ Renesas GDB Hardware () Enable auto build () Disable auto build
Blinky Debug (®) Use workspace settings Configure Workspace Settings...
[c7] Renesas Simulator Debt
< >
Revert Appl
Filter matched 14 of 16 items < PEN
@ Close

Figure 64: e2 studio Debugger Configurations window with Blinky project

3. Click Debug to begin debugging the application.

4. Extracting RA Debug.

Progress Information m] X

Configuring GDB

2.3.6.3 Details about the Debug Process

In debug mode, e2 studio executes the following tasks:

1. Downloading the application image to the microcontroller and programming the image to

the internal flash memory.
. Setting a breakpoint at main().
. Setting the stack pointer register to the stack.
. Loading the program counter register with the address of the reset vector.
. Displaying the startup code where the program counter points to.

b wWwN
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Program Counter

{8% [Blinky] RA Configgfation L€l hal_entry.c Lg startup.c 2

@ * MCU starts executing here out of re
void Reset Handler (void)

20800al3 | ]

/* Initialize system using BSP. */
@Bdala SystemInit();

/* Call user application. */
6 BeBBBale main();

while (1)
1

Figure 65: e2 studio Debugger memory window

2.3.7 Run the Blinky Project

While in Debug mode, click Run > Resume or click on the Play icon twice.

L U

Figure 66: e2 studio Debugger Play icon

The LEDs on the board marked LED1, LED2, and LED3 should now be blinking.

2.4 Tutorial: Using HAL Drivers - Programming the WDT

2.4.1 Application WDT

This application uses the WDT Interface implemented by the WDT HAL Driver WDT. This document
describes how to use e2 studio and FSP to create an application for the RA MCU Watchdog Timer
(WDT) peripheral. This application makes use of the following FSP modules:

e MCU Board Support Package
e Watchdog Timer (r_wdt)
e |/O Ports (r_ioport)

2.4.2 Creating a WDT Application Using the RA MCU FSP and e2 studio
2.4.2.1 Using the FSP and e2 studio

The Flexible Software Package (FSP) from Renesas provides a complete driver library for developing
RA MCU applications. The FSP provides Hardware Abstraction Layer (HAL) drivers, Board Support
Package (BSP) drivers for the developer to use to create applications. The FSP is integrated into
Renesas e2 studio based on eclipse providing build (editor, compiler and linker) and debug phases
with an extended GNU Debug (GDB) interface.

2.4.2.2 The WDT Application

The flowchart for the WDT application is shown below.
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BSP initialises
docks, pins etc

2 Initialise WDT

Loop Count =30

4 Turnonred LED and delay Lot

Turn off red LED and delay

Tickle WDT

Turn ongreenLEDamtdelay P

Il

Turn off green LED and delay

Figure 67: WDT Application flow diagram

2.4.2.3 WDT Application flow
These are the main parts of the WDT application:

1. main() calls hal_entry(). The function hal_entry() is created by the FSP with a placeholder for
user code. The code for the WDT will be added to this function.

2. Initialize the WDT, but do not start it.

3. Start the WDT by refreshing it.

4. The red LED is flashed 30 times and refreshes the watchdog each time the LED state is
changed.

5. Flash the green LED but DO NOT refresh the watchdog. After the timeout period of the
watchdog the device will reset which can be observed by the flashing red LED again as the
sequence repeats.

2.4.3 Creating the Project with e2 studio
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Start e2 studio and choose a workspace folder in the Workspace Launcher. Configure a new RA MCU

project as follows.

1. Select File > New > RA C/C++ Project. Then select the template for the project.

FSP_workspace 1 - & studio

Eile Edit MNavigate Search Project RenesasViews Run Window Help

Alt+Shift+N » | = RA C/C++ Project

New
Open File... ™ Project...
() Open Projects from File System... % Eample..
Close Chrl+W 9 Other..
E MNew RA C/C++ Project

Templates for New RA C/C++ Project

C—

C/C++

Ctrl+N

Renesas RA C Executable Project
FEEN A C Executable Project for Renesas RA.

Renesas RA C Library Project
y Proj
FEEZ= A C Library Project for Renesos RA.

Renesas RA C Project Using RA Library
FE= Creates a C application project which uses an
existing RA library project

Renesas RA C++ Executable Project
FEEN A C++ Executable Project for Renesas RA.

Renesas RA C+ -+ Library Project
y Proj
FEZ= A C++ Library Project for Renesas RA.

<

ey
@

< Back Mext > Einish

Cancel

Figure 68: Creating a new project

2. In e2 studio Project Configuration (RA Project) window enter a project name, for
example, WDT_Application. In addition select the toolchain. If you want to choose new
locations for the project unselect Use default location. Click Next.
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e studic - Project Configuration (RA C Executable Project) O *

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details,

Project Toolchains

Project name | WDT_Application| GCC ARM Embedded

Use default location
DAFSPAFSP_Warkspace\WOT_Application Browse

default

< Back Next » Einish Cancel

Figure 69: Project configuration (part 1)

3. This application runs on the RA6M3 board. So, for the Board select EK-RA6M3.

This will automatically populate the Device drop-down with the correct device used on this

board. Select the Toolchain version. Select J-Link ARM as the Debugger. Click Next to
configure the project.

22 studio - Project Configuration (RA C Executable Project)
Select the board support that you require.

Device Selection

FSP version: |0.8.0-rc.0 FomdDetat
Board: EK-RAGM3 ~
Device: RYFABM3IAHICFC
RTOS: No RTOS ~
Select Tools Available Tools
Toolchain: GCC ARM Embedded ~ GCCARM Embedded
7
Toolchain version: | 8.3.1.20190703 S PO
7.3.1.20180622
Debugger: J-Link ARM ~ 7.2.1.20170904
4.9.3.20150529
w Debuggers
J-Link ARM
~ Smart Manual
10 Registers Supported
Software Manual Supported
pr
@ < Back Dext > Finish Cancel

Figure 70: Project configuration (part 2)
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The project template is now selected. As no RTOS is required select Bare Metal - Blinky.

ﬁ e studio - Project Configuration (RA C Executable Project) m] X

e2 studio - Project Configuration (RA C Executable Project) —
Select the type of project you wish to create.

Project Template Selection

O] .. Bare Metal - Blinky

f-} Bare metal FSP project that includes BSP and will blink LEDs if available. This
project will initialize clocks, pins, stacks, and the C runtime environment.

[Renesas.RA0.8.0-rc.0.pack]

®[ .. Bare Metal - Minimal

©
) Bare metal FSP project that includes B5P. This project will initialize clocks, pins,
stacks, and the C runtime environment.

[Renesas.RA.0.8.0-rc.0.pack]

Code Generation Settings
Use RA Code Formatter

@ < Back

Next > T
Figure 71: Project configuration (part 3)

4. Click Finish.

e2 studio creates the project and opens the Project Explorer and Project Configuration
Settings views with the Summary page showing a summary of the project configuration.

2.4.4 Configuring the Project with e2 studio

e2 studio simplifies and accelerates the project configuration process by providing a GUI interface for
selecting the options to configure the project.

e2 studio offers a selection of perspectives presenting different windows to the user depending on
the operation in progress. The default perspectives are C/C++, RA Configuration and Debug. The
perspective can be changed by selecting a new one from the buttons at the top right.

‘ R C/Ce+ 4% RA Configuration 1 -

Figure 72: Selecting a perspective

The C/C++ perspective provides a layout selected for code editing. The RA Configuration
perspective provides elements for configuring a RA MCU project, and the Debug perspective
provides a view suited for debugging.

1. In order to configure the project settings ensure the RA Configuration perspective is
selected.

2. Ensure the Project Configuration [WDT Application] is open. It is already open if the
Summary information is visible. To open the Project Configuration now or at any time make
sure the RA Configuration perspective is selected and double-click on the
configuration.xml file in the Project Explorer pane on the right side of e2 studio.
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[ Project Explorer 332 =
BE|e ~
v =% WDT_Application [Debug]
[ Includes
v @ ra
2= arm
= board
= fsp
(2 ra_gen
(# src
(= ra_cfg
L cript
TFABMIAH3CFC.pincfg
=| RAGM3-EK.pincfg
= WDT_Application Debug.launch
(7) Developer Assistance

Figure 73: RA MCU Project Configuration Settings

At the base of the Project Configuration view there are several tabs for configuring the project. A
project may require changes to some or all of these tabs. The tabs are shown below.

485 [WDT_Application] RA Configuration 52 =
Sumimany Generate Project Content

Project Summary i A

RENESAS

Board: EK-RABM3

Device: R7FAGM3AH3CFC

Toolchain: GCC ARM Embedded

Toolchain Version; =7 °"1°0V "I+

FSP Version: HL R |

Selected software components

RAGM3-EK Board Support Files CRET S |
Arm CMSIS Version 5 - Core (M) (L |

110 Port .

Board Support Package Common Files .-

Board support package for RTFAGM3AH3CFC & i _H

Youl[T®

Summary | BSP | Clocks| Pins Interrupts| Event Links| Stacks | Components

Figure 74: Project Configuration Tabs

2.4.4.1 BSP Tab

The BSP tab allows the Board Support Package (BSP) options to be modified from their defaults. For
this particular WDT project no changes are required. However, if you want to use the WDT in auto-
start mode, you can configure the settings of the OFS0 (Option Function Select Register 0) register in
the BSP tab. See the RA Hardware User's Manual for details on the WDT autostart mode.

2.4.4.2 Clocks Tab
The Clocks tab presents a graphical view of the clock tree of the device. The drop-down boxes in the

GUI enables configuration of the various clocks. The WDT uses PCLCKB. The default output frequency
for this clock is 60 MHz. Ensure this clock is outputting this value.
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2.4.4.3 Pins Tab

£8% [WDT_Application] RA Configuration] &2

Clocks Configuration

XTAL 24MHz |-
PLL Src: XTAL ~
PLL Div /2 t v
PLL Mul x20.0 v
[usBMCLE 240z | | [P ZADMH;L |/ Clock Src: PLL
HOCO 20MHz v

LOCO 32768Hz
MOCO 8MHz
SUBCLK 32768Hz

CLKOUT Disabled

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

 ICLK Div /2 v
[ PCLKA Div /2 - @

fl» PCLKE Div /4 v |
| PCLKC Div /4 v
4= PCLKD Div /2 -
SDCLKout On v
b+l BCLK Div sz v
s
1 UCLK Div /5 v
\s! FCLK Div /4 v
 —/ CLKOUT Div /1 v @

Figure 75: Clock configuration

The Pins tab provides a graphical tool for configuring the functionality of the pins of the device. For
the WDT project no pin configuration is required. Although the project uses two LEDs connected to
pins on the device, these pins are pre-configured as output GPIO pins by the BSP.

2.4.4.4 Stacks Tab

You can add any driver to the project using the Stacks tab. The HAL driver IO port pins are added
automatically by e2 studio when the project is configured. The WDT application uses no RTOS
Resources, so you only need to add the HAL WDT driver.

{8} (WDT_Application] RA Configuration 53

Stacks Configuration

Threads = HAL/Common Stacks

v g HAL/Common

4a o
& g_iopert |/O Port Driver on r_icport € g_ieport /O Port

Driver on r_ioport

Objects

.Summary BSP Clncks.Pins.\nterrupts Event Links | Stacks Cnmpﬂner}ts.

0
0

Generate Project Content

&) New Stack »

Figure 76: Stacks tab

1. Click on the HAL/Common Panel in the Threads Window as indicated in the figure above.
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The Stacks Panel becomes a HAL/Common Stacks panel and is populated with the
modules preselected by e2 studio.

2. Click on New Stack to find a pop-up window with the available HAL level drivers.
3. Select WATCHDOG Driver on r_wdt.

{8} [WDT_Application] RA Configuration 53 = (= &1 Package &2

Stacks Configuration
9 Generate Project Content

Threads = HAL/Common Stacks =
ST Amazon FreeRTOS

~ g HAL/Commen Arm

>
& g mport /O Part Biiver.onopor i g}:szro:nlif;oor:t Driver z Analog r>_
Middleware > CapTouch >
SEGGER > Connectivity >
&7 Search.. Graphics >
Input >
@ CRC Driveronr_crc Monitoring >
3 Clock Accuracy Circuit Driver on r_cac Metwork ¥
&  Data Operation Circuit Driver on r_doc Power >
@ Watchdog Driver on r_iwdt Storage >
LLERE o+ Watchdog Driver on r_wdt System 3
Timers >
Transfer >
Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components < =

Figure 77: Module Selection

The selected HAL WDT driver is added to the HAL/Common Stacks Panel and the Property
Window shows all configuration options for the selected module. The Property tab for the WDT
should be visible at the bottom left of the screen. If it is not visible, check that the RA
Configuration perspective is selected.

4%k [WOT_Application] RA Configuration 52 =8

Stacks Configuration
9 Generate Project Content

Threads I i % . = HAL/Common Stacks 4] New Stack > = < » 1] Remove

v g HAL/Common
42 g_ioport 10 Port Driver on r_ioport
& g_wdtD Watchdog Driver on r_wdt

48 g_ioport /0 Port 4 g wdt) Watchdog
Driver on r_ioport Driver on r_wdt

Objects g
‘ |
Summary ESb.Clﬂ{ki:l.’iﬁs.Int.arrupts.Evant Links | Stacks Cumpnnents:

L‘b Pin Conflicts % MCU Package El Console

g_wdt0 Watchdog Driver on r_wdt

Se&ings Property Value
Biinag  Common
Parameter Checking Default (BSP)
Register Start NMI Support Disabled
~ Module g_wdt) Watchdog Driver on r_wdt
Name g_wdtD
Timeout 16,384 Cycles
Clock Division Ratio PCLK/8192
‘Window Start Position 100% (Window Position Not Specified)
Window End Position 0% (Window Position Not Specified)
Reset Control Reset Output
Stop Control WOT Count Disabled in Low Power Mode

Figure 78: Module Properties

All parameters can be left with their default values.
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[34 Pin Conflicts =# MCU Package [Z) Console | [T Properties 7 | 4% Debug

g wdt0 Watchdog Driver on r wdt

Settings Property Value

w Common
Parameter Checking Default (BSP)
Register Start NM| Support Disabled

v Module g_wdtd Watchdog Driver on r_wdt
Mame g_wdth
Timeout 16,384 Cycles
Clock Division Ratio PCLK/81532
Window Start Position 100% (Window Position Mot Specified)
Window End Position 0% [(Window Position Not Specified)
Reset Control Reset Qutput
Stop Control 'WOT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 79: g wdt WATCHDOG Driver on WDT properties

With PCLKB running at 60 MHz the WDT will reset the device 2.23 seconds after the last refresh.

WDT clock

Cycle time

60 MHz / 8192 = 7.32 kHz

1/7.324 kHz = 136.53 us

Timeout = 136.53 us x 16384 = 2.23 seconds

Save the Project Configuration file and click the Generate Project Content button in the top
right corner of the Project Configuration pane.

o

Generate Project Content

Figure 80: Generate Project Content button

e2 studio generates the project files.

2.4.4.5 Components Tab

The components tab is included for reference to see which modules are included in the project.
Modules are selected automatically in the Components view after they are added in the Stacks Tab.

For the WDT project ensure that the following modules are selected:

1. HAL_Drivers -> r_ioport
2. HAL Drivers -> r_wdt
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Components Configuration

Component

| riic_master

r_iic_slave

r_sci_uart
r_sdhi

r_spi

r_ssi
r_usb_basic
r_usb_pcde
rowdt

| rm_freertos_plus_tcp

[[] rm_psa_crypto

Version
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
0.8.0-rc.0
080
0.8.0-rc.0

Description

12C Master Interface

12C Slave Interface

1/0 Port

Independent Watchdog Timer

JPEG Codec

Key Input

Low Power Modes

Low Yoltage Detection

Real Time Clock

Secure Cryptography Engine on RAZ
Secure Cryptography Engine on RA4
Secure Cryptography Engine on RAG
SCII12C Master Interface

Serial Peripheral Interface on Serial Communic..
SCI UART

SD/MMC Host Interface

Serial Peripheral Interface

Serial Sound Interface

Universal Serial Bus Basic

Universal Serial Bus Peripheral Communication...
Watchdog Timer

r_ether to FreeRTOS Plus TCP IP Wrapper
PSA mbedCrypto

Summary | BSP Clu:ks.Pms.lnterrupts.Event Links | Stacks Compenents

Figure 81: Component Selection

Note

Variant

The list of modules displayed in the Components tab depends on the installed FSP version.

2.4.5 WDT Generated Project Files

Clicking the Generate Project Content button performs the following tasks.

e r_wdt folder and WDT driver contents created at:

ra/fsp/src

e r_wdt_api.h created in:
ra/fsp/inc/api

e r_wdt.h created in:

ra/fsp/inc/instance

The above files are the standard files for the WDT HAL module. They contain no specific project
contents. They are the driver files for the WDT. Further information on the contents of these files can
be found in the documentation for the WDT HAL module.

Configuration information for the WDT HAL module in the WDT project is found in:

ra_cfg/fsp_cfg/r_wdt_cfg.h

The above file's contents are based upon the Common settings in the g_wdt WATCHDOG Driver

on WDT Properties pane.

R11UMO0146EU0100 Revision 1.00
Mar.25.20

RLENESAS

Page 61/1,444



Flexible Software Package

User’s Manual

Starting Development > Tutorial: Using HAL Drivers - Programming the WDT > WDT Generated Project Files

[%3 Pin Conflicts =# MCU Package (=) Console | [T Properties 37 | 4 Debug
g_wdt0 Watchdog Driver on r_wdt

Property
~ Common

Settings

Parameter Checking
Register Start NMI Support
~ Madule g_wdtd Watchdog Driver on r_wdt
Name
Timeout
Clock Division Ratio
Window Start Position
Window End Positicn
Reset Control
Stop Control
MMI Callback

Warning

e 483 [WDT_Application] RA Configuration | [B] r.wdt.cfgh 32

" il | generated configuration header file - do not edit */
Default (85P) 2 #ifndef R_WDT_CFG_H_
Disabled 3 #define R_WDT_CFG_H_

4 #define WDT_CFG_PARAM_CHECKING_ENABLE (BSP_CFG_PARAM CHECKING_ENABLE)

g wdtd 5 #define WDT_CFG_REGISTER_START_NMI_SUPPORTED ((0))
= 6 #endif /* R_WDT_CFG_H_ */
16,384 Cycles g _WDT_CFG_H_
PCLK/8192

100% (Window Position Not Specified)
0% (Window Position Not Specified)
Reset Qutput

WDT Count Disabled in Low Power Mode
MULL

Figure 82: r_wdt_cfg.h contents

Do not edit any of these files as they are recreated every time the Generate Project Content
button is clicked and so any changes will be overwritten.

The r_ioport folder is not created at ra/fsp/src as this module is required by the BSP and so already
exists. It is included in the WDT project in order to include the correct header file in
ra_gen/hal_data.c-see later in this document for further details. For the same reason the other
IOPORT header files- ra/fsp/inc/api/r_ioport_api.handra/fsp/inc/instances/r_ioport.h-are not created as

they already exist.

In addition to generating the HAL driver files for the WDT and IOPORT files e2 studio also generates
files containing configuration data for the WDT and a file where user code can safely be added.

These files are shown below.

2.4.5.1 WDT hal_data.h

5 Project Explorer 13
~ 1% WDT_Application [Debug]
3 Binaries
5l Includes
= ra
w [ ra_gen
[B] bsp_clock_cfg.h
[B] bsp_pin_cfg.h
i_éj common_data.c
|£] commen_data.h
Ej hal_data.c
[H] hal_data.h
] main.c
[ pin_data.c
Ej vector_data.c
m vector_data.h
E24) RABM3-EK.csv
28 src
= Debug
= ra_cfg
= script
4k configuration.xml
=| R7TFABM3AH3CFC.pincfg
=/ ra_cfg.txt
= RABM3-EK.pincfg
= WDT_Application Debug.launch
(7) Developer Assistance

Figure 83: WDT project files

The contents of hal_data.h are shown below.

/* generated HAL header file -
#i fndef HAL_DATA H_

do not edit */
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hal_data.h contains the header files required by the generated project. In addition this file includes
external references to the g_wdt instance structure which contains pointers to the configuration,
control, api structures used for WDT HAL driver.

Warning
This file is regenerated each time Generate Project Content is clicked and must not be
edited.

2.4.5.2 WDT hal_data.c

The contents of hal_data.c are shown below.
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const wdt_cfg_t g wdtO_cfg =

{
.ti nmeout = WDT_TI MEOUT 16384,
.clock division = WDT_CLOCK DI VI SI ON 8192,
. Wi ndow st art = WDT_W NDOW START 100,
. Wi ndow_end = WDT_W NDOW END_0,
.reset _control = WDT_RESET CONTROL_RESET,
.stop_control = WDT_STOP_CONTROL_ENABLE,
. p_cal | back = NULL,

}i

[* Instance structure to use this nodule. */

const wdt _instance t g wdtO =

{.p_ctrl = & wdtO ctrl, .p_cfg = & wdtO _cfg, .p_api = &_wdt_on_wdt};
void g _hal _init (void)

{

g_common_init();

hal_data.c contains g_wdt ctrl which is the control structure for this instance of the WDT HAL driver.
This structure should not be initialized as this is done by the driver when it is opened.

The contents of g wdt _cfg are populated in this file using the g_ wdt WATCHDOG Driver on WDT
Properties pane in the e2 studio Project Configuration HAL tab. If the contents of this structure
do not reflect the settings made in e2 studio, ensure the Project Configuration settings are saved
before clicking the Generate Project Content button.

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

2.4.5.3 WDT main.c

Contains main() called by the BSP start-up code. main() calls hal_entry() which contains user
developed code (see next file). Here are the contents of main.c.
/* generated main source file - do not edit*/
#i ncl ude "hal data. h"
int main (void)
{
hal _entry();
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return O;

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

2.4.5.4 WDT hal_entry.c

This file contains the function hal_entry() called from main(). User developed code should be placed
in this file and function.

For the WDT project edit the contents of this file to contain the code below. This code implements
the flowchart in overview section of this document.

#i ncl ude "hal _data.h"

#i ncl ude "bsp_pin_cfg.h"

#i nclude "r _ioport.h"

#defi ne RED LED NO OF FLASHES 30

#define RED LED PIN BSP_| O PORT_01_PI N 00

#def i ne GREEN_LED _PI N BSP_| O PORT_04_PI N 00

#defi ne RED_LED DELAY_COUNT 1500000

#define GRN_LED DELAY_ COUNT 1200000

volatile uint32 t delay counter;

volatile uintl16_t | oop_counter;

void R BSP WarnfStart (bsp_warm start _event t event);
/* gl obal variable to access board LEDs */

extern bsp leds t g bsp_ | eds;

/************************************************************************************

*******************************/

voi d hal _entry (void) ({

/* Open the WDT */

R WDT_Open(&g_wdtO0_ctrl, & wdtO cfg);

[* Start the WDT by refreshing it */

R WDOT Refresh(&g wdtO _ctrl);

/* Flash the red LED and tickle the WDT for a few seconds */

for (loop_counter = 0; |oop_counter < RED LED NO OF FLASHES; | oop_counter ++)
{
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The WDT HAL driver is called through the interface g_wdt_on_wdt defined in r_wdt.h. The WDT
HAL driver is opened through the open API call using the instance defined in r_wdt_api.h:

The first passed parameter is the pointer to the control structure g_wdt_ctrl instantiated
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inhal_data.c. The second parameter is the pointer to the configuration data g wdt cfg instantiated in
the same hal_data.c file.

The WDT is started and refreshed through the API call:

/* Start the WDT by refreshing it */
R WDOT_Refresh(&y wdtO _ctrl);

Again the first (and only in this case) parameter passed to this API is the pointer to the control
structure of this instance of the driver.

2.4.6 Building and Testing the Project

Build the project by clicking Build > Build Project. The project should build without errors.

To debug the project

1. Connect the JLink debugger between the target board and host PC. Apply power to the
board.

2. In the Project Explorer pane on the right side of e2 studio right-click on the WDT project
WDT_Application and select Debug As > Debug Configurations.

3. Under Renesas GDB Hardware Debugging select WDT_Application Debug as shown

below.
Create, manage, and run configurations E *
=R o~ =
| 2 R | = Mame: |WDT7Apphcat|on Debug |
type filter text [] Main . %5 Debugger| = Startup| & Source ] Common
E C/C++ Application i Project
[€] C/C++ Remote Application
EASE Script ‘ WOT_Application Browse...
[ 6DB Hardvare Debugging CICrs Appiicaioe
[c] GDB CpenOCD Debugging -
= Debug\WDT_Application.elf
[E% GOB Simulstor Debugging (RH250) | Debug\WDT_Applicstion.¢
Java Applet Variables... Search Project... Browse...
Java Application Build {if required) before launching
f Launch Group
= Launch Group (Deprecated) Build Configuration: |Select Automatically o
Remote Java Application i .
v [ Renesas GDB Hardware Debugging (C)Enable auto build (O Disable auto build
&7 = WOT_Application Debug [local] ®) Use workspace settings Configure Workspace Settings...
[t Renesas Sirnulator Debugging (RX, RLTS)
Revert Apph
Filter matched 14 of 16 items ~ —
Figure 84: Debug configuration
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4. Click the Debug button. Click Yes to the debug perspective if asked.

Progress Information m] X

‘.0' Extracting RA Debug

Configuring GDB

5. The code should run the Reset Handler() function.

6. Resume execution via Run > Resume. Execution will stop in main() at the call to
hal_entry().

7. Resume execution again.

The red LED should start flashing. After 30 flashes the green LED will start flashing and the red LED
will stop flashing.

While the green LED is flashing the WDT will underflow and reset the device resulting in the red LED
to flash again as the sequence repeats. However, this sequence does not occur when using the
debugger because the WDT does not run when connected to the debugger.

1. Stop the debugger in e2 studio via Run > Terminate.
2. Click the reset button on the target board. The LEDs begin flashing.

2.5 RA SC User Guide for MDK and IAR

2.5.1 What is RA SC?

The Renesas RA Smart Configurator (RA SC) is a desktop application designed to configure device
hardware such as clock set up and pin assignment as well as initialization of FSP software
components for a Renesas RA microcontroller project when using a 3rd-party IDE and toolchain.

The RA Smart Configurator can currently be used with

1. Keil MDK and the ARM compiler toolchain.
2. IAR EWARM with IAR toolchain for ARM

Projects can be configured and the project content generated in the same way as in e2 studio.
Please refer to Configuring a Project section for more details.

2.5.2 Using RA Smart Configurator with Keil MDK

2.5.2.1 Prerequisites

e Keil MDK and ARM compiler are installed and licensed. Please refer to the Release notes for
the version to be installed.

* Import the RA device pack. Download the RA device pack archive file (ex:
MDK_Device_Packs_x.x.x.zip) from the FSP GitHub release page. Extract the archive file to
locate the RA device pack. To import the RA device pack, launch the Packinstaller.exe from
"<keil_mdk_install_dir>\UV4". Select the menu item "File|Import..." and browse to the
extracted .pack file.

e Verify that the latest updates for RA devices are included in Keil MDK. To verify, select the
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menu "Packs" in Pack Installer and verify that the menu item "Check for Updates on
Launch" is selected. If not, select "Check for Updates on Launch" and relaunch Pack
Installer.

e For flashing and debugging, the latest Segger J-Link DLL is installed into Keil MDK.

¢ Install RA SC and FSP using the Platform Installer from the GitHub release page.

2.5.2.2 Create new RA project
The following steps are required to create an RA project using Keil MDK, RA SC and FSP:

1. To create an RA project in Keil MDK, an example template needs to be copied from the Pack
Installer. The Pack Installer can be launched by running Packinstaller.exe from
"<keil_mdk_install_dir>\Uv4".

2. Select the device family or a device in the left pane of pack installer to filter the example
templates in Examples tab in the right pane. The search bar in left pane helps to easily find
a device. It is important to select the correct device and package type as this will be used
by RA SC to configure pins.

(@81 Pack Installer - C:\Users\C} m¥_pmwome o s s [\Arm\Packs - O X

File Packs Window Help
,2‘ Device: Renesas - RABMS3 Series

ﬂ Devices Boards ﬂ ﬂ Pa{ksl Examples ﬂ

ISEar(n: ABM3 i X [+ Show ex lled Packs only
Device /| Summary Example Action Description
=% All Devices 10 Devices R7FABM3AF2CBG project template (RTFABM3IAFZCBG custom) i Copy R7FABM3AF2CBG project template
=~ ¥ Renesas 10 Devices R7FABM3AFZCLK project template (RTFABM3AF2CLK custom) i Copy R7FABM3AF2CLK project template
-#ig 10 Devices RTFAEM3AF3CFB project template (RTFASM3AF3CFB custom) & Copy RIFAEM3AF3CFB project template
R7FABM3AF3CFC project template (R7TFABM3AF3CFC custom) i Copy R7FABM3AF3CFC project template

R7FABM3AF3CFP project template (RTFAGBM3AF3CFP custom) i Copy R7FAGM3AF3CFP project template

-R7TFAEM3AHZCBG project template (R7TFABM3AH2CBG custom) Jr7rasmaaHaceG project template
I: d

i py R7FABM3AH2CLK project template

TRRGISE BTOJECt IEMpIate (R /PRI AH TUstom
R7FABM3AH3CFB project template (RYFABM3AHICFE custom) i Copy R7FABM3AH3CFE project template
RTFABM3AHICFC project template (RTFABMIAHICFC EK-RAGM3) ! Copy R7FAEBM3AHICFC project template
RTFABM3AH3CFC project template (R7FABM3AH3CFC EK-RABM3G) i Copy R7FABM3AHICFC project template
R7FABM3AH3CFP project template (RTFABM3AHICFP custom) i Copy R7FABM3AH3CFP project template
4 »
Output 3 x

Refresh Pack descriptions

(Check for updates

Update available for ARM:: CMSIS-Driver (installed: 2.4.1, available: 2,5.0)

(Check for updates

Update available for ARM::CMSIS-Driver (installed: 2.4.1, available: 2.5.0)

Ready ONLINE

Figure 85: Packinstaller device example template

3. Click the "Copy" button for the example template to launch a dialog box and select where
to copy the example project. The default project name will be the target device name.
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Copy Example X
Destination Folder
[ Covm_mnw e w - ~| m’
[~ Use Pack Folder Structure ¥ Launch pVision
o« | cancel |

Figure 86: Copy Example dialog

Click "OK" to launch Keil uVision with the new project.

C:\Users) Viu_pmsmaitimmmion Documents\R7FAGM3IAH2CBG\RTFAEM3AH2CEG uvprajx - wVision - o x
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
NEHS % DR 96| «= | PRAR|EEEEL D Ma#la-lecoa- B[4
& 2 8 8 o
Project 28
= % Project: RTFAGM3AH2CBG
5T Target1
[ Source Group 1
4 Flex Software

MDK: Selected Software Component Requires Code Generation by ‘Renesas RA Smart Configur..

Component:
Renesas::Fiex Software:RA Configuration

Generator Program:
Renesas RA Smart Configurator

Generates:
\buidinfo.gpdsc

£ Start Renesas RA Smart confgarator |

(= Project| @3 5ooks | {3 Func..| 04y Temp.. |

Build Qutput

CAP NUM SCRL OVR R/W .

Figure 87: uVision

If the project name needs to be changed then deselect "Launch uVision" in Copy Example
dialog and click "OK". Follow project rename instructions here:
http://www.keil.com/support/docs/3579.htm Once renamed, open the project using menu
item "Project|Open Project..." in uVision and continue with steps in Modify existing RA
project.

4. uVision offers to start RA Smart Configurator(RA SC). Click "Start Renesas RA Smart
Configurator" to launch the RA smart configurator.

MDK: Selected Software Component Requires Code Generation by ‘Renesas RA Smart Configur... X

Component:
Renesas::Flex Software:RA Configuration

Generator Program:
Renesas RA Smart Configurator

Generates:
buildinfo. gpdsc

| Start Renesas RA Smart Configurator | Cancel
Figure 88: Launch RA SC confirmation dialog
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5. If multiple versions of RA SC are installed, select the appropriate version of RA SC to run.

BEE C:AWINDOWS\system32\cmd.exe - O X

Select which one to run [©,1]?

Figure 89: RA SC version selection

6. RA SC will be launched with project generator wizard.
7. The configuration window opens once the project wizard is closed. Refer to Configuring a
Project for more details on how to configure the project.

8. After clicking "Generate Project Content" in the RA Smart Configurator, return to uVision.
uVision offers a dialog to import the changes and updates to the project made in RA SC.
Select "Yes" to import the updated project and the project is ready to build.

HVision

=% For the current project new generated code is available for
! import.

Project:
C:\Dev_work\Keil_projects\lab_project\R7TFA6M3AH3CFC\RTFAG
M3AH3CFC.uvprojx

Generated:
C:\Dev_work\Keil_projects\lab_project\R7TFA6M3AH3CFC\buildi
nfo.gpdsc

Import Changes?

Figure 90: Import project data

RA SC will place the necessary FSP source code and header files into the project
workspace. The folder structure is defined as below.

e Source Group 1 User source code should be added to the project in this folder
e Renesas RA Smart Configurator: Common Sources These source files are generated by RA
Smart Configurator and can be edited as necessary

e Flex Software These are the source files from FSP and can be modified if needed. However,
it is recommended NOT to edit these files as this may impact dependencies or functionality.
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Project R x|
= % Project: RTFA6BM3AH3CFC o

=%z Target1

td Source Group 1
—1-Z Renesas RA Smart Configurator:Common Sources

+ ] blinky_thread_entry.c

# _1 hal_entry.c
= ’ Flex Software

& ] event_groups.c (Components:ra)
& _1 list.c (Components:ra)
=] queue.c (Components:ra)
@] stream_buffer.c (Components:ra)
[ _1 tasks.c (Components:ra)
[+ _1 timers.c (Compenents:ra) o
@] board_init.c (Components:ra)
% iy s am

Figure 91: uVision project workspace with imported project data

2.5.2.3 Modify existing RA project

Once an initial project has been generated and configured, it is also possible to make changes using

RA SC as follows:

1. If the desired project is not already open in uVision, the project can be opened using menu

item "Project|Open project..." or selecting from the list of previous projects.

2. Select menu item "Project|Manage|Run-time Environment..." or tool bar button "Manage

Run-Time Environment".

3. Expand the "Flex Software" tree item in the dialog shown and click the green run button
next to "RA Configuration". This launches RA SC and the FSP project configuration can be

modified and updated.

ﬂ Manage Run-Time Environment X
Software Component Sel. Variant Version  Description
@ CMSIS Cortex Microcontroller Software Interface Components =]
& ‘ CMSIS Driver Unified Device Drivers compliant to CMSIS-Driver Specifications
& ’ Compiler ARM Compiler 1.60 Compiler Bxtensions for ARM Compiler 5 and ARM Compiler 6
o 4 Device Startup, System Setup
w4 File System MDK-Plus ~|6.13.0 File Access on various storage devices
= 4 Flex Software Renesas Flex Software
@ Build Configuration [~ |
@ Generated Data 2 T
& linkerScrpt _F Ir_
# RA Configuration [v > [ 1.00 Renesas RA Configuration
i —
aR 3 Graphics MDK-Plus ~|5.50.0 User Interface on graphical LCD displays -l
W 4 Network MDK-Plus ~|7.12.0 1Pv4 Networking using Ethernet or Serial protocols
& . UsB MDK-Plus ~ | 6.13.7 USB Communication with various device classes ﬂ
o E ol
Validation Qutput Description

Resolve | | Select Packs Details Cancel Help

Figure 92: Manage run-time environment

2.5.2.4 Build and Debug RA project
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The project can be built by selecting the menu item "Project|Build Target" or tool bar item "Rebuild"
or the keyboard shortcut F7.

Assembler, Compiler, Linker and Debugger settings can be changed in "Options for Target" dialog,
which can be launched using the menu item "Project|Options for Target", the tool bar item "Options
for Target" or the keyboard shortcut Alt+F7.

KA Options for Target 'Target 1' X
Device | Target | Output | Listing | User | C/C++(ACB) | Asm | Linker Debug ILlliIitiesl
" Use Simulator ~ with restrictions Settings * Use: |.J-L|NK / J-TRACE Cortex Ll Settings
[ Limit Speed to Real-Time
V¥ Load Application at Startup ¥ Run to main() V¥ Load Application at Startup ™ Run to main()
Initialization File: Initialization File:
Restore Debug Session Settings Restore Debug Session Settings

[V Breakpoints [V Toolbox [V Breakpoints Vv Toolbox

¥ Watch Windows & Pefformance Analyzer ¥ Watch Windows

[v Memory Display v System Viewer [v Memory Display [v System Viewer
CPU DLL: Parameter: Driver DLL: Parameter:
[SARMCM3.DLL | [SARMCM3.DLL |
Dialog DLL: Parameter: Dialog DLL: Parameter:
[pcm.DLL [pCM4 [TcM.DLL [oCM4
[~ Wam if outdated Executable is loaded [~ Wam if outdated Executable is loaded

Manage Component Viewer Description Files ... |

[ ok |[ cacel |[ Defauts |

Figure 93: Options for Target

RA SC will set up the uVision project to debug the selected device using J-Link or J-Link OB debugger
by default.

A Debug session can be started or stopped by selecting the menu item "Debug|Start/Stop Debug
Session" or keyboard shortcut CTRL+F5. When debugging for the first time, J-Link firmware update
may be needed if requested by the tool.

Refer to the documentation from Keil to get more information on the debug features in uVision. Note
that not all features supported by uVision debugger are implemented in the J-Link interface. Consult
SEGGER J-Link documentation for more information.

2.5.2.5 Notes and Restrictions

1. When creating a new RA project, do not create a new project directly inside uVision. Follow
the steps as mentioned in Create new RA project

2. RA FSP contains a full set of drivers and middleware and may not be compatible with other
CMSIS packs from Keil, Arm or third parties.

3. Flash programming is currently only supported through the debugger connection.

2.5.3 Using RA Smart Configurator with IAR EWARM

IAR Systems Embedded Workbench for Arm (EWARM) includes support for Renesas RA devices.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 74 /1,444
Mar.25.20

User’s Manual



Flexible Software Package User’s Manual

Starting Development > RA SC User Guide for MDK and IAR > Using RA Smart Configurator with IAR EWARM

These can be set up as bare metal designs within EWARM. However, most RA developers will want to
integrate RA FSP drivers and middleware into their designs. RA SC will facilitate this.

RA SC generates a "Project Connection" file that can be loaded directly into EWARM to update
project files.

2.5.3.1 Prerequisites

¢ |AR EWARM installed and licensed. Pleae refer to the Release notes for the version to be
installed.
e RA SC and FSP Installed

2.5.3.2 Create new RA project
The following steps are required to create an RA project using IAR EWARM, RA SC and FSP:

1. To Use RA SC with EWARM, RA SC needs to configured as a tool in EWARM by selecting the
menu item "Tools|Configure Tools...". Select "New" to create a new tool in the dialog shown
and add the following information:

o Menu Text: RA Smart Configurator

Command: Select Browse... and navigate to rasc.exe in the installed RA SC
Argument: -compiler IAR configuration.xml

Initial Directory: $PROJ_DIR$

Tool Available: Always

[}

o

o

o

Configure Tools

Menu Content:

Cancel

Hew

Delete

Menu Text:

|F!A Smart Configuratar |

Command:

[ i | | Erowisa

Argument;

|--cumpllsr 18R configuration. sml |

Initial Directary:
[sPRO._DIRS |

I Redirect to Output /indow
] Prompt for Command Line

Tool Ayvailable:

Always ~

Figure 94: Tool_setup

2. A new EWARM project can be created using the menu item "Project|Create New Project..."
and selecting the "Empty Project" and toolchain as ARM. Save the project to an empty
folder.

3. RA SC can now be launched from EWARM using the menu item "Tools|RA Smart
Configurator".
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Tools I Window Help

o Options...

Filename Extensions...
Configure Viewers...
Configure Custom Argument Variables...

/%  Configure Tools...

IAR Project Converter

RA Smart Configurator

Figure 95: RA SC Menu Item

RA SC will be launched with project generator wizard. The configuration window opens
once the project wizard is closed. Refer to Configuring a Project for more details on how to
configure the project. After configuring the project, click "Generate Project Content".
Changes to the RA configuration will be reflected in the EWARM project.

4. A Project connection needs to be set up in EWARM to build the project. Select "Project|Add
Project Connection" in EWARM and select "IAR Project Connection". Navigate to the project
folder and select buildinfo.ipcf and click open. The project can now build in EWARM.
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Chapter 3 FSP Architecture

3.1 FSP Architecture Overview

This guide describes the Renesas Flexible Software Package (FSP) architecture and how to use the
FSP Application Programming Interface (API).

3.1.1 C99 Use

The FSP uses the ISO/IEC 9899:1999 (C99) C programming language standard. Specific features
introduced in C99 that are used include standard integer types (stdint.h), booleans (stdbool.h),
designated initializers, and the ability to intermingle declarations and code.

3.1.2 Doxygen

Doxygen is the default documentation tool used by FSP. You can find Doxygen comments throughout

the FSP source.

3.1.3 Weak Symbols

Weak symbols are used occasionally in the FSP. They are used to ensure that a project builds even
when the user has not defined an optional function.

3.1.4 Memory Allocation

Dynamic memory allocation through use of the malloc() and free() functions are not used in FSP
modules; all memory required by FSP modules is allocated in the application and passed to the
module in a pointer. Exceptions are considered only for ports of 3rd party code that require dynamic

memory.

3.1.5 FSP Terms

Term

Description

Reference

BSP

Short for Board Support
Package. In the FSP the BSP
provides just enough
foundation to allow other FSP
modules to work together
without issue.

MCU Board Support Package
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Module

Modules can be peripheral
drivers, purely software, or
anything in between. Each
module consists of a folder with
source code, documentation,
and anything else that the
customer needs to use the code
effectively. Modules are
independent units, but they
may depend on other modules.
Applications can be built by
combining multiple modules to
provide the user with the
features they need.

FSP Modules

Driver

A driver is a specific kind of
module that directly modifies
registers on the MCU.

Interface

An interface contains API
definitions that can be shared
by modules with similar
features. Interfaces are
definitions only and do not add
to code size.

FSP Interfaces

Stacks

The FSP architecture is
designed such that modules
work together to form a stack.
A stack consists of a top level
module and all its
dependencies.

FSP Stacks

Module Instance

Single and independent
instantiation of a module. An
application may require two
GPT timers. Each of these
timers is a module instance of
the r_gpt module.

Application

Code that is owned and
maintained by the user.
Application code may be based
on sample application code
provided by Renesas, but it is
the responsibility of the user to
maintain as necessary.
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Callback Function

This term refers to a function
that is called when an event
occurs. As an example, suppose
the user would like to be
notified every second based on
the RTC. As part of the RTC
configuration, a callback
function can be supplied that
will be jumped to during each
RTC interrupt. When a single
callback services multiple
events, the arguments contain
the triggering event. Callback
functions for interrupts should
be kept short and handled
carefully because when they
are called the MCU is still inside
of an interrupt, delaying any
pending interrupts.

3.2 FSP Modules

Modules are the core building block of FSP. Modules can do many different things, but all modules
share the basic concept of providing functionality upwards and requiring functionality from below.

f

Provides

Requires

Figure 96: Modules

The amount of functionality provided by a module is determined based on functional use cases.
Common functionality required by multiple modules is often placed into a self-contained submodule
so it can be reused. Code size, speed and complexity are also considered when defining a module.

The simplest FSP application consists of one module with the Board Support Package (BSP) and the

user application on top.
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Application

FSP Module

Figure 97: Module with application

The Board Support Package (BSP) is the foundation for FSP modules, providing functionality to
determine the MCU used as well as configuring clocks, interrupts and pins. For the sake of clarity,
the BSP will be omitted from further diagrams.

3.3 FSP Stacks

When modules are layered atop one another, an FSP stack is formed. The stacking process is
performed by matching what one module provides with what another module requires. For example,
the SPI module (Serial Peripheral Interface (r_spi)) requires a module that provides the transfer
interface (Transfer Interface) to send or receive data without a CPU interrupt. The transfer interface
requirement can be fulfilled by the DTC driver module (Data Transfer Controller (r_dtc)).

Through this methodology the same code can be shared by several modules simultaneously. The
example below illustrates how the same DTC module can be used with SPI (Serial Peripheral
Interface (r_spi)), UART (Serial Communications Interface (SCI) UART (r_sci_uart)) and SDHI (SD/MMC
Host Interface (r_sdhi)).

Application

Provides: SPI Provides: UART Provides: SD/MMC

UART Driver SD Card Driver

Requires: Transfer Requires: Transfer Requires: Transfer

Provides:|Transfer

Figure 98: Stacks -- Shared DTC Module

The ability to stack modules ensures the flexibility of the architecture as a whole. If multiple
modules include the same functionality issues arise when application features must work across
different user designs. To ensure that modules are reusable, any dependent modules must be
capable of being swapped out for other modules that provide the same features. The FSP
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architecture provides this flexibility to swap modules in and out through the use of FSP interfaces.

3.4 FSP Interfaces

At the architecture level, interfaces are the way that modules provide common features. This
commonality allows modules that adhere to the same interface to be used interchangeably.
Interfaces can be thought of as a contract between two modules - the modules agree to work
together using the information that was established in the contract.

On RA hardware there is occasionally an overlap of features between different peripherals. For
example, 12C communications can be achieved through use of the IIC peripheral or the SCI
peripheral. However, there is a difference in the level of features provided by both peripherals; in 12C
mode the SCI peripheral will only support a subset of the capabilities of the fully-featured IIC.

Interfaces aim to provide support for the common features that most users would expect. This
means that some of the advanced features of a peripheral (such as 1IC) might not be available in the
interface. In most cases these features are still available through interface extensions.

In FSP design, interfaces are defined in header files. All interface header files are located in the folder
ra/fsp/inc/api and end with *_api.h. Interface extensions are defined in header files in the folder
ra/fsp/inc/instances. The following sections detail what makes up an interface.

3.4.1 FSP Interface Enumerations

Whenever possible, interfaces use typed enumerations for function parameters and structure
members.

typedef enum e_i 2c_nmst er _addr _node

{
| 2C_ MASTER ADDR MODE 7BIT = 1, /1/< Use 7-bit addressing node

| 2C_MASTER ADDR MODE 10BI T = 2, /1/< Use 10-bit addressi ng node

} i2c_naster_addr_node t;

Enumerations remove uncertainty when deciding what values are available for a parameter. FSP
enumeration options follow a strict naming convention where the name of the type is prefixed on the
available options. Combining the naming convention with the autocomplete feature available in e?
studio (Ctrl + Space) provides the benefits of rapid coding while maintaining high readability.

3.4.2 FSP Interface Callback Functions

Callback functions allow modules to asynchronously alert the user application when an event has
occurred, such as when a byte has been received over a UART channel or an IRQ pin is toggled. FSP
driver modules define and handle the interrupt service routines for RA MCU peripherals to ensure
any required hardware procedures are implemented. The interrupt service routines in FSP modules
then call the user-defined callbacks to allow the application to respond.

Callback functions must be defined in the user application. They always return void and take a
structure for their one parameter. The structure is defined in the interface for the module and is
named <interface>_callback_args_t. The contents of the structure may vary depending on the
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interface, but two members are common: event and p_context.

The event member is an enumeration defined in the interface used by the application to determine
why the callback was called. Using the UART example, the callback could be triggered for many
different reasons, including when a byte is received, all bytes have been transmitted, or a framing
error has occurred. The event member allows the application to determine which of these three
events has occurred and handle it appropriately.

The p_context member is used for providing user-specified data to the callback function. In many
cases a callback function is shared between multiple channels or module instances; when the
callback occurs, the code handling the callback needs context information so that it can determine
which module instance the callback is for. For example, if the callback wanted to make an FSP API
call in the callback, then at a minimum the callback will need a reference to the relevant control
structure. To make this easy, the user can provide a pointer to the control structure as the
p_context. When the callback occurs, the control structure is passed in the p_context element of the
callback structure.

Callback functions are called from within an interrupt service routine. For this reason callback
functions should be kept as short as possible so they do not affect the real time performance of the
user's system. An example skeleton function for the flash interface callback is shown below.

void flash _cal |l back (flash _callback _args_t * p_args)

{

/* See what event caused this call back. */

switch (p_args->event)

{
case FLASH EVENT ERASE COVPLETE:
{
/* Handl e event. */
br eak;
}
case FLASH EVENT WRI TE COVPLETE:
{
/* Handl e event. */
br eak;
}
case FLASH EVENT BLANK:
{
/* Handl e event. */
br eak;
}

case FLASH EVENT_NOT_BLANK:
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When a module is not directly used in the user application (that is, it is not the top layer of the
stack), its callback function will be handled by the module above. For example, if a module requires
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a UART interface module the upper layer module will control and use the UART's callback function. In
this case the user would not need to create a callback function for the UART module in their
application code.

3.4.3 FSP Interface Data Structures

At a minimum, all FSP interfaces include three data structures: a configuration structure, an API
structure, and an instance structure.

3.4.3.1 FSP Interface Configuration Structure

The configuration structure is used for the initial configuration of a module during the
<MODULE>_Open() call. The structure consists of members such as channel number, bitrate, and
operating mode.

The configuration structure is used purely as an input into the module. It may be stored and
referenced by the module, so the configuration structure and anything it references must persist as
long as the module is open.

The configuration structure is allocated for each module instance in files generated by the RA
configuration tool.

When FSP stacks are used, it is also important to understand that configuration structures only have
members that apply to the current interface. If multiple layers in the same stack define the same
configuration parameters then it becomes difficult to know where to modify the option. For example,
the baud rate for a UART is only defined in the UART module instance. Any modules that use the
UART interface rely on the baud rate being provided in the UART module instance and do not offer it
in their own configuration structures.

3.4.3.2 FSP Interface API Structure

All interfaces include an API structure which contains function pointers for all the supported interface
functions. An example structure for the Digital to Analog Converter (r_dac) is shown below.
typedef struct st _dac_api
{

/[** Initial configuration.

* @ar |nplenmented as

* - @ef R DAC Open()

* - @ef R_DACB_Open()

.

* @aranfin] p_ctrl Pointer to control block. Mist be declared by user. Elenents
set here.

* @araniin] p_cfg Pointer to configuration structure. Al elenents of this
structure nust be set by user.

*/

fsp err t (* open)(dac _ctrl _t * const p ctrl, dac _cfg t const * const p_cfqQ);
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tinmer.
*/
fsp_err_t (* stop)(dac_ctrl _t * const p_ctrl);
[** Cet version and store it in provided pointer p_version.
* @ar |nplenented as
* - @ef R _DAC VersionGet()
* - @ef R DACB VersionCet()
B
* @aranfout] p_version Code and APl version used.
*/
fsp err_t (* versionGet)(fsp version_t * p _version);

} dac_api _t;

The API structure is what allows for modules to easily be swapped in and out for other modules that
are instances of the same interface. Let's look at an example application using the DAC interface
above.

RA MCUs have an internal DAC peripheral. If the DAC API structure in the DAC interface is not used

the application can make calls directly into the module. In the example below the application is
making calls to the R_DAC_Write() function which is provided in the r_dac module.

Application

r_dac
R_DAC_Write()

Figure 99: DAC Write example

Now let's assume that the user needs more DAC channels than are available on the MCU and
decides to add an external DAC module named dac_external using I12C for communications. The
application must now distinguish between the two modules, adding complexity and further
dependencies to the application.
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Application

Is External?

r_dac
R_DAC_Write()

dac_external

DAC_EXTERNAL Write()

Figure 100: DAC Write with two write modules

The use of interfaces and the API structure allows for the use of an abstracted DAC. This means that
no extra logic is needed if the user's dac_external module implements the FSP DAC interface, so the
application no longer depends upon hard-coded module function names. Instead the application now
depends on the DAC interface APl which can be implemented by any number of modules.

Application

Internal DAC External DAC 1

External DAC 2

Figure 101: DAC Interface

3.4.3.3 FSP Interface Instance Structure

Every FSP interface also has an instance structure. The instance structure encapsulates everything
required to use the module:

¢ A pointer to the instance API structure (FSP Instance API)
¢ A pointer to the configuration structure
e A pointer to the control structure

The instance structure is not required at the application layer. It is used to connect modules to their
dependencies (other than the BSP).

Instance structures have a standardized name of <interface>_instance_t. An example from the
Transfer Interface is shown below.
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typedef struct st_transfer_instance
{
transfer _ctrl t * p_ctrl; ///< Pointer to the control structure for this

i nstance

transfer _cfg t const * p _cfg; /1/< Pointer to the configuration structure
for this instance

transfer_api _t const * p_api; /1/< Pointer to the APl structure for this
i nstance

} transfer_instance_ t;

Note that when an instance structure variable is declared, the API is the only thing that is instance
specific, not module instance specific. This is because all module instances of the same module
share the same underlying module source code. If SPI is being used on SCI channels 0 and 2 then
both module instances use the same API while the configuration and control structures are typically
different.

3.5 FSP Instances

While interfaces dictate the features that are provided, instances actually implement those features.
Each instance is tied to a specific interface. Instances use the enumerations, data structures, and API
prototypes from the interface. This allows an application that uses an interface to swap out the
instance when needed.

On RA MCUs some peripherals are used to implement multiple interfaces. In the example below the
IIC and SPI peripherals map to only one interface each while the SCI peripheral implements three
interfaces.

Interface: 12C Interface: UART Interface: SPI
r i2c_api.h r_uart_api.h r spi_api.h

Peripheral: lIC Peripheral: SCI Peripheral: SCI Peripheral: SCI Peripheral: SPI

Module: r_riic Module: r_sci_i2c Module: r_sci_uart Module: r_sci_spi Module: r_rspi

Figure 102: Instances

In FSP design, instances consist of the interface extension and API defined in the instance header
file located in the folder ra/fsp/inc/instances and the module source ra/fsp/src/<module>.

3.5.1 FSP Instance Control Structure

The control structure is used as a unique identifier for the module instance and contains memory
required by the module. Elements in the control structure are owned by the module and must not be
modified by the application. The user allocates storage for a control structure, often as a global
variable, then sends a pointer to it into the <MODULE>_Open() call for a module. At this point, the
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module initializes the structure as needed. The user must then send in a pointer to the control
structure for all subsequent module calls.

3.5.2 FSP Interface Extensions

In some cases, instances require more information than is provided in the interface. This situation
can occur in the following cases:

* An instance offers extra features that are not common to most instances of the interface.
An example of this is the start source selection of the GPT (General PWM Timer (r_gpt)). The
GPT can be configured to start based on hardware events such as a falling edge on a trigger
pin. This feature is not common to all timers, so it is included in the GPT instance.

e An interface must be very generic out of necessity. As an interface becomes more generic,
the number of possible instances increases. An example of an interface that must be
generic is a block media interface that abstracts functions required by a file system.
Possible instances include SD card, SPI Flash, SDRAM, USB, and many more.

The p_extend member provides this extension function.

Use of interface extensions is not always necessary. Some instances do not offer an extension since
all functionality is provided in the interface. In these cases the p_extend member can be set to NULL.
The documentation for each instance indicates whether an interface extension is available and
whether it is mandatory or optional.

3.5.2.1 FSP Extended Configuration Structure

When extended configuration is required it can be supplied through the p_extend parameter of the
interface configuration structure.

The extended configuration structure is part of the instance, but it is also still considered to be part
of the configuration structure. All usage notes about the configuration structure described in FSP
Interface Configuration Structure apply to the extended configuration structure as well.

The extended configuration structure and all typed structures and enumerations required to define it
make up the interface extension.

3.5.3 FSP Instance API

Each instance includes a constant global variable tying the interface API functions to the functions
provided by the module. The name of this structure is standardized as
g_<interface>_on_<instance>. Examples include g_spi_on_spi, g_transfer _on_dtc, and
g_adc_on_adc. This structure is available to be used through an extern in the instance header file
(r_spi.h, r_dtc.h, and r_adc.h respectively).

3.6 FSP API Standards

3.6.1 FSP Function Names

FSP functions start with the uppercase module name (<MODULE>). All modules have
<MODULE>_Open() and <MODULE>_Close() functions. The <MODULE>_Open() function must be
called before any of the other functions. The only exception is the <MODULE>_VersionGet() function
which is not dependent upon any user provided information.

Other functions that will commonly be found are <MODULE>_Read(), <MODULE>_Write(),
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<MODULE>_InfoGet(), and <MODULE>_StatusGet(). The <MODULE>_StatusGet() function provides
a status that could change asynchronously, while <MODULE>_InfoGet() provides information that
cannot change after open or can only be updated by API calls. Example function names include:

R_SPI_Read(), R_SPI_Write(), R_SPI_WriteRead()

e R _SDHI_StatusGet()

R_RTC_CalendarAlarmSet(), R_RTC_CalendarAlarmGet()

R_FLASH HP_AccessWindowSet(), R_FLASH HP_AccessWindowClear()

3.6.2 Use of const in APl parameters

The const qualifier is used with APl parameters whenever possible. An example case is shown below.

fsp err t R FLASH HP Open(flash ctrl _t * const p_api_ctrl, flash cfg t const * const

p_cfg);

In this example, flash_cfg_t is a structure of configuration parameters for the r_flash_hp module. The
parameter p_cfg is a pointer to this structure. The first const qualifier on p_cfg ensures the
flash_cfg_t structure cannot be modified by R_FLASH_HP_Open(). This allows the structure to be
allocated as a const variable and stored in ROM instead of RAM.

The const qualifier after the pointer star for both p_ctrl and p_cfg ensures the FSP function does not
modify the input pointer addresses. While not fool-proof by any means this does provide some extra
checking inside the FSP code to ensure that arguments that should not be altered are treated as
such.

3.6.3 FSP Version Information
All instances supply a <MODULE>_VersionGet() function which fills in a structure of type

fsp_version_t. This structure is made up of two version numbers: one for the interface (the API) and
one for the underlying instance that is currently being used.

typedef union st_fsp_version

{

/** Version id */

uint32 t version_id;

/** Code version paraneters */

st ruct

{
uint8 t code_version_mn nor; /1/< Code m nor version
uint8 t code_version_mgjor; /1l < Code maj or version
uint8 t api_version_m nor; /1/< APl m nor version
uint8 t api_version_ngjor; /1/< APl major version

[
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} fsp_version_t;

The API version ideally never changes, and only rarely if it does. A change to the APl may require
users to go back and modify their code. The code version (the version of the current instance) may
be updated more frequently due to bug fixes, enhancements, and additional features. Changes to
the code version typically do not require changes to user code.

3.7 FSP Build Time Configurations

All modules have a build-time configuration header file. Most configuration options are supplied at
run time, though options that are rarely used or apply to all instances of a module may be moved to
build time. The advantage of using a build-time configuration option is to potentially reduce code
size reduction by removing an unused feature.

All modules have a build time option to enable or disable parameter checking for the module. FSP
modules check function arguments for validity when possible, though this feature is disabled by
default to reduce code size. Enabling it can help catch parameter errors during development and
debugging. By default, each module's parameter checking configuration inherits the BSP parameter
checking setting (set on the BSP tab of the RA configuration tool). Leaving each module's parameter
checking configuration set to Default (BSP) allows parameter checking to be enabled or disabled
globally in all FSP code through the parameter checking setting on the BSP tab.

If an error condition can reasonably be avoided it is only checked in a section of code that can be
disabled by disabling parameter checking. Most FSP APIs can only return FSP_SUCCESS if parameter
checking is disabled. An example of an error that cannot be reasonably avoided is the "bus busy"
error that occurs when another master is using an 12C bus. This type of error can be returned even if
parameter checking is disabled.

3.8 FSP File Structure

The high-level file structure of an FSP project is shown below.

ra_gen
ra
+--fsp
+---inc
| +- - -api
| \---instances
\---src
+---bsp
\---r_nodul e
ra_cfg
+---fsp_cfg
+---bsp
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+---driver

Directly underneath the base ra folder the folders are split into the source and include folders.
Include folders are kept separate from the source for easy browsing and easy setup of include paths.

The ra_gen folder contains code generated by the RA configuration tool. This includes global
variables for the control structure and configuration structure for each module.

The ra_cfg folder is where configuration header files are stored for each module. See FSP Build Time
Configurations for information on what is provided in these header files.

3.9 FSP Architecture in Practice

3.9.1 FSP Connecting Layers

FSP modules are meant to be both reusable and stackable. It is important to remember that modules
are not dependent upon other modules, but upon other interfaces. The user is then free to fulfill the
interface using the instance that best fits their needs.

Interface: X
FSP Module 1
Dependency: /

Interface:
FSP Module 2

Dependency:

Interface: /
FSP Module 3
Dependency: None

Figure 103: Connecting layers

In the image above interface Y is a dependency of interface X and has its own dependency on
interface Z. Interface X only has a dependency on interface Y. Interface X has no knowledge of
interface Z. This is a requirement for ensuring that layers can easily be swapped out.

3.9.2 Using FSP Modules in an Application

The typical use of an FSP module involves generating required module data then using the API in the
application.

3.9.2.1 Create a Module Instance in the RA Configuration Tool

The RA configuration tool in the Renesas e? studio IDE provides a graphical user interface for setting
the parameters of the interface and instance configuration structures. e? studio also automatically
includes those structures (once they are configured in the GUI) in application-specific header files
that can be included in application code.

The RA configuration tool allocates storage for the control structures, all required configuration
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structures, and the instance structure in generated files in the ra_gen folder. Use the e? studio
Properties view to set the values for the members of the configuration structures as needed. Refer
to the Configuration section of the module usage notes for documentation about the configuration
options.

If the interface has a callback function option then the application must declare and define the
function. The return value is always of type void and the parameter to the function is a typed
structure of name <interface>_callback_args_t. Once the function has been defined, assign its name
to the p_callback member of the configuration structure. Callback function names can be assigned
through the e? studio Properties window for the selected module.

3.9.2.2 Use the Instance API in the Application

Call the module's <MODULE>_Open() function. Pass pointers to the generated control structure and
configuration structure. The names of these structures are based on the 'Name' field provided in the
RA configuration tool. The control structure is <Name>_ctrl and the configuration structure is
<Name>_cfg. An example <MODULE>_Open() call for an r_rtc module instance named g_clock is:

R RTC Open(&g_clock ctrl, &g clock cfq);

Note
Each layer in the FSP Sack isresponsible for calling the API functions of its dependencies. This means that users
areonly responsible for calling the API functions at the layer at which they are interfacing. Using the example
above of a SPI module with a DTC dependency, the application uses only SPI APIs. The application starts by
calling R_SPI_Open(). Internally, the SPI module opensthe DTC. It locates R_DTC_Open() by accessing the
dependent transfer interface function pointers from the pointers DTC instances (spi_cfg_t::p_transfer_tx and
spi_cfg t::p_transfer_rx) to open the DTC.

Refer to the module usage notes for example code to help get started with any particular module.
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Chapter 4 Copyright

Copyright [2020] Renesas Electronics Corporation and/or its affiliates. All Rights Reserved.

This software and documentation are supplied by Renesas Electronics America Inc. and may only be
used with products of Renesas Electronics Corp. and its affiliates ("Renesas"). No other uses are
authorized. Renesas products are sold pursuant to Renesas terms and conditions of sale. Purchasers
are solely responsible for the selection and use of Renesas products and Renesas assumes no
liability. No license, express or implied, to any intellectual property right is granted by Renesas. This
software is protected under all applicable laws, including copyright laws. Renesas reserves the right
to change or discontinue this software and/or this documentation. THE SOFTWARE AND
DOCUMENTATION IS DELIVERED TO YOU "AS IS," AND RENESAS MAKES NO REPRESENTATIONS OR
WARRANTIES, AND TO THE FULLEST EXTENT PERMISSIBLE UNDER APPLICABLE LAW, DISCLAIMS ALL
WARRANTIES, WHETHER EXPLICITLY OR IMPLICITLY, INCLUDING WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT, WITH RESPECT TO THE SOFTWARE
OR DOCUMENTATION. RENESAS SHALL HAVE NO LIABILITY ARISING OUT OF ANY SECURITY
VULNERABILITY OR BREACH. TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT WILL
RENESAS BE LIABLE TO YOU IN CONNECTION WITH THE SOFTWARE OR DOCUMENTATION (OR ANY
PERSON OR ENTITY CLAIMING RIGHTS DERIVED FROM YOU) FOR ANY LOSS, DAMAGES, OR CLAIMS
WHATSOEVER, INCLUDING, WITHOUT LIMITATION, ANY DIRECT, CONSEQUENTIAL, SPECIAL,
INDIRECT, PUNITIVE, OR INCIDENTAL DAMAGES; ANY LOST PROFITS, OTHER ECONOMIC DAMAGE,
PROPERTY DAMAGE, OR PERSONAL INJURY; AND EVEN IF RENESAS HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH LOSS, DAMAGES, CLAIMS OR COSTS.
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Chapter 5 APl Reference

This section includes the FSP APl Reference for the Module and Interface level functions.

»BSP Common code shared by FSP drivers

»Modules Modules are the smallest unit of software
available in the FSP. Each module implements
one interface

»Interfaces The FSP interfaces provide APIs for common
functionality. They can be implemented by one
or more modules. Modules can use other
modules as dependencies using this interface
layer

5.1 BSP

Detailed Description

Common code shared by FSP drivers.

Modules

Common Error Codes

MCU Board Support Package

The BSP is responsible for getting the MCU from reset to the user's
application. Before reaching the user's application, the BSP sets up
the stacks, heap, clocks, interrupts, C runtime environment, and
stack monitor.

BSP 1/O access

This module provides basic read/write access to port pins.

5.1.1 Common Error Codes
BSP
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Detailed Description

All FSP modules share these common error codes.

Data Structures

union

struct

Macros

#define

#define

#define

Enumerations

enum

fsp_version _t

fsp_version_t. _unnamed__

FSP_PARAMETER_NOT _USED(p)
FSP_CPP_HEADER

FSP_HEADER

fsp_err_ t

Data Structure Documentation

¢ fsp_version_t

union fsp_version_t

Common version structure

Data Fields
uint32 t version_id Version id
struct fsp_version_t __unnamed__ Code version parameters
¢ fsp_version_t._ _unnamed__
struct fsp_version_t. unnamed__
Code version parameters

Data Fields
uint8 t code_version_minor Code minor version.
uint8 t code_version_major Code major version.
uint8 t api_version_minor API minor version.
uint8 t api_version_major APl major version.

Macro Definition Documentation
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¢ FSP_PARAMETER_NOT _USED

#define FSP_PARAMETER_NOT_USED ( p)

This macro is used to suppress compiler messages about a parameter not being used in a function.
The nice thing about using this implementation is that it does not take any extra RAM or ROM.

¢ FSP_CPP_HEADER

#define FSP_CPP_HEADER

information.

Determine if a C++ compiler is being used. If so, ensure that standard C is used to process the API

¢ FSP_HEADER

#define FSP_HEADER

FSP Header and Footer definitions

Enumeration Type Documentation

¢ fsp err_t

enum fsp_err_t

Common error codes

Enumerator

FSP_ERR_ASSERTION

A critical assertion has failed.

FSP_ERR_INVALID_POINTER

Pointer points to invalid memory location.

FSP_ERR_INVALID_ARGUMENT

Invalid input parameter.

FSP_ERR_INVALID_CHANNEL

Selected channel does not exist.

FSP_ERR_INVALID_MODE

Unsupported or incorrect mode.

FSP_ERR_UNSUPPORTED

Selected mode not supported by this API.

FSP_ERR_NOT OPEN

Requested channel is not configured or API not
open.

FSP_ERR_IN_USE

Channel/peripheral is running/busy.

FSP_ERR_OUT_OF_MEMORY

Allocate more memory in the driver's cfg.h.
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FSP_ERR_HW_LOCKED Hardware is locked.

FSP_ERR_IRQ_BSP_DISABLED IRQ not enabled in BSP.

FSP_ERR_OVERFLOW Hardware overflow.

FSP_ERR_UNDERFLOW Hardware underflow.

FSP_ERR_ALREADY_OPEN Requested channel is already open in a

different configuration.

FSP_ERR_APPROXIMATION Could not set value to exact result.

FSP_ERR_CLAMPED Value had to be limited for some reason.

FSP_ERR_INVALID_RATE Selected rate could not be met.

FSP_ERR_ABORTED An operation was aborted.

FSP_ERR_NOT_ENABLED Requested operation is not enabled.

FSP_ERR_TIMEOUT Timeout error.

FSP_ERR_INVALID_BLOCKS Invalid number of blocks supplied.

FSP_ERR_INVALID_ADDRESS Invalid address supplied.

FSP_ERR_INVALID_SIZE Invalid size/length supplied for operation.

FSP_ERR_WRITE_FAILED Write operation failed.

FSP_ERR_ERASE_FAILED Erase operation failed.

FSP_ERR_INVALID_CALL Invalid function call is made.

FSP_ERR_INVALID_HW_CONDITION Detected hardware is in invalid condition.

FSP_ERR_INVALID_FACTORY_FLASH Factory flash is not available on this MCU.

FSP_ERR_INVALID_STATE API or command not valid in the current state.

FSP_ERR_NOT_ERASED Erase verification failed.

FSP_ERR_SECTOR_RELEASE_FAILED Sector release failed.

FSP_ERR_NOT_INITIALIZED Required initialization not complete.

FSP_ERR_INTERNAL Internal error.
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FSP_ERR_WAIT_ABORTED

Wait aborted.

FSP_ERR_FRAMING

Framing error occurs.

FSP_ERR_BREAK_DETECT

Break signal detects.

FSP_ERR_PARITY

Parity error occurs.

FSP_ERR_RXBUF_OVERFLOW

Receive queue overflow.

FSP_ERR_QUEUE_UNAVAILABLE

Can't open s/w queue.

FSP_ERR_INSUFFICIENT_SPACE

Not enough space in transmission circular
buffer.

FSP_ERR_INSUFFICIENT_DATA

Not enough data in receive circular buffer.

FSP_ERR_TRANSFER_ABORTED

The data transfer was aborted.

FSP_ERR_MODE_FAULT

Mode fault error.

FSP_ERR_READ OVERFLOW

Read overflow.

FSP_ERR_SPI_PARITY

Parity error.

FSP_ERR_OVERRUN

Overrun error.

FSP_ERR_CLOCK_INACTIVE

Inactive clock specified as system clock.

FSP_ERR_CLOCK_ACTIVE

Active clock source cannot be modified without
stopping first.

FSP_ERR_NOT STABILIZED

Clock has not stabilized after its been turned
on/off.

FSP_ERR_PLL_SRC_INACTIVE

PLL initialization attempted when PLL source is
turned off.

FSP_ERR_OSC_STOP_DET ENABLED

Illegal attempt to stop LOCO when Oscillation
stop is enabled.

FSP_ERR_OSC_STOP_DETECTED

The Oscillation stop detection status flag is
set.

FSP_ERR_OSC_STOP_CLOCK_ACTIVE

Attempt to clear Oscillation Stop Detect Status
with PLL/MAIN_OSC active.

FSP_ERR_CLKOUT_EXCEEDED

Output on target output clock pin exceeds
maximum supported limit.
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FSP_ERR_USB_MODULE_ENABLED

USB clock configure request with USB Module
enabled.

FSP_ERR_HARDWARE_TIMEOUT

A register read or write timed out.

FSP_ERR_LOW_VOLTAGE_MODE

Invalid clock setting attempted in low voltage
mode.

FSP_ERR_PE_FAILURE

Unable to enter Programming mode.

FSP_ERR_CMD_LOCKED

Peripheral in command locked state.

FSP_ERR_FCLK

FCLK must be >= 4 MHz.

FSP_ERR_INVALID_LINKED_ADDRESS

Function or data are linked at an invalid region
of memory.

FSP_ERR_BLANK_CHECK_FAILED

Blank check operation failed.

FSP_ERR_INVALID_CAC_REF_CLOCK

Measured clock rate < reference clock rate.

FSP_ERR_CLOCK_GENERATION

Clock cannot be specified as system clock.

FSP_ERR_INVALID_TIMING_SETTING

Invalid timing parameter.

FSP_ERR_INVALID_LAYER_SETTING

Invalid layer parameter.

FSP_ERR_INVALID_ALIGNMENT

Invalid memory alignment found.

FSP_ERR_INVALID_GAMMA_SETTING

Invalid gamma correction parameter.

FSP_ERR_INVALID_LAYER_FORMAT

Invalid color format in layer.

FSP_ERR_INVALID_UPDATE_TIMING

Invalid timing for register update.

FSP_ERR_INVALID_CLUT ACCESS

Invalid access to CLUT entry.

FSP_ERR_INVALID_FADE_SETTING

Invalid fade-in/fade-out setting.

FSP_ERR_INVALID_BRIGHTNESS_SETTING

Invalid gamma correction parameter.

FSP_ERR_JPEG_ERR

JPEG error.

FSP_ERR _JPEG_SOI_NOT _DETECTED

SOl not detected until EOl detected.

FSP_ERR JPEG_SOF1 TO_SOFF_DETECTED

SOF1 to SOFF detected.

FSP_ERR_JPEG_UNSUPPORTED_PIXEL_FORMAT

Unprovided pixel format detected.
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FSP_ERR_JPEG_SOF _ACCURACY_ERROR

SOF accuracy error: other than 8 detected.

FSP_ERR JPEG_DQT_ACCURACY_ERROR

DQT accuracy error: other than 0 detected.

FSP_ERR_JPEG_COMPONENT ERROR1

Component errorl: the number of SOFO header
components detected is other than 1,3,or 4.

FSP_ERR_JPEG_COMPONENT_ERROR2

Component error2: the number of components
differs between SOF0 header and SOS.

FSP_ERR JPEG_SOFO0_DQT_DHT NOT_DETECTED

SOFO0, DQT, and DHT not detected when SOS
detected.

FSP_ERR_JPEG_SOS NOT DETECTED

SOS not detected: SOS not detected until EOI
detected.

FSP_ERR JPEG_EOI_NOT DETECTED

EOI not detected (default)

FSP_ERR_JPEG_RESTART INTERVAL DATA_NUMB
ER_ERROR

Restart interval data number error detected.

FSP_ERR _JPEG_IMAGE_SIZE_ERROR

Image size error detected.

FSP_ERR JPEG_LAST MCU_DATA NUMBER_ERRO
R

Last MCU data number error detected.

FSP_ERR _JPEG_BLOCK_DATA_NUMBER_ERROR

Block data number error detected.

FSP_ERR_JPEG_BUFFERSIZE_NOT_ENOUGH

User provided buffer size not enough.

FSP_ERR_JPEG_UNSUPPORTED_IMAGE_SIZE

JPEG Image size is not aligned with MCU.

FSP_ERR_CALIBRATE_FAILED

Calibration failed.

FSP_ERR_IP_HARDWARE_NOT PRESENT

Requested IP does not exist on this device.

FSP_ERR_IP_UNIT_NOT_PRESENT

Requested unit does not exist on this device.

FSP_ERR_IP_CHANNEL_NOT PRESENT

Requested channel does not exist on this
device.

FSP_ERR_NO_MORE_BUFFER

No more buffer found in the memory block
pool.

FSP_ERR_ILLEGAL BUFFER_ADDRESS

Buffer address is out of block memory pool.

FSP_ERR_INVALID_WORKBUFFER_SIZE

Work buffer size is invalid.

FSP_ERR_INVALID_MSG_BUFFER_SIZE

Message buffer size is invalid.
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FSP_ERR_TOO_MANY_BUFFERS Number of buffer is too many.

FSP_ERR_NO_SUBSCRIBER_FOUND No message subscriber found.

FSP_ERR_MESSAGE_QUEUE_EMPTY No message found in the message queue.

FSP_ERR_MESSAGE_QUEUE_FULL No room for new message in the message

queue.

FSP_ERR_ILLEGAL_SUBSCRIBER_LISTS Message subscriber lists is illegal.

FSP_ERR_BUFFER_RELEASED Buffer has been released.

FSP_ERR_D2D_ERROR_INIT Dave/2d has an error in the initialization.

FSP_ERR_D2D_ERROR_DEINIT Dave/2d has an error in the initialization.

FSP_ERR_D2D_ERROR_RENDERING Dave/2d has an error in the rendering.

FSP_ERR_D2D_ERROR_SIZE Dave/2d has an error in the rendering.

FSP_ERR_ETHER_ERROR_NO_DATA No Data in Receive buffer.

FSP_ERR_ETHER_ERROR_LINK ETHERC/EDMAC has an error in the Auto-
negotiation.

FSP_ERR_ETHER _ERROR_MAGIC PACKET _MODE As a Magic Packet is being detected, and
transmission/reception is not enabled.

FSP_ERR_ETHER_ERROR_TRANSMIT_BUFFER_FUL

L Transmit buffer is not empty.

FSP_ERR_ETHER_ERROR_FILTERING Detect multicast frame when multicast frame
filtering enable.

FSP_ERR_ETHER ERROR_PHY COMMUNICATION ETHERC/EDMAC has an error in the phy
communication.

FSP_ERR_ETHER PHY ERROR_LINK PHY is not link up.
FSP_ERR_ETHER_PHY_NOT_READY PHY has an error in the Auto-negotiation.
FSP_ERR_QUEUE_FULL Queue is full, cannot queue another data.
FSP_ERR_QUEUE_EMPTY Queue is empty, no data to dequeue.

FSP_ERR_CTSU_SCANNING Scanning.

FSP_ERR_CTSU_NOT_GET_DATA Not processed previous scan data.
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FSP_ERR_CTSU_INCOMPLETE_TUNING

Incomplete initial offset tuning.

FSP_ERR_CARD_INIT_FAILED

SD card or eMMC device failed to initialize.

FSP_ERR_CARD_NOT INSERTED

SD card not installed.

FSP_ERR_DEVICE_BUSY

Device is holding DATO low or another
operation is ongoing.

FSP_ERR_CARD_NOT_INITIALIZED

SD card was removed.

FSP_ERR_CARD_WRITE_PROTECTED

Media is write protected.

FSP_ERR_TRANSFER_BUSY

Transfer in progress.

FSP_ERR_RESPONSE

Card did not respond or responded with an
error.

FSP_ERR_MEDIA_FORMAT_FAILED

Media format failed.

FSP_ERR_MEDIA_OPEN_FAILED

Media open failed.

FSP_ERR_CAN_DATA_UNAVAILABLE

No data available.

FSP_ERR_CAN_MODE_SWITCH_FAILED

Switching operation modes failed.

FSP_ERR_CAN_INIT_FAILED

Hardware initialization failed.

FSP_ERR_CAN_TRANSMIT NOT_READY

Transmit in progress.

FSP_ERR_CAN_RECEIVE_MAILBOX

Mailbox is setup as a receive mailbox.

FSP_ERR_CAN_TRANSMIT_MAILBOX

Mailbox is setup as a transmit mailbox.

FSP_ERR_CAN_MESSAGE_LOST

Receive message has been overwritten or
overrun.

FSP_ERR_WIFI_CONFIG_FAILED

WiFi module Configuration failed.

FSP_ERR_WIFI_INIT_FAILED

WiFi module initialization failed.

FSP_ERR_WIFI_TRANSMIT_FAILED

Transmission failed.

FSP_ERR_WIFI_INVALID_MODE

API called when provisioned in client mode.

FSP_ERR_WIFI_FAILED

WiFi Failed.

FSP_ERR_CELLULAR_CONFIG_FAILED

Cellular module Configuration failed.
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FSP_ERR_CELLULAR_INIT_FAILED

Cellular module initialization failed.

FSP_ERR_CELLULAR_TRANSMIT_FAILED

Transmission failed.

FSP_ERR_CELLULAR_FW _UPTODATE

Firmware is uptodate.

FSP_ERR_CELLULAR_FW_UPGRADE_FAILED

Firmware upgrade failed.

FSP_ERR_CELLULAR_FAILED

Cellular Failed.

FSP_ERR_CELLULAR_INVALID STATE

API Called in invalid state.

FSP_ERR_CELLULAR_REGISTRATION_FAILED

Cellular Network registration failed.

FSP_ERR_BLE_FAILED

BLE operation failed.

FSP_ERR_BLE_INIT_FAILED

BLE device initialization failed.

FSP_ERR_BLE_CONFIG_FAILED

BLE device configuration failed.

FSP_ERR_BLE_PRF_ALREADY ENABLED

BLE device Profile already enabled.

FSP_ERR_BLE_PRF_NOT_ENABLED

BLE device not enabled.

FSP_ERR_CRYPTO_CONTINUE

Continue executing function.

FSP_ERR_CRYPTO_SCE_RESOURCE_CONFLICT

Hardware resource busy.

FSP_ERR_CRYPTO_SCE_FAIL

Internal 1/O buffer is not empty.

FSP_ERR_CRYPTO_SCE_HRK_INVALID_INDEX

Invalid index.

FSP_ERR_CRYPTO_SCE_RETRY

Retry.

FSP_ERR_CRYPTO_SCE_VERIFY_FAIL

Verify is failed.

FSP_ERR_CRYPTO_SCE_ALREADY_ OPEN

HW SCE module is already opened.

FSP_ERR_CRYPTO_NOT_OPEN

Hardware module is not initialized.

FSP_ERR_CRYPTO_UNKNOWN

Some unknown error occurred.

FSP_ERR_CRYPTO_NULL_POINTER

Null pointer input as a parameter.

FSP_ERR_CRYPTO_NOT_IMPLEMENTED

Algorithm/size not implemented.

FSP_ERR_CRYPTO_RNG_INVALID_PARAM

An invalid parameter is specified.
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FSP_ERR_CRYPTO_RNG_FATAL_ERROR

A fatal error occurred.

FSP_ERR_CRYPTO_INVALID_SIZE

Size specified is invalid.

FSP_ERR_CRYPTO_INVALID_STATE

Function used in an valid state.

FSP_ERR_CRYPTO_ALREADY_OPEN

control block is already opened

FSP_ERR_CRYPTO_INSTALL_KEY_FAILED

Specified input key is invalid.

FSP_ERR_CRYPTO_AUTHENTICATION_FAILED

Authentication failed.

FSP_ERR_CRYPTO_COMMON_NOT OPENED

Crypto Framework Common is not opened.

FSP_ERR_CRYPTO_HAL_ERROR

Cryoto HAL module returned an error.

FSP_ERR_CRYPTO_KEY_BUF_NOT_ENOUGH

Key buffer size is not enough to generate a
key.

FSP_ERR_CRYPTO_BUF_OVERFLOW

Attempt to write data larger than what the
buffer can hold.

FSP_ERR_CRYPTO_INVALID_OPERATION_MODE

Invalid operation mode.

FSP_ERR_MESSAGE_TOO_LONG

Message for RSA encryption is too long.

FSP_ERR_RSA DECRYPTION_ERROR

RSA Decryption error.

5.1.2 MCU Board Support Package
BSP

Functions

fsp_err t R_FSP_VersionGet (fsp_pack version_t *const p_version)

void Reset Handler (void)

void Default Handler (void)

void Systemlnit (void)

void R BSP WarmStart (bsp_warm_start event t event)

fsp_err t R _BSP_VersionGet (fsp_version_t *p_version)
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void R _BSP SoftwareDelay (uint32_t delay, bsp_delay_units_t units)

fsp_err t R_BSP_GrouplrqWrite (bsp_grp_irq_tirq,
void(*p_callback)(bsp_grp_irq_t irq))

void NMI_Handler (void)
void R _BSP_RegisterProtectEnable (bsp_reg_protect t regs to_protect)

void R _BSP_RegisterProtectDisable (bsp reg protect t regs to unprotect)

Detailed Description

The BSP is responsible for getting the MCU from reset to the user's application. Before reaching the
user's application, the BSP sets up the stacks, heap, clocks, interrupts, C runtime environment, and
stack monitor.

BSP Features

BSP Clock Configuration
System Interrupts
Group Interrupts
External and Peripheral Interrupts
Error Logging

BSP Weak Symbols
Warm Start Callbacks
Register Protection

ID Codes

e Software Delay

e Board Specific Features
e Configuration

Overview

BSP Features
BSP Clock Configuration

All system clocks are set up during BSP initialization based on the settings in bsp_clock cfg.h. These
settings are derived from clock configuration information provided from the RA Configuration tool
Clocks tab setting.

» Clock configuration is performed prior to initializing the C runtime environment to speed up
the startup process, as it is possible to start up on a relatively slow (that is, 32 kHz) clock.

e The BSP implements the required delays to allow the selected clock to stabilize.

e The BSP will configure the CMSIS SystemCoreClock variable after clock initialization with the
current system clock frequency.

System Interrupts

As RA MCUs are based on the Cortex-M ARM architecture, the NVIC Nested Vectored Interrupt
Controller (NVIC) handles exceptions and interrupt configuration, prioritization and interrupt
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masking. In the ARM architecture, the NVIC handles exceptions. Some exceptions are known as
System Exceptions. System exceptions are statically located at the "top" of the vector table and
occupy vector numbers 1 to 15. Vector zero is reserved for the MSP Main Stack Pointer (MSP). The
remaining 15 system exceptions are shown below:

e Reset

e NMI

Cortex-M4 Hard Fault Handler
Cortex-M4 MPU Fault Handler
Cortex-M4 Bus Fault Handler
Cortex-M4 Usage Fault Handler
Reserved

Reserved

Reserved

Reserved

Cortex-M4 SVCall Handler
Cortex-M4 Debug Monitor Handler
Reserved

Cortex-M4 PendSV Handler
Cortex-M4 SysTick Handler

NMI and Hard Fault exceptions are enabled out of reset and have fixed priorities. Other exceptions
have configurable priorities and some can be disabled.

Group Interrupts

Group interrupt is the term used to describe the 12 sources that can trigger the Non-Maskable
Interrupt (NMI). When an NMI occurs the NMI Handler examines the NMISR (status register) to
determine the source of the interrupt. NMI interrupts take precedence over all interrupts, are usable
only as CPU interrupts, and cannot activate the RA peripherals Data Transfer Controller (DTC) or
Direct Memory Access Controller (DMAC).

Possible group interrupt sources include:

IWDT Underflow/Refresh Error
WDT Underflow/Refresh Error
Voltage-Monitoring 1 Interrupt
Voltage-Monitoring 2 Interrupt
VBATT monitor Interrupt
Oscillation Stop is detected
NMI pin

RAM Parity Error

RAM ECC Error

e MPU Bus Slave Error

e MPU Bus Master Error

e MPU Stack Error

A user may enable notification for one or more group interrupts by registering a callback using the
BSP API function R_BSP_GrouplrgWrite(). When an NMI interrupt occurs, the NMI handler checks to
see if there is a callback registered for the cause of the interrupt and if so calls the registered
callback function.

External and Peripheral Interrupts

User configurable interrupts begin with slot 16. These may be external, or peripheral generated
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interrupts.

Although the number of available slots for the NVIC interrupt vector table may seem small, the BSP
defines up to 512 events that are capable of generating an interrupt. By using Event Mapping, the
BSP maps user-enabled events to NVIC interrupts. For an RA6M3 MCU, only 96 of these events may
be active at any one time, but the user has flexibility by choosing which events generate the active
event.

By allowing the user to select only the events they are interested in as interrupt sources, we are able
to provide an interrupt service routine that is fast and event specific.

For example, on other microcontrollers a standard NVIC interrupt vector table might contain a single
vector entry for the SCIO (Serial Communications Interface) peripheral. The interrupt service routine
for this would have to check a status register for the 'real' source of the interrupt. In the RA
implementation there is a vector entry for each of the SCI0O events that we are interested in.

BSP Weak Symbols

You might wonder how the BSP is able to place ISR addresses in the NVIC table without the user
having explicitly defined one. All that is required by the BSP is that the interrupt event be given a
priority.

This is accomplished through the use of the 'weak' attribute. The weak attribute causes the
declaration to be emitted as a weak symbol rather than a global. A weak symbol is one that can be
overridden by an accompanying strong reference with the same name. When the BSP declares a
function as weak, user code can define the same function and it will be used in place of the BSP
function. By defining all possible interrupt sources as weak, the vector table can be built at compile
time and any user declarations (strong references) will be used at runtime.

Weak symbols are supported for ELF targets and also for a.out targets when using the GNU
assembler and linker.

Note that in CMSIS system.c, there is also a weak definition (and a function body) for the Warm Start
callback function R_BSP_WarmStart(). Because this function is defined in the same file as the weak
declaration, it will be called as the 'default' implementation. The function may be overridden by the
user by copying the body into their user application and modifying it as necessary. The linker
identifies this as the 'strong' reference and uses it.

Warm Start Callbacks

As the BSP is in the process of bringing up the board out of reset, there are three points where the
user can request a callback. These are defined as the 'Pre Clock Init', 'Post Clock Init' and 'Post C'
warm start callbacks.

As described above, this function is already weakly defined as R_BSP_WarmStart(), so it is a simple
matter of redefining the function or copying the existing body from CMSIS system.c into the
application code to get a callback. R_BSP_WarmStart() takes an event parameter of type
bsp_warm_start_event_t which describes the type of warm start callback being made.

This function is not enabled/disabled and is always called for both events as part of the BSP startup.
Therefore it needs a function body, which will not be called if the user is overriding it. The function
body is located in system.c. To use this function just copy this function into your own code and
modify it to meet your needs.

Heap Allocation
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The relatively low amount of on-chip SRAM available and lack of memory protection in an MCU
means that heap use must be very carefully controlled to avoid memory leaks, overruns and
attempted overallocation. Further, many RTOSes provide their own dynamic memory allocation
system. For these reasons the default heap size is set at 0 bytes, effectively disabling dynamic
memory. If it is required for an application setting a positive value to the "Heap size (bytes)" option
in the RA Common configurations on the BSP tab will allocate a heap.

Note
When using printf/sprintf (and other variants) to output floating point numbers a heap is required. A minimum size
of 0x1000 (4096) bytes is recommended when starting development in this case.

Error Logging

When error logging is enabled, the error logging function can be redefined on the command line by
defining FSP_ERROR_LOG(err) to the desired function call. The default function implementation is
FSP_ERROR_LOG(err)=fsp_error_log(err, FILE, LINE). This implementation uses the predefined
macros FILE and LINE to help identify the location where the error occurred. Removing the line from
the function call can reduce code size when error logging is enabled. Some compilers may support
other predefined macros like FUNCTION, which could be helpful for customizing the error logger.

Register Protection

The BSP register protection functions utilize reference counters to ensure that an application which
has specified a certain register and subsequently calls another function doesn't have its register
protection settings inadvertently modified.

Each time RegisterProtectDisable() is called, the respective reference counter is incremented.

Each time RegisterProtectEnable() is called, the respective reference counter is decremented.

Both functions will only modify the protection state if their reference counter is zero.

/* Enable witing to protected CGC registers */

R BSP_Regi st er Pr ot ect Di sabl e( BSP_REG PROTECT CCC) ;
/* Insert code to nodify protected CGC registers. */
/* Disable witing to protected CCGC regi sters */

R BSP_Regi st er Pr ot ect Enabl e( BSP_REG PROTECT CCC) ;

ID Codes

The ID code is 16 byte value that can be used to protect the MCU from being connected to a
debugger or from connecting in Serial Boot Mode. There are different settings that can be set for the
ID code; please refer to the hardware manual for your device for available options.

Software Delay

Implements a blocking software delay. A delay can be specified in microseconds, milliseconds or
seconds. The delay is implemented based on the system clock rate.
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/* Delay at |least 1 second. Depending on the nunber of wait states required for the
regi on of nenory

* that the software_delay | oop has been linked in this could take | onger. The
default is 4 cycles per |oop.

* This can be nodified by redefining DELAY LOOP_CYCLES. BSP_DELAY UN TS SECONDS,
BSP_DELAY_UNI TS M LLI SECONDS,

* and BSP_DELAY UNI TS M CROSECONDS can all be used with R BSP_Sof t wareDel ay. */

R BSP_Sof t war eDel ay(1, BSP_DELAY UNI TS SECONDS) ;

Critical Section Macors

Implements a critical section. Some MCUs (MCUs with the BASEPRI register) support allowing high
priority interrupts to execute during critical sections. On these MCUs, interrupts with priority less
than or equal to BSP_CFG_IRQ_MASK LEVEL FOR_CRITICAL_SECTION are not serviced in critical
sections. Interrupts with higher priority than BSP_CFG_IRQ_MASK LEVEL_FOR_CRITICAL_SECTION still
execute in critical sections.
FSP_CRI Tl CAL_SECTI ON_DEFI NE;

/* Store the current interrupt posture. */

FSP_CRI TI CAL_SECTI ON_ENTER;

/* Interrupts cannot run in this section unless their priority is less than
BSP_CFG | RQ MASK LEVEL_FOR CRI TI CAL_SECTI ON. */

/* Restore saved interrupt posture. */

FSP_CRI TI CAL_SECTI ON_EXI T;

Board Specific Features

The BSP will call the board's initialization function (bsp_init) which can initialize board specific
features. Possible board features are listed below.

Board Feature Description
SDRAM Support The BSP will initialize SDRAM if the board
supports it
QSPI Support The BSP will initialize QSPI if the board supports

it and put it into ROM mode. Use the R_QSPI
module to write and erase the QSPI chip.

Configuration
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The BSP is heavily data driven with most features and functionality being configured based on the
content from configuration files. Configuration files represent the settings specified by the user and
are generated by the RA Configuration tool when the Generate Project Content button is clicked.

Build Time Configurations for fsp_common

The following build time configurations are defined in fsp_cfg/bsp/bsp_cfg.h:

Configuration

Options

Default

Description

Main stack size (bytes)

Heap size (bytes)

MCU Vcc (mV)

Parameter checking

Value must be an
integer multiple of 8
and between 8 and
OXFFFFFFFF

Value must be 0 or an
integer multiple of 8
between 8 and
OxFFFFFFFF.

Value must between 0
and 5500 (5.5V)

e Enabled
e Disabled

0x400

3300

Disabled

Set the size of the main
program stack.

NOTE: This entry is for
the main stack. When
using an RTOS, thread
stacks can be
configured in the
properties for each
thread.

The main heap is
disabled by default. Set
the heap size to a
positive integer
divisible by 8 to enable
it.

A minimum of 4K
(0x1000) is
recommended if
standard library
functions are to be
used.

Some peripherals
require different
settings based on the
supplied voltage.
Entering Vcc here (in
mV) allows the relevant
driver modules to
configure the
associated peripherals
accordingly.

When enabled,
parameter checking for
the BSP is turned on. In
addition, any modules
whose parameter
checking configuration
is set to 'Default (BSP)'
will perform parameter
checking as well.
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Assert Failures

Error Log

ID Code Mode

ID Code (32 Hex
Characters)

Soft Reset

Main Oscillator
Populated

PFS Protect

Value must be a 32
character long hex

string

Return FSP_ERR Return
_ASSERTION FSP_ERR_ASSERTION
Call

fsp_error_log

then Return FSP
_ERR_ASSERTIO

N

Use assert() to

Halt Execution

Disable checks

that would

return FSP_ERR
_ASSERTION

No Error Log
Errors Logged
via
fsp_error_log

No Error Log

Unlocked
(Ignore ID)
Locked with All
Erase support
Locked

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

Disabled
Enabled

Disabled

Populated
Not Populated

Populated

Disabled
Enabled

Enabled

Define the behavior of
the FSP_ASSERTY()
macro.

Specify error logging
behavior.

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

Support for soft reset.
If disabled, registers
are assumed to be set
to their default value
during startup.

Select whether or not
there is a main
oscillator (XTAL) on the
board. This setting can
be overridden in

board _cfg.h.

Keep the PFS registers
locked when they are
not being modified. If
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Main Oscillator Wait
Time

Main Oscillator Clock
Source

Subclock Populated

Subclock Drive

0.25 us
128 us
256 us
512 us
1024 us
2048 us
4096 us
8192 us
16384 us
32768 us

e External
Oscillator

e Crystal or
Resonator

e Populated
¢ Not Populated

e Middle (4.4pf)
e Standard
(12.5pf)

32768 us

Crystal or Resonator

Populated

Standard (12.5pf)

disabled they will be
unlocked during
startup.

Number of cycles to
wait for the main
oscillator clock to
stabilize. This setting
can be overridden in
board_cfg.h

Select the main
oscillator clock source.
This setting can be
overridden in

board _cfg.h

Select whether or not
there is a subclock
crystal on the board.
This setting can be
overridden in
board_cfg.h.

Select the subclock
oscillator drive
capacitance. This
setting can be
overridden in

board _cfg.h
Subclock Stabilization Value must between 0 1000 Select the subclock
Time (ms) and 10000 oscillator stabilization
time. This is only used
in the startup code if
the subclock is
selected as the system
clock on the Clocks tab.
This setting can be
overridden in
board_cfg.h
Modules
RA2A1
RA4AM1
RA6M1
RA6M2
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Macros

#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define

Enumerations

enum
enum
enum
enum
enum
enum

Variables

uint32_t

const fsp_version_t

RA6M3

BSP_IRQ_DISABLED
FSP_RETURN(err)
FSP_ERROR_LOG(err)
FSP_ASSERT(a)
FSP_ERROR_RETURN(a, err)
FSP_CRITICAL SECTION_ENTER
FSP_CRITICAL SECTION_EXIT
FSP_INVALID VECTOR
BSP_STACK_ALIGNMENT

R _BSP_MODULE_START(ip, channel)

R_BSP_MODULE_STOP(ip, channel)

fsp_ip_t

fsp_signal_t

bsp warm_start event t
bsp _delay units t
bsp_grp_irg_t

bsp_reg protect t

SystemCoreClock

g_bsp_version

Default initialization function. More...

Macro Definition Documentation
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¢ BSP_IRQ_DISABLED

#define BSP_IRQ_DISABLED

Used to signify that an ELC event is not able to be used as an interrupt.

¢ FSP_RETURN

#define FSP_RETURN ( err)

Macro to log and return error without an assertion.

o FSP_ERROR_LOG

#define FSP_ERROR_LOG ( err)

This function is called before returning an error code. To stop on a runtime error, define
fsp_error_log in user code and do required debugging (breakpoints, stack dump, etc) in this
function.

o FSP_ASSERT

#define FSP_ASSERT ( a)

Default assertion calls FSP_ERROR_RETURN if condition "a" is false. Used to identify incorrect use of
API's in FSP functions.

¢ FSP_ERROR_RETURN

#define FSP_ERROR_RETURN ( a, err )

All FSP error codes are returned using this macro. Calls FSP_ERROR_LOG function if condition "a" is
false. Used to identify runtime errors in FSP functions.

¢ FSP_CRITICAL_SECTION_ENTER

#define FSP_CRITICAL_SECTION_ENTER

This macro temporarily saves the current interrupt state and disables interrupts.

¢ FSP_CRITICAL_SECTION_EXIT

#define FSP_CRITICAL_SECTION_EXIT

This macro restores the previously saved interrupt state, reenabling interrupts.
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& FSP_INVALID_VECTOR

#define FSP_INVALID_VECTOR

Used to signify that the requested IRQ vector is not defined in this system.

¢ BSP_STACK_ALIGNMENT

#define BSP_STACK_ALIGNMENT

Stacks (and heap) must be sized and aligned to an integer multiple of this number.

¢ R_BSP_MODULE_START

#define R_BSP_MODULE_START ( ip, channel )

Cancels the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

¢ R_BSP_MODULE_STOP

#define R_BSP_MODULE_STOP ( ip, channel )

Enables the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

Enumeration Type Documentation
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¢ fsp_ip_t

enum fsp_ip t

Available modules.

Enumerator

FSP_IP_CFLASH Code Flash.

FSP_IP_DFLASH Data Flash.

FSP_IP_RAM RAM.

FSP_IP_LVD Low Voltage Detection.

FSP_IP_CGC Clock Generation Circuit.

FSP_IP_LPM Low Power Modes.

FSP_IP_FCU Flash Control Unit.

FSP_IP_ICU Interrupt Control Unit.

FSP_IP_DMAC DMA Controller.

FSP_IP_DTC Data Transfer Controller.
FSP_IP_IOPORT I/O Ports.

FSP_IP_PFS Pin Function Select.

FSP_IP_ELC Event Link Controller.

FSP_IP_MPU Memory Protection Unit.
FSP_IP_MSTP Module Stop.

FSP_IP_MMF Memory Mirror Function.

FSP_IP_KEY Key Interrupt Function.

FSP_IP_CAC Clock Frequency Accuracy Measurement

Circuit.

FSP_IP_DOC Data Operation Circuit.

FSP_IP_CRC Cyclic Redundancy Check Calculator.
FSP_IP_SCI Serial Communications Interface.
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FSP_IP_IIC I2C Bus Interface.

FSP_IP_SPI Serial Peripheral Interface.
FSP_IP_CTSU Capacitive Touch Sensing Unit.
FSP_IP_SCE Secure Cryptographic Engine.
FSP_IP_SLCDC Segment LCD Controller.
FSP_IP_AES Advanced Encryption Standard.
FSP_IP_TRNG True Random Number Generator.
FSP_IP_FCACHE Flash Cache.

FSP_IP_SRAM SRAM.

FSP_IP_ADC A/D Converter.

FSP_IP_DAC 12-Bit D/A Converter
FSP_IP_TSN Temperature Sensor.
FSP_IP_DAAD

D/A A/D Synchronous Unit.

FSP_IP_ACMPHS

High Speed Analog Comparator.

FSP_IP_ACMPLP

Low Power Analog Comparator.

FSP_IP_OPAMP Operational Amplifier.

FSP_IP_SDADC Sigma Delta A/D Converter.

FSP_IP_RTC Real Time Clock.

FSP_IP_WDT Watch Dog Timer.

FSP_IP_IWDT Independent Watch Dog Timer.

FSP_IP_GPT General PWM Timer.

FSP_IP_POEG Port Output Enable for GPT.

FSP_IP_OPS Output Phase Switch.

FSP_IP_AGT Asynchronous General-Purpose Timer.
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FSP_IP_CAN Controller Area Network.
FSP_IP_IRDA Infrared Data Association.
FSP_IP_QSPI Quad Serial Peripheral Interface.
FSP_IP_USBFS USB Full Speed.

FSP_IP_SDHI SD/MMC Host Interface.
FSP_IP_SRC Sampling Rate Converter.
FSP_IP_SSI Serial Sound Interface.
FSP_IP_DALI Digital Addressable Lighting Interface.
FSP_IP_ETHER Ethernet MAC Controller.
FSP_IP_EDMAC Ethernet DMA Controller.
FSP_IP_EPTPC Ethernet PTP Controller.
FSP_IP_PDC Parallel Data Capture Unit.
FSP_IP_GLCDC Graphics LCD Controller.
FSP_IP_DRW 2D Drawing Engine

FSP_IP_JPEG JPEG.

FSP_IP_DACS8 8-Bit D/A Converter
FSP_IP_USBHS

USB High Speed.
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¢ fsp_signal_t

enum fsp_signal_t

Signals that can be mapped to an interrupt.

Enumerator

FSP_SIGNAL_ADC_COMPARE_MATCH

ADC COMPARE MATCH.

FSP_SIGNAL_ADC_COMPARE_MISMATCH

ADC COMPARE MISMATCH.

FSP_SIGNAL_ADC_SCAN_END

ADC SCAN END.

FSP_SIGNAL_ADC_SCAN_END B

ADC SCAN END B.

FSP_SIGNAL_ADC_WINDOW A

ADC WINDOW A.

FSP_SIGNAL_ADC_WINDOW B

ADC WINDOW B.

FSP_SIGNAL_AES_RDREQ

AES RDREQ.

FSP_SIGNAL_AES_WRREQ

AES WRREQ.

FSP_SIGNAL_AGT_COMPARE_A

AGT COMPARE A.

FSP_SIGNAL_AGT_COMPARE_B

AGT COMPARE B.

FSP_SIGNAL_AGT_INT

AGT INT.

FSP_SIGNAL_CAC_FREQUENCY_ERROR

CAC FREQUENCY ERROR.

FSP_SIGNAL_CAC_MEASUREMENT _END

CAC MEASUREMENT END.

FSP_SIGNAL_CAC_OVERFLOW

CAC OVERFLOW.

FSP_SIGNAL_CAN_ERROR

CAN ERROR,
FSP_SIGNAL_CAN_FIFO_RX CAN FIFO RX.
FSP_SIGNAL_CAN_FIFO_TX CAN FIFO TX.

FSP_SIGNAL_CAN_MAILBOX_RX

CAN MAILBOX RX.

FSP_SIGNAL_CAN_MAILBOX_TX

CAN MAILBOX TX.

FSP_SIGNAL_CGC_MOSC_STOP

CGC MOSC STOP.

FSP_SIGNAL_LPM_SNOOZE_REQUEST

LPM SNOOZE REQUEST.
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FSP_SIGNAL_LVD LVD1

LVD LVD1.
FSP_SIGNAL_LVD_LVD2 LVD LVD2.
FSP_SIGNAL_VBATT_LVD VBATT LVD.
FSP_SIGNAL_LVD_VBATT LVD VBATT.
FSP_SIGNAL_ACMPHS_INT ACMPHS INT.
FSP_SIGNAL_ACMPLP_INT ACMPLP INT.
FSP_SIGNAL_CTSU_END CTSU END.
FSP_SIGNAL_CTSU_READ CTSU READ.
FSP_SIGNAL_CTSU_WRITE CTSU WRITE.
FSP_SIGNAL_DALI_DEI DALI DEI.
FSP_SIGNAL_DALI_CLI DALI CLI.
FSP_SIGNAL_DALI_SDI DALI SDI.
FSP_SIGNAL_DALI_BPI DALI BPI.
FSP_SIGNAL_DALI_FEI DALI FEI.

FSP_SIGNAL_DALI_SDI_OR_BPI

DALI SDI OR BPI.

FSP_SIGNAL_DMAC_INT

DMAC INT.
FSP_SIGNAL_DOC_INT DOC INT.
FSP_SIGNAL_DRW_INT DRW INT.

FSP_SIGNAL_DTC_COMPLETE

DTC COMPLETE.

FSP_SIGNAL_DTC_END

DTC END.

FSP_SIGNAL_EDMAC_EINT

EDMAC EINT.

FSP_SIGNAL_ELC_SOFTWARE_EVENT_0 ELC SOFTWARE EVENT 0.

FSP_SIGNAL_ELC_SOFTWARE_EVENT_1 ELC SOFTWARE EVENT 1.

FSP_SIGNAL_EPTPC_IPLS EPTPC IPLS.
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FSP_SIGNAL_EPTPC_MINT

EPTPC MINT.

FSP_SIGNAL_EPTPC_PINT

EPTPC PINT.

FSP_SIGNAL_EPTPC_TIMERO_FALL

EPTPC TIMERO FALL.

FSP_SIGNAL_EPTPC_TIMERO_RISE

EPTPC TIMERO RISE.

FSP_SIGNAL_EPTPC_TIMER1_FALL

EPTPC TIMER1 FALL.

FSP_SIGNAL_EPTPC_TIMER1_RISE

EPTPC TIMERL1 RISE.

FSP_SIGNAL_EPTPC_TIMER2_FALL

EPTPC TIMER2 FALL.

FSP_SIGNAL_EPTPC_TIMER2_RISE

EPTPC TIMER2 RISE.

FSP_SIGNAL_EPTPC_TIMER3_FALL

EPTPC TIMER3 FALL.

FSP_SIGNAL_EPTPC_TIMER3_RISE

EPTPC TIMER3 RISE.

FSP_SIGNAL_EPTPC_TIMER4 FALL

EPTPC TIMER4 FALL.

FSP_SIGNAL_EPTPC_TIMER4_RISE

EPTPC TIMER4 RISE.

FSP_SIGNAL_EPTPC_TIMER5_FALL

EPTPC TIMERS5 FALL.

FSP_SIGNAL_EPTPC_TIMER5_RISE

EPTPC TIMERS5 RISE.

FSP_SIGNAL_FCU_FIFERR

FCU FIFERR.

FSP_SIGNAL_FCU_FRDYI

FCU FRDYI.

FSP_SIGNAL_GLCDC_LINE_DETECT

GLCDC LINE DETECT.

FSP_SIGNAL_GLCDC_UNDERFLOW 1

GLCDC UNDERFLOW 1.

FSP_SIGNAL_GLCDC_UNDERFLOW 2

GLCDC UNDERFLOW 2.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_A

GPT CAPTURE COMPARE A.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_B

GPT CAPTURE COMPARE B.

FSP_SIGNAL_GPT_COMPARE_C

GPT COMPARE C.

FSP_SIGNAL_GPT_COMPARE_D

GPT COMPARE D.

FSP_SIGNAL_GPT_COMPARE_E

GPT COMPARE E.
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FSP_SIGNAL_GPT_COMPARE_F GPT COMPARE F.
FSP_SIGNAL_GPT_COUNTER_OVERFLOW GPT COUNTER OVERFLOW.
FSP_SIGNAL_GPT_COUNTER_UNDERFLOW GPT COUNTER UNDERFLOW.
FSP_SIGNAL GPT _AD TRIG_A GPT AD TRIG A.
FSP_SIGNAL GPT _AD TRIG B GPT AD TRIG B.
FSP_SIGNAL_OPS_UVW_EDGE OPS UVW EDGE.
FSP_SIGNAL ICU_IRQO ICU IRQO.
FSP_SIGNAL ICU_IRQ1 ICU IRQ1.
FSP_SIGNAL_ICU_IRQ2 ICU IRQ2.
FSP_SIGNAL_ICU_IRQ3 ICU IRQ3.
FSP_SIGNAL ICU_IRQ4 ICU IRQA4.
FSP_SIGNAL_ICU_IRQ5 ICU IRQ5.
FSP_SIGNAL ICU IRQ6 ICU IRQS6.
FSP_SIGNAL_ICU_IRQ7 ICU IRQ7.
FSP_SIGNAL ICU_IRQ8 ICU IRQS.
FSP_SIGNAL _ICU_IRQ9 ICU IRQO9.
FSP_SIGNAL ICU _IRQ10 ICU IRQ10.
FSP_SIGNAL_ICU_IRQ11 ICU IRQ11.
FSP_SIGNAL ICU IRQ12 ICU IRQ12.
FSP_SIGNAL ICU_IRQ13 ICU IRQ13.
FSP_SIGNAL ICU IRQ14 ICU IRQ14.
FSP_SIGNAL_ICU_IRQ15 ICU IRQ15.
FSP_SIGNAL ICU SNOOZE_CANCEL ICU SNOOZE CANCEL.
FSP_SIGNAL IIC_ERI IIC ERI.
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FSP_SIGNAL_IIC_RXI

[IC RXI.
FSP_SIGNAL_IIC_TEI [IC TEI.
FSP_SIGNAL_IIC_TXI [IC TXI.
FSP_SIGNAL_IIC_WUI [IC WUI.

FSP_SIGNAL_IOPORT EVENT_1

IOPORT EVENT 1.

FSP_SIGNAL_IOPORT_EVENT 2

IOPORT EVENT 2.

FSP_SIGNAL_IOPORT _EVENT 3

IOPORT EVENT 3.

FSP_SIGNAL_IOPORT_EVENT 4

IOPORT EVENT 4.

FSP_SIGNAL_IWDT_UNDERFLOW

IWDT UNDERFLOW.

FSP_SIGNAL_JPEG_JDTI JPEG JDTI.
FSP_SIGNAL_JPEG_JEDI JPEG JEDI.
FSP_SIGNAL_KEY_INT KEY INT.

FSP_SIGNAL_PDC_FRAME_END

PDC FRAME END.

FSP_SIGNAL_PDC_INT

PDC INT.

FSP_SIGNAL_PDC_RECEIVE_DATA READY

PDC RECEIVE DATA READY.

FSP_SIGNAL_POEG_EVENT

POEG EVENT.
FSP_SIGNAL_QSPIL_INT QSPI INT.
FSP_SIGNAL_RTC_ALARM RTC ALARM.
FSP_SIGNAL_RTC_PERIOD RTC PERIOD.
FSP_SIGNAL_RTC_CARRY RTC CARRY.

FSP_SIGNAL_SCE_INTEGRATE_RDRDY

SCE INTEGRATE RDRDY.

FSP_SIGNAL_SCE_INTEGRATE_WRRDY

SCE INTEGRATE WRRDY.

FSP_SIGNAL_SCE_LONG_PLG

SCE LONG PLG.

FSP_SIGNAL_SCE_PROC_BUSY

SCE PROC BUSY.
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FSP_SIGNAL_SCE_RDRDY_0

SCE RDRDY 0.
FSP_SIGNAL_SCE_RDRDY_1 SCE RDRDY 1.
FSP_SIGNAL_SCE_ROMOK SCE ROMOK.

FSP_SIGNAL_SCE_TEST_BUSY

SCE TEST BUSY.

FSP_SIGNAL_SCE_WRRDY_0

SCE WRRDY 0.
FSP_SIGNAL_SCE_WRRDY_1 SCE WRRDY 1.
FSP_SIGNAL_SCE_WRRDY_4 SCE WRRDY 4.
FSP_SIGNAL_SCI_AM SCI AM.
FSP_SIGNAL_SCI_ERI SCI ERI.
FSP_SIGNAL_SCI_RXI SCI RXI.
FSP_SIGNAL_SCI_RXI_OR_ERI SCI RXI OR ERI.
FSP_SIGNAL_SCI_TEI SCI TEI.
FSP_SIGNAL_SCI_TXI SCI TXI.
FSP_SIGNAL_SDADC_ADI SDADC ADI.

FSP_SIGNAL_SDADC_SCANEND

SDADC SCANEND.

FSP_SIGNAL_SDADC_CALIEND

SDADC CALIEND.

FSP_SIGNAL_SDHIMMC_ACCS

SDHIMMC ACCS.

FSP_SIGNAL_SDHIMMC_CARD

SDHIMMC CARD.

FSP_SIGNAL_SDHIMMC_DMA_REQ

SDHIMMC DMA REQ.

FSP_SIGNAL_SDHIMMC_SDIO

SDHIMMC SDIO.

FSP_SIGNAL_SPI_ERI

SPI ERI.
FSP_SIGNAL_SPI_IDLE SPI IDLE.
FSP_SIGNAL SPI _RXI SPI RXI.
FSP_SIGNAL _SPI TEI SPI TEI.
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FSP_SIGNAL_SPI_TXI

SPI TXI.

FSP_SIGNAL_SRC_CONVERSION_END

SRC CONVERSION END.

FSP_SIGNAL_SRC_INPUT FIFO_EMPTY

SRC INPUT FIFO EMPTY.

FSP_SIGNAL_SRC_OUTPUT_FIFO_FULL

SRC OUTPUT FIFO FULL.

FSP_SIGNAL_SRC_OUTPUT_FIFO_OVERFLOW

SRC OUTPUT FIFO OVERFLOW.

FSP_SIGNAL_SRC_OUTPUT_FIFO_UNDERFLOW

SRC OUTPUT FIFO UNDERFLOW.

FSP_SIGNAL_SSI_INT

SSIINT.
FSP_SIGNAL_SSI_RXI SSI RXI.
FSP_SIGNAL_SSI_TXI SSI TXI.
FSP_SIGNAL_SSI_TXI_RXI SSI TXI RXI.
FSP_SIGNAL_TRNG_RDREQ TRNG RDREQ.
FSP_SIGNAL_USB_FIFO_O USB FIFO 0.
FSP_SIGNAL_USB_FIFO_1 USB FIFO 1.
FSP_SIGNAL_USB_INT USB INT.
FSP_SIGNAL_USB_RESUME USB RESUME.

FSP_SIGNAL_USB_USB_INT RESUME

USB USB INT RESUME.

FSP_SIGNAL_WDT_UNDERFLOW

WDT UNDERFLOW.
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¢ bsp_warm_start_event_t

enum bsp_warm_start_event _t

Different warm start entry locations in the BSP.

Enumerator

BSP_WARM_START RESET

Called almost immediately after reset. No C
runtime environment, clocks, or IRQs.

BSP_WARM_START_POST CLOCK

Called after clock initialization. No C runtime
environment, or IRQs.

BSP_WARM_START _POST C

Called after clocks and C runtime environment
have been setup.

¢ bsp_delay_units_t

enum bsp_delay_units_t

microseconds

Available delay units for R_ BSP_SoftwareDelay(). These are ultimately used to calculate a total # of

Enumerator

BSP_DELAY_UNITS_SECONDS

Requested delay amount is in seconds.

BSP_DELAY_UNITS_MILLISECONDS

Requested delay amount is in milliseconds.

BSP_DELAY_UNITS_MICROSECONDS

Requested delay amount is in microseconds.
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¢ bsp _grp_irq_t

enum bsp_grp_irg_t

Which interrupts can have callbacks registered.

Enumerator

BSP_GRP_IRQ_IWDT_ERROR IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1 Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2 Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_VBATT VBATT monitor interrupt.

BSP_GRP_IRQ_OSC_STOP_DETECT Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN NMI Pin interrupt.

BSP_GRP_IRQ_RAM_PARITY RAM Parity Error.
BSP_GRP_IRQ_RAM_ECC RAM ECC Error.
BSP_GRP_IRQ_MPU_BUS_SLAVE MPU Bus Slave Error.
BSP_GRP_IRQ_MPU_BUS_MASTER MPU Bus Master Error.
BSP_GRP_IRQ_MPU_STACK MPU Stack Error.
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¢ bsp_reg_protect_t

enum bsp_reg_protect t

The different types of registers that can be protected.

Enumerator

BSP_REG_PROTECT CGC

Enables writing to the registers related to the
clock generation circuit.

BSP_REG_PROTECT OM_LPC_BATT

Enables writing to the registers related to
operating modes, low power consumption, and
battery backup function.

BSP_REG_PROTECT _LVD

Enables writing to the registers related to the
LVD:LVCMPCR, LVDLVLR, LVD1CRO, LVD1CR1,
LVD1SR, LVD2CRO, LVD2CR1, LVD2SR.

Function Documentation

4 R_FSP_VersionGet()

fsp_err t R_FSP_VersionGet ( fsp_pack version_t *const p version)

Parameters

Get the FSP version based on compile time macros.

[out]

p_version

Memory address to return
version information to.

Return values

FSP_SUCCESS

Version information stored.

FSP_ERR_ASSERTION

The parameter p_version is NULL.

¢ Reset_Handler()

void Reset Handler ( void )

MCU starts executing here out of reset. Main stack pointer is setup already.

¢ Default_Handler()

void Default Handler ( void )

Default exception handler.
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¢ Systeminit()

void Systemlnit ( void )

Initialize the MCU and the runtime environment.

4 R_BSP_WarmsStart()

void R_BSP_WarmStart ( bsp_warm_start_event t event)

This function is called at various points during the startup process. This function is declared as a
weak symbol higher up in this file because it is meant to be overridden by a user implemented
version. One of the main uses for this function is to call functional safety code during the startup
process. To use this function just copy this function into your own code and modify it to meet your

needs.
Parameters
[in] event Where at in the start up
process the code is currently
at

4 R_BSP _VersionGet()

fsp_err t R_BSP_VersionGet ( fsp_version_t * p version)

Get the BSP version based on compile time macros.

Parameters

[out] p_version Memory address to return
version information to.

Return values

FSP_SUCCESS Version information stored.
FSP_ERR_ASSERTION The parameter p_version is NULL.
R11UMO0146EU0100 Revision 1.00 RLENESAS Page 130/ 1,444

Mar.25.20



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package

¢ R_BSP_SoftwareDelay()

void R_BSP_SoftwareDelay ( uint32_t delay, bsp_delay_units _t units )

Delay the at least specified duration in units and return.

Parameters
[in] delay The number of 'units' to
delay.
[in] units The 'base’

(bsp_delay_units_t) for the
units specified. Valid values
are:

BSP_DELAY _UNITS_SECONDS
, BSP_DELAY_UNITS_MILLISE
CONDS, BSP_DELAY_UNITS _
MICROSECONDS.

For example:

At 1 MHz one cycle takes 1
microsecond (.000001
seconds).

At 12 MHz one cycle takes
1/12 microsecond or 83
nanoseconds.

Therefore one run through b
sp_prv_software_delay_loop(
) takes: ~ (83 *

BSP_DELAY LOOP_CYCLES)
or 332 ns. A delay of 2 us
therefore requires
2000ns/332ns or 6 loops.

The 'theoretical' maximum delay that may be obtained is determined by a full 32 bit loop count
and the system clock rate. @120MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 120000000) = 143
seconds. @32MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 32000000) = 536 seconds

Note that requests for very large delays will be affected by rounding in the calculations and the
actual delay achieved may be slightly longer. @32 MHz, for example, a request for 532 seconds will
be closer to 536 seconds.

Note also that if the calculations result in a loop_cnt of zero, the bsp_prv_software_delay _loop()
function is not called at all. In this case the requested delay is too small (nanoseconds) to be
carried out by the loop itself, and the overhead associated with executing the code to just get to
this point has certainly satisfied the requested delay.

Note
Thisfunction callsbsp_cpu_clock get() which ultimately callsR_ CGC_SystemClockFreqGet() and therefore
requires that the BSP has already initialized the CGC (which it does as part of the Sysinit). Care should be taken to
ensure this remains the case if in the future this function were to be called as part of the BSP initialization.
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4 R_BSP_GrouplrqWrite()

fsp_err_t R_BSP_GrouplrgWrite ( bsp _grp_irg_t irq, void(*)(bsp_grp_irq_t irq) p_callback )

Register a callback function for supported interrupts. If NULL is passed for the callback argument
then any previously registered callbacks are unregistered.

Parameters
[in] irq Interrupt for which to
register a callback.
[in] p_callback Pointer to function to call
when interrupt occurs.

Return values
FSP_SUCCESS Callback registered

FSP_ERR_ASSERTION Callback pointer is NULL

¢ NMI_Handler()

void NMI_Handler ( void )

Non-maskable interrupt handler. This exception is defined by the BSP, unlike other system
exceptions, because there are many sources that map to the NMI exception.

¢ R_BSP_RegisterProtectEnable()

void R_BSP_RegisterProtectEnable ( bsp reg protect t regs to protect)

Enable register protection. Registers that are protected cannot be written to. Register protection is
enabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters
[in] regs_to_protect Registers which have write
protection enabled.
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4 R_BSP_RegisterProtectDisable()

void R_BSP_RegisterProtectDisable ( bsp_reg protect t regs to unprotect)

Disable register protection. Registers that are protected cannot be written to. Register protection is
disabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters

[in] regs_to_unprotect Registers which have write
protection disabled.

Variable Documentation

¢ SystemCoreClock

uint32_t SystemCoreClock

System Clock Frequency (Core Clock)

¢ g_bsp_version

const fsp_version_t g bsp version

Default initialization function.

Version data structure used by error logger macro.

5.1.2.1 RA2A1
BSP » MCU Board Support Package

Detailed Description
Build Time Configurations for ra2al fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e I[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e IWDT is

automatically
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OFSO0 register settings
> Independent WDT >
Timeout Period

OFSO register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO register settings
> Independent WDT >
Window End Position

OFSO register settings
> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO0 register settings
> Independent WDT >
Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

OFSO0 register settings
> WDT > Timeout
Period

activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles

R11UMO0146EU0100 Revision 1.00
Mar.25.20

RLENESAS

Page 134 /1,444



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA2A1

OFSO register settings o 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO0 register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position e 25%
* 0% (no window
end position)
OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
e 100% (no
window start
position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO0 register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

¢ Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 3.84V 1.90V
> Voltage Detection 0 e 282V
Level e 251V
e 190V
e 170V
OFS1 register settings  HOCO oscillation is HOCO oscillation is HOCO must be enabled
> HOCO Oscillation enabled after reset enabled after reset out of reset because
Enable the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an Ox000FFFFC
integer between 0 and
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MPU > PCO End Value must be an Ox000FFFFF
integer between
0x00000003 and
Ox000FFFFF (ROM) or
between Ox1FF00003
and 0x200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OXxO0O0FFFFC
integer between 0 and
0x000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
MPU > PC1 End Value must be an Ox000FFFFF
integer between
0x00000003 and
Ox000FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXx000FFFFC
0 Start integer between 0 and
0x000FFFFC
MPU > Memory Region Value must be an 0x000FFFFF
0 End integer between
0x00000003 and
OxO00FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an 0x200FFFFF
1 End integer between
0x1FF00003 and
Ox200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
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2 Start

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an Ox400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
MPU > Memory Region Value must be an Ox400DFFFF
3 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003

and 0x407FFFFF
Use Low Voltage Mode e Enable Disable Use the low voltage

¢ Disable mode. This limits the

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.
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5.1.2.2 RAAM1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radm1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e |WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO register settings e 128 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings e 1
> Independent WDT > * 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75%
> Independent WDT > * 50%
Window End Position e 25%
¢ 0% (no window

end position)

OFSO register settings e 25%
> Independent WDT > * 50%
Window Start Position e 75%

e 100% (no
window start
position)

OFSO register settings ¢ NMI request or
> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled

e Resetis
enabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled
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OFSO0 register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or
Stop Control ¢ Stop counting Software Standby

when in Sleep,
Snooze mode,
or Software

Standby
OFSO0 register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO0 register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%

e 0% (no window
end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
e 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
e Voltage monitor
0 reset is
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disabled after

reset
OFS1 register settings e 3.84V 1.90V
> Voltage Detection 0 e 282V
Level e 251V
e 190V
e 170V

OFS1 register settings
> HOCO Oscillation
Enable

HOCO oscillation is
enabled after reset

HOCO oscillation is
enabled after reset

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Mar.25.20

MPU > Enable or e Enabled Disabled
disable PC Region 0 ¢ Disabled
MPU > PCO Start Value must be an OxO00FFFFFC
integer between 0 and
OxO0FFFFFC (ROM) or
between Ox1FFO0000
and 0x200FFFFC (RAM)
MPU > PCO End Value must be an OxOOFFFFFF
integer between
0x00000003 and
OxXOOFFFFFF (ROM) or
between 0x1FFO0003
and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
MPU > PC1 Start Value must be an OxO00FFFFFC
integer between 0 and
OXxOO0FFFFFC (ROM) or
between Ox1FFO0000
and 0x200FFFFC (RAM)
MPU > PC1 End Value must be an OxOOFFFFFF
integer between
0x00000003 and
OxXOOFFFFFF (ROM) or
between Ox1FFO0003
and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXOO0FFFFFC
0 Start integer between 0 and
OxO0O0FFFFFC
MPU > Memory Region Value must be an OxOOFFFFFF
0 End integer between
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0x00000003 and
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OxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an 0x200FFFFF
1 End integer between
0x1FF00003 and
Ox200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between
0x400C0003 and
O0x400DFFFF or
between 0x40100003
and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an O0x400DFFFC
3 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC
MPU > Memory Region Value must be an Ox400DFFFF
3 End integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF
Use Low Voltage Mode e Enable Disable Use the low voltage
¢ Disable mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least
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Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.

5.1.2.3 RA6M1
BSP » MCU Board Support Package

Detailed Description
Build Time Configurations for ra6m1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64
e 128
e 256
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OFSO register settings
> Independent WDT >
Window End Position

OFSO0 register settings
> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO register settings
> Independent WDT >
Stop Control

OFSO register settings
> WDT > Start Mode
Select

OFSO register settings
> WDT > Timeout
Period

OFSO0 register settings
> WDT > Clock
Frequency Division
Ratio

OFSO0 register settings

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4
64
128
512
2048
8192

75%

0% (no window end
position)

100% (no window start

position)

Reset is enabled

Stop counting when in

Sleep, Snooze mode, or

Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles

128

0% (no window end
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> WDT > Window End e 50% position)
Position e 25%
e 0% (no window
end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset ¢ Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

¢ Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 O reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection O e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after

reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OxXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OxFFFFFFFF

integer between
0x00000003 and

OxFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
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MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PC1 End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an OxO00FFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OxOOFFFFFF
0 End integer between
0x00000003 and
OxXOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between
0x400C0003 and
0Ox400DFFFF or
between 0x40100003
and Ox407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
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3 Start

MPU > Memory Region
3 End

Enumerations

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Value must be an 0x400DFFFF

integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU

5.1.2.4 RA6M2

BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6m2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

OFSO0 register settings e I[WDT is IWDT is Disabled

> Independent WDT > Disabled

Start Mode e I[WDT is
automatically
activated after
a reset
(Autostart
mode)
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OFSO register settings
> Independent WDT >
Timeout Period

OFSO0 register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO0 register settings
> Independent WDT >
Window End Position

OFSO register settings
> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO register settings
> Independent WDT >
Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

OFSO0 register settings

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after
a reset (register-

start mode)

1024 cycles

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles
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> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO0 register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%

¢ 0% (no window
end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
e 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
e Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after

reset
MPU > Enable or ¢ Enabled Disabled
disable PC Region 0 ¢ Disabled
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MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PC1 End Value must be an OxXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or ¢ Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an OxO00OFFFFFC
0 Start integer between 0 and
OXOO0FFFFFC
MPU > Memory Region Value must be an OxOOFFFFFF
0 End integer between
0x00000003 and
OxOO0FFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
R11UMO0146EU0100 Revision 1.00 RLENESAS Page 149 / 1,444



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA6M2

2 End integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and 0x407FFFFF

MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled

3

MPU > Memory Region Value must be an O0x400DFFFC
3 Start integer between

0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

MPU > Memory Region Value must be an Ox400DFFFF
3 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003

and 0x407FFFFF

Enumerations

enum elc event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note
Thislist may change based on based on the device.

5.1.2.5 RA6M3
BSP » MCU Board Support Package

Detailed Description
Build Time Configurations for rabm3_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:
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Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

OFSO register settings
> Independent WDT >
Timeout Period

OFSO register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO register settings
> Independent WDT >
Window End Position

OFSO0 register settings
> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO register settings
> Independent WDT >
Stop Control

automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1 128
16

32

64

128

256

2048 cycles

75% 0% (no window end
50% position)

25%

0% (no window

end position)

25% 100% (no window start
50% position)

75%

100% (no

window start

position)

NMI request or Reset is enabled
interrupt

request is

enabled

Reset is

enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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OFSO register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO0 register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%
¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
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> HOCO Oscillation oscillation is disabled after reset

Enable

enabled after
reset

e HOCO
oscillation is
disabled after

Mar.25.20

reset
MPU > Enable or ¢ Enabled Disabled
disable PC Region 0 * Disabled
MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PC1 End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXO0O0FFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OXOOFFFFFF
0 End integer between
0x00000003 and
OXOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
Ox200FFFFF
MPU > Enable or e Enabled Disabled
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disable Memory Region * Disabled

2

MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between

0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

0Ox400DFFFF or

between 0x40100003

and 0x407FFFFF

MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled

3

MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between

0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and 0x407FFFFF

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.

5.1.3 BSP 1I/O access
BSP
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Functions

__STATIC_INLINE uint32_ t R _BSP_PinRead (bsp_io_port _pin_t pin)

__STATIC_INLINE void R_BSP_PinWrite (bsp_io_port_pin_t pin, bsp_io_level_t level)

__STATIC_INLINE void R_BSP_PinAccessEnable (void)

__STATIC_INLINE void R _BSP_PinAccessDisable (void)

Detailed Description

This module provides basic read/write access to port pins.

Enumerations

enum bsp io level t
enum bsp_io_direction_t
enum bsp_io port t
enum bsp_io_port pin_t
Enumeration Type Documentation

¢ bsp_io_level t

enum bsp_io_level t

Levels that can be set and read for individual pins

Enumerator
BSP_IO_LEVEL LOW Low.
BSP_I0_LEVEL HIGH High.
¢ bsp_io_direction_t
enum bsp_io_direction_t
Direction of individual pins
Enumerator
BSP_IO_DIRECTION_INPUT Input.
BSP_I0_DIRECTION_OUTPUT Output.
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¢ bsp_io_port_t

enum bsp_io_port t

Superset list of all possible 10 ports.

Mar.25.20

Enumerator
BSP_I0_PORT_00 10 port 0.
BSP_10_PORT 01 10 port 1.
BSP_IO_PORT 02 10 port 2.
BSP_|O_PORT_03 10 port 3.
BSP_IO_PORT_04 10 port 4.
BSP_IO_PORT_05 10 port 5.
BSP_10_PORT_06 IO port 6.
BSP_I0_PORT_07 10 port 7.
BSP_I0_PORT_08 10 port 8.
BSP_10_PORT_09 IO port 9.
BSP_IO_PORT 10 10 port 10.
BSP_|0_PORT_11 10 port 11.
¢ bsp_io_port_pin_t
enum bsp_io_port _pin_t
Superset list of all possible 10 port pins.
Enumerator
BSP_I0_PORT_00_PIN_00 10 port 0 pin 0.
BSP_|O_PORT_00_PIN_01 |0 port 0 pin 1.
BSP_I0_PORT_00 PIN 02 10 port 0 pin 2.
BSP |0 _PORT_ 00 PIN_03 10 port 0 pin 3.
BSP_I0_PORT _00 PIN_04 10 port 0 pin 4.
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BSP_IO_PORT 00 _PIN_05

IO port 0 pin 5.
BSP_IO_PORT_00 _PIN_06 |0 port 0 pin 6.
BSP_IO_PORT_00_PIN_07 IO port 0 pin 7.
BSP_I0_PORT 00 PIN_08 10 port 0 pin 8.
BSP_I0_PORT 00 PIN_09 10 port 0 pin 9.

BSP_IO_PORT 00 _PIN_10

IO port 0 pin 10.

BSP_10_PORT 00 PIN_11

IO port 0 pin 11.

BSP_IO_PORT_00 PIN_12

IO port 0 pin 12.

BSP_|O_PORT 00 PIN 13

IO port 0 pin 13.

BSP_IO_PORT 00 PIN_14

IO port O pin 14.

BSP_I0_PORT 00 PIN_15

IO port 0 pin 15.

BSP_IO_PORT 01 _PIN_00

10 port 1 pin 0.
BSP_I0_PORT 01 PIN 01 10 port 1 pin 1.
BSP_IO_PORT_01_PIN_02 10 port 1 pin 2.
BSP_IO_PORT_01_PIN_03 10 port 1 pin 3.
BSP_I0_PORT 01 PIN_04 10 port 1 pin 4.
BSP_I0_PORT 01 PIN_05 10 port 1 pin 5.
BSP_IO_PORT_01_PIN_06 |0 port 1 pin 6.
BSP_IO_PORT_01_PIN_07 10 port 1 pin 7.
BSP_I0_PORT 01 PIN_08 10 port 1 pin 8.
BSP_10_PORT 01 PIN_09 10 port 1 pin 9.

BSP_IO_PORT 01 _PIN_10

IO port 1 pin 10.

BSP_10_PORT 01 PIN_11

IO port 1 pin 11.

BSP_IO_PORT_01_PIN_12

IO port 1 pin 12.
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BSP_IO_PORT 01 PIN 13

IO port 1 pin 13.

BSP_|O_PORT 01 PIN_14

IO port 1 pin 14.

BSP_I0_PORT 01 PIN_15

IO port 1 pin 15.

BSP_IO_PORT_02_PIN_00

10 port 2 pin 0.
BSP_I0_PORT 02 PIN 01 10 port 2 pin 1.
BSP_IO_PORT_02_PIN_02 |0 port 2 pin 2.
BSP_IO_PORT_02_PIN_03 |0 port 2 pin 3.
BSP_I0_PORT 02 PIN_04 10 port 2 pin 4.
BSP_I0_PORT 02 _PIN_05 10 port 2 pin 5.
BSP_IO_PORT_02_PIN_06 |0 port 2 pin 6.
BSP_IO_PORT_02_PIN_07 1O port 2 pin 7.
BSP_10_PORT 02 PIN_08 10 port 2 pin 8.
BSP_10_PORT 02 _PIN_09 10 port 2 pin 9.

BSP_IO_PORT 02_PIN_10

IO port 2 pin 10.

BSP_10_PORT 02 PIN_11

IO port 2 pin 11.

BSP_IO_PORT_02_PIN_12

IO port 2 pin 12.

BSP_IO_PORT_02_PIN 13

IO port 2 pin 13.

BSP_IO_PORT 02_PIN_14

IO port 2 pin 14.

BSP_I0_PORT 02_PIN_15

IO port 2 pin 15.

BSP_IO_PORT _03_PIN_00

Mar.25.20

IO port 3 pin 0.

BSP_IO_PORT 03_PIN_01 10 port 3 pin 1.

BSP_|O_PORT_03_PIN_02 |0 port 3 pin 2.

BSP_10 PORT 03 PIN 03 IO port 3 pin 3.

BSP_|O_PORT 03_PIN_04 10 port 3 pin 4.
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BSP_IO_PORT 03_PIN_05

IO port 3 pin 5.
BSP_IO_PORT_03_PIN_06 |0 port 3 pin 6.
BSP_IO_PORT_03_PIN_07 IO port 3 pin 7.
BSP_I0_PORT_03_PIN_08 10 port 3 pin 8.
BSP_10_PORT_03_PIN_09 10 port 3 pin 9.

BSP_IO_PORT 03_PIN_10

IO port 3 pin 10.

BSP_10_PORT 03_PIN_11

IO port 3 pin 11.

BSP_IO_PORT_03_PIN_12

IO port 3 pin 12.

BSP_|O_PORT 03 _PIN 13

IO port 3 pin 13.

BSP_IO_PORT 03_PIN_14

IO port 3 pin 14.

BSP_I0_PORT 03_PIN_15

IO port 3 pin 15.

BSP_IO_PORT 04 _PIN_00

10 port 4 pin 0.
BSP_I0_PORT 04 PIN 01 10 port 4 pin 1.
BSP_IO_PORT_04_PIN_02 |0 port 4 pin 2.
BSP_IO_PORT_04_PIN_03 |0 port 4 pin 3.
BSP_I0_PORT 04 PIN_04 10 port 4 pin 4.
BSP_I0_PORT 04 PIN_05 10 port 4 pin 5.
BSP_IO_PORT_04_PIN_06 |0 port 4 pin 6.
BSP_IO_PORT_04_PIN_07 1O port 4 pin 7.
BSP_I0_PORT 04 PIN_08 10 port 4 pin 8.
BSP_10_PORT 04 PIN_09 10 port 4 pin 9.

BSP_IO_PORT 04 _PIN_10

IO port 4 pin 10.

BSP_10_PORT 04 PIN_11

IO port 4 pin 11.

BSP_IO_PORT_04 PIN_12

IO port 4 pin 12.
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BSP_|O_PORT 04 PIN 13

IO port 4 pin 13.

BSP_IO_PORT 04 PIN_14

IO port 4 pin 14.

BSP_I0_PORT 04 PIN_15

IO port 4 pin 15.

BSP_IO_PORT_05_PIN_00

IO port 5 pin 0.
BSP_I0_PORT 05 PIN 01 10 port 5 pin 1.
BSP_IO_PORT_05_PIN_02 10 port 5 pin 2.
BSP_IO_PORT_05_PIN_03 |0 port 5 pin 3.
BSP_I0_PORT 05 PIN_04 10 port 5 pin 4.
BSP_IO_PORT_05_PIN_05 10 port 5 pin 5.
BSP_IO_PORT_05_PIN_06 |0 port 5 pin 6.
BSP_IO_PORT_05_PIN_07 10 port 5 pin 7.
BSP_IO_PORT_05_PIN_08 |0 port 5 pin 8.
BSP_IO_PORT_05_PIN_09 10 port 5 pin 9.

BSP_IO_PORT 05 _PIN_10

IO port 5 pin 10.

BSP_10_PORT 05 PIN_11

IO port 5 pin 11.

BSP_IO_PORT_05 PIN_12

IO port 5 pin 12.

BSP_|O_PORT 05 PIN 13

IO port 5 pin 13.

BSP_IO_PORT 05 PIN_14

IO port 5 pin 14.

BSP_I0_PORT 05 PIN_15

IO port 5 pin 15.

BSP_IO_PORT_06_PIN_00

Mar.25.20

IO port 6 pin 0.

BSP_ 10 _PORT 06 PIN 01 10 port 6 pin 1.

BSP_IO_PORT_06_PIN_02 |0 port 6 pin 2.

BSP_IO_PORT_06_PIN_03 1O port 6 pin 3.

BSP_I0_PORT 06 _PIN_04 IO port 6 pin 4.
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BSP_IO_PORT _06_PIN_05

IO port 6 pin 5.
BSP_|O_PORT_06_PIN_06 |0 port 6 pin 6.
BSP_IO_PORT_06_PIN_07 IO port 6 pin 7.
BSP_I0_PORT 06 _PIN_08 10 port 6 pin 8.
BSP_10_PORT 06 _PIN_09 10 port 6 pin 9.

BSP_IO_PORT 06_PIN_10

IO port 6 pin 10.

BSP_10_PORT 06 PIN_11

IO port 6 pin 11.

BSP_IO_PORT_06_PIN_12

IO port 6 pin 12.

BSP_|O_PORT 06 PIN 13

IO port 6 pin 13.

BSP_IO_PORT 06_PIN_14

IO port 6 pin 14.

BSP_I0_PORT 06 _PIN_15

IO port 6 pin 15.

BSP_IO_PORT_07_PIN_00

10 port 7 pin 0.
BSP_I0_PORT 07 _PIN 01 10 port 7 pin 1.
BSP_IO_PORT_07_PIN_02 |0 port 7 pin 2.
BSP_IO_PORT_07_PIN_03 |0 port 7 pin 3.
BSP_I0_PORT 07 _PIN_04 10 port 7 pin 4.
BSP_10_PORT 07 _PIN_05 10 port 7 pin 5.
BSP_IO_PORT_07_PIN_06 |0 port 7 pin 6.
BSP_IO_PORT_07_PIN_07 10 port 7 pin 7.
BSP_I0_PORT 07 _PIN_08 10 port 7 pin 8.
BSP_10_PORT_07_PIN_09 10 port 7 pin 9.

BSP_IO_PORT 07_PIN_10

IO port 7 pin 10.

BSP_10_PORT 07 PIN_11

IO port 7 pin 11.

BSP_IO_PORT_07_PIN_12

IO port 7 pin 12.
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BSP_IO_PORT_07_PIN_13

IO port 7 pin 13.

BSP_IO_PORT 07_PIN_14

IO port 7 pin 14.

BSP_I0_PORT 07 _PIN_15

IO port 7 pin 15.

BSP_IO_PORT_08_PIN_00

IO port 8 pin 0.
BSP_I0_PORT 08 PIN 01 10 port 8 pin 1.
BSP_IO_PORT_08 PIN_02 |0 port 8 pin 2.
BSP_IO_PORT_08 PIN_03 |0 port 8 pin 3.
BSP_I0_PORT 08 PIN_04 10 port 8 pin 4.
BSP_IO_PORT_08_PIN_05 |0 port 8 pin 5.
BSP_IO_PORT_08 _PIN_06 |0 port 8 pin 6.
BSP_IO_PORT_08 PIN_07 |0 port 8 pin 7.
BSP_IO_PORT_08_PIN_08 |0 port 8 pin 8.
BSP_IO_PORT_08_PIN_09 10 port 8 pin 9.

BSP_IO_PORT 08_PIN_10

IO port 8 pin 10.

BSP_10_PORT 08_PIN_11

IO port 8 pin 11.

BSP_IO_PORT_08_PIN_12

IO port 8 pin 12.

BSP_|O_PORT 08 _PIN 13

IO port 8 pin 13.

BSP_IO_PORT 08_PIN_14

IO port 8 pin 14.

BSP_I0_PORT 08 _PIN_15

IO port 8 pin 15.

BSP_IO_PORT_09_PIN_00

Mar.25.20

IO port 9 pin 0.

BSP_10_PORT 09 PIN 01 10 port 9 pin 1.

BSP_IO_PORT_09 PIN_02 10 port 9 pin 2.

BSP_IO_PORT_09 PIN_03 1O port 9 pin 3.

BSP_I0_PORT _09 PIN 04 IO port 9 pin 4.
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BSP_IO_PORT 09 PIN_05

IO port 9 pin 5.
BSP_IO_PORT_09 PIN_06 |0 port 9 pin 6.
BSP_IO_PORT_09 _PIN_07 IO port 9 pin 7.
BSP_I0_PORT 09 PIN_08 10 port 9 pin 8.
BSP_10_PORT_09 PIN_09 10 port 9 pin 9.

BSP_IO_PORT 09 PIN_10

IO port 9 pin 10.

BSP_10_PORT 09 PIN_11

IO port 9 pin 11.

BSP_IO_PORT_09 PIN_12

IO port 9 pin 12.

BSP_|O_PORT 09 PIN 13

IO port 9 pin 13.

BSP_IO_PORT 09 PIN_14

IO port 9 pin 14.

BSP_I0_PORT 09 PIN_15

IO port 9 pin 15.

BSP_IO_PORT_10_PIN_00

IO port 10 pin 0.

BSP_IO_PORT_10_PIN_01

IO port 10 pin 1.

BSP_|O_PORT _10_PIN_02

IO port 10 pin 2.

BSP_10_PORT 10 PIN_03

0 port 10 pin 3.

BSP_IO_PORT 10 _PIN_04

IO port 10 pin 4.

BSP_|O_PORT_10 PIN 05

IO port 10 pin 5.

BSP_IO_PORT_10_PIN_06

IO port 10 pin 6.

BSP_10_PORT 10 PIN_07

IO port 10 pin 7.

BSP_IO_PORT 10 PIN 08

IO port 10 pin 8.

BSP_|O_PORT_10 PIN_09

IO port 10 pin 9.

BSP_IO_PORT 10 _PIN_10

IO port 10 pin 10.

BSP_10_PORT 10 PIN_11

|0 port 10 pin 11.

BSP_IO_PORT_10 PIN_12

|0 port 10 pin 12.
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BSP_IO_PORT_10_PIN 13

IO port 10 pin 13.

BSP_|O_PORT 10 _PIN_14

IO port 10 pin 14.

BSP_10_PORT 10 PIN_15

|0 port 10 pin 15.

BSP_IO_PORT_11_PIN_00

IO port 11 pin O.

BSP_IO_PORT_11_PIN_01

IO port 11 pin 1.

BSP_|O_PORT 11_PIN_02

IO port 11 pin 2.

BSP_10_PORT 11 PIN_03

0 port 11 pin 3.

BSP_IO_PORT_11_PIN_04

0 port 11 pin 4.

BSP_IO_PORT_11_PIN_05

IO port 11 pin 5.

BSP_|O_PORT 11 _PIN_06

IO port 11 pin 6.

BSP_10_PORT 11 PIN_07

0 port 11 pin 7.

BSP_IO_PORT_11_PIN_08

IO port 11 pin 8.

BSP_IO_PORT_11_PIN_09

IO port 11 pin 9.

BSP_IO_PORT 11 PIN_10

IO port 11 pin 10.

BSP_10_PORT 11 PIN_11

0 port 11 pin 11.

BSP_IO_PORT_11_PIN_12

10 port 11 pin 12.

BSP_IO_PORT 11 PIN 13

IO port 11 pin 13.

BSP_|O_PORT 11 PIN_14

IO port 11 pin 14.

BSP_10_PORT 11 PIN_15

0 port 11 pin 15.

Function Documentation
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¢ R_BSP_PinRead()

__STATIC_INLINE uint32_t R_BSP_PinRead ( bsp_io_port_pin_t pin)

Read the current input level of the pin.

Parameters
[in] pin The pin

Return values
Current input level

4 R_BSP_PinWrite()

__STATIC_INLINE void R_BSP_PinWrite ( bsp_io_port pin_t pin, bsp_io_level t level )

Set a pin to output and set the output level to the level provided

Parameters
[in] pin The pin
[in] level The level

& R_BSP_PinAccessEnable()

__STATIC_INLINE void R_BSP_PinAccessEnable ( void )

Enable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.

4 R_BSP_PinAccessDisable()

__STATIC_INLINE void R_BSP_PinAccessDisable ( void )

Disable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.

5.2 Modules

Detailed Description

Modules are the smallest unit of software available in the FSP. Each module implements one
interface.
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Modules
High-Speed Analog Comparator (r_acmphs)

Driver for the ACMPHS peripheral on RA MCUs. This module
implements the Comparator Interface.

Low-Power Analog Comparator (r_acmplp)

Driver for the ACMPLP peripheral on RA MCUs. This module
implements the Comparator Interface.

Analog to Digital Converter (r_adc)

Driver for the ADC12, ADC14, and ADC16 peripherals on RA MCUs.
This module implements the ADC Interface.

Asynchronous General Purpose Timer (r_agt)

Driver for the AGT peripheral on RA MCUs. This module implements
the Timer Interface.

Clock Frequency Accuracy Measurement Circuit (r_cac)

Driver for the CAC peripheral on RA MCUs. This module implements
the CAC Interface.

Controller Area Network (r_can)

Driver for the CAN peripheral on RA MCUs. This module implements
the CAN Interface.

Clock Generation Circuit (r_cgc)

Driver for the CGC peripheral on RA MCUs. This module implements
the CGC Interface.

Cyclic Redundancy Check (CRC) Calculator (r_crc)

Driver for the CRC peripheral on RA MCUs. This module implements
the CRC Interface.

Capacitive Touch Sensing Unit (r_ctsu)

This HAL driver supports the Capacitive Touch Sensing Unit (CTSU). It
implements the CTSU Interface.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 166 /1,444
Mar.25.20



Flexible Software Package User’s Manual

API Reference > Modules

Digital to Analog Converter (r_dac)

Driver for the DAC12 peripheral on RA MCUs. This module
implements the DAC Interface.

Digital to Analog Converter (r_dac8)

Driver for the DACS8 peripheral on RA MCUs. This module implements
the DAC Interface.

Direct Memory Access Controller (r_dmac)

Driver for the DMAC peripheral on RA MCUs. This module implements
the Transfer Interface.

Data Operation Circuit (r_doc)

Driver for the DOC peripheral on RA MCUs. This module implements
the DOC Interface.

D/AVE 2D Port Interface (r_drw)

Driver for the DRW peripheral on RA MCUs. This module is a port of
D/AVE 2D.

Data Transfer Controller (r_dtc)

Driver for the DTC peripheral on RA MCUs. This module implements
the Transfer Interface.

Event Link Controller (r_elc)

Driver for the ELC peripheral on RA MCUs. This module implements
the ELC Interface.

Ethernet (r_ether)

Driver for the Ethernet peripheral on RA MCUs. This module
implements the Ethernet Interface.

Ethernet PHY (r_ether_phy)

The Ethernet PHY module (r_ether _phy) provides an API for standard
Ethernet PHY communications applications that use the ETHERC
peripheral. It implements the Ethernet PHY Interface.

High-Performance Flash Driver (r_flash_hp)
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Driver for the flash memory on RA high-performance MCUs. This
module implements the Flash Interface.

Low-Power Flash Driver (r_flash_Ip)

Driver for the flash memory on RA low-power MCUs. This module
implements the Flash Interface.

Graphics LCD Controller (r_glcdc)

Driver for the GLCDC peripheral on RA MCUs. This module
implements the Display Interface.

General PWM Timer (r_gpt)

Driver for the GPT32 and GPT16 peripherals on RA MCUs. This
module implements the Timer Interface.

General PWM Timer Three-Phase Motor Control Driver
(r_gpt_three phase)

Driver for 3-phase motor control using the GPT peripheral on RA
MCUs. This module implements the Three-Phase Interface.

Interrupt Controller Unit (r_icu)

Driver for the ICU peripheral on RA MCUs. This module implements
the External IRQ Interface.

I2C Master on IIC (r_iic_master)

Driver for the IIC peripheral on RA MCUs. This module implements
the 12C Master Interface.

I2C Slave on IIC (r_iic_slave)

Driver for the IIC peripheral on RA MCUs. This module implements
the 12C Slave Interface.

I/0 Ports (r_ioport)

Driver for the I/O Ports peripheral on RA MCUs. This module
implements the I/O Port Interface.

Independent Watchdog Timer (r_iwdt)
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Driver for the IWDT peripheral on RA MCUs. This module implements
the WDT Interface.

JPEG Codec (r_jpeg)

Driver for the JPEG peripheral on RA MCUs. This module implements
the JPEG Codec Interface.

Key Interrupt (r_kint)

Driver for the KINT peripheral on RA MCUs. This module implements
the Key Matrix Interface.

Low Power Modes (r_Ipm)

Driver for the LPM peripheral on RA MCUs. This module implements
the Low Power Modes Interface.

Low Voltage Detection (r_lvd)

Driver for the LVD peripheral on RA MCUs. This module implements
the Low Voltage Detection Interface.

Operational Amplifier (r_opamp)

Driver for the OPAMP peripheral on RA MCUs. This module
implements the OPAMP Interface.

Port Output Enable for GPT (r_poeg)

Driver for the POEG peripheral on RA MCUs. This module implements
the POEG Interface.

Quad Serial Peripheral Interface Flash (r_qgspi)

Driver for the QSPI peripheral on RA MCUs. This module implements
the SPI Flash Interface.

Realtime Clock (r_rtc)

Driver for the RTC peripheral on RA MCUs. This module implements
the RTC Interface.

Serial Communications Interface (SCI) 12C (r_sci_i2c)

Driver for the SCI peripheral on RA MCUs. This module implements
the 12C Master Interface.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 169/ 1,444
Mar.25.20



Flexible Software Package User’s Manual

API Reference > Modules

Serial Communications Interface (SCI) SPI (r_sci_spi)

Driver for the SCI peripheral on RA MCUs. This module implements
the SPI Interface.

Serial Communications Interface (SCI) UART (r_sci_uart)

Driver for the SCI peripheral on RA MCUs. This module implements
the UART Interface.

Sigma Delta Analog to Digital Converter (r_sdadc)

Driver for the SDADC24 peripheral on RA MCUs. This module
implements the ADC Interface.

SD/MMC Host Interface (r_sdhi)

Driver for the SD/MMC Host Interface (SDHI) peripheral on RA MCUs.
This module implements the SD/MMC Interface.

Segment LCD Controller (r_slcdc)

Driver for the SLCDC peripheral on RA MCUs. This module
implements the SLCDC Interface.

Serial Peripheral Interface (r_spi)

Driver for the SPI peripheral on RA MCUs. This module implements
the SPI Interface.

Serial Sound Interface (r_ssi)

Driver for the SSIE peripheral on RA MCUs. This module implements
the I12S Interface.

USB (r_usb_basic)

The USB module (r_usb_basic) provides an API to perform H /W
control of USB communication. It implements the USB Interface.

USB Host Communications Device Class Driver (r_usb_hcdc)

This module is USB Host Communication Device Class Driver (HCDC).
It implements the USB HCDC Interface.
This module works in combination with (r_usb_basic module).
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USB Host Mass Storage Class Driver (r_usb_hmsc)

The USB module (r_usb_hmsc) provides an API to perform hardware
control of USB communications. It implements the USB HMSC
Interface.

USB Peripheral Communication Device Class (r_usb_pcdc)

This module is USB Peripheral Communication Device Class Driver
(PCDQ). It implements the USB PCDC Interface.
This module works in combination with (r_usb_basic module).

USB Peripheral Mass Storage Class (r_usb_pmsc)

This module is USB Peripheral Mass Storage Class Driver (PMSC). It
implements the USB PMSC Interface.
This module works in combination with (r_usb_basic module).

Watchdog Timer (r_wdt)

Driver for the WDT peripheral on RA MCUs. This module implements
the WDT Interface.

SD/MMC Block Media Implementation (rm_block_media_sdmmc)

Middleware to implement the block media interface on SD cards.
This module implements the Block Media Interface.

USB HMSC Block Media Implementation (rm_block_media_usb)

Middleware to implement the block media interface on USB mass
storage devices. This module implements the Block Media Interface.

SEGGER emWin Port (rm_emwin_port)
SEGGER emWin port for RA MCUs.

FreeRTOS+FAT Port (rm_freertos plus fat)

Middleware for the Fat File System control on RA MCUs.

FreeRTOS Plus TCP (rm_freertos_plus_tcp)
Middleware for using TCP on RA MCUs.

FreeRTOS Port (rm_freertos_port)
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FreeRTOS port for RA MCUs.

LittleFS Flash Port (rm_littlefs_flash)
Middleware for the LittleFS File System control on RA MCUs.

Crypto Middleware (rm_psa_crypto)

Hardware acceleration for the mbedCrypto implementation of the
ARM PSA Crypto API.

Capacitive Touch Middleware (rm_touch)

This module supports the Capacitive Touch Sensing Unit (CTSU). It
implements the Touch Middleware Interface.

AWS Device Provisioning

AWS Device Provisioning example software.

AWS MQTT
This module provides the AWS MQTT integration documentation.

Wifi Middleware (rm_wifi_onchip_silex)

Wifi and Socket implementation using the Silex SX-ULPGN WiFi
module on RA MCUs.

AWS Secure Sockets

This module provides the AWS Secure Sockets implementation.

5.2.1 High-Speed Analog Comparator (r_acmphs)

Modules
Functions
fsp_err t R_ACMPHS Open (comparator_ctrl t *p_ctrl, comparator_cfg_t const
*const p_cfg)
fsp_err t R_ACMPHS OutputEnable (comparator ctrl_t *const p_ctrl)
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fsp_err t R_ACMPHS InfoGet (comparator_ctrl_t *const p_ctrl,
comparator_info_t *const p_info)

fsp_err t R_ACMPHS StatusGet (comparator_ctrl_t *const p_ctrl,
comparator_status_t *const p_status)

fsp_err t R_ACMPHS_Close (comparator_ctrl_t *const p_ctrl)

fsp_err t R_ACMPHS VersionGet (fsp_version_t *const p_version)

Detailed Description
Driver for the ACMPHS peripheral on RA MCUs. This module implements the Comparator Interface.
Overview

Features

The ACMPHS HAL module supports the following features:

Callback on rising edge, falling edge or both
e Configurable debounce filter

Option for comparator output on VCOUT pin
ELC event output

Configuration

Build Time Configurations for r_acmphs

The following build time configurations are defined in fsp_cfg/r_acmphs_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Analog > Comparator Driver on r_acmphs

This module can be added to the Stacks tab via New Stack > Driver > Analog > Comparator Driver
on r_acmphs:

Configuration Options Default Description
Name Name must be a valid  g_comparatorQ Module name.
C symbol
Channel Value must be a non- 0 Select the hardware
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negative integer channel.
Trigger Edge Selector ¢ Rising Both Edge The trigger specifies
¢ Falling when a comparator
e Both Edge callback event should

occur. Unused if the
interrupt priority is
disabled or the callback
is NULL.

No Filter No Filter Select the PCLK divisor
8 for the hardware digital
16 debounce filter. Larger
e 32 divisors provide a
longer debounce and
take longer for the
output to update.

Noise Filter

Maximum status retries Must be a valid non- 1024 Maximum number of
(CMPMON) negative integer status retries.
between 2 and 32-bit
maximum value

Output Polarity * Not Inverted Not Inverted When enabled
¢ Inverted comparator output is
inverted. This affects
the output read from
R_ACMPHS StatusGet()
, the pin output level,
and the edge trigger.

Pin Output(VCOUT) e Disabled Disabled Turn this on to include
¢ Enabled the output from this

comparator on VCOUT.
The comparator output
on VCOUT is OR'd with
output from all other
ACMPHS and ACMPLP
comparators.

Callback Name must be a valid  NULL Define this function in
C symbol the application. It is
called when the Trigger
event occurs.

Comparator Interrupt MCU Specific Options Select the interrupt
Priority priority for the
comparator interrupt.

Analog Input Voltage MCU Specific Options Select the Analog input

Source (IVCMP) voltage source.
Channel mentioned in
the options represents
channel in ACMPHS

Reference Voltage MCU Specific Options Select the Analog
Input Source (IVREF) reference voltage
source. Channel
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mentioned in the
options represents
channel in ACMPHS

Clock Configuration

The ACMPHS peripheral is clocked from PCLKB. You can set the PCLKB frequency using the clock
configurator in e2 studio or using the CGC Interface at run-time.

Pin Configuration

Comparator output can be enabled or disabled on each channel individually. The VCOUT pin is a
logical OR of all comparator outputs.

The IVCMPn pins are used as comparator inputs. The IVREFn pins are used as comparator reference
values.

Usage Notes

Noise Filter

When the noise filter is enabled, the ACMPHPO/ACMPHP1 signal is sampled three times based on the
sampling clock selected. The filter clock frequency is determined by PCLKB and the
comparator_filter_t setting.

Output Polarity

If output polarity is configured as "Inverted" then the VCOUT signal will be inverted and the
R_ACMPHS StatusGet() will return an inverted status.

Limitations

e Once the analog comparator is configured, the program must wait for the stabilization time
to elapse before using the comparator.

¢ When the noise filter is not enabled the hardware requires software debouncing of the
output (two consecutive equal values). This is automatically managed in
R_ACMPHS_StatusGet but may result in delay or an API error in rare edge cases.

e Constraints apply on the simultaneous use of ACMPHS analog input and ADC analog input.
Refer to the "Usage Notes" section in your MCU's User's Manual for the ADC unit(s) for more
details.

e To allow ACMPHSO to cancel Software Standby mode or enter Snooze, set the CSTEN bit to
1 and the CDFS bits to 00 in the CMPCTLO register.

Examples

Basic Example

The following is a basic example of minimal use of the ACMPHS. The comparator is configured to
trigger a callback when the input rises above the internal reference voltage (VREF). A GPIO output
acts as the comparator input and is externally connected to the IVCMP input of the ACMPHS.

/* Connect this control pin to the VCW input of the conparator. This can be any GPIO

pin
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User’s Manual

* that is not input only. */

#def i ne ACMPHS_EXAMPLE_CONTROL_PI N (BSP_I O PORT_05_PI N_03)

#def i ne ADC_PGA BYPASS_VALUE (0x9999)

volatile uint32_t g conparator_events = 0U

/* This callback is called when a conparator event occurs. */

voi d acnphs_exanpl e_cal | back (conparator_cal | back_args_t * p_args)

{

FSP_PARAMVETER_NOT

USED(p_ar gs) ;

g_conpar at or _event s++;

}

voi d acnphs_exanpl e ()

{

fsp_err_t err = FSP_SUCCESS;

/* Disable pin register wite protection, if enabled */

R BSP_Pi nAccessEnabl e() ;

/* Start with the VCVMP pin | ow This exanple assunes the conparat or

trigger

* when VCMP ri ses above VREF. */

(void) R BSP_PinWite( ACMPHS EXAMPLE CONTROL_PIN, BSP_| O LEVEL_LOW);

/* Initialize the ACMPHS nodul e */

err = R_ACMPHS

Open(&g_conparator_ctrl, &g_conparator_cfqg);

/* Handl e any errors. This function should be defined by the user

handl e _error(err);

/* Bypass PGA on ADC unit O.

* (See Table 50.2 "Input source configuration of the ACVPHS"

Manual ( RO1UHO886EJ0100)) */

R_BSP_MODULE_START(FSP_I P_ADC, 0);

R ADCO- >ADPGACR = ADC_PGA BYPASS VALUE;

R_ADCD- >ADPGADCRO = O0;

/* Wait for the mininmumstabilization wait tinme before enabling output.

conparator _info_t

i nfo;

R _ACMPHS | nf oGet (&g conparator_ctrl, & nfo);

R BSP_Sof t war eDel ay(i nfo. m n_stabilization_wait_us

/* Enabl e the conparator output */

is configured to

*/

*/

in the RAGMB User's

BSP_DELAY_UNI TS_M CROSECONDS) ;
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(voi d) R _ACMPHS Qut put Enabl e( &g_conparator _ctrl);
/* Set the VCWP pin high. */
(void) R BSP_Pi nWite(ACVMPHS EXAMPLE CONTROL_PIN, BSP_I O LEVEL H GH);

while (0 == g_conparator_events)
{

/* Wait for interrupt. */
}

conparator_status_t status;
/* Check status of conparator, Status wll be COVPARATOR STATE OQUTPUT_HI GH */
(void) R ACMPHS St atusCet (&g_conparator_ctrl, &status);

Function Documentation

¢ R_ACMPHS _Open()

fsp_err t R_ACMPHS Open ( comparator_ctrl_t *const p_ctrl, comparator_cfg_t const *const p cfg

)

Configures the comparator and starts operation. Callbacks and pin output are not active until
outputEnable() is called. comparator_api_t::outputEnable() should be called after the output has
stabilized. Implements comparator_api_t::open().

Comparator inputs must be configured in the application code prior to calling this function.

Return values

FSP_SUCCESS Open successful.
FSP_ERR_ASSERTION An input pointer is NULL
FSP_ERR_INVALID ARGUMENT An argument is invalid. Window mode

(COMPARATOR_MODE_WINDOW) and filter
of 1 (COMPARATOR FILTER 1) are not
supported in this implementation.

FSP_ERR_ALREADY_OPEN The control block is already open or the
hardware lock is taken.
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¢ R_ACMPHS_OutputEnable()

fsp_err_ t R_ ACMPHS OutputEnable ( comparator_ctrl_t *const p_ctr/)

Enables the comparator output, which can be polled using comparator_api_t::statusGet(). Also
enables pin output and interrupts as configured during comparator_api_t::open(). Implements
comparator_api_t::outputEnable().

Return values

FSP_SUCCESS Comparator output is enabled.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPHS _InfoGet()

fsp_err_t R_ACMPHS _InfoGet ( comparator_ctrl_t *const p_ctrl, comparator_info_t *const p_info )

Provides the minimum stabilization wait time in microseconds. Implements
comparator_api_t::infoGet().

Return values

FSP_SUCCESS Information stored in p_info.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPHS_StatusGet()

fsp_err t R_ ACMPHS StatusGet ( comparator_ctrl_t *const p_ctrl, comparator_status_t *const
p_status )

Provides the operating status of the comparator. Implements comparator_api_t::statusGet().

Return values

FSP_SUCCESS Operating status of the comparator is
provided in p_status.

FSP_ERR_ASSERTION An input pointer was NULL.

FSP_ERR_NOT _OPEN Instance control block is not open.

FSP_ERR_TIMEOUT The debounce filter is off and 2 consecutive
matching values were not read within 1024
attempts.
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# R_ACMPHS _Close()

fsp_err t R_ACMPHS Close ( comparator_ctrl t * p ctrl)

Stops the comparator. Implements comparator_api_t::close().

Return values

FSP_SUCCESS Instance control block closed successfully.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT _OPEN Instance control block is not open.

¢ R_ACMPHS VersionGet()

fsp_err t R_ACMPHS VersionGet ( fsp_version_t *const p_version)

Gets the API and code version. Implements comparator_api_t::versionGet().

Return values

FSP_SUCCESS Version information available in p_version.

FSP_ERR_ASSERTION The parameter p_version is NULL.

5.2.2 Low-Power Analog Comparator (r_acmplp)

Modules
Functions
fsp_err t R_ACMPLP_Open (comparator_ctrl_t *const p_ctrl, comparator _cfg t
const *const p_cfqg)
fsp_err t R_ACMPLP_OutputEnable (comparator_ctrl_t *const p_ctrl)
fsp_err t R_ACMPLP_InfoGet (comparator_ctrl_t *const p_ctrl,
comparator_info_t *const p_info)
fsp_err t R_ACMPLP_StatusGet (comparator_ctrl_t *const p_ctrl,
comparator_status_t *const p_status)
fsp_err t R_ACMPLP_Close (comparator_ctrl_t *const p_ctrl)
fsp_err t R_ACMPLP VersionGet (fsp_version_t *const p_version)
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Detailed Description

Driver for the ACMPLP peripheral on RA MCUs. This module implements the Comparator Interface.

Overview

Features
The ACMPLP HAL module supports the following features:

e Normal mode or window mode

Callback on rising edge, falling edge or both
Configurable debounce filter

Option for comparator output on VCOUT pin
ELC event output

Configuration

Build Time Configurations for r_acmplp

The following build time configurations are defined in fsp_cfg/r_acmplp_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Reference Voltage ¢ IVREFO IVREF1 Reference Voltage
Selection (ACMPLP1) e |[VREF1 Selection for ACMPLP1.

When set to IVREFO,
configure the reference
for ACMPLP channel 1
(if used) to one of the
channel 0 sources.

Configurations for Driver > Analog > Comparator Driver on r_acmplp

This module can be added to the Stacks tab via New Stack > Driver > Analog > Comparator Driver
on r_acmplp:

Configuration Options Default Description
Name Name must be a valid  g_comparatorQ Module name.
C symbol
Channel Value must be a non- 0 Select the hardware
negative integer channel.
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Mode e Standard Standard In standard mode,

e Window comparator output is
high if VCMP > VREF. In
window mode,
comparator output is
high if VCMP is outside
the range of VREFO to

VREFL1.
Trigger e Rising Both Edge The trigger specifies
¢ Falling when a comparator
¢ Both Edge callback event should

occur. Unused if the
interrupt priority is
disabled or the callback

is NULL.
Filter ¢ No sampling No sampling (bypass) Select the PCLK divisor
(bypass) for the hardware digital
¢ Sampling at debounce filter. Larger
PCLKB divisors provide a
¢ Sampling at longer debounce and
PCLKB/8 take longer for the
e Sampling at output to update.
PCLKB/32
Output Polarity * Not Inverted Not Inverted When enabled
¢ Inverted comparator output is
inverted. This affects
the output read from
R_ACMPLP_StatusGet(),
the pin output level,
and the edge trigger.
Pin Output (VCOUT) e Off Off Turn this on to include
e On the output from this
comparator on VCOUT.
The comparator output
on VCOUT is OR'd with
output from all other
ACMPHS and ACMPLP
comparators.
Vref (Standard mode e Enabled Disabled If reference voltage
only) e Disabled selection is enabled
then internal reference
voltage is used as
comparator input
Callback Name must be a valid  NULL Define this function in
C symbol the application. It is
called when the Trigger
event occurs.
Comparator Interrupt MCU Specific Options Select the interrupt
Priority priority for the
comparator interrupt.
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Analog Input Voltage MCU Specific Options Select the comparator

Source (IVCMP) input source. Only
options for the
configured channel are

valid.
Reference Voltage MCU Specific Options Select the comparator
Input Source (IVREF) reference voltage
source.

If channel 1 is
seleected and the
'Reference Voltage
Selection (ACMPLP1)'
config option is set to
IVREFO, select one of
the Channel 0 options.
In all other cases, only
options for the
configured channel are
valid.

Clock Configuration

The ACMPLP peripheral is clocked from PCLKB. You can set the PCLKB frequency using the clock
configurator in e2 studio or using the CGC Interface at run-time.

Pin Configuration

Comparator output can be enabled or disabled on each channel individually. The VCOUT pin is a
logical OR of all comparator outputs.

The CMPINN pins are used as comparator inputs. The CMPREFn pins are used as comparator
reference values.

Usage Notes

IVCMPn

IVREFNn [ 4\ =
IVREEN Reference voltage
Comparator i 0

NVCOUT A
IVCMPR :
Analog Input

VCouT

Figure 104: ACMPLP Standard Mode Operation

Noise Filter
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When the noise filter is enabled, the ACMPLPO/ACMPLP1 signal is sampled three times based on the
sampling clock selected. The filter clock frequency is determined by PCLKB and the
comparator filter t setting.

Output Polarity

If output polarity is configured as "Inverted" then the VCOUT signal will be inverted and the
R_ACMPLP_StatusGet() will return an inverted status.

Window Mode

In window mode, the comparator indicates if the analog input voltage falls within the window (low
and high reference voltage) or is outside the window.

IVCMPn

Low reference
voltage

IVREFO
IWVREF1 | = -

IVREFO

Analog Input VCOUT
IVCMPn ———»

VCOUT —
High reference .
IvReF1 —oltage )

Figure 105: ACMPLP Window Mode Operation

Limitations

e Once the analog comparator is configured, the program must wait for the stabilization time
to elapse before using the comparator.
e Low speed is not supported by the ACMPLP driver.

Examples

Basic Example

The following is a basic example of minimal use of the ACMPLP. The comparator is configured to
trigger a callback when the input rises above the internal reference voltage (VREF). A GPIO output
acts as the comparator input and is externally connected to the CMPIN input of the ACMPLP.

/* Connect this control pin to the VCWP input of the conparator. This can be any GPI O
pin

* that is not input only. */

#def i ne ACMPLP_EXAVMPLE_CONTROL_PI N (BSP_| O PORT_04_PI N_08)

volatile uint32_t g conparator_events = 0U,

/* This callback is called when a conparator event occurs. */
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voi d acnpl p_exanpl e_cal

{

| back (conparator_call back _args t * p_args)

FSP_PARAMVETER NOT_USED(p_ar gs) ;

g_conpar at or _event s++;

}
voi d acnpl p_exanple ()

{

fsp err t err = FSP_SUCCESS;

/* Disable pin register wite protection, if enabled */

R BSP_Pi nAccessEnabl e();

/* Start with the VCVMP pin | ow. This exanple assunes the conparat or

trigger

* when VCMWP ri ses above VREF. */

(void) R BSP_PinWite(ACMPLP_EXAMPLE CONTROL_PIN, BSP_| O LEVEL_LOW);

/* Initialize the ACMPLP nodul e */

err = R ACMPLP_Open(&g_conparator_ctrl, &g conparator_cfqg);

/* Handl e any errors.

handl e_error(err);

/* Wait for the mininum stabilization wait tinme before enabling output.

This function should be defined by the user

conparator_info_ t info;

R _ACMPLP_I nf oGet (&g _conparator_ctrl, & nfo);

R BSP_Sof t war eDel ay(i nfo. m n_stabilization wait _us,

/* Enabl e the conparator output */

(voi d) R _ACMPLP_OQut put Enabl e( &g_conparator _ctrl);

/[* Set VCWP |ow. */

(void) R BSP_PinWite(ACMPLP_EXAMPLE _CONTROL_PIN, BSP_| O LEVEL H GH);

while (0 == g_conparator_events)
{

/* Wait for interrupt. */
}

conparator_status_t status;

is configured to

*/

*/

BSP_DELAY_UNI TS_M CROSECONDS) ;

/* Check status of conparator, Status will be COVPARATOR STATE QUTPUT HI GH */

(void) R ACMPLP_St atusCet (&g_conparator_ctrl, &status);
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Enumerations

enum

enum

acmplp_input_t

acmplp_reference_t

Enumeration Type Documentation

¢ acmplp_input_t

enum acmplp_input t

Enumerator

ACMPLP_INPUT_AMPO

Only available on ra2al.

ACMPLP_INPUT_CMPIN_1

Only available on radml.

¢ acmplp_reference_t

enum acmplp_reference_t

Enumerator

ACMPLP_REFERENCE_CMPREF_1

Only available on radml.

ACMPLP_REFERENCE_IVREFO

Only available for Channel 1.

Function Documentation
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¢ R_ACMPLP_Open()

fsp_err_ t R_ACMPLP_Open ( comparator _ctrl_t *const p_ctrl, comparator_cfg_t const *const p cfg )

Configures the comparator and starts operation. Callbacks and pin output are not active until
outputEnable() is called. comparator_api_t::outputEnable() should be called after the output has
stabilized. Implements comparator_api_t::open().

Comparator inputs must be configured in the application code prior to calling this function.

Return values

FSP_SUCCESS Open successful.
FSP_ERR_ASSERTION An input pointer is NULL
FSP_ERR_INVALID ARGUMENT An argument is invalid. Window mode

(COMPARATOR_MODE_WINDOW) and filter
of 1 (COMPARATOR _FILTER 1) are not
supported in this implementation.
p_cfg->p_callback is not NULL, but ISR is not
enabled. ISR must be enabled to use
callback function.

FSP_ERR_ALREADY_OPEN The control block is already open or the
hardware lock is taken.

¢ R_ACMPLP_OutputEnable()

fsp_err t R_ ACMPLP_OutputEnable ( comparator_ctrl_t *const p_ctrl)

Enables the comparator output, which can be polled using comparator_api_t::statusGet(). Also
enables pin output and interrupts as configured during comparator_api_t::open(). Implements
comparator_api_t::outputEnable().

Return values

FSP_SUCCESS Comparator output is enabled.

FSP_ERR_ASSERTION An input pointer was NULL.

FSP_ERR_NOT_OPEN Instance control block is not open.
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¢ R_ACMPLP_InfoGet()

fsp_err_ t R_ACMPLP_InfoGet ( comparator _ctrl_t *const p_ctrl, comparator_info_t *const p_info )

Provides the minimum stabilization wait time in microseconds. Implements
comparator_api_t::infoGet().

Return values

FSP_SUCCESS Information stored in p_info.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT _OPEN Instance control block is not open.

¢ R_ACMPLP_StatusGet()

fsp_err_t R_ACMPLP_StatusGet ( comparator_ctrl_t *const p_ctrl, comparator_status_t *const
p_status )

Provides the operating status of the comparator. Implements comparator_api_t::statusGet().

Return values

FSP_SUCCESS Operating status of the comparator is
provided in p_status.

FSP_ERR_ASSERTION An input pointer was NULL.

FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPLP_Close()

fsp_err t R_ ACMPLP_Close ( comparator_ctrl t* p ctrl)

Stops the comparator. Implements comparator_api_t::close().

Return values

FSP_SUCCESS Instance control block closed successfully.

FSP_ERR_ASSERTION An input pointer was NULL.

FSP_ERR_NOT _OPEN Instance control block is not open.
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¢ R_ACMPLP_VersionGet()

fsp_err_t R_ACMPLP_VersionGet ( fsp_version_t *const p_version)

Gets the APl and code version. Implements comparator_api_t::versionGet().

Return values

FSP_SUCCESS Version information available in p_version.

FSP_ERR_ASSERTION The parameter p_version is NULL.

5.2.3 Analog to Digital Converter (r_adc)

Modules
Functions
fsp_err t R_ADC_Open (adc_ctrl_t *p_ctrl, adc_cfg_t const *const p_cfqg)
fsp_err t R_ADC ScanCfg (adc_ctrl _t *p_ctrl, void const *const p_extend)
fsp_err t R_ADC InfoGet (adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
fsp_err t R_ADC_ScanStart (adc_ctrl _t *p_ctrl)
fsp_err t R_ADC_ScanStop (adc_ctrl_t *p_ctrl)
fsp_err t R_ADC StatusGet (adc_ctrl t *p_ctrl, adc_status t *p_status)
fsp_err t R_ADC Read (adc_ctrl_t *p ctrl, adc_channel_t const reg_id, uintl6 t
*const p_data)
fsp_err t R_ADC_Read32 (adc_ctrl_t *p_ctrl, adc_channel_t const reg _id,
uint32_t *const p_data)
fsp_err t R_ADC_SampleStateCountSet (adc_ctrl_t *p_ctrl, adc_sample_state t
*p_sample)
fsp_err t R_ADC Close (adc_ctrl_t *p_ctrl)
fsp_err t R _ADC OffsetSet (adc_ctrl t *const p_ctrl, adc_channel _t const
reg_id, int32_t offset)
fsp_err t R_ADC Calibrate (adc_ctrl_t *const p_ctrl, void *const p_extend)
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fsp_err t R_ADC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the ADC12, ADC14, and ADC16 peripherals on RA MCUs. This module implements the ADC
Interface.

Overview

Features
The ADC module supports the following features:

e 12, 14, or 16 bit maximum resolution depending on the MCU
e Configure scans to include:
o Multiple analog channels
o Temperature sensor channel
o Voltage sensor channel
e Configurable scan start trigger:
o Software scan triggers
o Hardware scan triggers (timer expiration, for example)
o External scan triggers from the ADTRGn port pins
e Configurable scan mode:
o Single scan mode, where each trigger starts a single scan
o Continuous scan mode, where all channels are scanned continuously
o Group scan mode, where channels are grouped into group A and group B. The
groups can be assigned different start triggers, and group A can be given priority
over group B. When group A has priority over group B, a group A trigger suspends
an ongoing group B scan.
Supports adding and averaging converted samples
Optional callback when scan completes
Supports reading converted data
Sample and hold support
Double-trigger support

Configuration

Build Time Configurations for r_adc

The following build time configurations are defined in fsp_cfg/r_adc_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Analog > ADC Driver on r_adc

This module can be added to the Stacks tab via New Stack > Driver > Analog > ADC Driver on r_adc:
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Configuration Options Default Description

General > Name Name must be a valid g _adcO Module name

C symbol

General > Unit Unit must be a non- 0 Specifies the ADC Unit

negative integer to be used.

General > Resolution MCU Specific Options Specifies the
conversion resolution
for this unit.

General > Alignment e Right Right Specifies the

o Left conversion result
alignment.

General > Clear after o Off On Specifies if the result

read e On register will be

automatically cleared
after the conversion
result is read.

General > Mode ¢ Single Scan Single Scan Specifies the mode that
e Continuous this ADC unit is used in.
Scan

e Group Scan

General > Double- e Disabled Disabled When enabled, the
trigger ¢ Enabled scan-end interrupt for
e Enabled Group A is only thrown
(extended on every second scan.
mode) Extended double-

trigger mode (single-
scan only) triggers on
both ELC events,
allowing (for example)
a scan on two different
timer compare match
values.

In group mode Group B
is unaffected.

Input > Sample and e Channel 0 Specifies if this channel
Hold > Sample and e Channel 1 is included in the
Hold Channels e Channel 2 Sample and Hold Mask.

(Available only on
selected MCUs)

Input > Sample and Must be a valid non- 24 Specifies the updated
Hold > Sample Hold negative integer with sample-and-hold count
States (Applies only to  configurable value 4 to for the channel
channels 0, 1, 2) 255 dedicated sample-and-
hold circuit
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Input > Channel Scan
Mask (channel
availability varies by
MCU)

Input > Group B Scan
Mask (channel
availability varies by
MCU)

Input > Add/Average
Count

Input > Reference
Voltage control

Input >
Addition/Averaging
Mask (channel
availability varies by
MCU and unit)

Interrupts >
Normal/Group A
Trigger

Interrupts > Group B
Trigger

Interrupts > Group
Priority (Valid only in
Group Scan Mode)

Refer to the RA
Configuration tool for
available options.

Refer to the RA
Configuration tool for
available options.

e Disabled Disabled

e Add two
samples

¢ Add three
samples

e Add four
samples

¢ Add sixteen
samples

e Average two
samples

e Average four
samples

MCU Specific Options

Refer to the RA
Configuration tool for
available options.

MCU Specific Options

MCU Specific Options

e Group A cannot Group A cannot
interrupt Group interrupt Group B

B

e Group A can
interrupt Group
B; Group B scan
restarts at next

In Normal mode of
operation, this bitmask
field specifies the
channels that are
enabled in that ADC
unit. In group mode,
this field specifies
which channels belong
to group A.

In group mode, this
field specifies which
channels belong to

group B.

Specifies if addition or
averaging needs to be
done for any of the
channels in this unit.

Specify
VREFH/VREFADC
output voltage control.

Select channels to
include in the
Addition/Averaging
Mask

Specifies the trigger
type to be used for this
unit.

Specifies the trigger for
Group B scanning in
group scanning mode.
This event is also used
to trigger Group A in
extended double-
trigger mode.

Determines whether an
ongoing group B scan
can be interrupted by a
group A trigger,
whether it should abort
on a group A trigger, or
if it should pause to
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trigger allow group A scan and
e Group A can restart immediately

interrupt Group after group A scan is

B; Group B scan complete.

restarts

immediately

e Group A can
interrupt Group
B; Group B scan
restarts
immediately
and scans
continuously

Interrupts > Callback Name must be a valid  NULL A user callback
C symbol function. If this callback
function is provided, it
is called from the
interrupt service
routine (ISR) each time
the ADC scan

completes.
Interrupts > Scan End  MCU Specific Options Select scan end
Interrupt Priority interrupt priority.
Interrupts > Scan End  MCU Specific Options Select group B scan
Group B Interrupt end interrupt priority.

Priority
Clock Configuration
The ADC clock is PCLKC if the MCU has PCLKC, or PCLKD otherwise.
The ADC clock must be at least 1 MHz when the ADC is used. Many MCUs also have PCLK ratio
restrictions when the ADC is used. For details on PCLK ratio restrictions, reference the footnotes in
the second table of the Clock Generation Circuit chapter of the MCU User's Manual (for example,
Table 9.2 "Specifications of the clock generation circuit for the internal clocks" in the RA6M3 manual
RO1UHO0886EJ0100).

Pin Configuration

The ANxxx pins are analog input channels that can be used with the ADC.

ADTRGO and ADTRG1 can be used to start scans with an external trigger for unit 0 and 1
respectively. When external triggers are used, ADC scans begin on the falling edge of the ADTRG

pin.

Usage Notes

Sample Hold

Enabling the sample and hold functionality reduces the maximum scan frequency because the
sample and hold time is added to each scan. Refer to the hardware manual for details on the sample
and hold time.
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ADC Operational Modes

The driver supports three operation modes: single-scan, continuous-scan, and group-scan modes. In
each mode, analog channels are converted in ascending order of channel number, followed by scans
of the temperature sensor and voltage sensor if they are included in the mask of channels to scan.

Single-scan Mode
In single scan mode, one or more specified channels are scanned once per trigger.
Continuous-scan Mode

In continuous scan mode, a single trigger is required to start the scan. Scans continue until
R_ADC_ScanStop() is called.

Group-scan Mode

Group-scan mode allows the application to allocate channels to one of two groups (A and B).
Conversion begins when the specified ELC start trigger for that group is received.

With the priority configuration parameter, you can optionally give group A priority over group B. If
group A has priority over group B, a group B scan is interrupted when a group A scan trigger occurs.
The following options exist for group B when group A has priority:

* To restart the interrupted group B scan after the group A scan completes.
e To wait for another group B trigger and forget the interrupted scan.
e To continuously scan group B and suspend scanning group B only when a group A trigger is
received.
Note
If this option is selected, group B scanning beginsimmediately after R ADC_ScanCfg(). Group A scan
triggers must be enabled by R ADC_ScanStart() and can be disabled by R_ADC_ScanStop(). Group B
scans can only be disabled by reconfiguring the group A priority to a different mode.

Double-triggering

When double-triggering is enabled a single channel is selected to be scanned twice before an
interrupt is thrown. The first scan result when using double-triggering is always saved to the selected
channel's data register. The second result is saved to the data duplexing register

(ADC_CHANNEL DUPLEX).

Double-triggering uses Group A; only one channel can be selected when enabled. No other scanning
is possible on Group A while double-trigger mode is selected. In addition, any special ADC channels
(such as temperature sensors or voltage references) are not valid double-trigger channels.

When extended double-triggering is enabled both ADC input events are routed to Group A. The
interrupt is still thrown after every two scans regardless of the triggering event(s). While the first and
second scan are saved to the selected ADC data register and the ADC duplexing register as before,
scans associated with event A and B are additionally copied into duplexing register A and B,
respectively (ADC_CHANNEL DUPLEX_A and ADC_CHANNEL DUPLEX_B).

When Interrupts Are Not Enabled

If interrupts are not enabled, the R_ADC_StatusGet API can be used to poll the ADC to determine
when the scan has completed. The read API function is used to access the converted ADC result. This
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applies to both normal scans and calibration scans for MCUs that support calibration.
Sample-State Count Setting

The application program can modify the setting of the sample-state count for analog channels by
calling the R_ADC_SampleStateCountSet() API function. The application program only needs to
modify the sample-state count settings from their default values to increase the sampling time. This
can be either because the impedance of the input signal is too high to secure sufficient sampling
time under the default setting or if the ADCLK is too slow. To modify the sample-state count for a
given channel, set the channel number and the number of states when calling the
R_ADC_SampleStateCountSet() API function. Valid sample state counts are 7-255.

Note
Although the hardware supports a minimum number of sample states of 5, some MCUs require 7 states, so the
minimum is set to 7. At the lowest supported ADC conversion clock rate (1 MHz), these extra states will lead to, at
worst case, a 2 microsecond increase in conversion time. At 60 MHz the extra states will add 33.4 nsto the
conversion time.

If the sample state count needs to be changed for multiple channels, the application program must
call the R_ADC_SampleStateCountSet() API function repeatedly, with appropriately modified
arguments for each channel.

If the ADCLK frequency changes, the sample states may need to be updated.
Sample States for Temperature Sensor and Internal Voltage Reference

Sample states for the temperature sensor and the internal reference voltage are calculated during
R_ADC_ScanCfg() based on the ADCLK frequency at the time. The sample states for the temperature
sensor and internal voltage reference cannot be updated with R_ADC_SampleStateCountSet(). If the
ADCLK frequency changes, call R_ADC _ScanCfg() before using the temperature sensor or internal
reference voltage again to ensure the sampling time for the temperature sensor and internal voltage
reference is optimal.

Selecting Reference Voltage

The ADC16 can select VREFHO or VREFADC as the high-potential reference voltage on selected
MCU's. When using VREFADC stabilization time of 1500us is required after call for R_ADC_Open().

Using the Temperature Sensor with the ADC

The ADC HAL module supports reading the data from the on-chip temperature sensor. The value
returned from the sensor can be converted into degrees Celsius or Fahrenheit in the application
program using the following formula, T = (Vs - V1)/slope + T1, where:

e T: Measured temperature (degrees C)
* Vs: Voltage output by the temperature sensor at the time of temperature measurement
(Volts)

e T1: Temperature experimentally measured at one point (degrees C)
* V1: Voltage output by the temperature sensor at the time of measurement of T1 (Volts)
e T2: Temperature at the experimental measurement of another point (degrees C)
e V2: Voltage output by the temperature sensor at the time of measurement of T2 (Volts)
e Slope: Temperature gradient of the temperature sensor (V/degrees C); slope = (V2 - V1)/
(T2 -T1)
Note
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The slope value can be obtained from the hardware manual for each device in the Electrical Characteristics
Chapter - TSN Characteristics Table, Temperature slope entry.

Usage Notes for ADC16

Calibration

Calibration is required to use the ADC16 peripheral. When using this driver on an MCU that has
ADC16, call R_ADC_Calibrate() after open, and prior to any other function.

Range of ADC16 Results

The range of the ADC16 is from 0 (lowest) to Ox7FFF (highest) when used in single-ended mode. This
driver only supports single ended mode.

Examples

Basic Example

This is a basic example of minimal use of the ADC in an application.

/* A channel configuration is generated by the configurator based on the options
sel ected. |f additional

* configurations are desired additional adc_channel _cfg t elenents can be defined
and passed to R ADC ScanCfg. */

const adc_channel _cfg t g _adcO_channel cfg =

{
. scan_mask = ADC_MASK_CHANNEL O | ADC_MASK CHANNEL_1,
. scan_mask_group_b = 0,
.priority group_a = (adc_group_a_t) O,
. add_mask = 0,
. sanpl e_hol d_nask = 0,
.sanple_hol d_states = 0O,
ti
voi d adc_basi c_exanpl e (voi d)
{

fsp_err_t err = FSP_SUCCESS,;

/* Initializes the nodule. */
err = R ADC Open(&g_adcO _ctrl, &g _adcO_cfQ);

/* Handl e any errors. This function should be defined by the user. */
handl e _error(err);

/* Enabl e channels. */
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Temperature Sensor Example

This example shows how to calculate the MCU temperature using the ADC and the temperature
sensor.
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/* Initializes the nodule. */
err = R ADC Open(&g_adcO ctrl, &g adcO_cfqQ);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/* Enabl e tenperature sensor. */
err = R ADC ScanCf g(&g_adcO _ctrl, &g _adcO_channel cfg);
handl e_error(err);
/* In software trigger node, start a scan by calling R ADC ScanStart(). |n other
nodes, enabl e external
* triggers by calling R ADC ScanStart(). */
(void) R ADC ScanStart (&g _adcO ctrl);
/* Wait for conversion to conplete. */
adc_status_t status;
status. state = ADC_STATE SCAN | N_PROGRESS;
whi | e (ADC_STATE_SCAN | N PROGRESS == status.state)
{
(void) R ADC StatusCet(&y_adcO ctrl, &status);
}
/* Read converted data. */
uintl6 t tenperature_conversion result;
err = R ADC Read(&g_adcO_ctrl, ADC CHANNEL TEMPERATURE,
&t enperat ure_conversion_result);
handl e _error(err);
#i f BSP_FEATURE_ADC TSN CAL| BRATI ON_AVAI LABLE
/* Cet Calibration data fromthe MCU. */
int32_t ref erence_cal i bration_dat a;
adc_info_t adc_info;
(void) R ADC InfoCet(&g_adcO _ctrl, &adc_info);
reference calibration data = (int32 t) adc_info.calibration_data;
#el se
/* If the MCU does not provide calibration data, use the value in the hardware
manual or determine it
* experinmentally. */

int32_t reference_calibration _data = ADC EXAVMPLE CALI BRATI ON_DATA RA6ML;
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#endi f

/* NOTE: The sl ope of the tenperature sensor varies fromsensor to sensor. Renesas
recommends cal cul ati ng

* the slope of the tenperature sensor experinmentally.

=

* Thi s exanpl e uses the typical slope provided in Table 52.38 "TSN characteristics"”
in the RAGML nanual

* RO1UMDO11EUO0050. */

int32_t slope_uv_per_c = BSP_FEATURE _ADC TSN _SLOPE;

/* Formula for calculating tenperature copied fromsection 44.3.1 "Preparation for
Usi ng the Tenperature Sensor"

* of the RA6ML manual RO1UHO884EJ0100:

*

* In this MCU, the TSCDR regi ster stores the tenperature value (CAL127) of the
t enperature sensor neasured

* under the condition Ta = Tj = 127 C and AVCQ0 = 3.3 V. By using this value as the
sanpl e nmeasur enent result

* at the first point, preparation before using the tenperature sensor can be
om tted.

I

* If VI is calculated from CAL127,

* V1 = 3.3 * CAL127 / 4096 [V]

=

* Using this, the nmeasured tenperature can be cal cul ated according to the foll ow ng
for mul a.

*

* T = (Vs - V1) / Slope + 127 [(C]

* T. Measured tenperature (O

* Vs: Voltage output by the tenperature sensor when the tenperature is neasured (V)

* V1. Vol tage output by the tenperature sensor when Ta = Tj = 127 C and AVCCO = 3.3
vV (V)

* Sl ope: Tenperature slope given in Table 52.38 / 1000 (V/ O

*/
int32_t vl _uv = (ADC_EXAMPLE_VCC M CROVOLT >> ADC_EXAMPLE_TEMPERATURE_RESOLUTI ON)
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Double-Trigger Example

This example demonstrates reading data from a double-trigger scan. A flag is used to wait for a
callback event. Two scans must occur before the callback is called. These results are read via
R_ADC_Read using the selected channel enum value as well as ADC_CHANNEL _DUPLEX.
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Data Structures

struct adc_sample_state t

struct adc_extended cfg t

struct adc_channel_cfg_t

struct adc_instance_ctrl_t
Enumerations

enum adc_mask t

enum adc_add_t

enum adc_clear_t

enum adc_vref_control_t

enum adc_sample_state reg t
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enum adc_group a t

enum adc_double_trigger t

Data Structure Documentation

¢ adc_sample_state_t

struct adc_sample_state t

ADC sample state configuration

Data Fields
adc_sample_state reg t reg_id Sample state register ID.
uint8 t num_states Number of sampling states for
conversion. Ch16-20/21 use the
same value.
¢ adc_extended_cfg_t
struct adc_extended_cfg_t
Extended configuration structure for ADC.
Data Fields
adc_add t add_average count Add or average samples.
adc_clear_t clearing Clear after read.

adc_trigger_t

trigger_group_b

Group B trigger source; valid
only for group mode.

adc_double_trigger t

double_trigger_ mode

Double-trigger mode setting.

adc_vref _control_t

adc_vref_control

VREFADC output voltage
control.

¢ adc_channel_cfg_t

struct adc_channel_cfg_t

ADC channel(s) configuration

Data Fields
uint32_t scan_mask Channels/bits: bit 0 is chO; bit
15 is chl5.
uint32 t scan_mask group b Valid for group modes.
uint32_t add_mask Valid if add enabled in Open().

adc_group_a t

priority_group_a

Valid for group modes.

uint8 t

sample_hold_mask

Channels/bits 0-2.

uint8_t

sample_hold_states

Number of states to be used for
sample and hold. Affects
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channels 0-2.

& adc_instance_ctrl_t

struct adc_instance_ctrl_t

ADC instance control block. DO NOT INITIALIZE. Initialized in adc_api_t::open().

Enumeration Type Documentation

¢ adc_mask_t

enum adc_mask t

For ADC Scan configuration adc_channel cfg t::scan_mask, adc_channel _cfg t::scan_mask group b
, adc_channel _cfg t::add _mask and adc_channel cfg t::sample_hold _mask. Use bitwise OR to
combine these masks for desired channels and sensors.

Enumerator

ADC_MASK_OFF No channels selected.

ADC_MASK_CHANNEL_O Channel 0 mask.

ADC_MASK_CHANNEL_1 Channel 1 mask.

ADC_MASK_CHANNEL_2 Channel 2 mask.

ADC_MASK_CHANNEL_3 Channel 3 mask.

ADC_MASK_CHANNEL_4 Channel 4 mask.

ADC_MASK_CHANNEL_5 Channel 5 mask.

ADC_MASK_CHANNEL_6 Channel 6 mask.

ADC_MASK_CHANNEL_7 Channel 7 mask.

ADC_MASK_CHANNEL_8 Channel 8 mask.

ADC_MASK_CHANNEL_9 Channel 9 mask.

ADC_MASK_CHANNEL_10 Channel 10 mask.

ADC_MASK_CHANNEL_ 11 Channel 11 mask.

ADC_MASK_CHANNEL_12 Channel 12 mask.

ADC_MASK_CHANNEL_13 Channel 13 mask.

ADC_MASK_CHANNEL 14
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Channel 14 mask.

ADC_MASK_CHANNEL_15

Channel 15 mask.

ADC_MASK_CHANNEL _16

Channel 16 mask.

ADC_MASK_CHANNEL _17

Channel 17 mask.

ADC_MASK_CHANNEL 18

Channel 18 mask.

ADC_MASK_CHANNEL 19

Channel 19 mask.

ADC_MASK_CHANNEL _20

Channel 20 mask.

ADC_MASK_CHANNEL_21

Channel 21 mask.

ADC_MASK_CHANNEL_22

Channel 22 mask.

ADC_MASK_CHANNEL 23

Channel 23 mask.

ADC_MASK_CHANNEL_24

Channel 24 mask.

ADC_MASK_CHANNEL_25

Channel 25 mask.

ADC_MASK_CHANNEL 26

Channel 26 mask.

ADC_MASK_CHANNEL 27

Channel 27 mask.

ADC_MASK_TEMPERATURE

Temperature sensor channel mask.

ADC_MASK_VOLT

Voltage reference channel mask.

ADC_MASK_SENSORS

All sensor channel mask.
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¢ adc_add_t

enum adc_add_t

ADC data sample addition and averaging options

Enumerator

ADC_ADD_OFF Addition turned off for channels/sensors.

ADC_ADD_TWO Add two samples.

ADC_ADD_THREE Add three samples.

ADC_ADD_FOUR Add four samples.

ADC_ADD_SIXTEEN Add sixteen samples.

ADC_ADD_AVERAGE_TWO Average two samples.

ADC_ADD_AVERAGE_FOUR Average four samples.

ADC_ADD_AVERAGE_EIGHT Average eight samples.

¢ adc_clear_t

enum adc_clear_t

ADC clear after read definitions

Enumerator

ADC_CLEAR_AFTER_READ_OFF Clear after read off.

ADC_CLEAR_AFTER_READ_ON Clear after read on.
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¢ adc_vref _control _t

enum adc_vref_control_t

ADC VREFAMPCNT config options Reference Table 32.12 "VREFADC output voltage control list" in
the RA2A1 manual RO1UH0888EJ0100.

Enumerator
ADC_VREF_CONTROL_VREFH VREFAMPCNT reset value. VREFADC Output
voltage is Hi-Z.
ADC_VREF_CONTROL_1_5V_OUTPUT BGR turn ON. VREFADC Output voltage is 1.5
V.
ADC_VREF_CONTROL_2_0V_OUTPUT BGR turn ON. VREFADC Output voltage is 2.0
V.
ADC_VREF_CONTROL_2_5V_OUTPUT BGR turn ON. VREFADC Output voltage is 2.5
V.
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¢ adc_sample_state_reg_t

enum adc_sample state reg t

ADC sample state registers

Enumerator

ADC_SAMPLE_STATE_CHANNEL_0

Sample state

register channel 0.

ADC_SAMPLE_STATE_CHANNEL 1

Sample state

register channel 1.

ADC_SAMPLE_STATE_CHANNEL 2

Sample state

register channel 2.

ADC_SAMPLE_STATE_CHANNEL 3

Sample state

register channel 3.

ADC_SAMPLE_STATE_CHANNEL 4

Sample state

register channel 4.

ADC_SAMPLE_STATE_CHANNEL 5

Sample state

register channel 5.

ADC_SAMPLE_STATE_CHANNEL 6

Sample state

register channel 6.

ADC_SAMPLE_STATE_CHANNEL_7

Sample state

register channel 7.

ADC_SAMPLE_STATE_CHANNEL 8

Sample state

register channel 8.

ADC_SAMPLE_STATE_CHANNEL 9

Sample state

register channel 9.

ADC_SAMPLE_STATE_CHANNEL_10

Sample state

register channel 10.

ADC_SAMPLE_STATE_CHANNEL_11

Sample state

register channel 11.

ADC_SAMPLE_STATE_CHANNEL 12

Sample state

register channel 12.

ADC_SAMPLE_STATE_CHANNEL 13

Sample state

register channel 13.

ADC_SAMPLE_STATE_CHANNEL 14

Sample state

register channel 14.

ADC_SAMPLE_STATE_CHANNEL_15

Sample state

register channel 15.

ADC_SAMPLE_STATE_CHANNEL 16 TO 31

Sample state

register channel 16 to 31.
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¢ adc_group_a_t

enum adc_group_a_t

ADC action for group A interrupts group B scan. This enumeration is used to specify the priority
between Group A and B in group mode.

Enumerator

ADC_GROUP_A_PRIORITY_OFF Group A ignored and does not interrupt

onhgoing group B scan.

ADC_GROUP_A_GROUP_B_WAIT_FOR_TRIGGER Group A interrupts Group B(single scan) which

restarts at next Group B trigger.

ADC_GROUP_A_GROUP_B_RESTART_SCAN Group A interrupts Group B(single scan) which

restarts immediately after Group A scan is
complete.

ADC_GROUP_A_GROUP_B_CONTINUOUS_SCAN Group A interrupts Group B(continuous scan)

which continues scanning without a new Group

B trigger.
¢ adc_double_trigger_t
enum adc_double_trigger t
ADC double-trigger mode definitions
Enumerator

ADC_DOUBLE_TRIGGER_DISABLED Double-triggering disabled.

ADC_DOUBLE_TRIGGER_ENABLED Double-triggering enabled.

ADC_DOUBLE_TRIGGER_ENABLED_EXTENDED Double-triggering enabled on both ADC ELC
events.

Function Documentation
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4 R_ADC _Open()

fsp_err t R_ADC Open ( adc_ctrl t* p ctrl, adc_cfg_t const *const p cfg )

Sets the operational mode, trigger sources, interrupt priority, and configurations for the peripheral
as a whole. If interrupt is enabled, the function registers a callback function pointer for notifying the
user whenever a scan has completed.

Return values

FSP_SUCCESS Module is ready for use.

FSP_ERR_ASSERTION An input argument is invalid.

FSP_ERR_ALREADY_OPEN The instance control structure has already
been opened.

FSP_ERR_IRQ BSP_DISABLED A callback is provided, but the interrupt is
not enabled.

FSP_ERR_IP_CHANNEL_NOT_PRESENT The requested unit does not exist on this
MCU.

FSP_ERR_INVALID_HW_CONDITION The ADC clock must be at least 1 MHz

¢ R_ADC_ScanCfg()

fsp_err t R_ADC ScanCfg ( adc_ctrl t* p ctrl, void const *const p_extend )

Configures the ADC scan parameters. Channel specific settings are set in this function. Pass a
pointer to adc_channel_cfg_t to p_extend.

Note
This starts group B scansif adc_channel _cfg_t::priority group aissetto
ADC _GROUP_A GROUP_B_CONTINUOUS SCAN.

Return values

FSP_SUCCESS Channel specific settings applied.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.
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¢ R_ADC_InfoGet()

fsp_err_ t R_ADC InfoGet ( adc_ctrl t* p ctrl, adc_info t * p_adc_info )

Returns the address of the lowest number configured channel and the total number of bytes to be
read in order to read the results of the configured channels and return the ELC Event name. If no
channels are configured, then a length of 0 is returned.

Also provides the temperature sensor slope and the calibration data for the sensor if available on
this MCU. Otherwise, invalid calibration data of OXFFFFFFFF will be returned.

Note
In group mode, information is returned for group A only. Calculating information for group B is not currently
supported.
Return values
FSP_SUCCESS Information stored in p_adc_info.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.

4 R_ADC_ScanStart()

fsp_err t R_ADC ScanStart ( adc_ctrl_t* p_ctrl)

Starts a software scan or enables the hardware trigger for a scan depending on how the triggers
were configured in the R_ADC_Open call. If the unit was configured for ELC or external hardware
triggering, then this function allows the trigger signal to get to the ADC unit. The function is not
able to control the generation of the trigger itself. If the unit was configured for software triggering,
then this function starts the software triggered scan.

Precondition
Call R_ADC_ScanCfg after R_ADC_Open before starting a scan.
On MCUs that support calibration, call R_ADC_Calibrate and wait for calibration to complete
before starting a scan.

Return values

FSP_SUCCESS Scan started (software trigger) or hardware
triggers enabled.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT_OPEN Unit is not open.
FSP_ERR_IN_USE Another scan is still in progress (software
trigger).
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4 R_ADC_ScanStop()

fsp_err t R_ADC _ScanStop ( adc_ctrl_ t * p ctrl)

Stops the software scan or disables the unit from being triggered by the hardware trigger (ELC or
external) based on what type of trigger the unit was configured for in the R_ADC_Open function.
Stopping a hardware triggered scan via this function does not abort an ongoing scan, but prevents
the next scan from occurring. Stopping a software triggered scan aborts an ongoing scan.

Return values

FSP_SUCCESS Scan stopped (software trigger) or hardware
triggers disabled.

FSP_ERR_ASSERTION An input argument is invalid.

FSP_ERR_NOT _OPEN Unit is not open.

¢ R_ADC StatusGet()

fsp_err_ t R_ADC StatusGet ( adc_ctrl_ t * p ctrl, adc_status t * p_status )

Provides the status of any scan process that was started, including scans started by ELC or external
triggers and calibration scans on MCUs that support calibration.

Return values

FSP_SUCCESS Module status stored in the provided pointer
p_status

FSP_ERR_ASSERTION An input argument is invalid.

FSP_ERR_NOT _OPEN Unit is not open.

¢ R_ADC_Read()

fsp_err_t R_ADC_Read ( adc_ctrl_t* p_ctrl, adc_channel_t const reg_id, uintl6_t *const p_data )

Reads conversion results from a single channel or sensor.

Return values

FSP_SUCCESS Data read into provided p_data.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT_OPEN Unit is not open.
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& R_ADC_Read32()

fsp_err t R_ADC Read32 ( adc_ctrl t* p ctrl, adc_channel_t const reg id, uint32_t *const p data
)

Reads conversion results from a single channel or sensor register into a 32-bit result.

Return values

FSP_SUCCESS Data read into provided p_data.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.

¢ R_ADC_SampleStateCountSet()

fsp_err_t R_ADC_SampleStateCountSet ( adc_ctrl_t * p_ctrl, adc_sample_state t * p_sample )

Sets the sample state count for individual channels. This only needs to be set for special use cases.
Normally, use the default values out of reset.

Note

The sample states for the temperature and voltage sensor are set in R_ADC_ScanCfg.
Return values

FSP_SUCCESS Sample state count updated.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.

4 R_ADC _Close()

fsp_err t R_ADC Close ( adc_ctrl_t* p_ctrl)

This function ends any scan in progress, disables interrupts, and removes power to the A/D
peripheral.

Return values

FSP_SUCCESS Module closed.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.
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4 R_ADC _OffsetSet()

fsp_err_ t R_ADC OffsetSet ( adc_ctrl_t *const p_ctrl, adc_channel t const reg id, int32_t offset )

adc_api_t::offsetSet is not supported on the ADC.

Return values

FSP_ERR_UNSUPPORTED Function not supported in this
implementation.

¢ R_ADC Calibrate()

fsp_err_ t R_ADC Calibrate ( adc_ctrl_t *const p ctrl, void *const p_extend )

Initiates calibration of the ADC on MCUs that require calibration. This function must be called
before starting a scan on MCUs that require calibration.

Calibration is complete when the callback is called with ADC_EVENT_CALIBRATION_COMPLETE or
when R_ADC_StatusGet returns ADC_STATUS_IDLE. Reference Figure 32.35 "Software flow and
operation example of calibration operation." in the RA2A1 manual RO1IUH0888EJ0100.

ADC calibration time: 12 PCLKB + 774,930 ADCLK. (Reference Table 32.16 "Required calibration
time (shown as the number of ADCLK and PCLKB cycles)" in the RA2A1 manual RO1IUH0888E)J0100.
The lowest supported ADCLK is 1MHz.

Calibration will take a minimum of 24 milliseconds at 32 MHz PCLKB and ADCLK. This wait could
take up to 780 milliseconds for a 1 MHz PCLKD (ADCLK).

Parameters
[in] p_ctrl Pointer to the instance
control structure
[in] p_extend Unused argument. Pass
NULL.
Return values
FSP_SUCCESS Calibration successfully initiated.
FSP_ERR_INVALID_HW_CONDITION A scan is in progress or hardware triggers
are enabled.
FSP_ERR_UNSUPPORTED Calibration not supported on this MCU.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT_OPEN Unit is not open.
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4 R_ADC VersionGet()

fsp_err_t R_ADC VersionGet ( fsp_version_t *const p_version)

Retrieve the APl version number.

Return values
FSP_SUCCESS Version stored in the provided p_version.

FSP_ERR_ASSERTION An input argument is invalid.

5.2.4 Asynchronous General Purpose Timer (r_agt)

Modules
Functions
fsp_err t R_AGT_Close (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT PeriodSet (timer_ctrl_t *const p_ctrl, uint32_t const
period_counts)
fsp_err t R_AGT DutyCycleSet (timer_ctrl_t *const p_ctrl, uint32_t const
duty cycle counts, uint32_t const pin)
fsp_err t R_AGT Reset (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Start (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Enable (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Disable (timer _ctrl_t *const p_ctrl)
fsp_err t R_AGT InfoGet (timer_ctrl_t *const p_ctrl, timer_info_t *const p_info)
fsp_err t R_AGT StatusGet (timer_ctrl_t *const p_ctrl, timer_status_t *const
p_status)
fsp_err t R_AGT_Stop (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Open (timer_ctrl_t *const p_ctrl, timer_cfg_t const *const
p_cfg)
fsp_err_ t R_AGT VersionGet (fsp_version_t *const p_version)
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Detailed Description

Driver for the AGT peripheral on RA MCUs. This module implements the Timer Interface.

Overview

Features
The AGT module has the following features:

Supports periodic mode, one-shot mode, and PWM mode.

Signal can be output to a pin.

Configurable period (counts per timer cycle).

Configurable duty cycle in PWM mode.

Configurable clock source, including PCLKB, LOCO, SUBCLK, and external sources input to
AGTIO.

Supports runtime reconfiguration of period.

Supports runtime reconfiguration of duty cycle in PWM mode.

Supports counting based on an external clock input to AGTIO.

Supports debounce filter on AGTIO pins.

Supports measuring pulse width or pulse period.

APIs are provided to start, stop, and reset the counter.

APIs are provided to get the current period, source clock frequency, and count direction.
APIs are provided to get the current timer status and counter value.

Selecting a Timer

RA MCUs have two timer peripherals: the General PWM Timer (GPT) and the Asynchronous General
Purpose Timer (AGT). When selecting between them, consider these factors:

GPT AGT
Low Power Modes The GPT can operate in sleep The AGT can operate in all low
mode. power modes (when count

source is LOCO or subclock).

Available Channels The number of GPT channels is All MCUs have 2 AGT channels.
device specific. All currently
supported MCUs have at least 7
GPT channels.

Timer Resolution All MCUs have at least one The AGT timers are 16-bit
32-bit GPT timer. timers.

Clock Source The GPT runs off PCLKD witha  The AGT runs off PCLKB, LOCO,
configurable divider up to 1024. or subclock with a configurable
It can also be configured to divider up to 8 for PCLKB or up
count ELC events or external to 128 for LOCO or subclock.
pulses.

Configuration

Build Time Configurations for r_agt
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The following build time configurations are defined in fsp_cfg/r_agt_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.
Pin Output Support e Disabled Disabled If selected code for
¢ Enabled outputting a waveform
to a pinis included in
the build.
Pin Input Support e Disabled Disabled Enable input support to
e Enabled use pulse width

measurement mode,
pulse period
measurement mode, or
input from P402, P402,
or AGTIO.

Configurations for Driver > Timers > Timer Driver on r_agt

This module can be added to the Stacks tab via New Stack > Driver > Timers > Timer Driver on
r_agt:

Configuration Options Default Description
General > Name Name must be a valid  g_timer0 Module name.
C symbol
General > Channel Available AGT Channels 0 Physical hardware
are0and1l channel.
General > Mode e Periodic Periodic Mode selection. Note:
¢ One-Shot One-shot mode is
e PWM implemented in

software. ISR's must be
enabled for one shot
even if callback is

unused.
General > Period Value must be non- 0x10000 Specify the timer
negative period based on the

selected unit.

When the unit is set to
'Raw Counts', setting
the period to 0x10000
results in the maximum
period at the lowest
divisor (fastest timer
tick). Set the period to
0x10000 for a free
running timer, pulse
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General > Period Unit

General > Count
Source

Output > Duty Cycle
Percent (only
applicable in PWM
mode)

Output > AGTOA
Output

Output > AGTOB
Output

Output > AGTO Output

Raw Counts
Nanoseconds
Microseconds
Milliseconds
Seconds
Hertz
Kilohertz

PCLKB

LOCO
SUBCLOCK
AGTO Underflow
P402 Input
P403 Input
AGTIO Input

Value must be between
0 and 100

e Disabled
e Start Level Low
e Start Level High

e Disabled
e Start Level Low
e Start Level High

e Disabled
e Start Level Low
e Start Level High

Raw Counts

PCLKB

50

Disabled

Disabled

Disabled

width measurement or
pulse period
measurement. Setting
the period higher will
automatically select a
higher divider; the
period can be set up to
0x80000 when
counting from PCLKB or
0x800000 when
counting from
LOCO/subclock, which
will use a divider of 8
or 128 respectively
with the maximum
period.

Unit of the period
specified above

AGT counter clock
source. NOTE: The
divisor is calculated
automatically by the
configurator. See
agt _count_source t
documentation for
details.

Specify the timer duty
cycle percent. Only
used in PWM mode.

Configure AGTOA
output.

Configure AGTOB
output.

Configure AGTO
output.

Input > Measurement e Measure Measure Disabled Select if the AGT
Mode Disabled should be used to
¢ Measure Low measure pulse width or
Level Pulse pulse period. In high
Width level pulse width
¢ Measure High measurement mode,
Level Pulse the AGT counts when
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Width
e Measure Pulse
Period

Input > AGTIO Filter ¢ No Filter No Filter
e Filter sampled
at PCLKB
e Filter sampled
at PCLKB / 8
 Filter sampled
at PCLKB / 32

Input > Enable Pin e Enable Pin Not  Enable Pin Not Used
Used
¢ Enable Pin
Active Low
e Enable Pin
Active High

Input > Trigger Edge e Trigger Edge Trigger Edge Rising
Rising
e Trigger Edge
Falling
e Trigger Edge
Both

Interrupts > Callback Name must be a valid  NULL
C symbol

Interrupts > Underflow MCU Specific Options
Interrupt Priority

Clock Configuration

AGTIO is high and
starts counting
immediately in the
middle of a pulse if
AGTIO is high when
R_AGT Start() is called.
In low level pulse width
measurement mode,
the AGT counts when
AGTIO is low and could
start counting in the
middle of a pulse if
AGTIO is low when
R_AGT Start() is called.

Input filter, applies
AGTIO in pulse period
measurement, pulse
width measurement, or
event counter mode.
The filter requires the
signal to be at the
same level for 3
successive reads at the
specified filter
frequency.

Select active edge for
the AGTEE pin if used.
Only applies if the
count source is P402,
P403 or AGTIO.

Select the trigger edge.
Applies if measurement
mode is pulse period,
or if the count source is
P402, P403, or AGTIO.
Do not select Trigger
Edge Both with pulse
period measurement.

A user callback
function. If this callback
function is provided, it
is called from the
interrupt service
routine (ISR) each time
the timer period
elapses.

Timer interrupt priority.
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The AGT clock is based on the PCLKB, LOCO, or Subclock frequency. You can set the clock frequency
using the clock configurator in e2 studio or using the CGC Interface at run-time.

Pin Configuration

This module can use the AGTOA and AGTOB pins as output pins for periodic, one-shot, or PWM
signals.

For input capture, the input signal must be applied to the AGTIOn pin.
For event counting, the AGTEEn enable pin is optional.
Timer Period

The RA Configuration tool will automatically calculate the period count value and source clock divider
based on the selected period time, units and clock speed.

When the selected unit is "Raw counts", the maximum allowed period setting varies depending on
the selected clock source:

Clock source Maximum period (counts)
LOCO/Subclock 0x800000
PCLKB 0x80000
All other sources 0x10000

Note
Though the AGT is a 16-bit timer, because the period interrupt occurs when the counter underflows, setting the
period register to O resultsin an effective period of 1 count. For this reason all user-provided raw count values
reflect the actual number of period counts (not the raw register values).

Usage Notes

Starting and Stopping the AGT

After starting or stopping the timer, AGT registers cannot be accessed until the AGT state is updated
after 3 AGTCLK cycles. If another AGT function is called before the 3 AGTCLK period elapses, the
function spins waiting for the AGT state to update. The required wait time after starting or stopping
the timer can be determined using the frequency of AGTCLK, which is derived from
timer_cfg_t::source_div and agt_extended_cfg t::count_source.

The application is responsible for ensuring required clocks are started and stable before accessing
MCU peripheral registers.

Warning
The subclock can take seconds to stabilize. The RA startup code does not wait for subclock
stabilization unless the subclock is the main clock source. When running AGT or RTC off the
subclock, the application must ensure the subclock is stable before starting operation.

Low Power Modes

The AGT1 (channel 1 only) can be used to enter snooze mode or to wake the MCU from snooze,
software standby, or deep software standby modes when a counter underflow occurs. The compare
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match A and B events can also be used to wake from software standby or snooze modes.

One-Shot Mode

The AGT timer does not support one-shot mode natively. One-shot mode is achieved by stopping the
timer in the interrupt service routine before the callback is called. If the interrupt is not serviced
before the timer period expires again, the timer generates more than one event. The callback is only
called once in this case, but multiple events may be generated if the timer is linked to the Data

Transfer Controller (r_dtc).

One-Shot Mode Output

The output waveform in one-shot mode is one AGT clock cycle less than the configured period. The

configured period must be at least 2 counts to generate an output pulse.

Examples of one-shot signals that can be generated by this module are shown below:

AGT One-Shot Output

Time after start (AGTCLK
counts, AGT starts 3 AGTCLK ] |

counts after R_AGT_Start)

One-shot mode, agt_pin_cfg_t =
AGT_PIN_CFG_START_LEVEL_LOW

One-shot mode, agt_pin_cfg_t =
AGT PIN CFG START LEVEL HIGH

Figure 106: AGT One-Shot Output

Periodic Output

The AGTOA or AGTOB pin toggles twice each time the timer expires in periodic mode. This is
achieved by defining a PWM wave at a 50 percent duty cycle so that the period of the resulting
square (from rising edge to rising edge) matches the period of the AGT timer. Since the periodic
output is actually a PWM output, the time at the stop level is one cycle shorter than the time

opposite the stop level for odd period values.

Examples of periodic signals that can be generated by this module are shown below:
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AGT Periodic Output

\‘9\% 3 &
R § o

Time after start (AGTCLK
counts, AGT starts 3 AGTCLK I
counts after R_AGT_Start)

One-shot made, agt_pin_cfg_t=
AGT_PIN_CFG_START_LEVEL_LOW

One-shot mode, agt_pin_cfg_t =
AGT PIN CFG START LEVEL HIGH

Figure 107: AGT Periodic Output

PWM Output

This module does not support in phase PWM output. The PWM output signal is low at the beginning
of the cycle and high at the end of the cycle.

Examples of PWM signals that can be generated by this module are shown below:

AGT PWM Output

&
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& O 8 i8] %
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Time after start (AGTCLK
counts, AGT starts 3 AGTCLK | |
counts after R_AGT_Start) I I

PWIM mode, agt_pin_cfg_t =
AGT_PIN_CFG_START_LEVEL_LOW

PWM mode, agt_pin_cfg_t =
AGT_PIN_CFG_START_LEVEL HIGH

Figure 108: AGT PWM Output

Triggering ELC Events with AGT

The AGT timer can trigger the start of other peripherals. The Event Link Controller (r_elc) guide
provides a list of all available peripherals.

Examples

AGT Basic Example

This is a basic example of minimal use of the AGT in an application.

voi d agt _basi c_exanpl e (voi d)
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AGT Callback Example

This is an example of a timer callback.

AGT Free Running Counter Example

To use the AGT as a free running counter, select periodic mode and set the the Period to OxFFFF.
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AGT Input Capture Example

This is an example of using the AGT to capture pulse width or pulse period measurements.
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AGT Period Update Example

This an example of updating the period.
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* - Use the R AGT InfoGet function (it accounts for the clock source and divider).
* - Calculate the current PCLKB frequency using
R _FSP_Syst enCl ockHzGet ( FSP_PRI V_CLOCK PCLKB) and right shift
* by timer_cfg t::source_div.
* This exanpl e uses the |ast option (R FSP_SystentC ockHzGet) .
*/
uint32 t tinmer _freq hz = R FSP_Syst enTCl ockHzGet (FSP_PRI V_CLOCK PCLKB) >>
g_tinmer0_cfg.source_div;
/* Cal cul ate the desired period based on the current clock. Note that this
cal cul ation could overflow if the
* desired period is larger than U NT32_NMAX / pcl kb _freq_hz. A cast to uint64_t is
used to prevent this. */
uint32 t period _counts =
(uint32_t) (((uint64_t) tiner_freq_hz * AGT_EXAMPLE_DESI RED_PERI OD_MSEC) /
AGT_EXAMPLE_NMBEC_PER _SEC) ;
/* Set the calculated period. This will return an error if paraneter checking is
enabl ed and the cal cul at ed
* period is larger than U NT16_MAX. */
err = R AGT PeriodSet (& tinmerO _ctrl, period counts);

handl e_error(err);

AGT Duty Cycle Update Example

This an example of updating the duty cycle.

#def i ne AGT_EXAMPLE_DESI RED_DUTY_CYCLE_PERCENT (25)
#def i ne AGT_EXAMPLE_MAX_PERCENT (100)
/* This exanple shows how to cal cul ate a new duty cycle value at runtinme. */
voi d agt _duty cycl e cal cul ati on_exanpl e (voi d)

{

fsp_err_t err = FSP_SUCCESS,;

/* Initializes the nodule. */

err = R AGT_Open(&g_tinerO ctrl, &g _tiner0 _cfg);

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 224 /1,444
Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Asynchronous General Purpose Timer (r_agt)

AGT Cascaded Timers Example

This an example of using AGTO underflow as the count source for AGTL.
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/* (Optional) Stop AGI channel

O first. */

(void) R AGT Stop(&g_tiner_channel O ctrl);

(void) R AGT_Stop(&g_tiner_channel 1 _ctrl);

/* Read the current counter val ue.

timer_status t status;

(void) R AGI _StatusGet(&g tiner_channell ctrl,

Data Structures

struct

struct

Enumerations

enum

enum

enum

enum

enum

enum

enum

Counter value is in status.counter. */

agt instance_ctrl t

agt_extended cfg t

agt clock t

agt_measure_t

agt_agtio_filter_t

agt_enable_pin_t

agt _trigger _edge t

agt_output pin_t

agt_pin_cfg_t

&st at us) ;

Data Structure Documentation

¢ agt_instance_ctrl_t

struct agt_instance_ctrl_t

Channel control block. DO NOT INITIALIZE. Initialization occurs when timer_api_t::open is called.

Data Fields
uint32 t open Whether or not channel is open.
const timer_cfg_t* p_cfg Pointer to initial configurations.
R_AGTO Type * p_reg Base register for this channel.
uint32_t period Current timer period (counts)
¢ agt_extended_cfg_t
struct agt_extended_cfg_t
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Optional AGT extension data structure.
Data Fields

agt clock t count_source AGT channel clock source. Valid
values are: AGT_CLOCK PCLKB,
AGT_CLOCK LOCO,
AGT_CLOCK_FSUB.

union agt_extended cfg t __unnamed__

agt pin_cfg_t agto: 3 Configure AGTO pin,.
Note

AGTIO polarity is opposite
AGTO

agt_ measure_t measurement_mode Measurement mode.

agt_agtio_filter_t agtio_filter Input filter for AGTIO.

agt_enable_pin_t enable_pin Enable pin (event counting
only)

agt trigger_edge t trigger_edge Trigger edge to start pulse
period measurement or count
external event.

Enumeration Type Documentation
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¢ agt_clock_t

enum agt_clock_t

Count source

Enumerator

AGT_CLOCK_PCLKB PCLKB count source, division by 1, 2, or 8
allowed.

Counter clock source is PCLKB when

AGT _CLOCK PCLKB, AGT CLOCK PCLKB DIV_2,
or AGT_CLOCK PCLKB_DIV_8 is selected. The
PCLKB divisor is selected automatically by the
configurator as either PCLKB/1, PCLKB/2, or
PCLKB/8. If the timer_cfg_t::unit is
TIMER_UNIT_PERIOD_RAW_COUNTS, the
timer_cfg_t::period should be the desired value
in PCLKB counts, even if the value would
exceed 16 bits. For example, if a period of
0x30000 counts is requested, a divisor of
PCLKB/8 is be selected and the counter
underflows after 0x6000 counts.

AGT_CLOCK_LOCO LOCO count source, division by 1, 2, 4, 8, 16,
32, 64, or 128 allowed.

AGT_CLOCK_AGTO_UNDERFLOW Underflow event signal from AGTO, division
must be 1.

AGT_CLOCK_SUBCLOCK Subclock count source, division by 1, 2, 4, 8,

16, 32, 64, or 128 allowed.

AGT_CLOCK_P402 Counts events on P402, events are counted in
deep software standby mode.

AGT_CLOCK_P403 Counts events on P403, events are counted in
deep software standby mode.

AGT_CLOCK_AGTIO Counts events on AGTIOn, events are not
counted in software standby modes.
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¢ agt_measure_t

enum agt_measure_t

Enable pin for event counting mode.

Enumerator

AGT_MEASURE_PULSE_WIDTH_LOW_LEVEL AGT used to measure low level pulse width.

AGT_MEASURE_PULSE_WIDTH_HIGH_LEVEL AGT used to measure high level pulse width.

AGT_MEASURE_PULSE_PERIOD AGT used to measure pulse period.

¢ agt_agtio filter_t

enum agt_agtio filter t
Input filter, applies AGTIO in pulse period measurement, pulse width measurement, or event
counter mode. The filter requires the signal to be at the same level for 3 successive reads at the
specified filter frequency.
Enumerator
AGT _AGTIO_FILTER_NONE No filter.
AGT _AGTIO_FILTER _PCLKB Filter at PCLKB.
AGT_AGTIO_FILTER_PCLKB _DIV_8 Filter at PCLKB / 8.
AGT_AGTIO_FILTER PCLKB DIV_32 Filter at PCLKB / 32.
¢ agt_enable_pin_t
enum agt_enable_pin_t
Enable pin for event counting mode.
Enumerator
AGT_ENABLE_PIN_NOT_USED AGTEE is not used.

AGT_ENABLE_PIN_ACTIVE_LOW Events are only counted when AGTEE is low.

AGT_ENABLE_PIN_ACTIVE_HIGH Events are only counted when AGTEE is high.
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¢ agt_trigger_edge_t

enum agt _trigger_edge_t

Trigger edge for pulse period measurement mode and event counting mode.

Enumerator

AGT_TRIGGER_EDGE_RISING Measurement starts or events are counted on

rising edge.

AGT_TRIGGER_EDGE_FALLING Measurement starts or events are counted on

falling edge.

AGT_TRIGGER_EDGE_BOTH Events are counted on both edges (n/a for

pulse period mode)

¢ agt_output_pin_t

enum agt_output_pin_t

Output pins, used to select which duty cycle to update in R_AGT_DutyCycleSet().

Enumerator
AGT_OUTPUT _PIN_AGTOA GTIOCA.
AGT_OUTPUT _PIN_AGTOB GTIOCB.
¢ agt_pin_cfg_t
enum agt _pin_cfg_t
Level of AGT pin
Enumerator

AGT_PIN_CFG_START_LEVEL_LOW Pin level low.

AGT_PIN_CFG_START_LEVEL_HIGH Pin level high.

Function Documentation
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¢ R_AGT Close()

fsp_err t R_AGT Close ( timer_ctrl_t *const p_ctrl)

Stops counter, disables interrupts, disables output pins, and clears internal driver data. Implements
timer_api_t::close.

Return values

FSP_SUCCESS Timer closed.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT _OPEN The instance control structure is not
opened.

& R_AGT PeriodSet()

fsp_err_t R_AGT_PeriodSet ( timer_ctrl_t *const p_ctrl, uint32_t const period _counts )

Updates period. The new period is updated immediately and the counter is reset to the maximum
value. Implements timer_api_t::periodSet.

Warning
If periodic output is used, the duty cycle buffer registers are updated after the period buffer
register. If this function is called while the timer is running and an AGT underflow occurs
during processing, the duty cycle will not be the desired 50% duty cycle until the counter
underflow after processing completes.
Stop the timer before calling this function if one-shot output is used.

Example:
/* Get the source clock frequency (in Hz). There are several ways to do this in FSP:
* - |f LOCO or subclock is chosen in agt_extended cfg_ t::clock source
* - The source clock frequency is BSP_ LOCO HZ >> timer_cfg_t::source div
* - |If PCLKB is chosen in agt_extended cfg_ t::clock _source and the PCLKB frequency
has not changed since reset,
* - The source clock frequency is BSP_STARTUP_PCLKB HZ >> tinmer_cfg t::source_div
* - Use the R AGT InfoGet function (it accounts for the clock source and divider).
* - Calculate the current PCLKB frequency using
R FSP_Syst entCl ockHzGet (FSP_PRI V_CLOCK PCLKB) and right shift
* by timer_cfg t::source_div.
o
* This exanpl e uses the |ast option (R FSP_SystentC ockHzGet).
“
uint32_t tiner_freq_hz = R FSP_SystenCl ockHzGet (FSP_PRI V_CLOCK_PCLKB) >>
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g_tiner0 _cfg.source_div;
/* Calculate the desired period based on the current clock. Note that this
cal cul ati on could overflow if the
* desired period is larger than U NT32_MAX / pcl kb freq_hz. A cast to uint64 t is
used to prevent this. */
uint32_t period_counts =
(uint32_t) (((uint64_t) tiner_freq_hz * AGT_EXAVPLE_DESI RED_PERI OD_MSEC) /
AGT _EXAMPLE_MSEC PER _SEC) ;
/* Set the calculated period. This will return an error if paraneter checking is
enabl ed and the cal cul at ed
* period is |larger than U NT16_MAX. */
err = R AGT_PeriodSet (& tinmer0O_ctrl, period_counts);

handl e_error(err);

Return values

FSP_SUCCESS Period value updated.
FSP_ERR_ASSERTION A required pointer was NULL, or the period
was not in the valid range of 1 to OXFFFF.
FSP_ERR_NOT _OPEN The instance control structure is not
opened.
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& R_AGT _DutyCycleSet()

fsp_err_ t R_AGT DutyCycleSet ( timer_ctrl_t *const p_ctrl, uint32_t const duty cycle counts,
uint32_t const pin )

Updates duty cycle. If the timer is counting, the new duty cycle is reflected after the next counter
underflow. Implements timer_api_t::dutyCycleSet.

Example:
/* Get the current period setting. */
timer_info_ t info;
(void) R AGT_InfoGet(&g_timer0_ctrl, & nfo);
uint32 t current _period _counts = info. period counts;
/* Calculate the desired duty cycle based on the current period. */
uint32 t duty cycle counts = (current period counts *
IAGT _EXAMPLE_DESI RED_DUTY_CYCLE_PERCENT) /
AGT_EXAMPLE_NMAX_PERCENT;
/* Set the cal culated duty cycle. */
err = R AGT DutyCycleSet(&y tinerO ctrl, duty cycle counts, AGI_OUTPUT PI N AGTOA

handl e _error(err);

Return values
FSP_SUCCESS Duty cycle updated.

FSP_ERR_ASSERTION A required pointer was NULL, or the pin was
not AGT_AGTO_AGTOA or
AGT _AGTO_AGTOB.

FSP_ERR_INVALID_ARGUMENT Duty cycle was not in the valid range of 0 to
period (counts) - 1
FSP_ERR_NOT _OPEN The instance control structure is not
opened.
FSP_ERR_UNSUPPORTED AGT_CFG_OUTPUT_SUPPORT_ENABLE is 0.
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¢ R_AGT_Reset()

fsp_err t R_AGT Reset ( timer_ctrl_t *const p_ctrl)

Return values

Resets the counter value to the period minus one. Implements timer_api_t::reset.

FSP_SUCCESS

Counter reset.

FSP_ERR_ASSERTION

p_ctrlis NULL

FSP_ERR_NOT OPEN

The instance control structure is not
opened.

& R_AGT Start()

fsp_err_ t R_AGT Start ( timer_ctrl_t *const p_ctrl)

Starts timer. Implements timer_api_t::start.
Example:
[* Start the timer. */

(void) RAGT Start(&g tinmer0O_ctrl);

Return values

FSP_SUCCESS

Timer started.

FSP_ERR_ASSERTION

p_ctrl is null.

FSP_ERR_NOT_OPEN

The instance control structure is not
opened.
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¢ R_AGT_Enable()

fsp_err_ t R_AGT Enable ( timer_ctrl_t *const p_ctr/)

Enables external event triggers that start, stop, clear, or capture the counter. Implements
timer_api_t::enable.

Example:
/* Enabl e captures. Captured values arrive in the interrupt. */

(void) R AGT Enable(&y timer0O ctrl);

Return values

FSP_SUCCESS External events successfully enabled.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.

¢ R_AGT Disable()

fsp_err_t R_AGT _Disable ( timer_ctrl_t *const p_ctr/)

Disables external event triggers that start, stop, clear, or capture the counter. Implements
timer_api_t::disable.

Example:
/* (Optional) Disable captures. */
(void) R AGT Disable(&y tiner0 ctrl);

Return values

FSP_SUCCESS External events successfully disabled.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.
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¢ R_AGT InfoGet()

fsp_err_ t R_AGT InfoGet ( timer_ctrl_t *const p_ctrl, timer_info_t *const p_info )

Gets timer information and store it in provided pointer p_info. Implements timer_api_t::infoGet.
Example:
/* (Optional) Get the current period if not known. */
timer_info_t info;
(void) R AGT_InfoGet(&g_tinmer0_ctrl, & nfo);

uint32 t period = info. period counts;

Return values

FSP_SUCCESS Period, count direction, and frequency
stored in p_info.

FSP_ERR_ASSERTION A required pointer is NULL.

FSP_ERR_NOT_OPEN The instance control structure is not
opened.

¢ R_AGT StatusGet()

fsp_err_ t R_AGT StatusGet ( timer_ctrl_t *const p_ctrl, timer_status_t *const p_status )

Retrieves the current state and counter value stores them in p_status. Implements
timer_api_t::statusGet.

Example:

/* Read the current counter value. Counter value is in status.counter. */

timer_status t status;

(void) R AGI _StatusGet(&g tinerO_ctrl, &status);

Return values

FSP_SUCCESS Current status and counter value provided
in p_status.
FSP_ERR_ASSERTION A required pointer is NULL.
FSP_ERR_NOT _OPEN The instance control structure is not
opened.
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& R_AGT_Stop()

fsp_err t R_AGT Stop ( timer_ctrl_t *const p_ctrl)

Stops the timer. Implements timer_api_t::stop.
Example:
/* (Optional) Stop the tinmer. */

(void) R AGT _Stop(&g_tiner0 ctrl);

Return values
FSP_SUCCESS

Timer stopped.
FSP_ERR_ASSERTION p_ctrl was NULL.

FSP_ERR_NOT OPEN

The instance control structure is not
opened.
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¢ R_AGT_Open()

fsp_err t R_AGT Open ( timer_ctrl_t *const p_ctrl, timer_cfg_t const *const p cfg )

Initializes the AGT module instance. Implements timer_api_t::open.

The AGT hardware does not support one-shot functionality natively. The one-shot feature is
therefore implemented in the AGT HAL layer. For a timer configured as a one-shot timer, the timer
is stopped upon the first timer expiration.

The AGT implementation of the general timer can accept an optional agt_extended_cfg t extension
parameter. For AGT, the extension specifies the clock to be used as timer source and the output
pin configurations. If the extension parameter is not specified (NULL), the default clock PCLKB is
used and the output pins are disabled.

Example:
/* Initializes the nodule. */

err = R AGT_Open(&g_tinerO ctrl, &g tiner0 _cfg);

Return values

FSP_SUCCESS Initialization was successful and timer has
started.

FSP_ERR_ASSERTION A required input pointer is NULL or the
period is not in the valid range of 1 to
OxFFFF.

FSP_ERR_ALREADY_OPEN R_AGT Open has already been called for
this p_ctrl.

FSP_ERR_IRQ_BSP _DISABLED A required interrupt has not been enabled in
the vector table.

FSP_ERR_IP_ CHANNEL NOT PRESENT Requested channel number is not available
on AGT.

¢ R_AGT VersionGet()

fsp_err t R_AGT VersionGet ( fsp_version_t *const p_version)

Sets driver version based on compile time macros. Implements timer_api_t::versionGet.

Return values

FSP_SUCCESS Version in p_version.
FSP_ERR_ASSERTION The parameter p_version is NULL.
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5.2.5 Clock Frequency Accuracy Measurement Circuit (r_cac)

Modules

Functions

fsp_err t
fsp_err t
fsp_err t
fsp_err t
fsp_err t

fsp_err t

Detailed Description

R_CAC _Open (cac_ctrl_t *const p_ctrl, cac_cfg_t const *const p_cfqg)

R_CAC StartMeasurement (cac_ctrl_t *const p_ctrl)

R_CAC StopMeasurement (cac_ctrl_t *const p_ctrl)

R_CAC Read (cac_ctrl_t *const p_ctrl, uintl6_t *const p_counter)

R_CAC Close (cac_ctrl_t *const p_ctrl)

R_CAC VersionGet (fsp_version_t *const p_version)

Driver for the CAC peripheral on RA MCUs. This module implements the CAC Interface.

Overview

The interface for the clock frequency accuracy measurement circuit (CAC) peripheral is used to
check a system clock frequency with a reference clock signal by counting the number of
measurement clock edges that occur between two edges of the reference clock.

Features

e Supports clock frequency-measurement and monitoring based on a reference signal input

e Reference can be either an externally supplied clock source or an internal clock source

e An interrupt request may optionally be generated by a completed measurement, a detected
frequency error, or a counter overflow.

e A digital filter is available for an externally supplied reference clock, and dividers are
available for both internally supplied measurement and reference clocks.

e Edge-detection options for the reference clock are configurable as rising, falling, or both.

Configuration

Build Time Configurations for r_cac

The following build time configurations are defined in fsp_cfg/r_cac_cfg.h:

Configuration

Options

Default

Description

Parameter Checking

e Default (BSP) Default (BSP)

If selected code for
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¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Monitoring > Clock Accuracy Circuit Driver on r_cac

This module can be added to the Stacks tab via New Stack > Driver > Monitoring > Clock Accuracy
Circuit Driver on r_cac:

Configuration Options Default Description

Name Name must be a valid g _cacO Module name.
C symbol

32 32 Reference clock
128 divider.

1024

8192

Reference clock divider

Main Oscillator Main Oscillator Reference clock
Sub-clock source.

HOCO

MOCO

LOCO

PCLKB

IWDT

External

Reference clock source

Reference clock digital e Disabled Disabled Reference clock digital
filter e Sampling clock filter.
=Measuring
freq
¢ Sampling clock
=Measuring
freq/4
e Sampling clock
=Measuring
freq/16

Reference clock edge e Rising Rising Reference clock edge
detect ¢ Falling detection.
e Both

Measurement clock o1 1 Measurement clock
divider o 4 divider.

e 8

e 32

Main Oscillator HOCO Measurement clock
Sub-clock source.

HOCO

MOCO

e LOCO

e PCLKB

e IWDT

Measurement clock
source

Upper Limit Threshold  Value must be a non- 0 Top end of allowable
negative integer, range for measurement
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between 0 to 65535

Value must be a non- 0
negative integer,
between 0 to 65535

Lower Limit Threshold

Frequency Error MCU Specific Options

Interrupt Priority

Measurement End
Interrupt Priority

MCU Specific Options

Overflow Interrupt MCU Specific Options

Priority

Callback Name must be a valid NULL

C symbol
Clock Configuration
The CAC measurement clock source can be configured as the following:

. MAIN_OSC
. SUBCLOCK
. HOCO

. MOCO

. Loco

. PCLKB

. IWDT

Nouhs, WNBE

The CAC reference clock source can be configured as the following:

. MAIN_OSC

. SUBCLOCK

. HOCO

. MOCO

. LOCO

. PCLKB

. IWDT

. External Clock Source (CACREF)

oNOU s WNBKH

Pin Configuration

completion.

Bottom end of
allowable range for
measurement
completion.

CAC frequency error
interrupt priority.

CAC measurement end
interrupt priority.

CAC overflow interrupt
priority.

Function name for
callback

The CACREF pin can be configured to provide the reference clock for CAC measurements.

Usage Notes

Measurement Accuracy

The clock measurement result may be off by up to one pulse depending on the phase difference
between the edge detection circuit, digital filter, and CACREF pin signal, if applicable.

Frequency Error Interrupt

The frequency error interrupt is only triggered at the end of a CAC measurement. This means that
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there will be a measurement complete interrupt in addition to the frequency error interrupt.

Examples
Basic Example

This is a basic example of minimal use of the CAC in an application.

Data Structures

struct cac_instance_ctrl_t

Data Structure Documentation

& cac_instance_ctrl_t
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struct cac_instance_ctrl_t

CAC instance control block. DO NOT INITIALIZE.

Function Documentation

¢ R_CAC_Open()

fsp_err t R_CAC Open ( cac_ctrl_t *const p ctrl, cac_cfg_t const *const p_cfg )

The Open function configures the CAC based on the provided user configuration settings.

Return values

FSP_SUCCESS CAC is available and available for
measurement(s).

FSP_ERR_ASSERTION An argument is invalid.

FSP_ERR_ALREADY_OPEN The CAC has already been opened.

Note

Thereisonly a single CAC peripheral.

¢ R_CAC _StartMeasurement()

fsp_err_ t R_CAC_StartMeasurement ( cac_ctrl_t *const p_ctrl)

Start the CAC measurement process.

Return values

FSP_SUCCESS CAC measurement started.
FSP_ERR_ASSERTION NULL provided for p_instance_ctrl or p_cfg.
FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.
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4 R_CAC_StopMeasurement()

fsp_err_ t R_CAC_StopMeasurement ( cac_ctrl_t *const p_ctr/)

Stop the CAC measurement process.

Return values

FSP_SUCCESS CAC measuring has been stopped.

FSP_ERR_ASSERTION NULL provided for p_instance_ctrl or p_cfg.

FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.

¢ R_CAC_Read()

fsp_err_t R_CAC_Read ( cac_ctrl_t *const p_ctrl, uintl6_t *const p_counter )

Read and return the CAC status and counter registers.

Return values

FSP_SUCCESS CAC read successful.

FSP_ERR_ASSERTION An argument is NULL.

FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.

¢ R_CAC _Close()

fsp_err t R_CAC Close ( cac_ctrl_t *const p_ctrl)

Release any resources that were allocated by the Open() or any subsequent CAC operations.

Return values

FSP_SUCCESS Successful close.
FSP_ERR_ASSERTION NULL provided for p_instance_ctrl or p_cfg.
FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.
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& R_CAC VersionGet()

fsp_err_ t R_CAC VersionGet ( fsp_version_t *const p_version)

Get the APl and code version information.

Return values
FSP_SUCCESS Version info returned.

FSP_ERR_ASSERTION An argument is NULL.

5.2.6 Controller Area Network (r_can)
Modules

Functions

fsp_err t R_CAN_Open (can_ctrl_t *const p_api_ctrl, can_cfg_t const *const
p_cfg)

fsp_err t R_CAN_Close (can_ctrl_t *const p_api_ctrl)

fsp_err t R_CAN_ Write (can_ctrl_t *const p_api_ctrl, uint32_t const mailbox,
can_frame_t *const p_frame)

fsp_err t R_CAN_ModeTransition (can_ctrl_t *const p_api_ctrl,
can_operation_mode_t operation_mode, can_test mode_t test_mode)

fsp_err t R_CAN InfoGet (can_ctrl _t *const p_api_ctrl, can_info_t *const p_info)

fsp_err t R_CAN_VersionGet (fsp_version_t *const version)

Detailed Description

Driver for the CAN peripheral on RA MCUs. This module implements the CAN Interface.

Overview

The Controller Area network (CAN) HAL module provides a high-level API for CAN applications and
supports the CAN peripherals available on RA microcontroller hardware. A user-callback function
must be defined that the driver will invoke when transmit, receive or error interrupts are received.
The callback is passed a parameter which indicates the channel, mailbox and event as well as the
received data (if available).
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Features

Supports both standard (11-bit) and extended (29-bit) messaging formats

Supports speeds upto 1 Mbps

Support for bit timing configuration as defined in the CAN specification

Supports up to 32 transmit or receive mailboxes with standard or extended ID frames
Receive mailboxes can be configured to capture either data or remote CAN Frames

e Receive mailboxes can be configured to receive a range of IDs using mailbox masks

e Mailboxes can be configured with Overwrite or Overrun mode

e Supports a user-callback function when transmit, receive, or error interrupts are received

Configuration

Build Time Configurations for r_can

The following build time configurations are defined in fsp_cfg/r_can_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
Enable ¢ Enabled parameter checking is

* Disabled included in the build.

Configurations for Driver > Connectivity > CAN Driver on r_can

This module can be added to the Stacks tab via New Stack > Driver > Connectivity > CAN Driver on
r can:

Configuration Options Default Description
General > Name Name must be a valid g_canO Module name.
C symbol
General > Channel Value must be a non- 0 Specify the CAN
negative integer channel to use.
General > Clock Source e PCLKB CANMCLK Select the CAN clock
e CANMCLK source.

General > Sample- Value must be a non- 75 Sample-Point = (TSEG1

Point (%) negative integer. + 1)/ (TSEG1 + TSEG2
+ 1).

General > CAN Baud Value must be a non- 500000 Specify baud rate in

Rate (Hz) negative integer. Hz.

General > ¢ Overwrite Mode Overwrite Mode Select whether receive

Overwrite/Overrrun ¢ Overrrun Mode mailbox will be

Mode overwritten or overrun
if data is not read in
time.

General > Standard or e Standard ID Standard ID Mode Select whether the

Extended ID Mode Mode driver will use the CAN

¢ Extended ID standard or extended
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General > Number of
Mailboxes

Interrupts > Callback

Interrupts > Interrupt
Priority Level

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox 0 ID

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox 1 ID

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox 2 ID

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox 3 ID

Mode

¢ 4 Mailboxes
e 8 Mailboxes
e 16 Mailboxes
¢ 32 Mailboxes

Name must be a valid
C symbol

MCU Specific Options

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

32 Mailboxes

can_callback

IDs.

Select 4, 8, 16 or 32
mailboxes.

A user callback
function. If this callback
function is provided, it
is called from the
interrupt service
routine (ISR) each time
any interrupt occurs.

Error/Receive/Transmit
interrupt priority.

Select the receive ID
for mailbox 0, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 1, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 2, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 3, between
0 and Ox7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.
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Input > Mailbox 0-3
Group > Mailbox Type
> Mailbox 0 Type

Input > Mailbox 0-3
Group > Mailbox Type
> Mailbox 1 Type

Input > Mailbox 0-3
Group > Mailbox Type
> Mailbox 2 Type

Input > Mailbox 0-3
Group > Mailbox Type
> Mailbox 3 Type

Input > Mailbox 0-3
Group > Mailbox Frame
Type > Mailbox 0

e Receive
Mailbox

e Transmit
Mailbox

e Receive
Mailbox

e Transmit
Mailbox

e Receive
Mailbox

e Transmit
Mailbox

e Receive
Mailbox

e Transmit
Mailbox

¢ Data Mailbox
e Remote Mailbox

Transmit Mailbox

Receive Mailbox

Receive Mailbox

Receive Mailbox

Remote Mailbox

Select whether the
mailbox is used for
receive or transmit.

Select whether the
mailbox is used for
receive or transmit.

Select whether the
mailbox is used for
receive or transmit.

Select whether the
mailbox is used for
receive or transmit.

Select whether the
mailbox is used to
capture data frames or

Mar.25.20

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 0-3 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 1 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 0-3 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 2 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 0-3 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 3 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 0-3 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 0-3 or HEX integer of mailboxes 0-3.

Group Mask OX1FFFFFFF or less.

Input > Mailbox 4-7 Value must be decimal 4 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 4, between

Mailbox 4 ID Ox1FFFFFFF or less. 0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
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Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 5 ID

Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 6 ID

Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 7 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 5, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 6, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 7, between
0 and Ox7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Mar.25.20

Input > Mailbox 4-7 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 4 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 4-7 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 5 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 4-7 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 6 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 4-7 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 7 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 4-7 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 4 capture data frames or

Frame Type remote frames (ignored
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Input > Mailbox 4-7
Group > Mailbox Frame
Type > Mailbox 5
Frame Type

Input > Mailbox 4-7
Group > Mailbox Frame
Type > Mailbox 6
Frame Type

Input > Mailbox 4-7
Group > Mailbox Frame
Type > Mailbox 7
Frame Type

Input > Mailbox 4-7
Group > Mailbox 4-7
Group Mask

Input > Mailbox 8-11
Group > Mailbox ID >
Mailbox 8 ID

Input > Mailbox 8-11
Group > Mailbox ID >
Mailbox 9 ID

Input > Mailbox 8-11
Group > Mailbox ID >
Mailbox 10 ID

e Data Mailbox Data Mailbox

e Remote Mailbox

Remote Mailbox

Remote Mailbox

Value must be decimal Ox1FFFFFFF

or HEX integer of
OX1FFFFFFF or less.

Value must be decimal 8
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal 9
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal 10
or HEX integer of
Ox1FFFFFFF or less.

Data Mailbox Data Mailbox

Data Mailbox Data Mailbox

for transmit
mailboxes).

Select whether the
mailbox is used to
capture data frames or
remote frames (ignored
for transmit
mailboxes).

Select whether the
mailbox is used to
capture data frames or
remote frames (ignored
for transmit
mailboxes).

Select whether the
mailbox is used to
capture data frames or
remote frames (ignored
for transmit
mailboxes).

>Select the Mask for
mailboxes 4-7.

Select the receive ID
for mailbox 8, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 9, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 10,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.
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Select the receive ID
for mailbox 11,
between 0 and 0x7ff

Value must be decimal 11
or HEX integer of
Ox1FFFFFFF or less.

Input > Mailbox 8-11
Group > Mailbox ID >
Mailbox 11 ID

when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 8-11 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 8 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 8-11 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 9 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 8-11 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 10 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 8-11 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 11 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 8-11 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 8 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 8-11 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 9 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 8-11 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 10 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 8-11 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 11 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
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Input > Mailbox 8-11
Group > Mailbox 8-11
Group Mask

Input > Mailbox 12-15
Group > Mailbox ID >
Mailbox 12 ID

Input > Mailbox 12-15
Group > Mailbox ID >
Mailbox 13 ID

Input > Mailbox 12-15
Group > Mailbox ID >
Mailbox 14 ID

Input > Mailbox 12-15
Group > Mailbox ID >
Mailbox 15 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Ox1FFFFFFF

12

13

14

15

Select the Mask for
mailboxes 8-11.

Select the receive ID
for mailbox 12,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 13,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 14,
between 0 and 0x7ff
when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 15,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Mar.25.20

Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 12 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 13 Type e Transmit receive or transmit.
Mailbox
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Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 14 Type ¢ Transmit receive or transmit.

Mailbox

Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 15 Type e Transmit receive or transmit.

Mailbox

Input > Mailbox 12-15 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 12 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 12-15 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 13 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 12-15 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 14 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 12-15 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 15 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 12-15 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 12-15 or HEX integer of mailboxes 12-15.

Group Mask OX1FFFFFFF or less.

Input > Mailbox 16-19 Value must be decimal 16 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 16,

Mailbox 16 ID OX1FFFFFFF or less. between 0 and 0Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 16-19  Value must be decimal 17 Select the receive ID

Group > Mailbox ID >  or HEX integer of for mailbox 17,

Mailbox 17 ID OX1FFFFFFF or less. between 0 and 0x7ff
when using standard
IDs, between 0 and
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Input > Mailbox 16-19
Group > Mailbox ID >
Mailbox 18 ID

Input > Mailbox 16-19
Group > Mailbox ID >
Mailbox 19 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

18

19

OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 18,
between 0 and Ox7ff
when using standard
IDs, between 0 and
OXx1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 19,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Mar.25.20

Input > Mailbox 16-19 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 16 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 17 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 18 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 19 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 16 capture data frames or

Frame Type remote frames (ignored

for transmit
mailboxes).

Input > Mailbox 16-19 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 17 capture data frames or
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Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 18 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 19 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 16-19 or HEX integer of mailboxes 16-19.

Group Mask OX1FFFFFFF or less.

Input > Mailbox 20-23  Value must be decimal 20 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 20,

Mailbox 20 ID OX1FFFFFFF or less. between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 20-23  Value must be decimal 21 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 21,

Mailbox 21 ID OX1FFFFFFF or less. between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 20-23  Value must be decimal 22 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 22,

Mailbox 22 ID OX1FFFFFFF or less. between 0 and 0Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 20-23  Value must be decimal 23 Select the receive ID

Group > Mailbox ID >  or HEX integer of for mailbox 23,

Mailbox 23 ID OX1FFFFFFF or less. between 0 and 0x7ff
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IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Mar.25.20

Input > Mailbox 20-23 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 20 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 21 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 22 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 23 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 e Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 20 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 20-23 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 21 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 20-23 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 22 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 20-23 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 23 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 20-23  Value must be decimal Ox1FFFFFFF Select the Mask for
Group > Mailbox 20-23 or HEX integer of mailboxes 20-23
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Group Mask

Input > Mailbox 24-27
Group > Mailbox ID >
Mailbox 24 ID

Input > Mailbox 24-27
Group > Mailbox ID >
Mailbox 25 ID

Input > Mailbox 24-27
Group > Mailbox ID >
Mailbox 26 ID

Input > Mailbox 24-27
Group > Mailbox ID >
Mailbox 27 ID

Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

24

25

26

27

Select the receive ID
for mailbox 24,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 25,
between 0 and 0x7ff
when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 26,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 27,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Mar.25.20

Input > Mailbox 24-27 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 24 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 24-27 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 25 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 24-27 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for
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> Mailbox 26 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 24-27 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 27 Type e Transmit receive or transmit.

Mailbox

Input > Mailbox 24-27 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 24 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 24-27 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 25 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 24-27 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 26 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 24-27 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 27 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 24-27 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 24-27 or HEX integer of mailboxes 24-27.

Group Mask Ox1FFFFFFF or less.

Input > Mailbox 28-31 Value must be decimal 28 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 28,

Mailbox 28 ID OX1FFFFFFF or less. between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 28-31 Value must be decimal 29 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 29,

Mailbox 29 ID OX1FFFFFFF or less. between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
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Input > Mailbox 28-31
Group > Mailbox ID >
Mailbox 30 ID

Input > Mailbox 28-31
Group > Mailbox ID >
Mailbox 31 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

30

31

not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 30,
between 0 and 0x7ff
when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 31,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Mar.25.20

Input > Mailbox 28-31 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 28 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 28-31 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 29 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 28-31 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 30 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 28-31 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 31 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 28-31 e Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 28 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 28-31 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 29 capture data frames or
Frame Type remote frames (ignored
for transmit
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mailboxes).
Input > Mailbox 28-31 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 30 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 28-31 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 31 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 28-31 Value must be decimal Ox1FFFFFFF Select the Mask for
Group > Mailbox 28-31 or HEX integer of mailboxes 28-31.

Group Mask Ox1FFFFFFF or less.
Clock Configuration

The CAN peripheral uses the CANMCLK (main-clock oscillator) or PCLKB as its clock source (fCAN,
CAN System Clock.) Using the PCLKB with the default of 60 MHz and the default CAN configuration
will provide a CAN bit rate of 500 Kbit. To set the PCLKB frequency, use the clock configurator in e2
studio. To change the clock frequency at run-time, use the CGC Interface. Refer to the CGC module
guide for more information on configuring clocks.

* The user application must start the main-clock oscillator (CANMCLK or XTAL) at run-time
using the CGC Interface if it has not already started (for example, if it is not used as the
MCU clock source.)

e For RA6, RA4 and RA2 MCUs, the following clock restriction must be satisfied for the CAN
HAL module when the clock source is the main-clock oscillator (CANMCLK):

o fPCLKB >= fCANCLK (fCANCLK = XTAL / Baud Rate Prescaler)

e For RA6 and RA4 MCUs, the source of the peripheral module clocks must be PLL for the CAN
HAL module when the clock source is PCLKB.

e For RA4 MCUs, the clock frequency ratio of PCLKA and PCLKB must be 2:1 when using the
CAN HAL module. Operation is not guaranteed for other settings.

e For RA2 MCUs, the clock frequency ratio of ICLK and PCLKB must be 2:1 when using the
CAN HAL module. Operation is not guaranteed for other settings.

Pin Configuration
The CAN peripheral module uses pins on the MCU to communicate to external devices. I/O pins must

be selected and configured as required by the external device. A CAN channel would consist of two
pins - CRX and CTX for data transmission/reception.

Usage Notes

Bit Rate Calculation

The baudrate of the CAN peripheral is automatically set through the FSP configurator in e2 studio.
For more details on how the baudrate is set refer to section 37.4 "Data Transfer Rate Configuration"
of the RA6M3 User's Manual (RO1UH0886EJ0100).
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Examples

Basic Example

This is a basic example of minimal use of the CAN in an application.
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External Loop-back Test

This example requires a 120 Ohm resistor connected across channel 0 CAN pins. The mailbox
numbers are arbitrarily chosen.
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Function Documentation
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4 R_CAN_Open()

fsp_err_ t R_CAN Open ( can_ctrl_t *const p_api ctrl, can_cfg_t const *const p cfg )

Open and configure the CAN channel for operation.
Example:
/* Initialize the CAN nodul e */

err = R CAN Open(&g_canO _ctrl, &g _canO_cfQ);

Return values

FSP_SUCCESS Channel opened successfully
FSP_ERR_ALREADY_OPEN Driver already open.
FSP_ERR_CAN_INIT_FAILED Channel failed to initialize.
FSP_ERR_ASSERTION Null pointer presented.

4 R_CAN_Close()

fsp_err t R_CAN _Close ( can_ctrl_t *const p_api_ctrl)

Close the CAN channel.

Return values

FSP_SUCCESS Channel closed successfully.
FSP_ERR_NOT _OPEN Control block not open.
FSP_ERR_ASSERTION Null pointer presented.
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¢ R_CAN_Write()

fsp_err_t R_CAN_Write ( can_ctrl_t *const p_api_ctrl, uint32_t mailbox, can_frame_t *const
p_frame )

Write data to the CAN channel. Write up to eight bytes to the channel mailbox.
Example:
err = R CAN Wite(&g canO_ctrl, CAN MAI LBOX NUMBER 31, &g can_tx_frane);

handl e _error(err);

Return values

FSP_SUCCESS Operation succeeded.

FSP_ERR_NOT_OPEN Control block not open.

FSP_ERR_CAN_TRANSMIT_NOT_READY Transmit in progress, cannot write data at
this time.

FSP_ERR_CAN_RECEIVE_MAILBOX Mailbox is setup for receive and cannot
send.

FSP_ERR_INVALID ARGUMENT Data length or frame type invalid.

FSP_ERR_ASSERTION Null pointer presented

4 R_CAN_ModeTransition()

fsp_err t R_ CAN_ModeTransition ( can_ctrl_t *const p_api ctrl, can_operation_mode_t
operation_mode, can_test mode_t test mode )

CAN Mode Transition is used to change CAN driver state.
Example:
err = R CAN ModeTransition(& canO ctrl, operation_node, test_node);

handl e_error(err);

Return values

FSP_SUCCESS Operation succeeded.
FSP_ERR_NOT _OPEN Control block not open.
FSP_ERR_ASSERTION Null pointer presented
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¢ R_CAN_InfoGet()

fsp_err_ t R_CAN InfoGet ( can_ctrl_t *const p_api ctrl, can_info_t *const p_info )

Get CAN state and status information for the channel.

Return values

FSP_SUCCESS Operation succeeded.
FSP_ERR_NOT _OPEN Control block not open.
FSP_ERR_ASSERTION Null pointer presented

& R_CAN _VersionGet()

fsp_err_ t R_CAN_VersionGet ( fsp_version_t *const p_version)

Get CAN module code and API versions.

Return values

FSP_SUCCESS Operation succeeded.
FSP_ERR_ASSERTION Null pointer presented note This function is
reentrant.

5.2.7 Clock Generation Circuit (r_cgc)

Modules
Functions
fsp_err t R_CGC Open (cgc_ctrl t *const p_ctrl, cgc_cfg_t const *const p_cfg)
fsp_err t R _CGC ClocksCfg (cgc_ctrl_t *const p_ctrl, cgc_clocks cfg_t const
*const p_clock cfg)
fsp_err t R_CGC_ClockStart (cgc_ctrl_t *const p_ctrl, cgc_clock t clock source,
cgc_pll_cfg_t const *const p_pll_cfg)
fsp_err t R_CGC_ClockStop (cgc_ctrl_t *const p_ctrl, cgc_clock t clock source)
fsp_err t R_CGC_ClockCheck (cgc_ctrl_t *const p_ctrl, cgc_clock t
clock_source)
R11UMO0146EU0100 Revision 1.00 RLENESAS Page 267 / 1,444

Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Clock Generation Circuit (r_cgc)

fsp_err t R _CGC_SystemClockSet (cgc_ctrl_t *const p_ctrl, cgc_clock_t
clock _source, cgc_divider _cfg_t const *const p_divider_cfg)

fsp_err t R_CGC_SystemClockGet (cgc_ctrl_t *const p_ctrl, cgc_clock t *const
p_clock _source, cgc_divider_cfg t *const p_divider _cfqg)

fsp_err t R_CGC_OscStopDetectEnable (cgc_ctrl_t *const p_ctrl)
fsp_err t R_CGC_OscStopDetectDisable (cgc_ctrl_t *const p_ctrl)
fsp_err t R_CGC _OscStopStatusClear (cgc_ctrl_t *const p_ctrl)
fsp_err t R _CGC Close (cgc_ctrl_t *const p_ctrl)

fsp_err t R_CGC VersionGet (fsp_version_t *version)

Detailed Description
Driver for the CGC peripheral on RA MCUs. This module implements the CGC Interface.

Note
Thismoduleisnot required for theinitial clock configuration. Initial clock settings are configurable on the
Clocks tab of the configuration tool. The initial clock settings are applied by the BSP during the startup process
before main.

Overview

Features
The CGC module supports runtime modifications of clock settings. Key features include the following:

e Supports changing the system clock source to any of the following options (provided they
are supported on the MCU):
o High-speed on-chip oscillator (HOCO)
o Middle-speed on-chip oscillator (MOCO)
o Low-speed on-chip oscillator (LOCO)
o Main oscillator (external resonator or external clock input frequency)
o Sub-clock oscillator (external resonator)
PLL (not available on all MCUs)
¢ When the system core clock frequency changes, the following things are updated:
o The CMSIS standard global variable SystemCoreClock is updated to reflect the new
clock frequency.
o Wait states for ROM and RAM are adjusted to the minimum supported value for the
new clock frequency.
o The operating power control mode is updated to the minimum supported value for
the new clock settings.

o

e Supports starting or stopping any of the system clock sources
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e Supports changing dividers for the internal clocks

e Supports the oscillation stop detection feature
Internal Clocks

The RA microcontrollers have up to seven internal clocks. Not all internal clocks exist on all MCUs.
Each clock domain has its own divider that can be updated in R_CGC_SystemClockSet(). The dividers
are subject to constraints described in the footnote of the table "Specifications of the Clock
Generation Circuit for the internal clocks" in the hardware manual.

The internal clocks include:

e System clock (ICLK): core clock used for CPU, flash, internal SRAM, DTC, and DMAC

e PCLKA/PCLKB/PCLKC/PCLKD: Peripheral clocks, refer to the table "Specifications of the Clock
Generation Circuit for the internal clocks" in the hardware manual to see which peripherals
are controlled by which clocks.

e FCLK: Clock source for reading data flash and for programming/erasure of both code and
data flash.

e BCLK: External bus clock

Configuration

Note
Theinitial clock settings are configurable on the Clocks tab of the configuration tool.
There isa configuration to enable the HOCO on reset in the OF S settings on the BSP tab.
The following clock related settings are configurable in the RA Common section on the BSP tab:
o Main Oscillator Wait Time
o Main Oscillator Clock Source (external oscillator or crystal/resonator)
o Subclock Populated
Subclock Drive
Subclock Sabilization Time (ms)
The default stabilization times are determined based on devel opment boards provided by Renesas, but are
generally valid for most designs. Depending on the target board hardware configuration and requirements these
values may need to be adjusted for reliability or startup speed.

o

o

Build Time Configurations for r_cgc

The following build time configurations are defined in fsp_cfg/r_cgc_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > System > CGC Driver on r_cgc

This module can be added to the Stacks tab via New Stack > Driver > System > CGC Driver on
r cgc:
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Configuration Options Default Description
Name Name must be a valid g_cgcO Module name.
C symbol
NMI Callback Name must be a valid NULL A user callback
C symbol function must be

provided if oscillation
stop detection is used.
If this callback function
is provided, it is called
from the NMI handler if
the main oscillator
stops.

Clock Configuration

This module is used to configure the system clocks. There are no module specific clock
configurations required to use it.

Pin Configuration
The CGC module controls the output of the CLOCKOUT signal.

If an external oscillator is used the XTAL and EXTAL pins must be configured accordingly. When
running from an on chip oscillator there is no requirement for the main clock external oscillator. In
this case, the XTAL and EXTAL pins can be set to a different function in the configurator.

The functionality of the sub clock external oscillator pins XCIN and XCOUT is fixed.

Usage Notes
NMI Interrupt

The CGC timer uses the NMI for oscillation stop detection of the main oscillator after
R_CGC OscStopDetectEnable is called. The NMI is enabled by default. No special configuration is
required. When the NMI is triggered, the callback function registered during R_CGC_Open() is called.

Starting or Stopping the Subclock

If the Subclock Populated property is set to Populated on the BSP configuration tab, then the
subclock is started in the BSP startup routine. Otherwise, it is stopped in the BSP startup routine.
Starting and stopping the subclock at runtime is not recommended since the stabilization
requirements typically negate the negligible power savings.

The application is responsible for ensuring required clocks are started and stable before accessing
MCU peripheral registers.

Warning
The subclock can take up to several seconds to stabilize. RA startup code does not wait for
subclock stabilization unless the subclock is the main clock source. In this case the default
wait time is 1000ms (1 second). When running AGT or RTC off the subclock, the application
must ensure the subclock is stable before starting operation. Because there is no hardware
stabilization status bit for the subclock R_CGC_ClockCheck cannot be used to optimize this
wait.
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Changing the subclock state during R_CGC_ClocksCfg() is not supported.
Low Power Operation

If "Use Low Voltage Mode" is enabled in the BSP MCU specific properties (not available on all MCUs),
the MCU is always in low voltage mode and no other power modes are considered. The following
conditions must be met for the MCU to run in low voltage mode:

e Requires HOCO to be running, so HOCO cannot be stopped in low voltage mode

e Requires PLL to be stopped, so PLL APIs are not available in low voltage mode

e Requires ICLK <= 4 MHz

* |f oscillation stop detection is used, dividers of 1 or 2 cannot be used for any clock

If "Use Low Voltage Mode" is not enabled, the MCU applies the lowest power mode by searching
through the following list in order and applying the first power mode that is supported under the
current conditions:

e Subosc-speed mode (lowest power)
o Requires system clock to be LOCO or subclock
o Requires MOCO, HOCO, main oscillator, and PLL (if present) to be stopped
o Requires ICLK and FCLK dividers to be 1
Low-speed mode
o Requires PLL to be stopped
o Requires ICLK <=1 MHz
o If oscillation stop detection is used, dividers of 1, 2, 4, or 8 cannot be used for any
clock
Middle-speed mode (not supported on all MCUs)
o Requires ICLK <= 8 MHz
e High-speed mode
o Default mode if no other operating mode is supported

Refer to the section "Function for Lower Operating Power Consumption" in the "Low Power Modes"
chapter of the hardware manual for MCU specific information about operating power control modes.

When low voltage mode is not used, the following functions adjust the operating power control mode
to ensure it remains within the hardware specification and to ensure the MCU is running at the
optimal operating power control mode:

e R_CGC_ClockStart()
R_CGC_ClockStop()
R_CGC_SystemClockSet()
R_CGC_OscStopDetectEnable()
¢ R_CGC_OscStopDetectDisable()

Note
FSP APIs, including these APIs, are not thread safe. These APIs and any other user code that modifies the
operating power control mode must not be allowed to interrupt each other. Proper care must be taken during
application design if these APIs are used in threads or interrupts to ensure this constraint is met.

No action is required by the user of these APIs. This section is provided for informational purposes
only.

Examples
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Basic Example

This is a basic example of minimal use of the CGC in an application.
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Configuring Multiple Clocks

This example demonstrates switching to a new source clock and stopping the previous source clock
in a single function call using R_CGC_ClocksCfg().
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cl ocks_cfg. divider cfg.pclkc_div CGC _SYS CLOCK DIV_4;

CGC_SYS_CLOCK_DI V_4;

cl ocks_cfg. divider cfg.pclkd div
cl ocks_cfg.divider_cfg.bclk div = CGC_SYS CLOCK DIV_4;

cl ocks_cfg.divider cfg.fclk div CGC_SYS CLOCK DIV_4;

CGC_CLOCK_CHANGE_NONE;

cl ocks_cfg. mai nosc_state

cl ocks_cfg. hoco_state CGC_CLOCK_CHANGE _START;

cl ocks_cfg. noco_state CGC _CLOCK _CHANGE _STOR;

cl ocks_cfg.loco_state CGC_CLOCK CHANGE NONE;
err = R CGC O ocksCfg(&y_cgcO ctrl, &cl ocks_cfg);
handl e_error(err);
#i f BSP_FEATURE_CGC HAS PLL
/* Assum ng the systemclock is HOCO switch to PLL running frommain oscillator and

stop MOCO. */

cl ocks_cfg. system cl ock CGC CLOCK PLL;

cl ocks_cfg.pll_state CGC_CLOCK_CHANGE_START;

cl ocks_cfg.pll _cfg.source_cl ock CGC _CLOCK_NMAI N _OsCG;

(cgc_pll _mul t) BSP_CFG PLL_MJUL;

clocks cfg.pll _cfg.multiplier

cl ocks_cfg.pll _cfg.divider (cgc_pll _div_t) BSP_CFG PLL_DlV;

cl ocks_cfg.divider cfg.iclk div CGC _SYS CLOCK DIV_1;

cl ocks_cfg. divider cfg.pclka_div CGC_SYS CLOCK DIV_4;

cl ocks_cfg. divider_cfg.pclkb_div CGC_SYS CLOCK DIV _4;

cl ocks_cfg. divider cfg.pclkc_div CGC _SYS CLOCK DIV_4;

CGC_SYS_CLOCK_DI V_4;

cl ocks_cfg. divider cfg.pclkd div

cl ocks_cfg.divider_cfg.bclk _div CGC_SYS CLOCK DIV _4;

cl ocks_cfg.divider cfg.fclk div CGC _SYS CLOCK DIV_4;

CGC_CLOCK_CHANGE_START;

cl ocks_cfg. mai nosc_state

cl ocks_cfg. hoco_state CGC_CLOCK_CHANGE_STOP;

cl ocks_cfg. noco_state CGC_CLOCK_ CHANGE NONE;

cl ocks_cfg.loco_state CGC_CLOCK CHANGE NONE;
err = R CGC O ocksCfg(&y_cgcO ctrl, &cl ocks_cfg);

handl e_error(err);

#endi f
}
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Oscillation Stop Detection

This example demonstrates registering a callback for oscillation stop detection of the main oscillator.

/* Exanpl e cal |l back called when oscillation stop is detected. */
voi d oscillation_stop_callback (cgc_call back_args_t * p_args)
{
FSP_PARAVETER NOT USED(p_args);
fsp_err_t err = FSP_SUCCESS;
/* (Optional) If the MCU was running on the main oscillator, the MCU is now runni ng
on MOCO. Switch clocks if
* desired. This exanple shows switching to HOCO */
err = R CGC C ockStart(&g_cgcO_ctrl, CGC CLOCK HOCC, NULL);
handl e _error(err);
do
{
/* Wait for HOCO to stabilize. */
err = R CGC _C ockCheck(&g cgcO_ctrl, CGC_CLOCK HOCC);
} while (FSP_SUCCESS != err);

cgc_divider _cfg t dividers =

{
.pcl kb_div = CGC_SYS CLOCK DIV_4,
.pclkd div = CGC _SYS CLOCK DI V_4,
.iclk _div = CGC_SYS CLOCK DI V_1,
.pcl ka_div = CGC_SYS _CLOCK DI V_4,
.pclkc_div = CGC_SYS CLOCK DI V_4,
.fclk _div = CGC_SYS CLOCK DI V_4,
.bclk_div = CGC_SYS CLOCK DI V_4,

i

err = R CGC _SystenCl ockSet (& _cgcO_ctrl, CGC CLOCK HOCC, &dividers);
handl e_error(err);
#i f BSP_FEATURE_CGC HAS PLL
/* (Optional) If the MCU was running on the PLL, the PLL is now in free-running
node. Switch cl ocks if
* desired. This exanple shows switching to the PLL runni ng on HOCO. */
err = R CGC O ockStart (& cgcO _ctrl, CGC CLOCK HOCC, NULL);
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* oscillator and if the main oscillator is stable again. */
err = R CGC OscStopStatusC ear (&g _cgcO_ctrl);
handl e_error(err);
}
voi d cgc_osc_stop_exanpl e (void)
{
fsp_err_t err = FSP_SUCCESS;
/* Open the nodule. */
err = R CGC Open(&g_cgcO _ctrl, &g cgcO_cfqQ);
/* Handl e any errors. This function should be defined by the user. */
handl e _error(err);
/* Enable oscillation stop detection. The main oscillator nust be running at this
poi nt. */
err = R CGC OscSt opDet ect Enabl e(&g cgcO_ctrl);
handl e_error(err);
/* (Optional) Gscillation stop detection nust be disabl ed before entering any | ow
power node. */
err = R CGC _OscSt opDet ect Di sabl e(&g_cgcO_ctrl);
handl e_error(err);
__WFI();
/* (Optional) Reenable oscillation stop detection after waking from| ow power node.
*/
err = R CGC OscSt opDet ect Enabl e(&g cgcO_ctrl);

handl e_error(err);

Data Structures

struct cgc_instance_ctrl t

Data Structure Documentation

& cgc_instance_ctrl_t

struct cgc_instance_ctrl_t

CGC private control block. DO NOT MODIFY. Initialization occurs when R_CGC_Open() is called.
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Function Documentation

4 R_CGC_Open()

fsp_err t R_CGC Open ( cgc_ctrl_t *const p_ctrl, cgc_cfg_t const *const p cfg )

Initialize the CGC API. Implements cgc_api_t::open.
Example:
/* Initializes the CGC nodule. */

err = R CGC _Open(&g_cgcO _ctrl, &g cgcO_cfqQ);

Return values

FSP_SUCCESS CGC successfully initialized.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_ALREADY_OPEN Module is already open.

¢ R_CGC_ClocksCfg()

fsp_err t R_CGC_ClocksCfg ( cgc_ctrl_t *const p_ctrl, cgc_clocks cfg t const *const p clock cfg )

Reconfigures all main system clocks. This API can be used for any of the following purposes:

e start or stop clocks

* change the system clock source

e configure the PLL multiplication and division ratios when starting the PLL
e change the system dividers

If the requested system clock source has a stabilization flag, this function blocks waiting for the
stabilization flag of the requested system clock source to be set. If the requested system clock
source was just started and it has no stabilization flag, this function blocks for the stabilization time
required by the requested system clock source according to the Electrical Characteristics section of
the hardware manual. If the requested system clock source has no stabilization flag and it is
already running, it is assumed to be stable and this function will not block. If the requested system
clock is the subclock, the subclock must be stable prior to calling this function.

The internal dividers (cgc_clocks cfg_t::divider_cfg) are subject to constraints described in
footnotes of the hardware manual table detailing specifications for the clock generation circuit for
the internal clocks for the MCU. For example:

¢ RA6M3: see footnotes of Table 9.2 "Specifications of the clock generation circuit for the
internal clocks" in the RA6M3 manual ROIUHO0886EJ0100

* RA2A1: see footnotes of Table 9.2 "Clock generation circuit specifications for the internal
clocks" in the RA2A1 manual RO1IUHO0888E)J0100

Do not attempt to stop the requested clock source or the source of the PLL if the PLL will be
running after this operation completes.

Implements cgc_api_t::clocksCfg.

Example:
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/* Assumi ng the system cl ock is MOCO,

cgc_clocks cfg t clocks cfg;

cl ocks_cfg.system cl ock

cl ocks_cfg.pll_state

cl ocks_cfg.pll _cfg.source_cl ock

clocks_cfg.pll_cfg.multiplier =

cl ocks_cfg. pll_cfg.divider =

cl ocks_cfg.divider cfg.iclk div =

cl ocks_cfg. divider_cfg.pclka_ div =

cl ocks_cfg. divider cfg.pclkb_div

cl ocks_cfg. divider cfg.pclkc _div

cl ocks_cfg. divider_cfg.pclkd div =

cl ocks_cfg. divider cfg.bclk div

fclk div

cl ocks_cfg. divider cfg.

cl ocks_cfg. mai nosc_state =

cl ocks_cfg. hoco_state

cl ocks_cfg.noco_state

clocks _cfg.loco_state
err =

handl e _error(err);

Return values

R CGC O ocksCfg(&g _cgcO _ctrl,

switch to HOCO. */

OGC_CLOCK_PLL;
OGC_CLOCK_CHANGE_NONE;

CGC _CLOCK _MAIN CsSC; // wunused
CGC_PLL_MJL_10_0; /1 unused
CGC PLL DIV _2; /'l unused

CGC_SYS_CLOCK DI V_1;

CGC_SYS CLOCK DI V._4;
CGC_SYS_CLOCK DI V._4;
CGC_SYS CLOCK DI V_4;
CGC_SYS CLOCK DI V._4;

CGC_SYS CLOCK DI V._4;
CGC_SYS_CLOCK DI V_4;

CGC_CLOCK_CHANGE_NONE;
CGC_CLOCK_CHANGE_START;
CGC_CLOCK_CHANGE_STOP;
CGC_CLOCK_CHANGE_NONE;

&cl ocks_cfg);

FSP_SUCCESS

Clock configuration applied successfully.

FSP_ERR_ASSERTION

Invalid input argument.

FSP_ERR_NOT_OPEN

Module is not open.

FSP_ERR_IN_USE

Attempt to stop the current system clock or
the PLL source clock.

FSP_ERR_CLOCK_ACTIVE

PLL configuration cannot be changed while
PLL is running.

FSP_ERR_OSC_STOP_DET_ENABLED

PLL multiplier must be less than 20 if
oscillation stop detect is enabled and the
input frequency is less than 12.5 MHz.

FSP_ERR_NOT_STABILIZED

PLL clock source is not stable.

FSP_ERR_PLL_SRC_INACTIVE

PLL clock source is not running.
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4 R_CGC_ClockStart()

fsp_err t R_CGC_ClockStart ( cgc_ctrl_t *const p _ctrl, cgc_clock t clock source, cgc_pll_cfg t const
*const p pll cfg )

Start the specified clock if it is not currently active. The PLL configuration cannot be changed while
the PLL is running. Implements cgc_api_t::clockStart.

The PLL source clock must be operating and stable prior to starting the PLL.
Example:
/[* Start the LOCO */

err = R CGC C ockStart(&g_cgcO ctrl, CGC CLOCK LOCC, NULL);

handl e_error(err);

Return values

FSP_SUCCESS Clock initialized successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.
FSP_ERR_NOT_STABILIZED The clock source is not stabilized after being
turned off or PLL clock source is not stable.
FSP_ERR_PLL SRC _INACTIVE PLL clock source is not running.
FSP_ERR_CLOCK_ ACTIVE PLL configuration cannot be changed while
PLL is running.
FSP_ERR_OSC_STOP_DET_ENABLED PLL multiplier must be less than 20 if

oscillation stop detect is enabled and the
input frequency is less than 12.5 MHz.
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4 R_CGC_ClockStop()

fsp_err t R_CGC_ClockStop ( cgc_ctrl_t *const p_ctrl, cgc_clock t clock source )

Stop the specified clock if it is active. Implements cgc_api_t::clockStop.

Do not attempt to stop the current system clock source. Do not attempt to stop the source clock of
the PLL if the PLL is running.

Return values

FSP_SUCCESS Clock stopped successfully.

FSP_ERR_ASSERTION Invalid input argument.

FSP_ERR_NOT _OPEN Module is not open.

FSP_ERR_IN_USE Attempt to stop the current system clock or
the PLL source clock.

FSP_ERR_OSC STOP_DET ENABLED Attempt to stop MOCO when Oscillation stop
is enabled.

FSP_ERR_NOT_STABILIZED Clock not stabilized after starting.

4 R_CGC_ClockCheck()

fsp_err t R_CGC_ClockCheck ( cgc_ctrl_t *const p_ctrl, cgc_clock t clock source )

Check the specified clock for stability. Implements cgc_api_t::clockCheck.

Return values
FSP_SUCCESS Clock is running and stable.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT _OPEN Module is not open.
FSP_ERR_NOT_STABILIZED Clock not stabilized.
FSP_ERR_CLOCK_ INACTIVE Clock not turned on.
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4 R_CGC_SystemClockSet()

fsp_err_ t R_CGC_SystemClockSet ( cgc_ctrl t *const p ctrl, cgc_clock t clock source,
cgc_divider _cfg_t const *const p_divider cfg )

Set the specified clock as the system clock and configure the internal dividers for ICLK, PCLKA,
PCLKB, PCLKC, PCLKD, BCLK, and FCLK. Implements cgc_api_t::systemClockSet.

The requested clock source must be running and stable prior to calling this function. The internal
dividers are subject to constraints described in the hardware manual table "Specifications of the
Clock Generation Circuit for the internal clocks".

The internal dividers (p_divider_cfg) are subject to constraints described in footnotes of the
hardware manual table detailing specifications for the clock generation circuit for the internal
clocks for the MCU. For example:

e RA6M3: see footnotes of Table 9.2 "Specifications of the clock generation circuit for the
internal clocks" in the RA6M3 manual ROLUH0886EJ0100

e RA2A1: see footnotes of Table 9.2 "Clock generation circuit specifications for the internal
clocks" in the RA2A1 manual RO1UH0888E)J0100

This function also updates the RAM and ROM wait states, the operating power control mode, and
the SystemCoreClock CMSIS global variable.

Example:
/* Set divisors. Divisors for clocks that don't exist on the MCU are ignored. */
cgc_divider_cfg t dividers =
{

/* PCLKB is not used in this application, so select the maxi num divisor for |owest
power. */

.pcl kb _div = CGC _SYS CLOCK DI V_64,
/* PCLKD is not used in this application, so select the maxi num divisor for |owest
power. */

.pcl kd _div = CGC_SYS CLOCK DI V_64,
/* ICLK is the MCU clock, allowit to run as fast as the LOCO is capable. */

.iclk_div = CGC_SYS_CLOCK DI V_1,
/* These cl ocks do not exist on sone devices. |f any clocks don't exist, set the
di vider to 1. */

.pclka_div = CGC _SYS CLOCK DI V_1,

.pclkc_div = CGC _SYS CLOCK DIV_1,
.fclk _div = CGC_SYS CLOCK DI V_1,
.bclk div = CGC_SYS CLOCK DI V_1,

1
/* Switch the systemclock to LOCO */
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err = R CGC Syst entl ockSet (& cgcO ctrl, CGC CLOCK LOCC, &dividers);

handl e _error(err);

Return values

FSP_SUCCESS Operation performed successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.

FSP_ERR_CLOCK INACTIVE The specified clock source is inactive.
FSP_ERR_NOT_STABILIZED The clock source has not stabilized

4 R_CGC_SystemClockGet()

fsp_err t R_CGC_SystemClockGet ( cgc_ctrl _t *const p_ctrl, cgc_clock_t *const p_clock source,
cgc_divider _cfg_t *const p_divider cfg )

Return the current system clock source and configuration. Implements cgc_api_t::systemClockGet.

Return values

FSP_SUCCESS Parameters returned successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.
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4 R_CGC_OscStopDetectEnable()

fsp_err t R_CGC_OscStopDetectEnable ( cgc_ctrl _t *const p_ctrl)

Enable the oscillation stop detection for the main clock. Implements
cgc_api_t::oscStopDetectEnable.

The MCU will automatically switch the system clock to MOCO when a stop is detected if Main Clock
is the system clock. If the system clock is the PLL, then the clock source will not be changed and
the PLL free running frequency will be the system clock frequency.

Example:

/* Enable oscillation stop detection. The main oscillator nmust be running at this
poi nt. */

err = R CGC OscSt opDet ect Enabl e(&g cgcO_ctrl);

handl e _error(err);

Return values

FSP_SUCCESS Operation performed successfully.

FSP_ERR_ASSERTION Invalid input argument.

FSP_ERR_NOT _OPEN Module is not open.

FSP_ERR_LOW _ VOLTAGE_MODE Settings not allowed in low voltage mode.
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& R_CGC_OscStopDetectDisable()

fsp_err_ t R_CGC_OscStopDetectDisable ( cgc_ctrl_t *const p_ctrl)

Disable the oscillation stop detection for the main clock. Implements
cgc_api_t::oscStopDetectDisable.

Example:
/* (Optional) Gscillation stop detection nust be disabled before entering any | ow
power node. */

err = R CGC _OscStopDet ect Di sabl e(&g_cgcO_ctrl);

handl e_error(err);

__WFI();

Return values

FSP_SUCCESS Operation performed successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.

FSP_ERR_OSC STOP DETECTED The Oscillation stop detect status flag is set.

Under this condition it is not possible to
disable the Oscillation stop detection
function.
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¢ R_CGC_OscStopStatusClear()

fsp_err_ t R_CGC_OscStopStatusClear ( cgc_ctrl_t *const p_ctrl)

Clear the Oscillation Stop Detection Status register. This register is not cleared automatically if the
stopped clock is restarted. Implements cgc_api_t::oscStopStatusClear.

After clearing the status, oscillation stop detection is no longer enabled.

This register cannot be cleared while the main oscillator is the system clock or the PLL source
clock.

Example:
/* (Optional) Clear the error flag. Only clear this flag after switching the MCU
cl ock source away fromthe main
* oscillator and if the main oscillator is stable again. */
err = R CGC OCscStopStatusC ear(&g_cgcO_ctrl);

handl e_error(err);

Return values

FSP_SUCCESS Operation performed successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.
FSP_ERR_CLOCK_INACTIVE Main oscillator must be running to clear the
oscillation stop detection flag.
FSP_ERR_OSC_STOP_CLOCK_ACTIVE The Oscillation Detect Status flag cannot be

cleared if the Main Osc or PLL is set as the
system clock. Change the system clock
before attempting to clear this bit.

FSP_ERR_INVALID_HW_CONDITION Oscillation stop status was not cleared.
Check preconditions and try again.

4 R_CGC _Close()

fsp_err t R_ CGC Close ( cgc_ctrl_t *const p_ctrl)

Closes the CGC module. Implements cgc_api_t::close.

Return values

FSP_SUCCESS The module is successfully closed.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT _OPEN Module is not open.
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& R_CGC_VersionGet()

fsp_err_ t R_CGC VersionGet ( fsp_version_t *const p_version)

Return the driver version. Implements cgc_api_t::versionGet.

Return values

FSP_SUCCESS Module version provided in p_version.

FSP_ERR_ASSERTION Invalid input argument.

5.2.8 Cyclic Redundancy Check (CRC) Calculator (r_crc)

Modules

Functions

fsp_err t R_CRC_Open (crc_ctrl_t *const p_ctrl, crc_cfg_t const *const p_cfg)
fsp_err t R _CRC Close (crc_ctrl_t *const p_ctrl)

fsp_err t R_CRC_Calculate (crc_ctrl_t *const p_ctrl, crc_input_t *const
p_crc_input, uint32_t *calculatedValue)

fsp_err t R_CRC_CalculatedValueGet (crc_ctrl_t *const p_ctrl, uint32_t
*calculatedValue)

fsp_err t R_CRC_SnoopEnable (crc_ctrl_t *const p_ctrl, uint32_t crc_seed)
fsp_err t R_CRC_SnoopDisable (crc_ctrl_t *const p_ctrl)

fsp_err t R _CRC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the CRC peripheral on RA MCUs. This module implements the CRC Interface.

Overview

The CRC module provides a API to calculate 8, 16 and 32-bit CRC values on a block of data in
memory or a stream of data over a Serial Communication Interface (SCI) channel using industry-
standard polynomials.

Features
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e CRC module supports the following 8 and 16 bit CRC polynomials which operates on 8-bit
data in parallel
o X~8+X"2+X+1 (CRC-8)
o X*16+X"15+X"2+1 (CRC-16)
o X*16+X"12+X"5+1 (CRC-CCITT)
e CRC module supports the following 32 bit CRC polynomials which operates on 32-bit data in
parallel
o XN324+XN26+X"N234 X224+ XN 164+ XN 124X 114+ XN 104+ XN 8+ XN T+ X5+ X4+ X
~2+X+ 1 (CRC-32)
o X™324+ X728+ X727+ X726+ X725+ X723+ X722+ X720+ X~ 19+
XM184+ XN 144 XN 134X 114X 104X 9+ X8+ X" 6+1 (CRC-32C)
¢ CRC module can calculate CRC with LSB first or MSB first bit order.

Configuration

Build Time Configurations for r_crc

The following build time configurations are defined in fsp_cfg/r_crc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Monitoring > CRC Driver on r_crc

This module can be added to the Stacks tab via New Stack > Driver > Monitoring > CRC Driver on
r crc:

Configuration Options Default Description
Name Name must be a valid g_crcO Module name.
C symbol
CRC Polynomial e CRC-8 CRC-32C Select the CRC
e CRC-16 polynomial.
e CRC-CCITT
e CRC-32
e CRC-32C
Bit Order e LSB MSB Select the CRC bit
e MSB order.
Snoop Address Refer to the RA NONE Select the SCI register
Configuration tool for address CRC snoop

available options.
Clock Configuration

There is no clock configuration for the CRC module.
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Pin Configuration

This module does not use I/O pins.

Usage Notes
CRC Snoop

The CRC snoop function monitors reads from and writes to a specified I/O register address and
performs CRC calculation on the data read from and written to the register address automatically.
Instead of calling R_CRC_Calculate on a block of data, R_ CRC_SnoopEnable is called to start
monitoring reads/writes and R_CRC_CalculatedValueGet is used to obtain the current CRC.

Note
Shoop mode is available for transmit/receive operations on SCI only.

Limitations

When using CRC32 polynomial functions the CRC module produces the same results as popular
online CRC32 calculators, but it is important to remember a few important points.

e Online CRC32 calculators allow the input to be any number of bytes. The FSP CRC32 API
function uses 32-bit words. This means the online calculations must be 'padded' to end on a
32-bit boundary.

e Online CRC32 calculators usually invert the output prior to presenting it as a result. It is up
to the application program to include this step if needed.

e The seed value of OXFFFFFFFF needs to be used by both the online calculator and the
R_CRC module API (CRC32 polynomials)

» Make sure the bit orientation of the R_CRC CRC32 is set for LSB and that you have CRC32
selected and not CRC32C.

e Some online CRC tools XOR the final result with OxFFFFFFFF.

Examples

Basic Example

This is a basic example of minimal use of the CRC module in an application.

void crc_exanple ()
{
uint32_t |ength;
uint32_t uint8 cal cul ated_val ue;
| ength = sizeof (g _data 8bit) / sizeof (g data 8bit[0]);

crc_input _t exanple_ input =

{
.p_input_buffer = g data 8bit,
. num byt es = | engt h,
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.crc_seed = 0,
i
/* Open CRC nodule with 8 bit polynom al */
R CRC Open(&crc_ctrl, &g crc_test cfg);
/* 8-bit CRC cal culation */

R CRC Cal cul ate(&crc_ctrl, &exanple_input, &uint8 cal cul ated_val ue);

Snoop Example

This example demonstrates CRC snoop operation.

voi d crc_snoop_exanpl e ()

{

/* Open CRC nodule with 8 bit polynom al */

R CRC Open(&crc_ctrl, &g crc_test cfg);

/* Open SCI Driver */

/* Configure Snoop address and enabl e snoop node */

R _CRC _SnoopEnabl e(&crc_ctrl, 0);

/* Perfrom SCl read/ Wite operation depending on the SCI snoop address configure */
/* Read CRC val ue */

R CRC Cal cul at edVal ueGet (&crc_ctrl, &g crc_buff);

Data Structures

struct crc_instance_ctrl_t

Data Structure Documentation

¢ crc_instance_ctrl_t

struct crc_instance_ctrl_t

Driver instance control structure.

Function Documentation
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4 R_CRC_Open()

fsp_err t R_CRC_Open ( crc_ctrl_t *const p ctrl, crc_cfg t const *const p cfg )

Open the CRC driver module
Implements crc_api_t::open

Open the CRC driver module and initialize the driver control block according to the passed-in
configuration structure.

Return values

FSP_SUCCESS Configuration was successful.
FSP_ERR_ASSERTION p_ctrl or p_cfg is NULL.
FSP_ERR_ALREADY_OPEN Module already open

4 R_CRC_Close()

fsp_err t R_CRC Close ( crc_ctrl_t *const p_ctrl)

Close the CRC module driver.

Implements crc_api_t::close

Return values

FSP_SUCCESS Configuration was successful.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN The driver is not opened.
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4 R_CRC_Calculate()

fsp_err_ t R_CRC_Calculate ( crc_ctrl_t *const p_ctrl, crc_input_t *const p_crc_input, uint32 t*
calculatedValue )

Perform a CRC calculation on a block of 8-bit/32-bit(for 32-bit polynomial) data.

Implements crc_api_t::calculate

This function performs a CRC calculation on an array of 8-bit/32-bit(for 32-bit polynomial) values
and returns an 8-bit/32-bit(for 32-bit polynomial) calculated value

Return values

FSP_SUCCESS Calculation successful.

FSP_ERR_ASSERTION Either p_ctrl, inputBuffer, or calculatedValue
is NULL.

FSP_ERR_INVALID_ARGUMENT length value is NULL.

FSP_ERR_NOT _OPEN The driver is not opened.

¢ R_CRC_CalculatedValueGet()

fsp_err_ t R_CRC_CalculatedValueGet ( crc_ctrl _t *const p_ctrl, uint32_t * calculatedValue )

Return the current calculated value.
Implements crc_api_t::crcResultGet

CRC calculation operates on a running value. This function returns the current calculated value.

Return values

FSP_SUCCESS Return of calculated value successful.
FSP_ERR_ASSERTION Either p_ctrl or calculatedValue is NULL.
FSP_ERR_NOT_OPEN The driver is not opened.
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4 R_CRC_SnoopEnable()

fsp_err_t R_CRC_SnoopEnable ( crc_ctrl_t *const p_ctr/, uint32_t crc seed )

Configure the snoop channel and set the CRC seed.
Implements crc_api_t::snoopEnable

The CRC calculator can operate on reads and writes over any of the first ten SCI channels. For
example, if set to channel 0, transmit, every byte written out SCI channel 0 is also sent to the CRC
calculator as if the value was explicitly written directly to the CRC calculator.

Return values

FSP_SUCCESS Snoop configured successfully.
FSP_ERR_ASSERTION Pointer to control stucture is NULL
FSP_ERR_NOT_OPEN The driver is not opened.

4 R_CRC_SnoopDisable()

fsp_err_ t R_CRC_SnoopDisable ( crc_ctrl_t *const p_ctrl)

Disable snooping.

Implements crc_api_t::snoopDisable

Return values

FSP_SUCCESS Snoop disabled.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN The driver is not opened.

¢ R_CRC VersionGet()

fsp_err_ t R_CRC_VersionGet ( fsp_version_t *const p_version)

Get the driver version based on compile time macros.

Implements crc_api_t::versionGet

Return values

FSP_SUCCESS Successful close.
FSP_ERR_ASSERTION p_version is NULL.
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5.2.9 Capacitive Touch Sensing Unit (r_ctsu)
Modules

Functions

fsp_err t R _CTSU Open (ctsu_ctrl_t *const p_ctrl, ctsu_cfg_t const *const
p_cfg)

Opens and configures the CTSU driver module. Implements
ctsu_api_t::open. More...

fsp_err t R_CTSU_ScanStart (ctsu_ctrl_t *const p_ctrl)

This function should be called each time a periodic timer expires. If
initial offset tuning is enabled, The first several calls are used to
tuning for the sensors. Before starting the next scan, first get the
data with R_CTSU_DataGet(). If a different control block scan should
be run, check the scan is complete before executing. Implements
ctsu_api_t::scanStart. More...

fsp_err t R _CTSU DataGet (ctsu_ctrl t *const p_ctrl, uintl6 t *p data)

This function gets the sensor values as scanned by the CTSU. If initial
offset tuning is enabled, The first several calls are used to tuning for
the sensors. Implements ctsu_api_t::dataGet. More...

fsp_err t R_CTSU Close (ctsu_ctrl_t *const p_ctrl)

Disables specified CTSU control block. Implements ctsu_api_t::close.
More...

fsp_err t R_CTSU VersionGet (fsp_version_t *const p_version)

Return CTSU HAL driver version. Implements ctsu_api_t::versionGet.
More...

Detailed Description

This HAL driver supports the Capacitive Touch Sensing Unit (CTSU). It implements the CTSU Interface

Overview

The capacitive touch sensing unit HAL driver (r_ctsu) provides an API to control the CTSU/CTSU2
peripheral. This driver performs capacitance measurement based on various settings defined by the
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configuration.

Features

Supports both Self-capacitance multi scan mode and Mutual-capacitance full scan mode
e Scans may be started by software or an external trigger

e Returns measured capacitance data on scan completion

e Optional DTC support

Configuration

Note
Thismoduleis configured via the QE for Capacitive Touch tuning tool.

Build Time Configurations for r_ctsu

The following build time configurations are defined in fsp_cfg/r_ctsu_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Support for using DTC e Enabled Disabled If enabled, DTC
e Disabled instances will be

included in the build for
both transmission and
reception.

Interrupt priority level  MCU Specific Options Priority level of all
CTSU interrupt (CSTU_
WR,CTSU_RD,CTSU_FN)

Configurations for Driver > CapTouch > CTSU Driver on r_ctsu

This module can be added to the Stacks tab via New Stack > Driver > CapTouch > CTSU Driver on
r_ctsu:

Configuration Options Default Description
General > Name Name must be a valid g _ctsu0 Module name.
C symbol
Scan Start Trigger MCU Specific Options CTSU Scan Start

Trigger Select
Interrupt Configuration
The first R_CTSU_Open function call sets CTSU peripheral interrupts. The user should provide a

callback function to be invoked at the end of the CTSU scan sequence. The callback argument will
contain information about the scan status.
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Clock Configuration

The CTSU peripheral module uses PCLKB as its clock source. You can set the PCLKB frequency using
the clock configurator in e2 studio or by using the CGC Interface at run-time.

Note
The CTSU Drive pulse will be calculated and set by the tooling depending on the selected transfer rate.

Pin Configuration
The TSn pins are sensor pins for the CTSU.

The TSCAP pin is used for an internal low-pass filter and must be connected to an external
decoupling capacitor.

Usage Notes

CTSU

Self-capacitance multi scan mode

In self-capacitance mode each TS pin is assigned to one touch button. Electrodes of multiple TS pins
can be physically aligned to create slider or wheel interfaces.

e Scan Order
o The hardware scans the specified pins in ascending order.
o For example, if pins TS05, TS08, TS02, TS03, and TS06 are specified in your
application, the hardware will scan them in the order TS02, TS03, TS05, TSO06,
TSO08.
e Element
o An element refers to the index of a pin within the scan order. Using the previous
example, TSO5 is element 2.
e Scan Time
o Scanning is handled directly by the CTSU peripheral and does not utilize any main
processor time.
o It takes approximately 500us to scan a single sensor.
o If DTC is not used additional overhead is required for the main processor to
transfer data to/from registers when each sensor is scanned.

Mutual-capacitance full scan mode

In mutual-capacitance mode each TS pin acts as either a 'row' or 'column' in an array of sensors. As
a result, this mode uses fewer pins when more than five sensors are configured. Mutual-capacitance
mode is ideal for applications where many touch sensors are required, like keypads, button matrices
and touchpads.

As an example, consider a standard phone keypad comprised of a matrix of four rows and three
columns.
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1 2 3
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Figure 109: Mutual Button Image

In mutual capacitance mode only 7 pins are necessary to scan 12 buttons. In self mode, 12 pins
would be required.

e Scan Order
o The hardware scans the matrix by iterating over the TX pins first and the RX pins
second.
o For example, if pins TS10, TS11, and TS03 are specified as RX sensors and pins
TS02, TS07, and TS04 are specified as TX sensors, the hardware will scan them in
the following sensor-pair order:
TS03-TS02, TS03-TS04, TS03-TS07, TS10-TS02, TS10-TS04, TS10-TS07,
TS11-TS02, TS11-TS04, TS11-TS07
e Element
o An element refers to the index of a sensor-pair within the scan order. Using the
previous example, TS10-TS07 is element 5.
e Scan Time
o Because mutual-capacitance scans two patterns for one element it takes twice as
long as self-capacitance (1ms vs 0.5ms per element).

CTSU2

Note
The above notes regarding self- and mutual -capacitance modes on CTSU apply to the CTSU2 peripheral aswell.

CFC mutual-capacitance multi scan mode

In CFC mutual-capacitance mode the receive lines are scanned in parallel, providing a significant
speed boost. Operation is otherwise identical to normal CTSU mutual scanning.

e Scan Order

o The hardware scans all RX pins simultaneously for each TX pin.

o For example, if sensors TS10, TS11, and TS03 are specified as RX sensors, and
sensors TS02, TS07, and TS04 are specified as TX sensors, the hardware will scan
them in the following sensor-pair order:

TS02-(TS03, TS10, TS11), TS04-(TS03, TS10, TS11), TSO07-(TS03, TS10, TS11)
e Element

o An element refers to the index of a sensor-pair within the scan order. Using the

previous example, TS07-TS10 is element 7.
e Scan Time

o Because the RX lines are scanned in parallel, CFC mutual-capacitance scan is the
same amount of times faster than a basic mutual matrix scan as the number of RX
lines. In other words, on a matrix with N receive lines, CFC mutual scanning is N
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times faster than basic mutual scanning.

Shield Output

The CTSU2 can optionally drive a shield signal on a single TS pin comprised of all TX pulses. This
signal can be used to drive a shield trace or lattice pour around touch sensors to improve the signal-

to-noise ratio.

Note

7 && ) ) %
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Figure 110: Shield pin Image

Thisfunction is only available in self-capacitance mode.

Limitations

Developers should be aware of the following limitations when using the CTSU:

e Self-capacitance single-scan mode is not supported.

e If DTC is used, external triggers may not be used for scan trigger type.

Examples

Basic Example

This is a basic example of minimal use of the CTSU in an application.

vol atil e bool g scan flag = fal se;

void ctsu_call back (ctsu_callback args t * p_args)

{
i f (CTSU_EVENT_SCAN _COWPLETE == p_args->event)
{
g_scan_flag = true;
}
}

voi d ctsu_basi c_exanpl e (void)

{

fsp err t err = FSP_SUCCESS;

uint 16_t data[ CTSU_CFG NUM SELF_ELEMENTS] ;
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Multi-configuration Example

This is a optional exmaple of using both Self-capacitance and Mutual-capacitance configurations in
the same project.
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Data Structures
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Enumerations

enum ctsu_state t
enum ctsu_tuning_t
enum ctsu_correction_status_t

enum ctsu_range_t

Data Structure Documentation

¢ ctsu_ctsuwr_t

struct ctsu_ctsuwr _t
CTSUWR write register value
Data Fields
uintl6 t ctsussc Copy from (ssdiv << 8) by
Open API.
uintl6_t ctsuso0 Copy from ((shum << 10) | so)
by Open API.
uintle t ctsusol Copy from (sdpa << 8) by Open
API. ICOG and RICOA is set
recommend value.
¢ ctsu_self buf t
struct ctsu_self_buf t
Scan buffer data formats (Self)
Data Fields
uintl6_t sen Sensor counter data.
uintl6_t ref Reference counter data (Not
used)
¢ ctsu_mutual_buf_t
struct ctsu_mutual_buf_t
Scan buffer data formats (Mutual)
Data Fields
uintlé t pri_sen Primary sensor data.
uintl6_t pri_ref Primary reference data (Not
used)
uintlé t snd_sen Secondary sensor data.
uintl6_t snd_ref Secondary reference data (Not
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used)

& ctsu_correction_info_t

struct ctsu_correction_info_t

Correction information

Data Fields

ctsu_correction_status_t status Correction status.
ctsu_ctsuwr _t ctsuwr Correction scan parameter.
volatile ctsu_self buf t scanbuf Correction scan buffer.
uintl6_t first_val 1st correction value
uintl6_t second_val 2nd correction value
uint32_t first_coefficient 1st correction coefficient
uint32 t second_coefficient 2nd correction coefficient
uint32_t ctsu_clock CTSU clock [MHz].

& ctsu_instance_ctrl_t

struct ctsu_instance_ctrl t

CTSU private control block. DO NOT MODIFY. Initialization occurs when R_CTSU_Open() is called.

Data Fields

uint32_t open

Whether or not driver is open.
ctsu state t state
CTSU run state.
ctsu_tuning t tuning

CTSU Initial offset tuning status.

uintlé_t num_elements
Number of elements to scan.

uintlé_t wr_index
Word index into ctsuwr register array.
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uintlé t

rd_index

Word index into scan data buffer.

uint8 t* p_tuning_complete
Pointer to tuning completion flag of each element.
g_ctsu_tuning _complete[] is set by Open API.

int32_t* p_tuning_diff
Pointer to difference from base value of each element.
g_ctsu_tuning_diff[] is set by Open API.

uintlé_ t average
CTSU Moving average counter.

uintl6_t num_moving_average
Copy from config by Open API.

uint8 t ctsucrl

Copy from (atunel << 3, md << 6) by Open API. CLK, ATUNEO, CSW,

and PON is set by HAL driver.

ctsu_ctsuwr t *

p_ctsuwr

CTSUWR write register value. g _ctsu_ctsuwr[] is set by Open API.

ctsu_self buf t*

p_self raw

Pointer to Self raw data. g _ctsu_self raw[] is set by Open API.

uintl6_t *

p_self_work

pointer to Self work buffer. g_ctsu_self work[] is set by Open API.

R11UMO0146EU0100 Revision 1.00

Mar.25.20

RLENESAS

Page 303 /1,444



Flexible Software Package User’s Manual

API| Reference > Modules > Capacitive Touch Sensing Unit (r_ctsu)

uintle t* p_self data

pointer to Self moving average data. g_ctsu_self data[] is set by
Open API.

ctsu_mutual buf t* p mutual raw

pointer to Mutual raw data. g _ctsu_mutual_raw[] is set by Open API.

uintlé_t* p_mutual_pri_work

pointer to Mutual primary work buffer. g _ctsu_mutual_pri_work[] is
set by Open API.

uintlé t* p _mutual snd work

pointer to Mutual secondary work buffer. g_ctsu_mutual_snd_work[]
is set by Open API.

uintlé_t* p mutual_pri_data

pointer to Mutual primary moving average data.
g_ctsu_mutual pri_data[] is set by Open API.

uintlé t* p _mutual snd data

pointer to Mutual secondary moving average data.
g_ctsu_mutual_snd_datal[] is set by Open API.

ctsu_correction_info_t * | p_correction_info

pointer to correction info

ctsu cfg tconst * p ctsu cfg

Pointer to initial configurations.

IRQn_Type write irq
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Copy from config by Open API. CTSU_CTSUWR interrupt vector.

IRQn_Type read irq

Copy from config by Open API. CTSU_CTSURD interrupt vector.

IRQn_Type end irq

Copy from config by Open API. CTSU_CTSUFN interrupt vector.

void const * p_context

Placeholder for user data.

void(* p_callback )(ctsu_callback_args_t *p_args)

Callback provided when a CTSUFN occurs.

Enumeration Type Documentation

¢ ctsu_state_t

enum ctsu_state t

CTSU run state

Enumerator
CTSU_STATE_INIT Not open.
CTSU _STATE_IDLE Opened.

CTSU_STATE_SCANNING Scanning now.

CTSU_STATE_SCANNED Scan end.
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¢ ctsu_tuning_t

enum ctsu_tuning_t

CTSU Initial offset tuning status

Enumerator

CTSU_TUNING_INCOMPLETE Initial offset tuning incomplete.

CTSU_TUNING_COMPLETE Initial offset tuning complete.

# ctsu_correction_status_t

enum ctsu_correction_status_t

CTSU Correction status

Enumerator

CTSU_CORRECTION_INIT Correction initial status.

CTSU_CORRECTION_RUN Correction scan running.

CTSU_CORRECTION_ERROR Correction error.

¢ ctsu_range_t

enum ctsu_range_t

CTSU range definition

Enumerator
CTSU_RANGE_20UA 20uA mode
CTSU_RANGE_40UA 40uA mode
CTSU_RANGE_80UA 80uA mode
CTSU_RANGE_160UA 160uA mode
CTSU_RANGE_NUM number of range

Function Documentation
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# R_CTSU Open()

fsp_err t R_CTSU_Open ( ctsu_ctrl_t *const p_ctrl, ctsu_cfg_t const *const p cfg )

Opens and configures the CTSU driver module. Implements ctsu_api_t::open.
Example:

err = R CTSU Open(&g_ctsu_ctrl, &g ctsu cfg);

Return values

FSP_SUCCESS CTSU successfully configured.

FSP_ERR_ASSERTION Null pointer, or one or more configuration
options is invalid.

FSP_ERR_ALREADY_OPEN Module is already open. This module can
only be opened once.

FSP_ERR_INVALID_ARGUMENT Configuration parameter error.

Note
In the first Open, measurement for correction works, and it takes several tens of milliseconds.
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& R_CTSU_ScanStart()

fsp_err t R_CTSU_ScanStart ( ctsu_ctrl_t *const p_ctr/)

This function should be called each time a periodic timer expires. If initial offset tuning is enabled,
The first several calls are used to tuning for the sensors. Before starting the next scan, first get the
data with R_CTSU_DataGet(). If a different control block scan should be run, check the scan is
complete before executing. Implements ctsu_api_t::scanStart.

Example:
while (true)
{
err = R CTSU ScanStart(&g_ctsu_ctrl);
handl e_error(err);
while (!g_scan_fl ag)
{
/* Wait for scan end call back */
}
g_scan_flag = fal se;
err = R CTSU DataCet (&g ctsu ctrl, data);
i f (FSP_SUCCESS == err)

{
/* Application specific data processing. */
}
}
Return values
FSP_SUCCESS CTSU successfully configured.
FSP_ERR_ASSERTION Null pointer passed as a parameter.
FSP_ERR_NOT_OPEN Module is not open.
FSP_ERR_CTSU_SCANNING Scanning this instance or other.
FSP_ERR_CTSU NOT GET DATA The previous data does not been getted by
DataGet.
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¢ R_CTSU_DataGet()

fsp_err t R_CTSU_DataGet ( ctsu_ctrl_t *const p_ctrl/, uintlé t* p data )

This function gets the sensor values as scanned by the CTSU. If initial offset tuning is enabled, The
first several calls are used to tuning for the sensors. Implements ctsu_api_t::dataGet.

Example:
while (true)
{
err = R CTSU ScanStart(&g_ctsu_ctrl);
handl e_error(err);
while (!g scan flag)
{
/* Wait for scan end cal |l back */
}
g_scan_flag = fal se;
err = R CTSU Dat aGet (&g _ctsu_ctrl, data);
i f (FSP_SUCCESS == err)

{
/* Application specific data processing. */
}
}
Return values
FSP_SUCCESS CTSU successfully configured.
FSP_ERR_ASSERTION Null pointer passed as a parameter.
FSP_ERR_NOT _OPEN Module is not open.
FSP_ERR_CTSU_SCANNING Scanning this instance.
FSP_ERR_CTSU_INCOMPLETE_TUNING Incomplete initial offset tuning.
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& R_CTSU_Close()

fsp_err t R_CTSU_Close ( ctsu_ctrl_t *const p_ctrl)

Disables specified CTSU control block. Implements ctsu_api_t::close.

Return values

FSP_SUCCESS CTSU successfully configured.
FSP_ERR_ASSERTION Null pointer passed as a parameter.
FSP_ERR_NOT_OPEN Module is not open.

& R_CTSU VersionGet()

fsp_err_ t R_CTSU_VersionGet ( fsp_version_t *const p_version)

Return CTSU HAL driver version. Implements ctsu_api_t::versionGet.

Return values

FSP_SUCCESS Version information successfully read.

FSP_ERR_ASSERTION Null pointer passed as a parameter

5.2.10 Digital to Analog Converter (r_dac)

Modules

Functions

fsp_err t R_DAC Open (dac_ctrl_t *p_api_ctrl, dac_cfg_t const *const p_cfqg)
fsp_err t R_DAC_ Write (dac_ctrl_t *p_api_ctrl, uintl6_t value)

fsp_err t R_DAC_Start (dac_ctrl_t *p_api_ctrl)

fsp_err t R_DAC Stop (dac_ctrl_t *p_api_ctrl)

fsp_err t R _DAC Close (dac_ctrl t *p_api_ctrl)

fsp_err t R_DAC VersionGet (fsp_version_t *p_version)

Detailed Description
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Driver for the DAC12 peripheral on RA MCUs. This module implements the DAC Interface.

Overview

Features

The DAC module outputs one of 4096 voltage levels between the positive and negative reference
voltages.

e Supports setting left-justified or right-justified 12-bit value format for the 16-bit input data
registers

Supports output amplifiers on selected MCUs

e Supports charge pump on selected MCUs

Supports synchronization with the Analog-to-Digital Converter (ADC) module

Configuration

Note
For MCUs supporting more than one channel, the following configuration options are shared by all the DAC
channels:;
o Synchronize with ADC
o Data Format
o Charge Pump

Build Time Configurations for r_dac

The following build time configurations are defined in fsp_cfg/r_dac_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
¢ Disabled included in the build.

Configurations for Driver > Analog > DAC Driver on r_dac

This module can be added to the Stacks tab via New Stack > Driver > Analog > DAC Driver on r_dac:

Configuration Options Default Description
Name Name must be a valid g_dacO Module name.
C symbol
Channel Value must be an 0 Specify the hardware
integer greater than or channel.
equal to 0
Synchronize with ADC e Enabled Disabled Enable DA/AD
e Disabled synchronization.
Data Format » Right Justified Right Justified Specify the DAC data
¢ Left Justified format.
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Output Amplifier MCU Specific Options Enable the DAC output
amplifier.

Charge Pump (Requires MCU Specific Options Enable the DAC charge

MOCO active) pump.

ELC Trigger Source MCU Specific Options ELC event source that

will trigger the DAC to
start a conversion.

Clock Configuration

The DAC peripheral module uses PCLKB as its clock source.

Pin Configuration

The DAnN pins are used as analog outputs. Each DAC channel has one output pin.
The AVCCO and AVSSO pins are power and ground supply pins for the DAC and ADC.

The VREFH and VREFL pins are top and ground voltage reference pins for the DAC and ADC.

Usage Notes

Charge Pump
The charge pump must be enabled when using DAC pin output while operating at AV¢c < 2.7V.

Note
The MOCO must be running to use the charge pump.
If the DAC output isto be routed to an internal signal, do not enable the charge pump.

Synchronization with ADC

When ADC synchronization is enabled and an ADC conversion is in progress, if a DAC conversion is
started it will automatically be delayed until after the ADC conversion is complete.

Limitations

e For MCUs supporting ADC unit 1:

o Once synchronization between DAC and ADC unit 1 is turned on during
R_DAC_Open synchronization cannot be turned off by the driver. In order to
desynchronize DAC with ADC unit 1, manually clear DAADSCR.DAADST to 0 when
the ADCSR.ADST bit is 0 and ADC unit 1 is halted.

o The DAC module can only be synchronized with ADC unit 1.

o For MCUs having more than 1 DAC channel, both channels are synchronized with
ADC unit 1 if synchronization is enabled.

Examples

Basic Example

This is a basic example of minimal use of the R_DAC in an application. This example shows how this
driver can be used for basic Digital to Analog Conversion operations.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 312/1,444
Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Digital to Analog Converter (r_dac)

voi d basi c_exanpl e (void)
{
fsp_err_t err;
uint16_t val ue;
/* Pin configuration: Qutput enable DAO as Anal og. */
/* Initialize the DAC channel */
err = R DAC Open(&g_dac_ctrl, &g dac _cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
value = (uintl1l6 t) DAC EXAMPLE VALUE ABC
err = R DAC Wite(&g dac _ctrl, val ue);
handl e_error(err);
err = R DAC Start(&g_dac_ctrl);

handl e _error(err);

Data Structures

struct dac_instance_ctrl_t

struct dac_extended cfg_t

Data Structure Documentation

¢ dac_instance_ctrl_t

struct dac_instance_ctrl_t

DAC instance control block.

¢ dac_extended_cfg_t

struct dac_extended_cfg_t
DAC extended configuration
Data Fields

bool enable_charge pump Enable DAC charge pump
available on selected MCUs.

bool output_amplifier_enabled Output amplifier enable
available on selected MCUs.

dac_data_format t data_format Data format.
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Function Documentation

4 R_DAC Open()

fsp_err t R_DAC Open ( dac_ctrl t* p_api ctrl, dac_cfg_t const *const p cfg )

Perform required initialization described in hardware manual. Implements dac_api_t::open.
Configures a single DAC channel, starts the channel, and provides a handle for use with the DAC
API Write and Close functions. Must be called once prior to calling any other DAC API functions.
After a channel is opened, Open should not be called again for the same channel without calling
Close first.

Return values
FSP_SUCCESS The channel was successfully opened.

FSP_ERR_ASSERTION Parameter check failure due to one or more
reasons below:

1. One or both of the following
parameters may be NULL: p_api_ctrl
or p_cfg

2. data_format value in p_cfg is out of
range.

3. Extended configuration structure is
set to NULL for MCU supporting
charge pump.

FSP_ERR_IP_CHANNEL_NOT_PRESENT Channel ID requested in p_cfg may not
available on the devices.

FSP_ERR_ALREADY_OPEN The control structure is already opened.

¢ R_DAC_Write()

fsp_err t R_DAC Write ( dac_ctrl t* p_api ctrl, uintlé t value )

Write data to the D/A converter and enable the output if it has not been enabled.

Return values

FSP_SUCCESS Data is successfully written to the D/A
Converter.
FSP_ERR_ASSERTION p_api_ctrl is NULL.
FSP_ERR_NOT _OPEN Channel associated with p_ctrl has not been
opened.
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¢ R_DAC _Start()

fsp_err_ t R_DAC Start ( dac_ctrl t* p_api ctrl)

Start the D/A conversion output if it has not been started.

Return values

FSP_SUCCESS The channel is started successfully.

FSP_ERR_ASSERTION p_api_ctrl is NULL.

FSP_ERR_IN_USE Attempt to re-start a channel.

FSP_ERR_NOT _OPEN Channel associated with p_ctrl has not been
opened.

4 R_DAC_Stop()

fsp_err t R_DAC Stop ( dac_ctrl t* p_api ctrl)

Stop the D/A conversion and disable the output signal.

Return values

FSP_SUCCESS The control is successfully stopped.

FSP_ERR_ASSERTION p_api_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_ctrl has not been
opened.

¢ R_DAC Close()

fsp_err_t R_DAC Close ( dac_ctrl_t* p_api_ctrl)

Stop the D/A conversion, stop output, and close the DAC channel.

Return values

FSP_SUCCESS The channel is successfully closed.
FSP_ERR_ASSERTION p_api_ctrl is NULL.
FSP_ERR_NOT_OPEN Channel associated with p_ctrl has not been
opened.
R11UMO146EU0100 Revision 1.00 RLENESAS Page 315/ 1,444

Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Digital to Analog Converter (r_dac)

4 R_DAC VersionGet()

fsp_err_t R_DAC VersionGet ( fsp_version_t * p_version)

Get version and store it in provided pointer p_version.

Return values

FSP_SUCCESS Successfully retrieved version information.

FSP_ERR_ASSERTION p_version is NULL.

5.2.11 Digital to Analog Converter (r_dac8)
Modules

Functions

fsp_err t R_DAC8 Open (dac_ctrl_t *const p_ctrl, dac_cfg_t const *const p_cfg)
fsp_err t R _DAC8 Close (dac_ctrl_t *const p_ctrl)

fsp_err t R_DACS8 Write (dac_ctrl_t *const p_ctrl, uintl6_t value)

fsp_err t R_DACS8 Start (dac_ctrl_t *const p_ctrl)

fsp_err t R_DAC8_Stop (dac_ctrl_t *const p_ctrl)

fsp_err t R _DAC8 VersionGet (fsp_version_t *p_version)

Detailed Description

Driver for the DACS8 peripheral on RA MCUs. This module implements the DAC Interface.

Overview

Features

The DAC8 module outputs one of 256 voltage levels between the positive and negative reference
voltages. DACS8 on selected MCUs have below features

e Charge pump control
e Synchronization with the Analog-to-Digital Converter (ADC) module
e Multiple Operation Modes

o Normal

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 316 /1,444
Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Digital to Analog Converter (r_dac8)

o Real-Time (Event Link)

Configuration

Note
For MCUs supporting more than one channel, the following configuration options are shared by all the DAC8
channels:;
o Synchronize with ADC
o Charge Pump

Build Time Configurations for r dac8

The following build time configurations are defined in fsp_cfg/r_dac8 cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
¢ Disabled included in the build.

Configurations for Driver > Analog > DACS8 Driver on r_dac8

This module can be added to the Stacks tab via New Stack > Driver > Analog > DACS8 Driver on
r dac8:

Configuration Options Default Description
Name Name must be a valid g _dac8 0 Module name.
C symbol
Channel Value must be an 0 Specify the hardware
integer greater than or channel.
equal to 0
D/A A/D Synchronous e Enabled Disabled Synchronize the DACS8
Conversion e Disabled update with the ADC to

reduce interference
with A/D conversions.

DAC Mode ¢ Normal Mode Normal Mode Select the DAC
¢ Real-time operating mode
(Event Link)
Mode
Real-time Trigger Event MCU Specific Options Specify the event used

to trigger conversion in
Real-time mode. This
setting is only valid
when Real-time mode
is enabled.

Charge Pump (Requires e Enabled Enabled Enable the DAC charge
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MOCO active) * Disabled pump.
Clock Configuration
The DACS8 peripheral module uses the PCLKB as its clock source.
Pin Configuration
The DA8_n pins are used as analog outputs. Each DAC8 channel has one output pin.

The AVCCO and AVSSO pins are power and ground supply and reference pins for the DACS.

Usage Notes

Charge Pump
The charge pump must be enabled when using DACS8 pin output while operating at AV < 2.7V.

Note
The MOCO must be running to use the charge pump.
If DAC8 output is to be routed to an internal signal, do not enable the charge pump.

Synchronization with ADC

When ADC synchronization is enabled and an ADC conversion is in progress, if a DAC8 conversion is
started it will automatically be delayed until after the ADC conversion is complete.

Real-time Mode

When Real-time mode is selected, the DACS8 will perform a conversion each time the selected ELC
event is received.

Limitations

e Synchronization between DAC8 and ADC is activated when calling R_DAC8_Open. At this
point synchronization cannot be deactivated by the driver. In order to desynchronize DACS8
with ADC, manually clear DACADSCR.DACADST to 0 while the ADCSR.ADST bit is 0 and the
ADC is halted.

e For MCUs having more than 1 DAC8 channel, both channels are synchronized with ADC if
synchronization is enabled.

Examples

Basic Example

This is a basic example of minimal use of the R_DACS8 in an application. This example shows how this
driver can be used for basic 8 bit Digital to Analog Conversion operations.

dac8 instance ctrl _t g _dac8 ctrl;
dac_cfg t g dac8 cfg =
{

. channel = 0y,
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.ad_da_synchroni zed = fal se,

. p_extend = &g_dac8 cfg extend
b5
voi d basi c_exanpl e (void)
{

fsp_err_t err;

uint16_t val ue;
/* Pin configuration: Qutput enable DA8 O(RA2A1) as Anal og. */
/* Initialize the DAC8 channel */

err = R DAC8_(pen(&g_dac8 ctrl, &g dac8 cfg);

/* Handl e any errors. This function should be defined by the user.

handl e_error(err);
value = (uint8 t) DAC8 EXAVPLE VALUE ABC,
/* Wite value to DAC nodul e */
err = R DACB Wite(&y dac8 ctrl, value);
handl e_error(err);
/* Start DAC8 conversion */
err = R DAC8_Start(&g dac8 ctrl);

handl e_error(err);

Data Structures

struct dac8_instance_ctrl_t
struct dac8 extended cfg t

Enumerations

enum dac8 _mode_t

*/

Data Structure Documentation

& dac8_instance _ctrl_t

struct dac8_instance_ctrl_t

DACS instance control block. DO NOT INITIALIZE.

¢ dac8_extended cfg t

struct dac8_extended_cfg_t
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DACS8 extended configuration
Data Fields
bool enable_charge pump Enable DAC charge pump.
dac8 mode_t dac_mode DAC mode.
Enumeration Type Documentation
¢ dac8 _mode_t
enum dac8_mode_t
Enumerator

DAC8_MODE_NORMAL

DAC Normal mode.

DAC8_MODE_REAL_TIME

DAC Real-time (event link) mode.

Function Documentation

¢ R_DACS8 Open()

fsp_err t R_DAC8 Open ( dac_ctrl_t *const p_ctrl, dac_cfg t const *const p cfg )

Implements dac_api_t::open.

Close first.

Return values

Perform required initialization described in hardware manual.

Configures a single DAC channel. Must be called once prior to calling any other DAC API functions.
After a channel is opened, Open should not be called again for the same channel without calling

FSP_SUCCESS

The channel was successfully opened.

FSP_ERR_ASSERTION

One or both of the following parameters
may be NULL: p_ctrl or p_cfg

FSP_ERR_ALREADY_OPEN

The instance control structure has already
been opened.

FSP_ERR_IP_CHANNEL_NOT_PRESENT

An invalid channel was requested.

FSP_ERR_NOT ENABLED

Setting DACADSCR is not enabled when
ADCSR.ADST = 0.

Note

This function is reentrant for different channels. It is not reentrant for the same channel.
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4 R_DACS8_Close()

fsp_err t R_DAC8 Close ( dac_ctrl_t *const p_ctrl)

Stop the D/A conversion, stop output, and close the DAC channel.

Return values

FSP_SUCCESS The channel is successfully closed.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.

¢ R_DAC8 Write()

fsp_err_t R_DAC8_Write ( dac_ctrl_t *const p_ctrl, uintl6_t value )

Write data to the D/A converter.

Return values

FSP_SUCCESS Data is successfully written to the D/A
Converter.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.

FSP_ERR_OVERFLOW Data overflow when data value exceeds
8-bit limit.

& R_DACS Start()

fsp_err t R_DACS8 Start ( dac_ctrl_t *const p_ctrl)

Start the D/A conversion output.

Return values

FSP_SUCCESS The channel is started successfully.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.
FSP_ERR_IN_USE Attempt to re-start a channel.
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& R_DAC8_Stop()

fsp_err_ t R_DACS8 Stop ( dac_ctrl_t *const p_ctr/)

Stop the D/A conversion and disable the output signal.

Return values

FSP_SUCCESS The control is successfully stopped.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.

¢ R_DAC8 VersionGet()

fsp_err_t R_DAC8_VersionGet ( fsp_version_t * p_version)

Get version and store it in provided pointer p_version.

Return values

FSP_SUCCESS Successfully retrieved version information.

FSP_ERR_ASSERTION p_version is NULL.

5.2.12 Direct Memory Access Controller (r_dmac)

Modules
Functions
fsp_err t R_DMAC Open (transfer_ctrl_t *const p_api_ctrl, transfer _cfg t const
*const p_cfg)
fsp_err t R_DMAC_Reconfigure (transfer_ctrl_t *const p_api_ctrl, transfer_info_t
*p_info)
fsp_err t R_DMAC_Reset (transfer_ctrl_t *const p_api_ctrl, void const *volatile
p_src, void *volatile p_dest, uintl6_t const num_transfers)
fsp_err t R_DMAC_SoftwareStart (transfer_ctrl_t *const p_api_ctrl,
transfer_start mode_t mode)
fsp_err t R_DMAC_SoftwareStop (transfer_ctrl_t *const p_api_ctrl)
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fsp_err t R_DMAC_Enable (transfer_ctrl_t *const p_api_ctrl)
fsp_err t R_DMAC Disable (transfer _ctrl_t *const p_api_ctrl)

fsp_err t R_DMAC InfoGet (transfer_ctrl_t *const p_api_ctrl,
transfer_properties_t *const p_info)

fsp_err t R_DMAC Close (transfer_ctrl_t *const p_api_ctrl)

fsp_err t R_DMAC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the DMAC peripheral on RA MCUs. This module implements the Transfer Interface.

Overview

The Direct Memory Access Controller (DMAC) transfers data from one memory location to another
without using the CPU.

Features

e Supports multiple transfer modes
o Normal transfer
o Repeat transfer
o Block transfer
e Address increment, decrement, fixed, or offset modes
e Triggered by ELC events
o Some exceptions apply, see the Event table in the Event Numbers section of the
Interrupt Controller Unit chapter of the hardware manual
e Supports 1, 2, and 4 byte data units

Configuration

Build Time Configurations for r_dmac

The following build time configurations are defined in fsp_cfg/r_dmac_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > Transfer > Transfer Driver on r_dmac

This module can be added to the Stacks tab via New Stack > Driver > Transfer > Transfer Driver on
r dmac:

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 323 /1,444
Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Direct Memory Access Controller (r_dmac)

Configuration Options Default Description
Name Name must be a valid  g_transferQ Module name.
C symbol
Channel Value must be a non- 0 Specify the hardware
negative integer channel.
Mode e Normal Normal Select the transfer
e Repeat mode. Normal: One
e Block transfer per activation,

transfer ends after
Number of Transfers;
Repeat: One transfer
per activation, Repeat
Area address reset
after Number of
Transfers, transfer
ends after Number of
Blocks; Block: Number
of Blocks per
activation, Repeat Area
address reset after
Number of Transfers,
transfer ends after
Number of Blocks.

Transfer Size ¢ 1 Byte 2 Bytes Select the transfer size.
e 2 Bytes
e 4 Bytes
Destination Address e Fixed Fixed Select the address
Mode o Offset addition mode for the
¢ Incremented destination.

e Decremented

Source Address Mode e Fixed Fixed Select the address
¢ Offset addition mode for the source.
¢ Incremented
e Decremented

Repeat Area (Unused in ¢ Destination Source Select the repeat area.

Normal Mode) e Source Either the source or
destination address
resets to its initial
value after completing
Number of Transfers in
Repeat or Block mode.

Destination Pointer Manual Entry NULL Specify the transfer
destination pointer.
Source Pointer Manual Entry NULL Specify the transfer
source pointer.
Number of Transfers Value must be a non- 0 Specify the number of
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Number of Blocks
(Valid only in Repeat
and Block Mode)

Activation Source

Callback

Transfer End Interrupt

Priority

Interrupt Frequency

negative integer

Value must be a non-
negative integer

MCU Specific Options

Name must be a valid
C symbol

MCU Specific Options

e Interrupt after
all transfers
have completed

¢ Interrupt after
each block, or
repeat size is
transfered

Offset value (Valid only Value must be a 24 bit

when address mode is

\'Offset\')

Clock Configuration

signed integer.

NULL

Interrupt after all
transfers have
completed

transfers.

Specify the number of
blocks to transfer in
Repeat or Block mode.

Select the DMAC
transfer start event. If
no ELC event is chosen
then software start can
be used.

A user callback that is
called at the end of the
transfer.

Select the transfer end
interrupt priority.

Select to have interrupt
after each transfer or
after last transfer.

Offset value * transfer
size is added to the
address after each
transfer.

The DMAC peripheral module uses ICLK as the clock source. The ICLK frequency is set by using the
RA Configuration Clocks tab prior to a build, or by using the CGC module at run-time.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Transfer Modes

The DMAC Module supports three modes of operation.

e Normal Mode - In normal mode, a single data unit is transfered every time the configured
ELC event is received by the DMAC channel. A data unit can be 1-byte, 2-bytes, or 4-bytes.
The source and destination addresses can be fixed, increment, decrement, or add an offset
to the next data unit after each transfer. A 16-bit counter decrements after each transfer.
When the counter reaches 0, transfers will no longer be triggered by the ELC event and the

CPU can be interrupted to signal that all transfers have finished.

* Repeat Mode - Repeat mode works the same way as normal mode, however the length is
limited to an integer in the range[1,1024]. When the transfer counter reaches 0, the
counter is reset to its configured value, the repeat area(source or destination address)
resets to its starting address and the block count remaining will decrement by 1. When the
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block count reaches 0, transfers will no longer be triggered by the ELC event and the CPU
may be interrupted to signal that all transfers have finished.

¢ Block Mode - In block mode, the amount of data units transfered by each interrupt can be
set to an integer in the range [1,1024]. The number of blocks to transfer can also be
configured to a 16-bit number. After each block transfer the repeat area(source or
destination address) will reset to the original address and the other address will be
incremented or decremented to the next block.

Selecting the DTC or DMAC

The Transfer APl is implemented by both DTC and the DMAC so that applications can switch between
the DTC and the DMAC. When selecting between them, consider these factors:

DTC

DMAC

Repeat Mode

Block Mode

Channels

Chained Transfers

Software Trigger

Offset Address Mode

Interrupts

¢ Repeats forever
¢ Max repeat size is 256 x
4 bytes

e Max block size is 256 x
4 bytes

¢ One instance per
interrupt

e Supported

e Must use the software
ELC event

¢ Not supported

¢ Configurable number of
repeats

¢ Max repeat size is 1024
x 4 bytes

e Max block size is 1024 x
4 bytes

¢ MCU specific (8
channels or less)

¢ Not Supported

¢ Has support for software
trigger without using
software ELC event

e Supports TRANSFER_ST
ART_MODE_SINGLE and
TRANSFER _START_MOD
E_REPEAT

e Supported

The DTC and DMAC interrupts behave differently. The DTC uses the configured IELSR event IRQ as
the interrupt source whereas each DMAC channel has its own IRQ.

The transfer_info_t::irq setting also behaves a little differently depending on which mode is selected.

Normal Mode

DTC

DMAC

TRANSFER_IRQ_EACH
TRANSFER_IRQ_END

Repeat Mode

Interrupt after each transfer

Interrupt after last transfer

N/A

Interrupt after last transfer

DTC

DMAC

TRANSFER_IRQ_EACH

Interrupt after each transfer

Interrupt after each repeat
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TRANSFER_IRQ_END Interrupt after each repeat Interrupt after last transfer
Block Mode

DTC DMAC
TRANSFER_IRQ_EACH Interrupt after each block Interrupt after each block
TRANSFER IRQ _END Interrupt after last block Interrupt after last block

Additional Considerations

e The DTC requires a moderate amount of RAM (one transfer_info_t struct per open instance
+ DTC_VECTOR TABLE_SIZE).

e The DTC stores transfer information in RAM and writes back to RAM after each transfer
whereas the DMAC stores all transfer information in registers.

* When transfers are configured for more than one activation source, the DTC must fetch the
transfer info from RAM on each interrupt. This can cause a higher latency between
transfers.

Offset Address Mode

When the source or destination mode is configured to offset mode, a configurable offset is added to
the source or destination pointer after each transfer. The offset is a signed 24 bit number.

Examples

Basic Example

This is a basic example of minimal use of the DMAC in an application. In this case, one or more
events have been routed to the DMAC for handling so it only needs to be enabled to start accepting
transfers.
voi d dmac_mi ni mal _exanpl e (voi d)
{
/* Open the transfer instance with initial configuration. */
fsp err t err = R DMAC Open(&g _transfer _ctrl, &g transfer_cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/* Enable the DVAC so that it responds to transfer requests. */
err = R DMAC Enabl e(&g_transfer _ctrl);

handl e _error(err);

CRC32 Example

In this example the DMAC is used to feed the CRC peripheral to perform a CRC32 operation.
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/*

/*

/*
/*

Wait for transfer conplete interrupt */

}

Get CRC result and performfinal XOR */

uint32_t crc3z;

(voi d) R CRC Cal cul at edVal ueGet (&g crc_ctrl, &crc32);
crc32 A= CRC32_FI NAL_XOR VALUE;

Verify that the CRC32 is calculated correctly. */
CRC32("ABCD. . . NOP*) = OxXEOE8FF4D. */

const uint32_t expected crc32 = OXEOES8FF4D,

i f

/*

(expected _crc32 !'= crc32)
{

Handl e any CRC errors. This function should be defined by the user.

handl e crc_error();

Data Structures

struct dmac_instance_ctrl_t
struct dmac_callback_args t

struct dmac_extended_cfg_t

Macros

#define DMAC_MAX_NORMAL TRANSFER_LENGTH
#define DMAC_MAX_REPEAT TRANSFER_LENGTH
#define DMAC_MAX_BLOCK TRANSFER LENGTH
#define DMAC_MAX_REPEAT COUNT

#define  DMAC_MAX_BLOCK_COUNT

*/

Data Structure Documentation

4 dmac_instance_ctrl_t

struct dmac_instance_ctrl_t

Control block used by driver. DO NOT INITIALIZE - this structure will be initialized in
transfer_api_t::open.
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4 dmac_callback_args_t

struct dmac_callback_args_t

Callback function parameter data.

Data Fields

void const * p_context

Placeholder for user data. Set in
r transfer_t::open function in
transfer cfg_t.

¢ dmac_extended cfg t

struct dmac_extended_cfg_t

DMAC transfer configuration extension. This extension is required.

Data Fields

uint8 t channel

Channel number, does not apply to all HAL drivers.

IRQn_Type | irq

DMAC interrupt number.

uint8_t ipl

DMAC interrupt priority.

int32_t | offset

Offset value used with

transfer_addr_mode_t:: TRANSFER_ADDR_MODE_OFFSET.

elc_event t activation_source

void(* | p_callback )(dmac_callback args t *cb_data)

void const * | p_context

Field Documentation
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¢ activation_source

elc_event_t dmac_extended_cfg_t::activation_source

Select which event will trigger the transfer.

Note
Select ELC_EVENT_NONE for software activation in order to use softwareStart and softwareStart to trigger
transfers.
¢ p_callback

void(* dmac_extended_cfg_t::p_callback) (dmac_callback_args_t *cb_data)

Callback for transfer end interrupt.

¢ p_context

void const* dmac_extended_cfg_t::p_context

Placeholder for user data. Passed to the user p_callback in dmac_callback args t.

Macro Definition Documentation

¢ DMAC_MAX_NORMAL_TRANSFER_LENGTH

#define DMAC_MAX_NORMAL_TRANSFER_LENGTH

Max configurable number of transfers in TRANSFER_MODE_NORMAL.

¢ DMAC_MAX_REPEAT_TRANSFER_LENGTH

#define DMAC_MAX_REPEAT_TRANSFER LENGTH

Max number of transfers per repeat for TRANSFER_MODE_REPEAT.

& DMAC_MAX_BLOCK_TRANSFER_LENGTH

#define DMAC_MAX BLOCK TRANSFER_LENGTH
Max number of transfers per block in TRANSFER_MODE_BLOCK

¢ DMAC_MAX_REPEAT COUNT

#define DMAC_MAX_REPEAT COUNT

Max configurable number of repeats to trasnfer in TRANSFER_MODE_REPEAT
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¢ DMAC_MAX_BLOCK_COUNT

#define DMAC_MAX_BLOCK_COUNT

Max configurable number of blocks to transfer in TRANSFER_MODE_BLOCK

Function Documentation

4 R_DMAC _Open()

fsp_err t R_ DMAC _Open ( transfer_ctrl_t *const p_api _ctrl, transfer_cfg_t const *const p_cfg )

Configure a DMAC channel.

Return values

FSP_SUCCESS Successful open.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_IP_CHANNEL_NOT_PRESENT The configured channel is invalid.

FSP_ERR_IRQ_BSP_DISABLED The IRQ associated with the activation
source is not enabled in the BSP.

FSP_ERR_ALREADY_OPEN The control structure is already opened.

¢ R_DMAC_Reconfigure()

fsp_err_t R_DMAC_Reconfigure ( transfer_ctrl_t *const p_api_ctrl, transfer_info_t * p_info )

Reconfigure the transfer with new transfer info.

Return values

FSP_SUCCESS Transfer is configured and will start when
trigger occurs.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_ENABLED DMAC is not enabled. The current

configuration must not be valid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.
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¢ R_DMAC_Reset()

fsp_err t R_ DMAC_Reset ( transfer_ctrl_t *const p_api ctrl, void const *volatile p_src, void *volatile
p_dest, uintl6 t const num_transfers )

Reset transfer source, destination, and number of transfers.

Return values

FSP_SUCCESS Transfer reset successfully.
FSP_ERR_ASSERTION An input parameter is invalid.
FSP_ERR_NOT_ENABLED DMAC is not enabled. The current

configuration must not be valid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.

4 R_DMAC_SoftwareStart()

fsp_err t R_ DMAC_SoftwareStart ( transfer_ctrl_t *const p_api ctrl, transfer_start mode_t mode )

If the mode is TRANSFER_START_MODE_SINGLE initiate a single transfer with software. If the mode

is TRANSFER_START_MODE_REPEAT continue triggering transfers until all of the transfers are
completed.

Return values

FSP_SUCCESS Transfer started written successfully.
FSP_ERR_ASSERTION An input parameter is invalid.
FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.
FSP_ERR_UNSUPPORTED Handle was not configured for software
activation.
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4 R_DMAC_SoftwareStop()

fsp_err_t R_DMAC_SoftwareStop ( transfer_ctrl _t *const p_api ctrl)
Stop software transfers if they were started with TRANSFER_START _MODE_REPEAT.

Return values

FSP_SUCCESS Transfer stopped written successfully.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.

4 R_DMAC_Enable()

fsp_err_t R_DMAC_Enable ( transfer_ctrl_t *const p_api_ctrl)

Enable transfers for the configured activation source.

Return values

FSP_SUCCESS Counter value written successfully.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DMAC_Open
to initialize the control block.

4 R_DMAC Disable()

fsp_err t R_ DMAC Disable ( transfer_ctrl t *const p_api ctrl)

Disable transfers so that they are no longer triggered by the activation source.

Return values

FSP_SUCCESS Counter value written successfully.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.
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¢ R_DMAC _InfoGet()

fsp_err_ t R_DMAC InfoGet ( transfer _ctrl_t *const p_api ctrl, transfer_properties_t *const p_info )

Set driver specific information in provided pointer.

Return values
FSP_SUCCESS Information has been written to p_info.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.

FSP_ERR_ASSERTION An input parameter is invalid.

¢ R_DMAC Close()

fsp_err_t R_DMAC_Close ( transfer_ctrl_t *const p_api_ctrl)

Disable transfer and clean up internal data. Implements transfer_api_t::close.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DMAC_Open
to initialize the control block.

4 R_DMAC VersionGet()

fsp_err t R_ DMAC VersionGet ( fsp_version_t *const p_version)

Set driver version based on compile time macros.

Return values
FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION An input parameter is invalid.

5.2.13 Data Operation Circuit (r_doc)
Modules
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Functions

fsp_err t R_DOC Open (doc_ctrl_t *const p_api_ctrl, doc_cfg_t const *const
p_cfg)

fsp_err t R _DOC Close (doc_ctrl t *const p_api_ctrl)

fsp_err t R _DOC StatusGet (doc_ctrl _t *const p_api_ctrl, doc_status_t *const
p_status)

fsp_err t R_DOC_Write (doc_ctrl_t *const p_api_ctrl, uintl6_t data)

fsp_err t R_DOC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the DOC peripheral on RA MCUs. This module implements the DOC Interface.

Overview

Features

The DOC HAL module peripheral is used to compare, add or subtract 16-bit data and can detect the
following events:

e A match or mismatch between data values
e Overflow of an addition operation
e Underflow of a subtraction operation

A user-defined callback can be created to inform the CPU when any of above events occur.

Configuration

Build Time Configurations for r_doc

The following build time configurations are defined in fsp_cfg/r_doc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Monitoring > Data Operation Circuit Driver on r_doc

This module can be added to the Stacks tab via New Stack > Driver > Monitoring > Data Operation
Circuit Driver on r_doc:

Configuration Options Default Description
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Name

Event

Reference/Initial Data

Callback

DOC Interrupt Priority

Clock Configuration

Name must be a valid
C symbol

e Comparison
mismatch

e Comparison
match

e Addition
overflow

e Subtraction
underflow

Value must be a 16 bit
integer between 0 and
65535

Name must be a valid
C symbol

MCU Specific Options

g_docO

Comparison mismatch

NULL

The DOC HAL module does not require a specific clock configuration.

Pin Configuration

The DOC HAL module does not require and specific pin configurations.

Usage Notes

DMAC/DTC Integration

Module name.

Select the event that
will trigger the DOC
interrupt.

Enter Initial Value for
Addition/Subtraction or
enter reference value
for comparison.

A user callback
function must be
provided. This will be
called from the
interrupt service
routine (ISR) when the
configured DOC event
occurs.

Select the DOC
interrupt priority.

DOC can be used with Direct Memory Access Controller (r_dmac) or Data Transfer Controller (r_dtc)
to write to the input register without CPU intervention. DMAC is more useful for most DOC
applications because it can be started directly from software. To write DOC input data with
DTC/DMAC, set transfer_info_t::p_dest to R_DOC->DODIR.

Examples

Basic Example

This is a basic example of minimal use of the R_DOC in an application. This example shows how this
driver can be used for continuous 16 bit addition operation while reading the result at every overflow

event.

#def i ne DOC_EXAMPLE_VALUE 0xF000
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Function Documentation

4 R_DOC _Open()

fsp_err t R_DOC Open ( doc_ctrl_t *const p_api _ctrl, doc_cfg t const *const p cfg )

Opens and configures the Data Operation Circuit (DOC) in comparison, addition or subtraction
mode and sets initial data for addition or subtraction, or reference data for comparison.

Example:

/* Initialize the DOC nodule for addition with initial value specified in
doc_cfg t::doc_data. */

err = R DOC Open(&g_doc_ctrl, &g doc cfg);

Return values

FSP_SUCCESS DOC successfully configured.

FSP_ERR_ALREADY_OPEN Module already open.

FSP_ERR_ASSERTION One or more pointers point to NULL or
callback is NULL or the interrupt vector is
invalid.

¢ R_DOC _Close()

fsp_err t R_DOC Close ( doc_ctrl_t *const p_api ctrl)

Closes the module driver. Enables module stop mode.

Return values

FSP_SUCCESS Module successfully closed.
FSP_ERR_NOT _OPEN Driver not open.
FSP_ERR_ASSERTION Pointer pointing to NULL.
Note
This function will disable the DOC interrupt in the NVIC.
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4 R_DOC _StatusGet()

fsp_err_ t R_DOC StatusGet ( doc_ctrl_t *const p_api ctrl, doc_status_t *const p status )

Returns the result of addition/subtraction.

Example:
/* Read the result of the operation */

err = R DOC StatusGet (& _doc_ctrl, &result);

handl e _error(err);

Return values

FSP_SUCCESS Status successfully read.
FSP_ERR_NOT _OPEN Driver not open.
FSP_ERR_ASSERTION One or more pointers point to NULL.

¢ R_DOC_Write()

fsp_err_ t R_DOC_Write ( doc_ctrl_t *const p_api ctrl, uintl6 t data )

Writes to the DODIR - DOC Input Register.
Example:
err = RDOC Wite(&g doc _ctrl, DOC EXAVPLE VALUE);

handl e_error(err);

Return values
FSP_SUCCESS

Values successfully written to the registers.
FSP_ERR_NOT_OPEN Driver not open.

FSP_ERR_ASSERTION

One or more pointers point to NULL.

4 R_DOC _VersionGet()

fsp_err_t R_DOC_VersionGet ( fsp_version_t *const p_version)

Returns DOC HAL driver version.

Return values
FSP_SUCCESS

Version information successfully read.
FSP_ERR_ASSERTION Pointer pointing to NULL.
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5.2.14 D/AVE 2D Port Interface (r_drw)

Modules

Driver for the DRW peripheral on RA MCUs. This module is a port of D/AVE 2D.

Overview

Note
The D/AVE 2D Port Interface (D1 layer) isa HAL layer for the D/AVE D2 layer API and does not provide any
interfacesto the user. Consult the TES Dave2D Driver Documentation for further information on using the D2
API.
For cross-platform compatibility purposes the D1 and D2 APIs are not bound by the FSP coding guidelines for
function names and general module functionality.

Configuration

Build Time Configurations for r_drw

The following build time configurations are defined in fsp_cfg/r_drw_cfg.h:

Configuration Options Default Description

Enabled Enabled Enable indirect mode

Disabled to allow no-copy mode
for d2_adddlist (see the
TES Dave2D Driver
Documentation for

Allow Indirect Mode

details).
Memory Allocation e Default Default Set Memory Allocation
e Custom to Default to use built-

in dynamic memory
allocation for the D2
heap. This will use an
RTOS heap if
configured; otherwise,
standard C malloc and
free will be used.

Set to Custom to define
your own allocation
scheme for the D2
heap. In this case, the
developer will need to
define the following
functions:
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void * d1_malloc(size_t
size)
void d1_free(void * ptr)

Configurations for Driver > Graphics > D/AVE 2D Port Interface on r_drw

This module can be added to the Stacks tab via New Stack > Driver > Graphics > D/AVE 2D Port
Interface on r_drw:

Configuration Options Default Description

D2 Device Handle Name must be a valid  d2_handle0 Set the name for the

Name C symbol d2_device handle used
when calling D2 layer
functions.

DRW Interrupt Priority = MCU Specific Options Select the DRW_INT
(display list
completion) interrupt
priority.

Heap Size

The D1 port layer allows the D2 driver to allocate memory as needed. There are three ways the
driver can accomplish this:

1. Allocate memory using the main heap
2. Allocate memory using a heap provided by an RTOS
3. Allocate memory via user-provided functions

When the "Memory Allocation" configuration option is set to "Default" the driver will use an RTOS
implementation if available and the main heap otherwise. Setting the option to "Custom" allows the
user to define their own scheme using the following prototypes:

void * d1_nmall oc(size_ t size);

void dl_free(void * ptr);

Warning
If there is no RTOS-based allocation scheme the main heap will be used. Be sure that it is
enabled by setting the "Heap size (bytes)" property under RA Common on the BSP tab of
the configurator.

Note
It is recommended to add 32KB of additional heap space for the D2 driver until the actual usage can be deter mined
inyour application.

Interrupt

The D1 port includes one interrupt to handle various events like display list completion or bus error.
This interrupt is managed internally by the D2 driver and no callback function is available.
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Usage Notes
Limitations
Developers should be aware of the following limitations when using the DRW engine:
e The DRW module supports two additional interrupt types - bus error and render complete.
These interrupts are not needed for D2 layer operation and thus are not supported.
 If the DRW module is stopped during rendering the render will continue once the module is

started again. If this behavior is undesirable in your application it is recommended to call
d2_flushframe before stopping the peripheral.

5.2.15 Data Transfer Controller (r_dtc)
Modules

Functions

fsp_err t R_DTC Open (transfer_ctrl_t *const p_api_ctrl, transfer cfg_t const
*const p_cfg)

fsp_err t R _DTC Reconfigure (transfer ctrl _t *const p_api_ctrl, transfer_info_t
*p_info)

fsp_err t R _DTC Reset (transfer_ctrl_t *const p_api_ctrl, void const *volatile
p_src, void *volatile p_dest, uintl6_t const num_transfers)

fsp_err t R _DTC SoftwareStart (transfer_ctrl_t *const p_api_ctrl,
transfer_start mode_t mode)

fsp_err t R_DTC_SoftwareStop (transfer _ctrl_t *const p_api_ctrl)
fsp_err t R_DTC_Enable (transfer_ctrl_t *const p_api_ctrl)
fsp_err t R _DTC Disable (transfer ctrl t *const p_api_ctrl)

fsp_err t R _DTC InfoGet (transfer_ctrl t *const p_api_ctrl, transfer_properties _t
*const p_properties)

fsp_err t R_DTC Close (transfer _ctrl_t *const p_api_ctrl)

fsp_err t R_DTC_VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the DTC peripheral on RA MCUs. This module implements the Transfer Interface.
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Overview

The Data Transfer Controller (DTC) transfers data from one memory location to another without
using the CPU.

The DTC uses a RAM based vector table. Each entry in the vector table corresponds to an entry in
the ISR vector table. When the DTC is triggered by an interrupt, it reads the DTC vector table,
fetches the transfer information, and then executes the transfer. After the transfer is executed, the
DTC writes the updated transfer info back to the location pointed to by the DTC vector table.

Features

e Supports multiple transfer modes
o Normal transfer
o Repeat transfer
o Block transfer
e Chain transfers
Address increment, decrement or fixed modes
Can be triggered by any event that has reserved a slot in the interrupt vector table.
o Some exceptions apply, see the Event table in the Event Numbers section of the
Interrupt Controller Unit chapter of the hardware manual
e Supports 1, 2, and 4 byte data units

Configuration

Build Time Configurations for r_dtc

The following build time configurations are defined in fsp_cfg/r_dtc_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.
Linker section to keep  Manual Entry fsp_dtc_vector_table Section to place the
DTC vector table DTC vector table.

Configurations for Driver > Transfer > Transfer Driver on r_dtc

This module can be added to the Stacks tab via New Stack > Driver > Transfer > Transfer Driver on
r dtc:

Configuration Options Default Description
Name Name must be a valid  g_transferO Module name.
C symbol
Mode e Normal Normal Select the transfer
¢ Repeat mode. Select the
e Block transfer mode. Normal:
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User’s Manual

Transfer Size

Destination Address
Mode

Source Address Mode

Repeat Area (Unused in

1 Byte
2 Bytes
4 Bytes

e Fixed
¢ |[ncremented
e Decremented

e Fixed
¢ Incremented
e Decremented

e Destination

2 Bytes

Fixed

Fixed

Source

One transfer per
activation, transfer
ends after Number of
Transfers; Repeat: One
transfer per activation,
Repeat Area address
reset after Number of
Transfers, transfer
repeats until stopped,;
Block: Number of
Blocks per activation,
Repeat Area address
reset after Number of
Transfers, transfer
ends after Number of
Blocks.

Select the transfer size.

Select the address
mode for the
destination.

Select the address
mode for the source.

Select the repeat area.

Normal Mode) e Source Either the source or
destination address
resets to its initial
value after completing
Number of Transfers in
Repeat or Block mode.

Interrupt Frequency o After all After all transfers have Select to have interrupt

transfers have  completed after each transfer or
completed after last transfer.

e After each
transfer

Number of Transfers Value must be a non- 0 Specify the number of

negative integer transfers.

Number of Blocks Must be a valid non- 0 Specify the number of

(Valid only in Block negative integer with a blocks to transfer in

Mode) maximum configurable Block mode.

value of 65536.
Applicable only in Block
Mode.

Activation Source MCU Specific Options Select the DTC transfer

start event.
Clock Configuration
R11UMO0146EU0100 Revision 1.00 RLENESAS Page 345/ 1,444

Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Data Transfer Controller (r_dtc)

The DTC peripheral module uses ICLK as the clock source. The ICLK frequency is set by using the FSP
configurator Clocks tab prior to a build or by using the CGC module at runtime.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Transfer Modes
The DTC Module supports three modes of operation.

¢ Normal Mode - In normal mode, a single data unit is transfered every time an interrupt is
received by the DTC. A data unit can be 1-byte, 2-bytes, or 4-bytes. The source and
destination addresses can be fixed, increment or decrement to the next data unit after each
transfer. A 16-bit counter(length) decrements after each transfer. When the counter
reaches 0, transfers will no longer be triggered by the interrupt source and the CPU can be
interrupted to signal that all transfers have finished.

* Repeat Mode - Repeat mode works the same way as normal mode, however the length is
limited to an integer in the range[1,256]. When the tranfer counter reaches 0, the counter
is reset to its configured value and the repeat area(source or destination address) resets to
its starting address and transfers will still be triggered by the interrupt.

e Block Mode - In block mode, the amount of data units transfered by each interrupt can be
set to an integer in the range [1,256]. The number of blocks to transfer can also be
configured to a 16-bit number. After each block transfer the repeat area(source or
destination address) will reset to the original address and the other address will be
incremented or decremented to the next block.

Note
1. The source and destination address of the transfer must be aligned to the configured data unit.
2. In normal mode the length can be set to [ 0,65535]. When the length is set to 0, than the transaction will execute
65536 transfers not O.
3. In block mode, num_blocks can be set to [0,65535] . When the length is set to 0, than the transaction will execute
65536 transfers not O.

Chaining Transfers

Multiple transfers can be configured for the same interrupt source by specifying an array of
transfer_info_t structs instead of just passing a pointer to one. In this configuration, every
transfer_info_t struct must be configured for a chain mode except for the last one. There are two
types of chain mode; CHAIN_MODE_EACH and CHAIN_MODE_END. If a transfer is configured in
CHAIN_MODE_EACH then it triggers the next transfer in the chain after it completes each transfer. If
a transfer is configured in CHAIN_MODE_END then it triggers the next transfer in the chain after it
completes its last transfer.
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DTC
Activation
ource Even

Chain Mode
[Disabled]

Transfer Complete

Transfer data

[Each]

A4

Decrement counter
and update source |

Chain Mode

and destination

Repeat mode? [Yes]
[No]

Chain mode?

Chain Mode
[End, Disabled]

h 4
Reset transfer

Disable DTC counter and repeat

activation source

area(source or

Go to next transfer

pointer destination)
« |
Y
Chain mode? Ch?&ggﬁ?de .
Chain Mode
[End]
Last transfer? [Yes]

info in the chain

A

1. Counter refers to transfer_infc_t::length in normal and repeat mode and transfer_info_t::num_blocks in block mode

Selecting the DTC or DMAC

Figure 111: DTC Transfer Flowchart

The Transfer API is implemented by both DTC and the DMAC so that applications can switch between
the DTC and the DMAC. When selecting between them, consider these factors:

DTC

DMAC

Repeat Mode

e Repeats forever .

e Max repeat size is 256 x

Configurable number of
repeats

4 bytes e Max repeat size is 1024
x 4 bytes
Block Mode e Max block size is 256 x e Max block size is 1024 x
4 bytes 4 bytes
Channels ¢ One instance per e MCU specific (8
interrupt channels or less)
Chained Transfers e Supported ¢ Not Supported
Software Trigger ¢ Must use the software e Has support for software
ELC event trigger without using
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software ELC event

e Supports TRANSFER ST
ART _MODE_SINGLE and
TRANSFER START _MOD
E_REPEAT

Offset Address Mode ¢ Not supported e Supported
Additional Considerations

e The DTC requires a moderate amount of RAM (one transfer_info_t struct per open instance
+ DTC_VECTOR TABLE_SIZE).

* The DTC stores transfer information in RAM and writes back to RAM after each transfer
whereas the DMAC stores all transfer information in registers.

e When transfers are configured for more than one activation source, the DTC must fetch the
transfer info from RAM on each interrupt. This can cause a higher latency between
transfers.

e The DTC interrupts the CPU using the activation source's IRQ. Each DMAC channel has its
own IRQ.

Interrupts

The DTC and DMAC interrupts behave differently. The DTC uses the configured IELSR event IRQ as
the interrupt source whereas each DMAC channel has its own IRQ.

The transfer_info_t::irq setting also behaves a little differently depending on which mode is selected.

Normal Mode

DTC DMAC
TRANSFER IRQ_EACH Interrupt after each transfer N/A
TRANSFER_IRQ_END Interrupt after last transfer Interrupt after last transfer
Repeat Mode

DTC DMAC
TRANSFER IRQ_EACH Interrupt after each transfer Interrupt after each repeat
TRANSFER_IRQ_END Interrupt after each repeat Interrupt after last transfer
Block Mode

DTC DMAC
TRANSFER_IRQ_EACH Interrupt after each block Interrupt after each block
TRANSFER IRQ_END Interrupt after last block Interrupt after last block
Note

DTC_VECTOR TABLE_SIZE = (ICU_NVIC_IRQ_SOURCESX 4) Bytes
Peripheral Interrupts and DTC

When an interrupt is configured to trigger DTC transfers, the peripheral ISR will trigger on the
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following conditions:

e Each transfer completed (transfer_info_t::irq = TRANSFER IRQ_EACH)
e Last transfer completed (transfer_info_t::irg = TRANSFER _IRQ END)

For example, if SCI1_RXI is configured to trigger DTC transfers and a SCI1_RXI event occurs, the
interrupt will not fire until the DTC transfer is completed. If the DTC transfer_info_t::irq is configured
to only interrupt on the last transfer, than no RXI interrupts will occur until the last transfer is
completed.

Note
1. The DTC activation source must be enabled in the NVIC in order to trigger DTC transfers (Modules that are
designed to integrate the R_DTC module will automatically handle this).
2. The DTC prioritizes activation sources by granting the smaller interrupt vector numbers higher priority. The
priority of interrupts to the CPU is determined by the NVIC priority.

Low Power Modes
DTCST must be set to 0 before transitioning to any of the following:

e Module-stop state
e Software Standby mode without Snooze mode transition
* Deep Software Standby mode

Note
1. R_ LPM Module stops the DTC before entering deep softwar e standby mode and softwar e standby without snooze

mode transition.
2. For more information see 18.9 and 18.10 in the RA6M3 manual RO1UHO0886EJ0100.

Limitations
Developers should be aware of the following limitations when using the DTC:

e |f the DTC is configured to service many different activation sources, the system could run
in to performance issues due to memory contention. To address this issue, it is
reccomended that the DTC vector table and transfer information be moved to their own
dedicated memory area (Ex: SRAMO, SRAM1, SRAMHS). This allows memory accesses from
different BUS Masters (CPU, DTC, DMAC, EDMAC and Graphics IPs) to occur in parallel.

Examples

Basic Example

This is a basic example of minimal use of the DTC in an application.

voi d dtc_mni ni mal _exanpl e (void)

{

/* Open the transfer instance with initial configuration. */
fsp_err_ t err = R DIC Open(&g_transfer _ctrl, & _transfer_cfg);

/* Handl e any errors. This function should be defined by the user. */

handl e _error(err);
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/* Enable the DTC to handle incom ng transfer requests. */
err = R DTC Enabl e(&g transfer _ctrl);

handl e_error(err);

Data Structures

struct dtc_extended cfg t
struct dtc_instance_ctrl_t

Macros

#define DTC_MAX_NORMAL_TRANSFER_LENGTH
#define DTC_MAX_REPEAT TRANSFER_LENGTH
#define DTC_MAX_BLOCK_TRANSFER_LENGTH

#define DTC_MAX_BLOCK_COUNT

Data Structure Documentation

¢ dtc_extended cfg_ t

struct dtc_extended_cfg_t

DTC transfer configuration extension. This extension is required.

Data Fields

IRQn_Type activation_source Select which IRQ will trigger the
transfer.

¢ dtc_instance_ctrl_t

struct dtc_instance_ctrl_t

Control block used by driver. DO NOT INITIALIZE - this structure will be initialized in
transfer_api_t::open.

Macro Definition Documentation

¢ DTC_MAX_NORMAL_TRANSFER_LENGTH

#define DTC_MAX_NORMAL_TRANSFER_LENGTH

Max configurable number of transfers in NORMAL MODE
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& DTC_MAX_REPEAT_TRANSFER_LENGTH

#define DTC_MAX_REPEAT TRANSFER_LENGTH

Max number of transfers per repeat for REPEAT MODE

¢ DTC_MAX_BLOCK _TRANSFER_LENGTH

#define DTC_MAX_BLOCK_TRANSFER_LENGTH

Max number of transfers per block in BLOCK MODE

& DTC_MAX_BLOCK_COUNT

#define DTC_MAX_BLOCK_COUNT

Max configurable number of blocks to transfer in BLOCK MODE

Function Documentation

¢ R_DTC Open()

fsp_err t R_DTC Open ( transfer _ctrl _t *const p_api ctrl, transfer _cfg t const *const p cfg )

Configure the vector table if it hasn't been configured, enable the Module and copy the pointer to
the transfer info into the DTC vector table. Implements transfer_api_t::open.

Example:
/* Open the transfer instance with initial configuration. */

fsp err t err = R DIC Open(&g_transfer ctrl, & transfer cfg);

Return values

FSP_SUCCESS Successful open. Transfer transfer info
pointer copied to DTC Vector table. Module
started. DTC vector table configured.

FSP_ERR_ASSERTION An input parameter is invalid.
FSP_ERR_UNSUPPORTED Address Mode Offset is selected.
FSP_ERR_ALREADY_OPEN The control structure is already opened.
FSP_ERR_IN_USE The index for this IRQ in the DTC vector

table is already configured.

FSP_ERR_IRQ BSP_DISABLED The IRQ associated with the activation
source is not enabled in the BSP.
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4 R_DTC_Reconfigure()

fsp_err_ t R_DTC_Reconfigure ( transfer_ctrl_t *const p_api ctrl, transfer_info t * p _info )

Copy pointer to transfer info into the DTC vector table and enable transfer in ICU. Implements
transfer_api_t::reconfigure.

Return values

FSP_SUCCESS Transfer is configured and will start when
trigger occurs.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to

initialize the control block.

FSP_ERR_NOT_ENABLED Transfer source address is NULL or is not
aligned corrrectly. Transfer destination
address is NULL or is not aligned corrrectly.

Note

p_info must persist until all transfers are completed.

¢ R_DTC_Reset()

fsp_err t R_DTC_Reset ( transfer_ctrl_t *const p_api ctrl, void const *volatile p_src, void *volatile
p_dest, uintl6_t const num_transfers )

Reset transfer source, destination, and number of transfers. Implements transfer_api_t::reset.

Return values

FSP_SUCCESS Transfer reset successfully (transfers are
enabled).

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to

initialize the control block.

FSP_ERR_NOT_ENABLED Transfer source address is NULL or is not
aligned corrrectly. Transfer destination
address is NULL or is not aligned corrrectly.
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4 R_DTC_SoftwareStart()

fsp_err_ t R_DTC_SoftwareStart ( transfer_ctrl_t *const p_api_ctrl, transfer_start mode t mode )

Placeholder for unsupported softwareStart function. Implements transfer_api_t::softwareStart.

Return values

FSP_ERR_UNSUPPORTED DTC software start is not supported.

¢ R_DTC_SoftwareStop()

fsp_err_t R_DTC_SoftwareStop ( transfer_ctrl_t *const p_api_ctrl)

Placeholder for unsupported softwareStop function. Implements transfer_api_t::softwareStop.

Return values

FSP_ERR_UNSUPPORTED DTC software stop is not supported.

¢ R_DTC_Enable()

fsp_err_ t R_DTC_Enable ( transfer_ctrl_t *const p_api_ctrl)

Enable transfers on this activation source. Implements transfer_api_t::enable.

Example:
/* Enable the DTC to handl e inconmi ng transfer requests. */
err = R DTC Enabl e(&g_transfer_ctrl);

handl e _error(err);

Return values

FSP_SUCCESS Transfers will be triggered by the activation
source

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_UNSUPPORTED Address Mode Offset is selected.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DTC_Open to
initialize the control block.
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¢ R_DTC Disable()

fsp_err_ t R_DTC Disable ( transfer_ctrl_t *const p_api _ctrl)

Disable transfer on this activation source. Implements transfer_api_t::disable.

Return values

FSP_SUCCESS Transfers will not occur on activation
events.
FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to

initialize the control block.

FSP_ERR_ASSERTION An input parameter is invalid.

¢ R_DTC InfoGet()

fsp_err_t R_DTC_InfoGet ( transfer_ctrl_t *const p_api_ctrl, transfer_properties_t *const
p_properties )

Provides information about this transfer. Implements transfer_api_t::infoGet.

Return values

FSP_SUCCESS p_info updated with current instance
information.
FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DTC_Open to

initialize the control block.

FSP_ERR_ASSERTION An input parameter is invalid.

¢ R_DTC_Close()

fsp_err t R_DTC Close ( transfer_ctrl_t *const p_api_ctrl)

Disables DTC activation in the ICU, then clears transfer data from the DTC vector table. Implements
transfer_api_t::close.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to
initialize the control block.
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¢ R_DTC VersionGet()

fsp_err_ t R_DTC VersionGet ( fsp_version_t *const p_version)

Get the driver version based on compile time macros. Implements transfer_api_t::versionGet.

Return values

FSP_SUCCESS Version information written to p_version.

FSP_ERR_ASSERTION An input parameter is invalid.

5.2.16 Event Link Controller (r_elc)
Modules

Functions

fsp_err t R_ELC Open (elc_ctrl_t *const p_ctrl, elc_cfg_t const *const p_cfg)
fsp_err t R _ELC Close (elc_ctrl_t *const p_ctrl)

fsp_err t R_ELC SoftwareEventGenerate (elc_ctrl_t *const p_ctrl,
elc_software_event t event_number)

fsp_err t R _ELC _LinkSet (elc_ctrl_t *const p_ctrl, elc_peripheral_t peripheral,
elc_event _t signal)

fsp_err t R_ELC_LinkBreak (elc_ctrl_t *const p_ctrl, elc_peripheral_t peripheral)
fsp_err t R_ELC Enable (elc_ctrl_t *const p_ctrl)
fsp_err t R _ELC Disable (elc_ctrl _t *const p_ctrl)

fsp_err t R_ELC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the ELC peripheral on RA MCUs. This module implements the ELC Interface.

Overview

The event link controller (ELC) uses the event requests generated by various peripheral modules as
source signals to connect (link) them to different modules, allowing direct cooperation between the
modules without central processing unit (CPU) intervention. The conceptual diagram below illustrates
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User’s Manual

a potential setup where a pin interrupt triggers a timer which later triggers an ADC conversion and
CTSU scan, while at the same time a serial communication interrupt automatically starts a data
transfer. These tasks would be automatically handled without the need for polling or interrupt

management.
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Figure 112: Event Link Controller Conceptual Diagram

In essence, the ELC is an array of multiplexers to route a wide variety of interrupt signals to a subset
of peripheral functions. Events are linked by setting the multiplexer for the desired function to the
desired signal (through R_ELC LinkSet). The diagram below illustrates one peripheral output of the
ELC. In this example, a conversion start is triggered for ADCO Group A when the GPTO counter

overflows:

Available events

| GPTOMatch B }—\_:
| GPTO Match C }_\_>

| GPTO Match D |—\_,

/

h 4

Peripheral function

000Y 1¥HIHdRAd 213

[ GPTO Overflow | —— 7]
[ GPT0 Underflow }_/_:

’

/ ELC_EVENT_GPTO_COUNTER_OVERFLOW

Selected event
Figure 113: ELC Example

Features

The ELC HAL module can perform the following functions:

ADCO Start
Conversion A
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* |nitialize the ELC to a pre-defined set of links

* Create an event link between two blocks

* Break an event link between two blocks

e Generate one of two software events that interrupt the CPU
e Globally enable or disable event links

A variety of functions can be activated via events, including:

e General-purpose timer (GPT) control

e ADC and DAC conversion start

e Synchronized I/O port output (ports 1-4 only)

e Capacitive touch unit (CTSU) measurement activation

Note
The available sources and peripherals may differ between devices. A full list of selectable peripherals and eventsis
available in the User's Manual for your device.
Some peripherals have specific settings related to ELC event generation and/or reception. Details on how to enable
event functionality for each peripheral are located in the usage notes for the related module(s) as well asin the
User's Manual for your device.

Configuration

Note

The RA Configuration tool will automatically generate event links based on the sel ections made in module
properties. To view the currently linked events check the Event Links tab in the configuration.
Calling R_ELC_Open followed by R_ELC_Enable will automatically link all events shown in the Event Links tab.

To manually link an event to a peripheral at runtime perform the following steps:

1. Configure the operation of the destination peripheral (including any configuration necessary
to receive events)

2. Use R_ELC_LinkSet to set the desired event link to the peripheral

3. Use R_ELC_Enable to enable transmission of event signals

4. Configure the signaling module to output the desired event (typically an interrupt)

To disable the event, either use R_ELC_LinkBreak to clear the link for a specific event or
R_ELC Disable to globally disable event linking.

Note

The ELC module needs no pin, clocking or interrupt configuration; it is merely a mechanismto connect signals
between peripherals. However, when linking 1/0 Ports via the ELC the relevant 1/0 pins need to be configured as
inputs or outputs.

Build Time Configurations for r_elc

The following build time configurations are defined in fsp_cfg/r_elc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > System > ELC Driver on r_elc
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This module can be added to the Stacks tab via New Stack > Driver > System > ELC Driver on r_elc:

Configuration Options Default Description

Name ELC instance name g_elc Module name.
must be g_elc to match
elc_cfg_t data structure
created in elc_data.c

Usage Notes

Limitations
Developers should be aware of the following limitations when using the ELC:

e To link events it is necessary for the ELC and the related modules to be enabled. The ELC
cannot operate if the related modules are in the module stop state or the MCU is in a low
power consumption mode for which the module is stopped.

e If two modules are linked across clock domains there may be a 1 to 2 cycle delay between
event signaling and reception. The delay timing is based on the frequency of the slowest
clock.

Examples

Basic Example
Below is a basic example of minimal use of event linking in an application.
/* This struct is automatically generated by the RA Configuration tool based on the

events configured by peripherals. */

static const elc_cfg t g elc cfg =

{
.1'ink[ ELC_PERI PHERAL_GPT_A] = ELC_EVENT_| CU_| RQ,
.1'i nk[ ELC_PERI PHERAL | OPORT1] = ELC_EVENT_GPTO_COUNTER OVERFLOW
ti
voi d el c_basi c_exanpl e (void)
{

fsp_err_t err = FSP_SUCCESS,;

/* Initializes the software and sets the |inks defined in the control structure. */
err = RELC Open(&g_elc_ctrl, & elc_cfg);

/* Handl e any errors. This function should be defined by the user. */

handl e_error(err);

/* Create or nodify a |link between a peripheral function and an event source. */
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Software-Generated Events

This example demonstrates how to use a software-generated event to signal a peripheral. This can
be useful when the desired event source is not supported by the ELC hardware.
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Data Structures

struct elc_instance_ctrl_t

Data Structure Documentation

¢ elc_instance_ctrl_t

struct elc_instance_ctrl_t

ELC private control block. DO NOT MODIFY. Initialization occurs when R_ELC Open() is called.

Function Documentation

¢ R_ELC Open()

fsp_err t R_ELC Open ( elc_ctrl_t *const p_ctrl, elc_cfg _t const *const p cfg )

Initialize all the links in the Event Link Controller. Implements elc_api_t::open

The configuration structure passed in to this function includes links for every event source included
in the ELC and sets them all at once. To set or clear an individual link use R_ELC LinkSet and
R _ELC LinkBreak respectively.

Example:
/* Initializes the software and sets the |links defined in the control structure. */

err = RELC Open(&g_elc_ctrl, & elc_cfg);

Return values

FSP_SUCCESS Initialization was successful
FSP_ERR_ASSERTION p_ctrl or p_cfg was NULL
FSP_ERR_ALREADY_OPEN The module is currently open
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4 R_ELC Close()

fsp_err t R_ELC Close ( elc_ctrl_t *const p_ctrl)

Globally disable ELC linking. Implements elc_api_t::close

Return values

FSP_SUCCESS The ELC was successfully disabled
FSP_ERR_ASSERTION p_ctrl was NULL
FSP_ERR_NOT_OPEN The module has not been opened

4 R_ELC SoftwareEventGenerate()

fsp_err_ t R_ELC SoftwareEventGenerate ( elc_ctrl_t *const p_ctrl, elc_software_event t
event_number )

Generate a software event in the Event Link Controller. Implements
elc_api_t::softwareEventGenerate

Example:
/* Cenerate an event signal through software to the |inked peripheral. */

err = R ELC Softwar eEvent Generate(&g elc _ctrl, ELC SOFTWARE EVENT 0) ;

handl e_error(err);

Return values

FSP_SUCCESS Initialization was successful

FSP_ERR_ASSERTION Invalid event number or p_ctrl was NULL

FSP_ERR_NOT_OPEN The module has not been opened
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& R_ELC_LinkSet()

fsp_err t R_ELC LinkSet ( elc_ctrl_t *const p_ctrl, elc_peripheral t peripheral, elc_event_ t signal )

Create a single event link. Implements elc_api_t::linkSet

Example:

/* Create or nodify a |link between a peripheral function and an event source. */
err = R ELC LinkSet(&y_elc _ctrl, ELC PERI PHERAL ADCO,

ELC_EVENT_GPTO_COUNTER OVERFLOW ;

handl e_error(err);

Return values

FSP_SUCCESS Initialization was successful
FSP_ERR_ASSERTION p_ctrl was NULL
FSP_ERR_NOT_OPEN The module has not been opened

4 R_ELC_LinkBreak()

fsp_err t R_ELC LinkBreak ( elc_ctrl_t *const p ctrl, elc_peripheral t peripheral )

Break an event link. Implements elc_api_t::linkBreak

Return values

FSP_SUCCESS Event link broken
FSP_ERR_ASSERTION p_ctrl was NULL
FSP_ERR_NOT _OPEN The module has not been opened

¢ R ELC _Enable()

fsp_err t R_ELC Enable ( elc_ctrl_t *const p_ctrl)

Enable the operation of the Event Link Controller. Implements elc_api_t::enable

Return values

FSP_SUCCESS ELC enabled.

FSP_ERR_ASSERTION p_ctrl was NULL

FSP_ERR_NOT_OPEN The module has not been opened
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¢ R_ELC Disable()

fsp_err t R_ELC Disable ( elc_ctrl_t *const p_ctrl)

Disable the operation of the Event Link Controller. Implements elc_api_t::disable

Return values

FSP_SUCCESS ELC disabled.
FSP_ERR_ASSERTION p_ctrl was NULL
FSP_ERR_NOT_OPEN The module has not been opened

¢ R_ELC VersionGet()

fsp_err t R_ELC VersionGet ( fsp_version_t *const p_version)

Get the driver version based on compile time macros. Implements elc_api_t::versionGet

Return values
FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION p_version is NULL.

5.2.17 Ethernet (r_ether)
Modules

Functions

fsp_err t R_ETHER Open (ether ctrl_t *const p_ctrl, ether _cfg_t const *const
p_cfg)

After ETHERC, EDMAC and PHY-LSI are reset in software, an auto
negotiation of PHY-LSI is begun. Afterwards, the link signal change
interrupt is permitted. Implements ether_api_t::open. More...

fsp_err t R_ETHER_Close (ether_ctrl_t *const p_ctrl)

Disables interrupts. Removes power and releases hardware lock.
Implements ether_api_t::close. More...

fsp_err t R_ETHER Read (ether ctrl _t *const p_ctrl, void *const p_buffer,
uint32_t *const length_bytes)
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Receive Ethernet frame. Receives data to the location specified by
the pointer to the receive buffer. In zero copy mode, the address of
the receive buffer is returned. In non zero copy mode, the received
data in the internal buffer is copied to the pointer passed by the
argument. Implements ether_api_t::read. More...

fsp_err t R_ETHER BufferRelease (ether ctrl t *const p_ctrl)

Move to the next buffer in the circular receive buffer list. Implements
ether_api_t::bufferRelease. More...

fsp_err t R_ETHER Write (ether_ctrl_t *const p_ctrl, void *const p_buffer,
uint32_t const frame_length)

Transmit Ethernet frame. Transmits data from the location specified
by the pointer to the transmit buffer, with the data size equal to the
specified frame length. In the non zero copy mode, transmits data
after being copied to the internal buffer. Implements
ether_api_t::write. More...

fsp_err t R_ETHER_LinkProcess (ether ctrl_t *const p_ctrl)

The Link up processing, the Link down processing, and the magic
packet detection processing are executed. Implements
ether_api_t::linkProcess. More...

fsp_err t R _ETHER WakeOnLANEnable (ether ctrl t *const p_ctrl)

The setting of ETHERC is changed from normal sending and
receiving mode to magic packet detection mode. Implements
ether_api_t::wakeOnLANEnable. More...

fsp_err t R_ETHER VersionGet (fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer.
Implements ether_api_t::versionGet. More...

Detailed Description

Driver for the Ethernet peripheral on RA MCUs. This module implements the Ethernet Interface.

Overview

This module performs Ethernet frame transmission and reception using an Ethernet controller and an
Ethernet DMA controller.

Features
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The Ethernet module supports the following features:

Transmit/receive processing

Optional zero-copy buffering

Callback function with returned event code
Magic packet detection mode support
Auto negotiation support

Flow control support

Multicast filtering support

Broadcast filtering support

Promiscuous mode support

Configuration

Build Time Configurations for r_ether

The following build time configurations are defined in fsp_cfg/r_ether cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.
The polarity of the link ¢ Fall -> Rise Fall -> Rise Specify the polarity of
signal output by the e Rise -> Fall the link signal output
PHY-LSI by the PHY-LSI. When 0

is specified, link-up and
link-down correspond
respectively to the fall
and rise of the LINKSTA
signal. When 1 is
specified, link-up and
link-down correspond
respectively to the rise
and fall of the LINKSTA

signal.
The link status is e Unused Unused Use LINKSTA signal for
detected by LINKSTA e Used detect link status
signal changes 0 = unused

(use PHY-LSI status
register) 1 = use (use
LINKSTA signal)

Configurations for Driver > Network > Ethernet Driver on r_ether

This module can be added to the Stacks tab via New Stack > Driver > Network > Ethernet Driver on
r ether:

Configuration Options Default Description
General > Name Name must be a valid g_ether0 Module name.
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C symbol
General > Channel 0 0 Select the ether
channel number.
General > MAC address Must be a valid MAC 00:11:22:33:44:55 MAC address of this
address channel.
General > Zero-copy e Disable Disable Enable or disable zero-
Mode e Enable copy mode.
General > Flow control ¢ Disable Disable Enable or disable flow
functionality ¢ Enable control.
Filters > Multicast e Disable Enable Enable or disable
Mode e Enable multicast frame
reception.
Filters > Promiscuous ¢ Disable Disable Enable this option to
Mode ¢ Enable receive packets
addressed to other
NICs.
Filters > Broadcast Must be a valid non- 0 Limit of the number of
filter negative integer with broadcast frames
maximum configurable received continuously
value of 65535.
Buffers > Number of Must be an integer 1 Number of transmit
TX buffer from 1to 8 buffers
Buffers > Number of Must be an integer 1 Number of receive
RX buffer from1lto8 buffers
Buffers > Buffer size Must be at least 1514 1514 Size of Ethernet buffer
which is the maximum
Ethernet frame size
Interrupts > Interrupt MCU Specific Options Select the EDMAC
priority interrupt priority.
Interrupts > Callback Name must be a valid  NULL Callback provided
C symbol when an ISR occurs

Interrupt Configuration

The first R_ ETHER Open function call sets EINT interrupts. The user could provide callback function
which would be invoked when EINT interrupt handler has been completed. The callback arguments
will contain information about a channel number, the ETHERC and EDMAC status, the event code,
and a pointer to the user defined context.

Callback Configuration

The user could provide callback function which would be invoked when either a magic packet or a
link signal change is detected. When the callback function is called, a variable in which the channel
number for which the detection occurred and a constant shown in Table 2.4 are stored is passed as
an argument. If the value of this argument is to be used outside the callback function, it's value
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should be copied into, for example, a global variable.
Clock Configuration

The ETHER clock is derived from the following peripheral clock on each device.

MCU Peripheral Clock
RA6M?2 PCLKA
RA6M3 PCLKA

Note
1. When using ETHERC, the PCLKA frequency isin therange 12.5 MHz <= PCLKA <= 120 MHz
2. When using ETHERC, PCLKA = ICLK.
Pin Configuration
To use the Ethernet module, input/output signals of the peripheral function have to be allocated to

pins with the multi-function pin controller (MPC). Please perform the pin setting before calling the
R_ETHER_Open function.

Usage Notes
Ethernet Frame Format
The Ethernet module supports the Ethernet II/IEEE 802.3 frame format.

Frame Format for Data Transmission and Reception

Preamble SFD dl[s?rljﬁarn Tranasszgéosurce Length/type Data + padding FCS
(7 bytes) (1 byte) address (8 bytes) (6 bytes) (2 bytes) (46 to 1,500 bytes) (4 bytes)

<4— Physical header —»4———— Ethemnst header ——————»¢——— Payload ———»4— Trailler —»

Hardware
processing data

Hardware

processing data

—»4+——— Valid software (Ethemet module) data

Figure 114: Frame Format Image

The preamble and SFD signal the start of an Ethernet frame. The FCS contains the CRC of the
Ethernet frame and is calculated on the transmitting side. When data is received the CRC value of
the frame is calculated in hardware, and the Ethernet frame is discarded if the values do not match.
When the hardware determines that the data is normal, the valid range of receive data is:
(transmission destination address) + (transmission source address) + (length/type) + (data).

PAUSE Frame Format

Transfer destination | Transfer source p Operation
reme | sro | "™ | T romeel VIR resesion | g |
(Toytes) [ (1bvle) | 01-80:C2:00:00:01) |  (Bbyies) | O¥FB08) | (axo001) (0~65933) (4 bytes)
<+— Physical header —»¢————————— Ethernet header L Payload 1t Traller —»
Figure 115: Pause Frame Format Image
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The transmission destination address is specified as 01:80:C2:00:00:01 (a multicast address
reserved for PAUSE frames). At the start of the payload the length/type is specified as 0x8808 and
the operation code as 0x0001. The pause duration in the payload is specified by the value of the
automatic PAUSE (AP) bits in the automatic PAUSE frame setting register (APR), or the manual PAUSE
time setting (MP) bits in the manual PAUSE frame setting register (MPR).

Magic Packet Frame Format

Transfer source Data
T;TT:Q? (155?6) T;adrlls[;esrsdésgniaégn address L?;gbtht.?g;e (FF:FF:FFFF:FF.FF, Transfer destination Padding (4'2025)
¥ Y ¥ (6 bytes) Y address = 16) ¥

<— Physical header —w4—————————— Ethernet header >4 Payload g ] Traller —»

Figure 116: Magic Packet Frame Format Image

In a Magic Packet, the value FF:FF:FF:FF:FF:FF followed by the transmission destination address
repeated 16 times is inserted somewhere in the Ethernet frame data.

Limitations

The Ethernet Driver has several alignment constraints:

16-byte alignment for the descriptor

e 32-byte aligned write buffer for R_ ETHER_Write when zero copy mode is enabled

Examples

ETHER Basic Example

This is a basic example of minimal use of the ETHER in an application.

Note

#defi ne
#def i ne
#def i ne
#defi ne
#def i ne
#def i ne
0x00, \

0x00,

0x00,

0x00,

In this example zero-copy mode is disabled and there are no restrictions on buffer alignment.

ETHER_EXAMPLE_MAXI MUM_ETHERNET _FRAME_SI ZE (1514)

ETHER EXAMPLE_TRANSM T_ETHERNET FRAME_SI ZE ( 60)

ETHER EXAVPLE SOURCE MAC ADDRESS 0x74, 0x90, 0x50, 0x00, 0x79, 0x01

ETHER _EXAVPLE_DESTI NATI ON_MAC _ADDRESS 0x74, 0x90, 0x50, 0x00, 0x79, 0x02
ETHER EXAVPLE FRAMVE TYPE 0x00, Ox2E

ETHER EXAMPLE_PAYLQOAD 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0xO00,

0x00, 0Ox00, 0x00, Ox00, 0x00, Ox00, 0x00, 0Ox00, 0x00, \
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \
0x00, 0x00, 0x00, 0x00, 0x00, O0x00, 0x00, 0x00, 0x00, \

/* Receive data buffer */
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static uint8 t gp_read buffer[ ETHER EXAMPLE MAXI MUM ETHERNET FRAME S| ZE] =
[* Transmt data buffer */
static uint8_t gp_send_data] ETHER EXAMPLE TRANSM T_ETHERNET FRAME_SI ZE] =

{
ETHER EXAMPLE DESTI NATI ON_MAC ADDRESS, /* Destinati on MAC address */

ETHER_EXAMPLE_SOURCE_MAC_ADDRESS, /* Source MAC address */
ETHER EXAMPLE_FRAME_TYPE, /* Type field */
ETHER EXAMPLE PAYLOAD /* Payl oad val ue (46byte) */
b
voi d et her basi c_exanpl e (void)
{

fsp_err_t err = FSP_SUCCESS;

/* Source MAC Address */

static uint8 t nmac_address_source[ 6] = { ETHER EXAMPLE SOURCE MAC ADDRESS};
uint32_t read _data _size = 0;
g_ether0 _cfg. p_nmac_address = mac_addr ess_sour ce;

/* Open the ether instance with initial configuration. */
err = R ETHER Open(&g ether0O_ctrl, &g ether0_cfg);

/* Handl e any errors. This function should be defined by the user. */
handl e _error(err);

do
{

{0};

/* When the Ethernet |ink status read fromthe PHY-LSI Basic Status register is |ink-

up,
* |nitializes the nodul e and make auto negotiation. */
err = R ETHER Li nkProcess(&g ether0 _ctrl);
} while (FSP_SUCCESS != err);

/* Transm ssion is non-bl ocking. */

/* User data copy to internal buffer and is transferred by DVA in the background. */

err = RETHER Wite(&g_ether0 ctrl, (void *) gp_send data, sizeof(gp_send _data));

handl e_error(err);

/* received data copy to user buffer frominternal buffer. */

err = R ETHER Read(&g etherO_ctrl, (void *) gp_read_buffer, & ead data_size);

handl e_error(err);
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/* Di sable transm ssion and recei ve function and cl ose the ether instance. */

R ETHER Cl ose(&g ether0_ctrl);

ETHER Advanced Example

The example demonstrates using send and receive function in zero copy mode. Transmit buffers
must be 32-byte aligned and the receive buffer must be released once its contents have been used.
#def i ne ETHER EXAMPLE_FLAG ON (1U)

#defi ne ETHER_EXAMPLE_FLAG OFF (0U)

#def i ne ETHER EXAMPLE_ETHER | SR_EE_FR MASK (1UL << 18)

#def i ne ETHER EXAMPLE_ETHER | SR_EE_TC MASK (1UL << 21)

#def i ne ETHER EXAMPLE_ETHER | SR EC MPD MASK (1UL << 1)

#def i ne ETHER EXAVPLE_AL|I GNVENT_32_BYTE (32)

static volatile uint32_t g _exanple receive conplete = 0;

static volatile uint32_t g exanple transfer conplete = 0;

static volatile uint32_t g exanpl e_magi c_packet done = 0;

/* The data buffer nmust be 32-byte aligned when using zero copy node. */

static uint8 t gp_send data nocopy[ ETHER EXAMPLE TRANSM T _ETHERNET FRAME_SI ZE]
BSP_ALI GN_VARI ABLE(32) =

{
ETHER EXAMPLE_DESTI NATI ON_MAC _ADDRESS, /* Destination MAC address */
ETHER EXAMPLE SOURCE MAC ADDRESS, /* Source MAC address */
ETHER EXAMPLE_FRANME_TYPE, /* Type field */
ETHER EXAMPLE PAYLOAD /* Payl oad val ue (46byte) */
1

voi d et her _exanpl e_cal | back (ether_call back _args t * p_args) {
switch (p_args->event)
{
case ETHER EVENT_| NTERRUPT:
{
i f (ETHER EXAMPLE ETHER | SR EC MPD MASK == (p_args->status_ecsr &
ETHER_EXAMPLE_ETHER | SR_ EC_MPD_MASK) )
{
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Data Structures

struct ether_instance ctrl t

Enumerations

ether_previous_link status t
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enum ether_link_change_t
enum ether magic_packet t

enum ether_link_establish_status_t

Data Structure Documentation

¢ ether_instance_ctrl_t

struct ether_instance_ctrl_t
ETHER control block. DO NOT INITIALIZE. Initialization occurs when ether_api_t::open is called.
Data Fields

uint32_t open Used to determine if the
channel is configured.

ether _cfg t const * p_ether cfg Pointer to initial configurations.

ether_instance_descriptor_t * p_rx_descriptor Pointer to the currently
referenced transmit descriptor.

ether_instance_descriptor_t * p_tx_descriptor Pointer to the currently
referenced receive descriptor.

void * p_reg_etherc Base register of ethernet
controller for this channel.

void * p_reg_edmac Base register of EDMA
controller for this channel.

ether_previous_link status t previous_link_status Previous link status.

ether_link_change_t link_change status of link change

ether_magic_packet t magic_packet status of magic packet
detection

ether_link_establish_status_t link_establish_status Current Link status.

Enumeration Type Documentation

¢ ether_previous_link_status_t

enum ether_previous_link_status_t

Enumerator
ETHER PREVIOUS_LINK STATUS DOWN Previous link status is down.
ETHER_PREVIOUS_LINK_STATUS_UP Previous link status is up.
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¢ ether_link_change_t

enum ether_link_change_t

Enumerator

ETHER_LINK_CHANGE_NO_CHANGE

Link status is no change.

ETHER_LINK_CHANGE_LINK_DOWN

Link status changes to down.

ETHER_LINK_CHANGE_LINK_UP

Link status changes to up.

¢ ether_magic_packet_t

enum ether _magic_packet t

Enumerator

ETHER_MAGIC_PACKET NOT DETECTED

Magic packet is not detected.

ETHER_MAGIC_PACKET_DETECTED

Magic packet is detected.

¢ ether _link_establish_status t

enum ether_link_establish_status_t

Enumerator

ETHER_LINK_ESTABLISH_STATUS_DOWN

Link establish status is down.

ETHER_LINK_ESTABLISH_STATUS_UP

Link establish status is up.

Function Documentation
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¢ R_ETHER_Open()

fsp_err t R_ ETHER Open ( ether_ctrl_t *const p_ctrl, ether cfg_t const *const p cfg )

After ETHERC, EDMAC and PHY-LSI are reset in software, an auto negotiation of PHY-LSI is begun.
Afterwards, the link signal change interrupt is permitted. Implements ether_api_t::open.

Return values

FSP_SUCCESS Channel opened successfully.

FSP_ERR_ASSERTION Pointer to ETHER control block or
configuration structure is NULL.

FSP_ERR_ALREADY_OPEN Control block has already been opened or

channel is being used by another instance.
Call close() then open() to reconfigure.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATI | Initialization of PHY-LSI failed.

ON

FSP_ERR_INVALID CHANNEL Invalid channel number is given.
FSP_ERR_INVALID_POINTER Pointer to MAC address is NULL.
FSP_ERR_INVALID ARGUMENT Interrupt is not enabled.
FSP_ERR_ETHER_PHY_ERROR_LINK Initialization of PHY-LSI failed.

¢ R_ETHER_Close()

fsp_err t R_ ETHER Close ( ether_ctrl_t *const p_ctrl)

Disables interrupts. Removes power and releases hardware lock. Implements ether_api _t::close.

Return values

FSP_SUCCESS Channel successfully closed.

FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.

FSP_ERR_NOT_OPEN The control block has not been opened
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¢ R_ETHER_Read()

fsp_err t R_ ETHER Read ( ether_ctrl_t *const p_ctr/, void *const p_buffer, uint32_t *const
length_bytes )

Receive Ethernet frame. Receives data to the location specified by the pointer to the receive
buffer. In zero copy mode, the address of the receive buffer is returned. In non zero copy mode, the
received data in the internal buffer is copied to the pointer passed by the argument. Implements
ether_api_t::read.

Return values

FSP_SUCCESS Processing completed successfully.
FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT _OPEN The control block has not been opened.
FSP_ERR_ETHER ERROR _NO_DATA There is no data in receive buffer.
FSP_ERR_ETHER ERROR_LINK Auto-negotiation is not completed, and

reception is not enabled.

FSP_ERR_ETHER _ERROR_MAGIC _PACKET M | As a Magic Packet is being detected,
ODE transmission and reception is not enabled.

FSP_ERR_ETHER_ERROR_FILTERING Multicast Frame filter is enable, and
Multicast Address Frame is received.

FSP_ERR_INVALID_POINTER Value of the pointer is NULL.

& R_ETHER_BufferRelease()

fsp_err t R_ETHER BufferRelease ( ether ctrl t *const p ctrl)

Move to the next buffer in the circular receive buffer list. Implements ether_api_t::bufferRelease.

Return values

FSP_SUCCESS Processing completed successfully.

FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened
FSP_ERR_ETHER ERROR_LINK Auto-negotiation is not completed, and

reception is not enabled.

FSP_ERR_ETHER ERROR_MAGIC PACKET M | As a Magic Packet is being detected,
ODE transmission and reception is not enabled.
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& R_ETHER_Write()

fsp_err_t R_ETHER_Write ( ether_ctrl_t *const p_ctrl, void *const p_buffer, uint32_t const
frame_length )

Transmit Ethernet frame. Transmits data from the location specified by the pointer to the transmit
buffer, with the data size equal to the specified frame length. In the non zero copy mode, transmits
data after being copied to the internal buffer. Implements ether_api_t::write.

Return values

FSP_SUCCESS Processing completed successfully.

FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened.
FSP_ERR_ETHER ERROR_LINK Auto-negotiation is not completed, and

reception is not enabled.

FSP_ERR_ETHER_ERROR_MAGIC_PACKET M [As a Magic Packet is being detected,

ODE transmission and reception is not enabled.

FSP_ERR_ETHER_ERROR_TRANSMIT_BUFFER | Transmit buffer is not empty.

_FULL

FSP_ERR_INVALID POINTER Value of the pointer is NULL.

FSP_ERR_INVALID ARGUMENT Value of the send frame size is out of range.
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¢ R_ETHER_LinkProcess()

fsp_err t R_ETHER _LinkProcess ( ether _ctrl _t *const p _ctrl)

The Link up processing, the Link down processing, and the magic packet detection processing are
executed. Implements ether_api_t::linkProcess.

Return values

FSP_SUCCESS

Link is up.

FSP_ERR_ASSERTION

Pointer to ETHER control block is NULL.

FSP_ERR_NOT OPEN

The control block has not been opened.

FSP_ERR_ETHER_ERROR_LINK

Link is down.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATI
ON

When reopening the PHY interface
initialization of the PHY-LSI failed.

FSP_ERR_ALREADY_OPEN

When reopening the PHY interface it was
already opened.

FSP_ERR_INVALID_CHANNEL

When reopening the PHY interface an
invalid channel was passed.

FSP_ERR_INVALID_POINTER

When reopening the PHY interface the MAC
address pointer was NULL.

FSP_ERR_INVALID_ARGUMENT

When reopening the PHY interface the
interrupt was not enabled.

FSP_ERR_ETHER_PHY ERROR_LINK

Initialization of the PHY-LSI failed.

¢ R_ETHER_WakeOnLANEnable()

fsp_err_ t R_ ETHER WakeOnLANEnable ( ether ctrl _t *const p_ctrl)

Return values

The setting of ETHERC is changed from normal sending and receiving mode to magic packet
detection mode. Implements ether_api_t::wakeOnLANEnable.

FSP_SUCCESS

Processing completed successfully.

FSP_ERR_ASSERTION

Pointer to ETHER control block is NULL.

FSP_ERR_NOT OPEN

The control block has not been opened.

FSP_ERR_ETHER_ERROR_LINK

Auto-negotiation is not completed, and
reception is not enabled.

FSP_ERR_ETHER_PHY_ERROR_LINK

Initialization of PHY-LSI failed.
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¢ R_ETHER_ VersionGet()

__INLINE fsp_err_t R_ETHER_VersionGet ( fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer. Implements ether_api_t::versionGet.

Return values

FSP_SUCCESS Version information stored in provided
p_version.
FSP_ERR_ASSERTION p_version is NULL.

5.2.18 Ethernet PHY (r_ether_phy)

Modules

Functions

fsp_err t R_ETHER_PHY Open (ether_phy ctrl_t *const p_ctrl, ether_phy cfg_t
const *const p_cfg)

Resets Ethernet PHY device. Implements ether phy api_t::open. *.
More...

fsp_err t R_ETHER PHY Close (ether phy ctrl t *const p_ctrl)

Close Ethernet PHY device. Implements ether phy _api_t::close.
More...

fsp_err t R_ETHER_PHY_StartAutoNegotiate (ether phy ctrl_t *const p_ctrl)

Starts auto-negotiate. Implements
ether_phy api_t::startAutoNegotiate. More...

fsp_err t R_ETHER_PHY_LinkPartnerAbilityGet (ether_phy ctrl_t *const p_ctrl,
uint32_t *const p_line_speed_duplex, uint32_t *const p_local_pause,
uint32_t *const p_partner_pause)

Reports the other side's physical capability. Implements
ether_phy api_t::linkPartnerAbilityGet. More...

fsp_err t R _ETHER PHY LinkStatusGet (ether phy ctrl t *const p_ctrl)

Returns the status of the physical link. Implements
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ether_phy api_t::linkStatusGet. More...

fsp_err t R_ETHER_PHY VersionGet (fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer.
Implements ether _phy api _t::versionGet. More...

Detailed Description

The Ethernet PHY module (r_ether_phy) provides an API for standard Ethernet PHY communications
applications that use the ETHERC peripheral. It implements the Ethernet PHY Interface.

Overview

The Ethernet PHY module is used to setup and manage an external Ethernet PHY device for use with
the on-chip Ethernet Controller (ETHERC) peripheral. It performs auto-negotiation to determine the
optimal connection parameters between link partners. Once initialized the connection between the
external PHY and the onboard controller is automatically managed in hardware.
Features
The Ethernet PHY module supports the following features:

* Auto negotiation support

e Flow control support
e Link status check support

Configuration

Build Time Configurations for r_ether_phy

The following build time configurations are defined in fsp_cfg/r_ether_phy cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
e Disabled included in the build.
Select PHY e Default Default Select PHY chip to use.
e Other Selecting 'Default’ will
e KSZ8091RNB automatically choose
e KSZ8041 the correct option
e DP83620 when using a Renesas
development board.
Use Reference Clock e Default Enabled Select whether to use
e Enabled the RMII reference
e Disabled clock. Selecting
'‘Default' will
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automatically choose
the correct option
when using a Renesas
development board.

Configurations for Driver > Network > Ethernet Driver on r_ether_phy

This module can be added to the Stacks tab via New Stack > Driver > Network > Ethernet Driver on
r_ether_phy:

Configuration Options Default Description
Name Name must be a valid  g_ether_phy0 Module name.
C symbol
Channel e 0 0 Select the Ethernet
e 1 controller channel
number.
PHY-LSI Address Specify a value 0 Specify the address of
between 0 and 31. the PHY-LSI used.
PHY-LSI Reset Specify a value 0x00020000 Specify the number of
Completion Timeout between 1 and times to read the PHY-
OxFFFFFFFF. LSI control register

while waiting for reset
completion. This value
should be adjusted
experimentally based
on the PHY-LSI used.

MII/RMII Register Specify a value 8 Specify the bit timing
Access Wait-time between 1 and for MII/RMII register
OX7FFFFFFF. accesses during PHY

initialization. This value
should be adjusted
experimentally based
on the PHY-LSI used.

Flow Control e Disable Disable Select whether to
e Enable enable or disable flow
control.

Usage Notes

Note
See the example below for details on how to initialize the Ethernet PHY module.

Limitations
e The r_ether_phy module may need to be customized for PHY devices other than the ones

currently supported (KSZ8091RNB, KSZ8041 and DP83620). Use the existing code as a
starting point for creating a custom implementation.
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Examples

ETHER PHY Basic Example

This is a basic example of minimal use of the ETHER PHY in an application.

Data Structures

struct ether_phy instance_ctrl t
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Data Structure Documentation

¢ ether_phy_instance_ctrl_t

struct ether_phy instance_ctrl_t
ETHER PHY control block. DO NOT INITIALIZE. Initialization occurs when ether_phy api_t::open is
called.
Data Fields
uint32_t open Used to determine if the
channel is configured.
ether_phy cfg t const * p_ether phy cfg Pointer to initial configurations.
volatile uint32_t * p_reg_pir Pointer to ETHERC peripheral
registers.
uint32_t local_advertise Capabilities bitmap for local
advertising.

Function Documentation

& R_ETHER_PHY Open()

fsp_err_t R_ETHER_PHY_Open ( ether_phy_ctrl_t *const
)

p_ctrl, ether phy cfg t const *const p_cfg

Resets Ethernet PHY device. Implements ether_phy api

Return values

_t:iopen. *,

FSP_SUCCESS

Channel opened successfully.

FSP_ERR_ASSERTION

Pointer to ETHER _PHY control block or
configuration structure is NULL.

FSP_ERR_ALREADY_OPEN

Control block has already been opened or
channel is being used by another instance.
Call close() then open() to reconfigure.

FSP_ERR_INVALID_CHANNEL

Invalid channel number is given.

FSP_ERR_INVALID_POINTER

Pointer to p_cfg is NULL.

FSP_ERR_TIMEOUT

PHY-LSI Reset wait timeout.
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¢ R_ETHER_PHY Close()

fsp_err_ t R_ETHER PHY _Close ( ether_phy ctrl_t *const p_ctrl)

Close Ethernet PHY device. Implements ether_phy api_t::close.

Return values

FSP_SUCCESS Channel successfully closed.
FSP_ERR_ASSERTION Pointer to ETHER _PHY control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened

¢ R_ETHER_PHY_StartAutoNegotiate()

fsp_err t R_ETHER_PHY_StartAutoNegotiate ( ether phy ctrl t *const p_ctrl)

Starts auto-negotiate. Implements ether phy _api_t::startAutoNegotiate.

Return values

FSP_SUCCESS ETHER_PHY successfully starts auto-
negotiate.

FSP_ERR_ASSERTION Pointer to ETHER _PHY control block is NULL.

FSP_ERR_NOT_OPEN The control block has not been opened

¢ R_ETHER_PHY_LinkPartnerAbilityGet()

fsp_err t R_ ETHER _PHY_LinkPartnerAbilityGet ( ether phy ctrl t *const p_ctr/, uint32_t *const
p_line_speed duplex, uint32_t *const p_local pause, uint32_t *const p_partner pause )
Reports the other side's physical capability. Implements ether phy_api_t::linkPartnerAbilityGet.
Return values
FSP_SUCCESS ETHER_PHY successfully get link partner
ability.
FSP_ERR_ASSERTION Pointer to ETHER_PHY control block is NULL.
FSP_ERR_INVALID POINTER Pointer to arguments are NULL.
FSP_ERR_NOT_OPEN The control block has not been opened
FSP_ERR_ETHER PHY ERROR_LINK PHY-LSI is not link up.
FSP_ERR_ETHER PHY_NOT_READY The auto-negotiation isn't completed
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& R_ETHER_PHY _LinkStatusGet()

fsp_err t R_ETHER PHY_LinkStatusGet ( ether_phy ctrl_t *const p_ctrl)

Return values

Returns the status of the physical link. Implements ether_phy api_t::linkStatusGet.

FSP_SUCCESS

ETHER_PHY successfully get link partner
ability.

FSP_ERR_ASSERTION

Pointer to ETHER_PHY control block is NULL.

FSP_ERR_NOT OPEN

The control block has not been opened

FSP_ERR_ETHER_PHY ERROR_LINK

PHY-LSI is not link up.

¢ R_ETHER_PHY_VersionGet()

__INLINE fsp_err_t R_ETHER_PHY_VersionGet ( fsp_version_t *const p_version)

ether_phy api_t::versionGet.

Parameters

Provides APl and code version in the user provided pointer. Implements

lin]

p_version

Version number set here

Return values

FSP_SUCCESS

Version information stored in provided
p_version.

FSP_ERR_ASSERTION

p_version is NULL.

5.2.19 High-Performance Flash Driver (r_flash_hp)

Modules
Functions
fsp_err t
fsp_err t
fsp_err t

R_FLASH_HP_Open (flash_ctrl_t *const p_api_ctrl, flash_cfg t const

*const p_cfg)

R_FLASH HP_ Write (flash_ctrl _t *const p_api_ctrl, uint32_t const
src_address, uint32_t flash_address, uint32_t const num_bytes)

R_FLASH_HP_Erase (flash_ctrl_t *const p_api_ctrl, uint32_t const
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address, uint32_t const num_blocks)

fsp_err t R_FLASH HP BlankCheck (flash_ctrl_t *const p_api_ctrl, uint32_t
const address, uint32_t num_bytes, flash_result t
*blank_check result)

fsp_err t R_FLASH HP Close (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH HP StatusGet (flash_ctrl_t *const p_api_ctrl, flash_status t
*const p_status)

fsp_err t R _FLASH HP_AccessWindowSet (flash_ctrl_t *const p_api_ctrl,
uint32_t const start_addr, uint32_t const end_addr)

fsp_err t R _FLASH HP_AccessWindowClear (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH HP_IdCodeSet (flash_ctrl_t *const p_api_ctrl, uint8 t const
*const p_id_code, flash_id_code_mode_t mode)

fsp_err t R_FLASH HP Reset (flash_ctrl _t *const p_api_ctrl)
fsp_err t R_FLASH HP UpdateFlashClockFreq (flash_ctrl_t *const p_api_ctrl)

fsp_err t R _FLASH HP_StartUpAreaSelect (flash_ctrl t *const p_api_ctrl,
flash_startup_area swap_t swap_type, bool is_temporary)

fsp_err t R _FLASH HP_VersionGet (fsp_version_t *const p_version)

fsp_err t R_FLASH_HP_InfoGet (flash_ctrl_t *const p_api_ctrl, flash_info_t
*const p_info)

Detailed Description

Driver for the flash memory on RA high-performance MCUs. This module implements the Flash
Interface.

Overview

The Flash HAL module APIs allow an application to write, erase and blank check both the data and
ROM flash areas that reside within the MCU. The amount of flash memory available varies across
MCU parts.

Features

The R_FLASH_HP module has the following key features:
¢ Blocking and non-blocking erasing, writing and blank-checking of data flash.
e Blocking erasing, writing and blank-checking of code flash.

e Callback functions for completion of non-blocking data-flash operations.
e Access window (write protection) for ROM Flash, allowing only specified areas of code flash
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to be erased or written.
e Boot block-swapping.
e ID code programming support.

Configuration

Build Time Configurations for r_flash_hp

The following build time configurations are defined in fsp_cfg/r_flash_hp_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
¢ Disabled included in the build.
Code Flash e Enabled Disabled Controls whether or not
Programming Enable ¢ Disabled code-flash

programming is
enabled. Disabling
reduces the amount of
ROM and RAM used by

the API.
Data Flash e Enabled Enabled Controls whether or not
Programming Enable e Disabled data-flash

programming is
enabled. Disabling
reduces the amount of
ROM used by the API.

Configurations for Driver > Storage > Flash Driver on r_flash_hp

This module can be added to the Stacks tab via New Stack > Driver > Storage > Flash Driver on
r_flash_hp:

Configuration Options Default Description
Name Name must be a valid  g_flashO Module name.
C symbol
Data Flash Background ¢ Enabled Enabled Enabling allows Flash
Operation ¢ Disabled API calls that reference

data-flash to return
immediately, with the
operation continuing in
the background.

Callback Name must be a valid NULL A user callback
C symbol function can be
specified. Callback
function called when a
dataflash BGO
operation completes or

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 387 /1,444
Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > High-Performance Flash Driver (r_flash_hp)

errors.
Flash Ready Interrupt MCU Specific Options Select the flash ready
Priority interrupt priority.
Flash Error Interrupt MCU Specific Options Select the flash error
Priority interrupt priority.

Clock Configuration

Flash uses FCLK as the clock source depending on the MCU. When writing and erasing the clock
source must be at least 4 MHz.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Warning
It is highly recommended that the developer reviews sections 5 and 6 of the Flash Memory
section of the target MCUs Hardware User’s Manual prior to using the r_flash_hp module. In
particular, understanding ID Code and Access Window functionality can help avoid
unrecoverable flash scenarios.

Data Flash Background Operation (BGO) Precautions

When using the data-flash BGO (Background Operation) mode, you can still access the user ROM,
RAM and external memory. You must ensure that the data-flash is not accessed during a data-flash
operation. This includes interrupts that may access the data-flash.

Code-Flash Precautions

Code flash cannot be accessed while writing, erasing or blank checking code flash. Code flash cannot
be accessed while modifying the access window, selecting the startup area or setting the ID code. In
order to support modifying code flash all supporting code must reside in RAM. This is only done when
code flash programming is enabled. BGO mode is not supported for code flash, so a code flash
operation will not return before the operation has completed. By default, the vector table resides in
the code flash. If an interrupt occurs during the code flash operation, then code flash will be
accessed to fetch the interrupt's starting address and an error will occur. The simplest work-around
is to disable interrupts during code flash operations. Another option is to copy the vector table to
RAM, update the VTOR (Vector Table Offset Register) accordingly and ensure that any interrupt
service routines execute out of RAM. Similarly, you must insure that if in a multi-threaded
environment, threads running from code flash cannot become active while a code flash operation is
in progress.

Flash Clock (FCLK)

The flash clock source is the clock used by the Flash peripheral in performing all Flash operations. As
part of the flash_api_t::open function the Flash clock source is checked will return FSP_ERR_FCLK if it
is invalid. Once the Flash APl has been opened, if the flash clock source frequency is changed, the
flash_api_t::updateFlashClockFreq API function must be called to inform the API of the change.
Failure to do so could result in flash operation failures and possibly damage the part.

Interrupts
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Enable the flash ready interrupt only if you plan to use the data flash BGO. In this mode, the
application can initiate a data flash operation and then be asynchronously notified of its completion,
or an error, using a user supplied-callback function. The callback function is passed a structure
containing event information that indicates the source of the callback event (for example,
flash_api_t::FLASH EVENT _ERASE_COMPLETE) When the FLASH FRDYI interrupt is enabled, the
corresponding ISR will be defined in the flash driver. The ISR will call a user-callback function if one
was registered with the flash_api_t::open API.

Note
The Flash HP supports an additional flash-error interrupt and if the BGO mode is enabled for the FLASH HP then
both the Flash Ready Interrupt and Flash Error Interrupts must be enabled (assigned a priority).

Limitations

e Write operations must be aligned on page boundaries and must be a multiple of the page
boundary size.

e Erase operations will erase the entire block the provided address resides in.

e Data flash is better suited for storing data as it can be erased and written to while code is
still executing from code flash. Data flash is also guaranteed for a larger number of
reprogramming/erasure cycles than code flash.

e Read values of erased data flash blocks are not guaranteed to be OxFF. Blank check should
be used to determine if memory has been erased but not yet programmed.

Examples

High-Performance Flash Basic Example

This is a basic example of erasing and writing to data flash and code flash.

#defi ne FLASH DF BLOCK 0 0x40100000U /* 64 B: 0x40100000 - 0x4010003F */
#defi ne FLASH CF_BLOCK 8 0x00010000 /* 32 KB: 0x00010000 - OxO00017FFF */
#defi ne FLASH DATA BLOCK_SI ZE (1024)
#defi ne FLASH HP_EXAMPLE_WRI TE_SI ZE 32
ui nt 8_t g_dest [ TRANSFER _LENGTH] ;
uint8 t g_src[ TRANSFER LENGTH] ;
flash result _t blank check result;
voi d r_flash_hp_basi c_exanpl e (void)
{
/* Initialize p_src to known data */
for (uint32_t i = 0; i < TRANSFER LENGTH; i ++)
{
g_src[i] = (uint8_t) (‘A + (i %26));
}
/* Open the flash hp instance. */
fsp err t err = R FLASH HP Open(&g flash_ctrl, &g flash cfg);
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handl e_error(err);

/* Erase 1 block of data flash starting at block 0. */
err = R FLASH HP_Erase(&g flash ctrl, FLASH DF BLOCK 0, 1);
handl e_error(err);

[* Check if block O is erased. */
err = R FLASH HP_ Bl ankCheck(&g flash ctrl, FLASH DF BLOCK 0

FLASH DATA BLOCK SI ZE, &bl ank_check result);
handl e _error(err);

/* Verify the previously erased area is blank */

i f (FLASH RESULT NOT_BLANK == bl ank_check_result)

{
handl e_error (FSP_ERR BLANK CHECK FAI LED) ;

}
/* Wite 32 bytes to the first block of data flash. */

err = R FLASH HP Wite(&g flash ctrl, (uint32_t) g src, FLASH DF BLOCK 0O
FLASH HP _EXAMPLE W\RI TE SI ZE)

handl e _error(err);

if (0 !'= mencnp(g_src, (uint8_t *) FLASH DF _BLOCK 0, FLASH HP_EXAVPLE W\RI TE_SI ZE))

{
handl e_error ( FSP_ERR WRI TE_FAI LED) ;

}
/* Disable interrupts to prevent vector table access while code flash is in P/E
node. */
__disable_irq();
/* Erase 1 block of code flash starting at block 10. */
err = R FLASH HP_Erase(&g_flash ctrl, FLASH CF BLOCK 8, 1);
handl e_error(err);
/* Wite 32 bytes to the first block of data flash. */
err = R FLASH HP Wite(&g flash ctrl, (uint32 t) g src, FLASH CF BLOCK 8,
FLASH HP_EXAMPLE_W\RI TE_SI ZE) ;
handl e_error(err);
/* Enable interrupts after code flash operations are conplete. */
__enable_irq();
if (0 != mencnp(g_src, (uint8_t *) FLASH CF_BLOCK 8, FLASH HP_EXAMPLE WRI TE_SI ZE))
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High-Performance Flash Advanced Example

This example demonstrates using BGO to do non-blocking operations on the data flash.
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}
void flash_cal |l back (flash _callback args t * p_args)
{
interrupt_called = true;
flash_event = p_args->event;
}

Data Structures

struct flash_hp_instance_ctrl_t

Enumerations

enum flash_bgo_operation_t

Data Structure Documentation

¢ flash_hp_instance_ctrl_t

struct flash_hp_instance_ctrl_t

Flash HP instance control block. DO NOT INITIALIZE.

Data Fields

uint32_t opened

To check whether api has been opened or not.

flash_cfg_t const * p_cfg

User Callback function.

flash_bgo operation_t current operation

Operation in progress, ie. FLASH_OPERATION_CF_ERASE.

Enumeration Type Documentation

¢ flash_bgo_operation_t

enum flash_bgo_operation_t

Possible Flash operation states
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Function Documentation

& R_FLASH_HP_Open()

fsp_err t R_ FLASH _HP_Open ( flash_ctrl_t *const p_api ctrl, flash_cfg_t const *const p cfg )

Initializes the high performance flash peripheral. Implements flash_api_t::open.
The Open function initializes the Flash.

Example:

/* Open the flash hp instance. */

fsp err t err = R FLASH HP Open(&g flash_ctrl, &g flash cfg);

Return values

FSP_SUCCESS Initialization was successful and timer has
started.

FSP_ERR_ALREADY_OPEN The flash control block is already open.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_cfg.

FSP_ERR_IRQ_BSP _DISABLED Caller is requesting BGO but the Flash
interrupts are not enabled.

FSP_ERR_FCLK FCLK must be a minimum of 4 MHz for Flash
operations.
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¢ R_FLASH_HP_Write()

fsp_err t R_FLASH HP_Write ( flash_ctrl_t *const p_api ctrl, uint32_t const src_address, uint32_t
flash_address, uint32_t const num_bytes )

Writes to the specified Code or Data Flash memory area. Implements flash_api_t::write.
Example:
/* Wite 32 bytes to the first block of data flash. */

err = R FLASH HP Wite(&g flash ctrl, (uint32_t) g src, FLASH DF BLOCK O,
FLASH HP_EXAMPLE_V\RI TE_SI ZE) ;

Return values

FSP_SUCCESS Operation successful. If BGO is enabled this
means the operation was started
successfully.

FSP_ERR_IN_USE The Flash peripheral is busy with a prior on-
going transaction.

FSP_ERR_NOT_OPEN The Flash API is not Open.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result

of attempting to Write an area that is
protected by an Access Window.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation. This may be
returned if the requested Flash area is not

blank.

FSP_ERR_TIMEOUT Timed out waiting for FCU operation to
complete.

FSP_ERR_INVALID SIZE Number of bytes provided was not a

multiple of the programming size or
exceeded the maximum range.

FSP_ERR_INVALID ADDRESS Invalid address was input or address not on
programming boundary.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.
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¢ R_FLASH_HP_Erase()

fsp_err t R_FLASH HP Erase ( flash_ctrl _t *const p_api ctrl, uint32_t const address, uint32_t const
num_blocks )

Erases the specified Code or Data Flash blocks. Implements flash_api_t::erase by the
block _erase_address.

Note
Code flash may contain blocks of different sizes. When erasing code flash it isimportant to take thisinto
consideration to prevent erasing a larger address space than desired.

Example:

/* Erase 1 block of data flash starting at block 0. */

err = R FLASH HP_Erase(&g_flash_ctrl, FLASH DF BLOCK 0, 1);

Return values

FSP_SUCCESS Successful open.
FSP_ERR_INVALID_BLOCKS Invalid number of blocks specified
FSP_ERR_INVALID ADDRESS Invalid address specified. If the address is in

code flash then code flash programming
must be enabled.

FSP_ERR_IN_USE Other flash operation in progress, or API not
initialized
FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result

of attempting to Erase an area that is
protected by an Access Window.

FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT_OPEN The Flash API is not Open.
FSP_ERR_ERASE _FAILED Status is indicating a Erase error.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.
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¢ R_FLASH_HP_BlankCheck()

fsp_err t R_FLASH HP BlankCheck ( flash_ctrl_t *const p_api ctrl, uint32_t const address, uint32 t
num_bytes, flash_result t * p blank check result )

Performs a blank check on the specified address area. Implements flash_api_t::blankCheck.
Example:
[* Check if block O is erased. */
err = R FLASH HP Bl ankCheck(&g_flash ctrl, FLASH DF BLOCK O,
FLASH DATA BLOCK_SI ZE, &bl ank_check_result);

handl e_error(err);

Return values

FSP_SUCCESS Blank check operation completed with result
in p_blank_check_result, or blank check
started and in-progess (BGO mode).

FSP_ERR_INVALID ADDRESS Invalid data flash address was input.

FSP_ERR_INVALID SIZE 'num_bytes' was either too large or not
aligned for the CF/DF boundary size.

FSP_ERR_IN_USE Other flash operation in progress or APl not
initialized.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result

of attempting to Erase an area that is
protected by an Access Window.

FSP_ERR_NOT _OPEN The Flash API is not Open.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.
FSP_ERR_BLANK CHECK FAILED Blank check operation failed.
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¢ R_FLASH_HP_Close()

fsp_err t R_FLASH HP_Close ( flash_ctrl_t *const p_api ctrl)

Releases any resources that were allocated by the Open() or any subsequent Flash operations.
Implements flash_api_t::close.

Return values
FSP_SUCCESS

Successful close.

FSP_ERR_NOT_OPEN The control block is not open.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_cfg.

¢ R_FLASH_HP_StatusGet()

fsp_err_t R_FLASH_HP_StatusGet ( flash_ctrl_t *const p_api_ctrl, flash_status_t *const p_status )

Query the FLASH peripheral for its status. Implements flash_api_t::statusGet.
Example:

flash_status t status;

/* Wait until the current flash operation conpletes. */
do

err = R FLASH HP_Stat usGet (& flash_ctrl, &status);

} while ((FSP_SUCCESS == err) && (FLASH STATUS BUSY == status));

Return values
FSP_SUCCESS

FLASH peripheral is ready to use.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_NOT OPEN

The Flash API is not Open.
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¢ R_FLASH_HP_AccessWindowSet()

fsp_err t R_FLASH HP_AccessWindowSet ( flash_ctrl_t *const p_api ctrl, uint32_t const start addr,
uint32_t const end_addr )

Configure an access window for the Code Flash memory using the provided start and end address.
An access window defines a contiguous area in Code Flash for which programming/erase is
enabled. This area is on block boundaries. The block containing start_addr is the first block. The
block containing end_addr is the last block. The access window then becomes first block -> last
block inclusive. Anything outside this range of Code Flash is then write protected.

Note
If the start address and end address are set to the same value, then the access window is effectively removed. This
accomplishes the same functionality asR FLASH _HP_AccessWindowClear().

Implements flash_api_t::accessWindowSet.

Return values

FSP_SUCCESS Access window successfully configured.

FSP_ERR_INVALID_ADDRESS Invalid settings for start_addr and/or
end_addr.

FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.
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4 R_FLASH_HP_AccessWindowClear()

fsp_err t R_FLASH HP_AccessWindowClear ( flash_ctrl _t *const p_api ctrl)

Remove any access window that is currently configured in the Code Flash. Subsequent to this call
all Code Flash is writable. Implements flash_api_t::accessWindowClear.

Return values

FSP_SUCCESS Access window successfully removed.

FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

FSP_ERR_NOT_OPEN Flash APl has not yet been opened.

FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.
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¢ R_FLASH_HP_IdCodeSet()

fsp_err t R_FLASH HP_IdCodeSet ( flash_ctrl _t *const p_api ctrl, uint8_t const *const p_id code,
flash_id code _mode t mode )
Implements flash_api_t::idCodeSet.
Return values
FSP_SUCCESS ID Code successfully configured.
FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.
FSP_ERR_NOT_OPEN Flash APl has not yet been opened.
FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.
FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.

# R_FLASH_HP_Reset()

fsp_err_ t R_FLASH_HP_Reset ( flash_ctrl_t *const p_api_ctrl)

Reset the FLASH peripheral. Implements flash_api_t::reset.

No attempt is made to check if the flash is busy before executing the reset since the assumption is
that a reset will terminate any existing operation.

Return values

FSP_SUCCESS Flash circuit successfully reset.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_NOT _OPEN The control block is not open.

FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.
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¢ R_FLASH_HP_UpdateFlashClockFreq()

fsp_err_ t R_FLASH HP_UpdateFlashClockFreq ( flash_ctrl _t *const p_api ctrl)

Indicate to the already open Flash API that the FCLK has changed. Implements
flash_api_t::updateFlashClockFreq.

This could be the case if the application has changed the system clock, and therefore the FCLK.

Failure to call this function subsequent to changing the FCLK could result in damage to the flash
macro.

Return values

FSP_SUCCESS Start-up area successfully toggled.
FSP_ERR_IN_USE Flash is busy with an on-going operation.
FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT_OPEN Flash APl has not yet been opened.
FSP_ERR_FCLK FCLK is not within the acceptable range.
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¢ R_FLASH_HP_StartUpAreaSelect()

fsp_err t R_FLASH HP_StartUpAreaSelect ( flash_ctrl t *const p_api ctrl, flash_startup_area swap_t
swap_type, bool is temporary )

Selects which block, Default (Block 0) or Alternate (Block 1), is used as the startup area block. The
provided parameters determine which block will become the active startup block and whether that
action will be immediate (but temporary), or permanent subsequent to the next reset. Doing a
temporary switch might appear to have limited usefulness. If there is an access window in place
such that Block 0 is write protected, then one could do a temporary switch, update the block and
switch them back without having to touch the access window. Implements
flash_api_t::startupAreaSelect.

Return values

FSP_SUCCESS Start-up area successfully toggled.

FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_NOT_OPEN The control block is not open.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.

4 R_FLASH_HP_VersionGet()

fsp_err t R_FLASH HP VersionGet ( fsp_version_t *const p_version)

This function gets FLASH HAL driver version

Return values

FSP_SUCCESS Operation performed successfully
FSP_ERR_ASSERTION Null pointer
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& R_FLASH_HP_InfoGet()

fsp_err t R_FLASH HP_InfoGet ( flash_ctrl_t *const p_api_ctrl, flash_info_t *const p_info )

Returns the information about the flash regions. Implements flash_api_t::infoGet.

Return values

FSP_SUCCESS Successful retrieved the request
information.

FSP_ERR_NOT_OPEN The control block is not open.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_info.

5.2.20 Low-Power Flash Driver (r_flash_Ip)

Modules
Functions

fsp_err_ t R_FLASH_LP Open (flash_ctrl_t *const p_api_ctrl, flash_cfg_t const
*const p_cfg)

fsp_err t R_FLASH_LP_ Write (flash_ctrl_t *const p_api_ctrl, uint32_t const
src_address, uint32_t flash_address, uint32_t const num_bytes)

fsp_err t R_FLASH_LP Erase (flash_ctrl_t *const p_api_ctrl, uint32_t const
address, uint32_t const num_blocks)

fsp_err t R _FLASH_LP BlankCheck (flash_ctrl_t *const p_api_ctrl, uint32_t
const address, uint32_t num_bytes, flash_result_t
*blank_check_result)

fsp_err t R_FLASH_LP Close (flash_ctrl_t *const p_api_ctrl)

fsp_err t R _FLASH LP_StatusGet (flash_ctrl t *const p_api_ctrl, flash_status_t
*const p_status)

fsp_err t R _FLASH LP_AccessWindowSet (flash_ctrl_t *const p_api_ctrl,
uint32_t const start_addr, uint32_t const end_addr)

fsp_err t R_FLASH LP AccessWindowClear (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH_LP_IdCodeSet (flash_ctrl_t *const p_api_ctrl, uint8_t const
*const p_id_code, flash_id_code_mode_t mode)
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fsp_err t R_FLASH LP Reset (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH LP StartUpAreaSelect (flash_ctrl_t *const p_api_ctrl,
flash_startup_area_swap_t swap_type, bool is_temporary)

fsp_err t R _FLASH LP_UpdateFlashClockFreq (flash_ctrl_t *const p_api_ctrl)
fsp_err t R _FLASH LP VersionGet (fsp_version_t *const p_version)

fsp_err t R_FLASH_LP_InfoGet (flash_ctrl_t *const p_api_ctrl, flash_info_t *const
p_info)

Detailed Description

Driver for the flash memory on RA low-power MCUs. This module implements the Flash Interface.

Overview

The Flash HAL module APIs allow an application to write, erase and blank check both the data and
code flash areas that reside within the MCU. The amount of flash memory available varies across
MCU parts.

Features
The Low-Power Flash HAL module has the following key features:

Blocking and non-blocking erasing, writing and blank-checking of data flash.

Blocking erasing, writing and blank checking of code flash.

Callback functions for completion of non-blocking data flash operations.

Access window (write protection) for code flash, allowing only specified areas of code flash
to be erased or written.

e Boot block-swapping.

¢ |D code programming support.

Configuration

Build Time Configurations for r_flash_Ip

The following build time configurations are defined in fsp_cfg/r_flash_lp_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Code Flash e Enabled Disabled Controls whether or not
Programming e Disabled code-flash

programming is
enabled. Disabling
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reduces the amount of
ROM and RAM used by

the API.
Data Flash e Enabled Enabled Controls whether or not
Programming e Disabled data-flash

programming is
enabled. Disabling
reduces the amount of
ROM used by the API.

Configurations for Driver > Storage > Flash Driver on r_flash_Ip

This module can be added to the Stacks tab via New Stack > Driver > Storage > Flash Driver on
r flash_Ip:

Configuration Options Default Description
Name Name must be a valid  g_flashO Module name.
C symbol
Data Flash Background ¢ Enabled Enabled Enabling allows Flash
Operation ¢ Disabled API calls that reference

data-flash to return
immediately, with the
operation continuing in
the background.

Callback Name must be a valid NULL A user callback
C symbol function can be
specified. Callback
function called when a
dataflash BGO
operation completes or

errors.
Flash Ready Interrupt MCU Specific Options Select the flash ready
Priority interrupt priority.

Clock Configuration

Flash either uses FCLK or ICLK as the clock source depending on the MCU. When writing and erasing
the clock source must be at least 4 MHz.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Warning
It is highly recommended that the developer reviews sections 5 and 6 of the Flash Memory
section of the target MCUs Hardware User’s Manual prior to using the r_flash_Ip module. In
particular, understanding ID Code and Access Window functionality can help avoid
unrecoverable flash scenarios.
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Data Flash Background Operation (BGO) Precautions

When using the data flash BGO, the code flash, RAM and external memory can still be accessed. You
must ensure that the data flash is not accessed during a data flash operation. This includes
interrupts that may access the data flash.

Code Flash Precautions

Code flash cannot be accessed while writing, erasing or blank checking code flash. Code flash cannot
be accessed while modifying the access window, selecting the startup area or setting the ID code. In
order to support modifying code flash all supporting code must reside in RAM. This is only done when
code flash programming is enabled. BGO mode is not supported for code flash, so a code flash
operation will not return before the operation has completed. By default, the vector table resides in
the code flash. If an interrupt occurs during the code flash operation, then code flash will be
accessed to fetch the interrupt's starting address and an error will occur. The simplest work-around
is to disable interrupts during code flash operations. Another option is to copy the vector table to
RAM, update the VTOR (Vector Table Offset Register) accordingly and ensure that any interrupt
service routines execute out of RAM. Similarly, you must insure that if in a multi-threaded
environment, threads running from code flash cannot become active while a code flash operation is
in progress.

Flash Clock Source

The flash clock source is the clock used by the Flash peripheral in performing all Flash operations. As
part of the flash_api_t::open function the Flash clock source is checked will return FSP_ERR_FCLK if it
is invalid. Once the Flash APl has been opened, if the flash clock source frequency is changed, the
flash_api_t::updateFlashClockFreq API function must be called to inform the API of the change.
Failure to do so could result in flash operation failures and possibly damage the part.

Interrupts

Enable the flash ready interrupt only if you plan to use the data flash BGO. In this mode, the
application can initiate a data flash operation and then be asynchronously notified of its completion,
or an error, using a user supplied-callback function. The callback function is passed a structure
containing event information that indicates the source of the callback event (for example,
flash_api_t::FLASH_EVENT_ERASE_COMPLETE) When the FLASH FRDYI interrupt is enabled, the
corresponding ISR will be defined in the flash driver. The ISR will call a user-callback function if one
was registered with the flash_api_t::open API.

Note
The Flash HP supports an additional flash-error interrupt and if the BGO mode is enabled for the FLASH HP then
both the Flash Ready Interrupt and Flash Error Interrupts must be enabled (assigned a priority).

Limitations

e Write operations must be aligned on page boundaries and must be a multiple of the page
boundary size.

e Erase operations will erase the entire block the provided address resides in.

» Data flash is better suited for storing data as it can be erased and written to while code is
still executing from code flash. Data flash is also guaranteed for a larger number of
reprogramming/erasure cycles than code flash.

e Read values of erased blocks are not guaranteed to be OxFF. Blank check should be used to
determine if memory has been erased but not yet programmed.
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Examples

Low-Power Flash Basic Example

This is a basic example of erasing and writing to data flash and code flash.
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Low-Power Flash Advanced Example

This example demonstrates using BGO to do non-blocking operations on the data flash.
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/* Wait until the current flash operation conpletes. */

do

err = R FLASH LP StatusGet (&g flash ctrl, &status);
} while ((FSP_SUCCESS == err) && (FLASH STATUS BUSY == status));
/* If the interrupt wasn't called process the error. */
if (!interrupt_call ed)
{
handl e_error (FSP_ERR WRI TE_FAI LED) ;
}
/* If the event wasn't a wite conplete process the error. */
i f (FLASH EVENT _WRI TE_COWMPLETE ! = fl ash_event)

{
handl e_error ( FSP_ERR WRI TE_FAI LED) ;

}

/* Verify the data was witten correctly. */

if (0 != mencnp(g_src, (uint8_t *) FLASH DF _BLOCK 0, FLASH LP_EXAVPLE VRl TE_SI ZE))

{
handl e_error (FSP_ERR WRI TE_FAI LED) ;

}
}
void flash_call back (flash_callback args t * p_args)
{

interrupt _called = true;

fl ash_event = p_args->event;
}

Data Structures

struct flash_Ip_instance_ctrl_t

Data Structure Documentation

¢ flash_Ip_instance_ctrl_t

struct flash_lp_instance_ctrl_t

Flash instance control block. DO NOT INITIALIZE. Initialization occurs when R_FLASH LP Open() is
called.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 411 /1,444
Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Low-Power Flash Driver (r_flash_Ip)

Function Documentation

& R_FLASH_LP Open()

fsp_err t R_ FLASH LP_Open ( flash_ctrl_t *const p_api ctrl, flash_cfg t const *const p cfg )

Initialize the Low Power flash peripheral. Implements flash_api_t::open.
The Open function initializes the Flash.

This function must be called once prior to calling any other FLASH API functions. If a user supplied
callback function is supplied, then the Flash Ready interrupt will be configured to call the users
callback routine with an Event type describing the source of the interrupt for Data Flash operations.

Example:
/* Open the flash | p instance. */

fsp err t err = R FLASH LP Open(&g flash_ctrl, &g flash cfqg);

Note
Providing a callback function in the supplied p_cfg-> callback field automatically configures the Flash for Data
Flash to operate in non-blocking background operation (BGO) mode.

Return values

FSP_SUCCESS Initialization was successful and timer has
started.

FSP_ERR_ASSERTION NULL provided for p_ctrl, p_cfg or p_callback
if BGO is enabled.

FSP_ERR_IRQ_BSP_DISABLED Caller is requesting BGO but the Flash
interrupts are not enabled.

FSP_ERR_FCLK FCLK must be a minimum of 4 MHz for Flash
operations.

FSP_ERR_ALREADY_OPEN Flash Open() has already been called.

FSP_ERR_TIMEOUT Failed to exit P/E mode after configuring
flash.
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¢ R_FLASH_LP_Write()

fsp_err t R_FLASH_ LP_Write ( flash_ctrl_t *const p_api ctrl, uint32_t const src_address, uint32_t
flash_address, uint32_t const num_bytes )

Write to the specified Code or Data Flash memory area. Implements flash_api_t::write.
Example:
/* Wite 32 bytes to the first block of data flash. */

err = R FLASH LP Wite(&g flash ctrl, (uint32_t) g src, FLASH DF BLOCK O,
FLASH LP_EXAMPLE W\RI TE_SI ZE) ;

Return values

FSP_SUCCESS Operation successful. If BGO is enabled this
means the operation was started
successfully.

FSP_ERR_IN_USE The Flash peripheral is busy with a prior on-
going transaction.

FSP_ERR_NOT_OPEN The Flash API is not Open.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for

the requested operation. This may be
returned if the requested Flash area is not

blank.

FSP_ERR_TIMEOUT Timed out waiting for FCU operation to
complete.

FSP_ERR_INVALID SIZE Number of bytes provided was not a

multiple of the programming size or
exceeded the maximum range.

FSP_ERR_INVALID _ADDRESS Invalid address was input or address not on
programming boundary.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
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4 R_FLASH_LP_Erase()

fsp_err t R_FLASH LP Erase ( flash_ctrl_t *const p_api ctrl, uint32_t const address, uint32_t const
num_blocks )

Erase the specified Code or Data Flash blocks. Implements flash_api_t::erase.
Example:
/* Erase 1 block of data flash starting at block 0. */

err = R FLASH LP Erase(&g_flash ctrl, FLASH DF BLOCK 0, 1);

Return values

FSP_SUCCESS Successful open.

FSP_ERR_INVALID BLOCKS Invalid number of blocks specified

FSP_ERR_INVALID_ADDRESS Invalid address specified

FSP_ERR_IN_USE Other flash operation in progress, or API not

initialized

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN The Flash APl is not Open.

FSP_ERR_TIMEOUT Timed out waiting for FCU to be ready.

FSP_ERR_ERASE_FAILED Status is indicating a Erase error.
R11UMO146EU0100 Revision 1.00 RLENESAS Page 414 / 1,444

Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Low-Power Flash Driver (r_flash_Ip)

4 R_FLASH_LP_BlankCheck()

fsp_err t R_FLASH LP BlankCheck ( flash_ctrl_t *const p_api ctrl, uint32_t const address, uint32_t
num_bytes, flash_result t * p blank check result )

Perform a blank check on the specified address area. Implements flash_api_t::blankCheck.
Example:
[* Check if block O is erased. */
err = R FLASH LP Bl ankCheck(&g_flash ctrl, FLASH DF BLOCK O,
FLASH DATA BLOCK_SI ZE, &bl ank_check_result);

handl e_error(err);

Return values

FSP_SUCCESS Blankcheck operation completed with result
in p_blank_check_result, or blankcheck
started and in-progess (BGO mode).

FSP_ERR_INVALID ADDRESS Invalid data flash address was input

FSP_ERR_INVALID SIZE 'num_bytes' was either too large or not
aligned for the CF/DF boundary size.

FSP_ERR_IN_USE Flash is busy with an on-going operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_BLANK CHECK FAILED An error occurred during blank checking.

¢ R_FLASH_LP Close()

fsp_err t R_FLASH LP Close ( flash_ctrl _t *const p_api ctrl)

Release any resources that were allocated by the Flash API. Implements flash_api_t::close.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_cfg.

FSP_ERR_NOT_OPEN Flash APl has not yet been opened.

FSP_ERR_IN_USE The flash is currently in P/E mode.
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¢ R_FLASH_LP_StatusGet()

fsp_err t R_FLASH_ LP_ StatusGet ( flash_ctrl_t *const p_api ctrl, flash_status_t *const p_status )

Query the FLASH for its status. Implements flash_api_t::statusGet.

Example:
flash_status t status;

/* Wait until the current flash operation conpletes. */
do

err = R FLASH LP _StatusGet (&g flash_ctrl, &status);
} while ((FSP_SUCCESS == err) && (FLASH STATUS BUSY == status));

Return values

FSP_SUCCESS Flash is ready and available to accept
commands.
FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT _OPEN Flash API has not yet been opened.
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¢ R_FLASH LP_AccessWindowSet()

fsp_err t R_FLASH LP_AccessWindowsSet ( flash_ctrl_t *const p_api ctrl, uint32_t const start_addr,
uint32_t const end_addr )

Note

If the start address and end address are set to the same value, then the access window is effectively removed. This
accomplishes the same functionality asR FLASH_LP_AccessWindowClear ().

Configure an access window for the Code Flash memory. Implements flash_api_t::accessWindowSet

An access window defines a contiguous area in Code Flash for which programming/erase is
enabled. This area is on block boundaries. The block containing start_addr is the first block. The
block containing end_addr is the last block. The access window then becomes first block (inclusive)
-> |ast block (exclusive). Anything outside this range of Code Flash is then write protected. As an
example, if you wanted to place an accesswindow on Code Flash Blocks 0 and 1, such that only
those two blocks were writable, you would need to specify (address in block 0, address in block 2)
as the respective start and end address.

The invalid address and programming boundaries supported and enforced by this function are
dependent on the MCU in use as well as the part package size. Please see the User manual and/or
requirements document for additional information.

Parameters
p_api_ctrl The p api control
[in] start_addr The start address
[in] end_addr The end address
Return values
FSP_SUCCESS Access window successfully configured.
FSP_ERR_INVALID_ADDRESS Invalid settings for start_addr and/or
end_addr.
FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.
FSP_ERR_NOT_OPEN Flash APl has not yet been opened.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.
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User’s Manual

¢ R_FLASH_LP_AccessWindowClear()

fsp_err t R_FLASH LP_AccessWindowClear ( flash_ctrl _t *const p_api ctrl)

Return values

Remove any access window that is configured in the Code Flash. Implements
flash_api_t::accessWindowClear. On successful return from this call all Code Flash is writable.

FSP_SUCCESS

Access window successfully removed.

FSP_ERR_IN_USE

FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION

NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED

Code Flash Programming is not enabled.

FSP_ERR_NOT OPEN

Flash APl has not yet been opened.

FSP_ERR_TIMEOUT

Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED

Status is indicating a Programming error for
the requested operation.

¢ R_FLASH_LP IdCodeSet()

flash_id_code_mode_t mode )

fsp_err t R_FLASH_LP_IdCodeSet ( flash_ctrl _t *const p_api ctrl, uint8_t const *const p_id code,

Return values

Write the ID code provided to the id code registers. Implements flash_api_t::idCodeSet.

FSP_SUCCESS

ID code successfully configured.

FSP_ERR_IN_USE

FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION

NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED

Code Flash Programming is not enabled.

FSP_ERR_NOT _OPEN

Flash API has not yet been opened.

FSP_ERR_TIMEOUT

Timed out waiting for completion of extra
command.

FSP_ERR_WRITE_FAILED

Status is indicating a Programming error for
the requested operation.
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¢ R_FLASH_LP Reset()

fsp_err t R_FLASH LP Reset ( flash_ctrl_t *const p_api ctrl)

Reset the FLASH peripheral. Implements flash_api_t::reset.

No attempt is made to check if the flash is busy before executing the reset since the assumption is
that a reset will terminate any existing operation.

Return values

FSP_SUCCESS Flash circuit successfully reset.
FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT _OPEN Flash API has not yet been opened.

4 R_FLASH_LP_StartUpAreaSelect()

fsp_err t R_FLASH_LP_StartUpAreaSelect ( flash_ctrl_t *const p_api ctrl, flash_startup_area swap t
swap_type, bool is temporary )

Select which block is used as the startup area block. Implements flash_api_t::startupAreaSelect.

Selects which block - Default (Block 0) or Alternate (Block 1) is used as the startup area block. The
provided parameters determine which block will become the active startup block and whether that
action will be immediate (but temporary), or permanent subsequent to the next reset. Doing a
temporary switch might appear to have limited usefulness. If there is an access window in place
such that Block 0 is write protected, then one could do a temporary switch, update the block and
switch them back without having to touch the access window.

Return values

FSP_SUCCESS Start-up area successfully toggled.

FSP_ERR_IN_USE Flash is busy with an on-going operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

Cannot set FLASH _STARTUP_AREA BTFLG
when the temporary flag is false.
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4 R_FLASH_LP_UpdateFlashClockFreq()

fsp_err t R_FLASH LP UpdateFlashClockFreq ( flash_ctrl t *const p_api ctrl)

Indicate to the already open Flash API that the FCLK has changed. Implements
r_flash_t::updateFlashClockFreq.

This could be the case if the application has changed the system clock, and therefore the FCLK.
Failure to call this function subsequent to changing the FCLK could result in damage to the flash
macro.

Return values

FSP_SUCCESS Start-up area successfully toggled.

FSP_ERR_IN_USE Flash is busy with an on-going operation.

FSP_ERR_FCLK Invalid flash clock source frequency.

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

¢ R_FLASH_LP_VersionGet()

fsp_err t R_FLASH_LP VersionGet ( fsp_version_t *const p_version)

Get Flash LP driver version.

Return values

FSP_SUCCESS Operation performed successfully
FSP_ERR_ASSERTION Null Pointer

¢ R_FLASH_LP InfoGet()

fsp_err_t R_FLASH_LP_InfoGet ( flash_ctrl_t *const p_api ctrl, flash_info_t *const p_info )

Returns the information about the flash regions. Implements flash_api_t::infoGet.

Return values

FSP_SUCCESS Successful retrieved the request
information.
FSP_ERR_ASSERTION NULL provided for p_ctrl or p_info.
FSP_ERR_NOT_OPEN The flash is not open.
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5.2.21 Graphics LCD Controller (r_glcdc)
Modules

Functions

fsp_err t R_GLCDC Open (display_ctrl_t *const p_api_ctrl, display_cfg_t const
*const p_cfg)

fsp_err t R _GLCDC Close (display ctrl t *const p_api_ctrl)

fsp_err t R _GLCDC Start (display_ctrl_t *const p_api_ctrl)

fsp_err t R_GLCDC Stop (display_ctrl_t *const p_api_ctrl)

fsp_err t R_GLCDC LayerChange (display_ctrl_t const *const p_api_ctrl,
display_runtime_cfg_t const *const p_cfg, display_frame_layer_t

layer)

fsp_err t R_GLCDC BufferChange (display_ctrl_t const *const p_api_ctrl,
uint8_t *const framebuffer, display frame_layer t layer)

fsp_err t R_GLCDC ColorCorrection (display ctrl_t const *const p_api_ctrl,
display _correction_t const *const p_correction)

fsp_err t R _GLCDC ClutUpdate (display_ctrl_t const *const p_api_ctrl,
display clut cfg t const *const p_clut_cfg, display _frame_layer t
layer)

fsp_err t R _GLCDC StatusGet (display_ctrl_t const *const p_api_ctrl,
display_status_t *const status)

fsp_err t R_GLCDC VersionGet (fsp_version_t *p_version)

Detailed Description

Driver for the GLCDC peripheral on RA MCUs. This module implements the Display Interface.

Overview

The GLCDC is a multi-stage graphics output peripheral designed to automatically generate timing
and data signals for LCD panels. As part of its internal pipeline the two internal graphics layers can
be repositioned, alpha blended, color corrected, dithered and converted to and from a wide variety
of pixel formats.

Features
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The following features are available:

Feature Options

Input color formats ARGB8888, ARGB4444, ARGB1555, RGB888
(32-bit), RGB565, CLUT 8bpp, CLUT 4bpp, CLUT
1lbpp

Output color formats RGB888, RGB666, RGB565, Serial RGB888 (8-bit
parallel)

Correction processes Alpha blending, positioning, brightness and
contrast, gamma correction, dithering

Timing signals Dot clock, Vsync, Hsync, Vertical and horizontal
data enable (DE)

Maximum resolution Up to 1020 x 1008 pixels (dependent on sync
signal width)

Maximum dot clock 60MHz for serial RGB mode, 54MHz otherwise

Internal clock divisors 1-9, 12, 16, 24, 32

Interrupts Vsync (line detect), Layer 1 underflow, Layer 2
underflow

Other functions Byte-order and endianness control, line repeat
function

Configuration

Build Time Configurations for r_glcdc

The following build time configurations are defined in fsp_cfg/r_glcdc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected, code for
¢ Enabled parameter checking is
* Disabled included in the build.
Color Correction e On Off If selected, code to
e Off adjust brightness,

contrast and gamma
settings is included in
the build. When
disabled all color

correction
configuration options
are ignored.
Configurations for Driver > Graphics > Display Driver on r_glcdc
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This module can be added to the Stacks tab via New Stack > Driver > Graphics > Display Driver on

r glcdc:

Configuration Options Default Description
General > Name Name must be a valid  g_display0 Module name.
C symbol

Interrupts > Callback Name must be a valid  NULL A user callback

Function C symbol function can be defined
here.

Interrupts > Line MCU Specific Options Select the line detect

Detect Interrupt (Vsync) interrupt

Priority priority.

Interrupts > Underflow MCU Specific Options Select the underflow

1 Interrupt Priority interrupt priority for
layer 1.

Interrupts > Underflow MCU Specific Options Select the underflow

2 Interrupt Priority interrupt priority for
layer 2.

Input > Graphics Layer e Yes Yes Specify Used if the

1 > General > Enabled ¢ No graphics layer 1 is
used. If so a
framebuffer will be
automatically
generated based on
the specified height
and horizontal stride.

Input > Graphics Layer Value must be between 480 Specify the number of

1 > General > 16 and 1016 horizontal pixels.

Horizontal size

Input > Graphics Layer Value must be between 272 Specify the number of

1 > General > Vertical 16 and 1020 vertical pixels.

size

Input > Graphics Layer Must be a valid non- 0 Specify the horizontal

1 > General > negative integer with a offset in pixels of the

Horizontal position maximum configurable graphics layer from the

value of 4091 background layer.
Input > Graphics Layer Must be a valid non- 0 Specify the vertical

1 > General > Vertical
position

Input > Graphics Layer
1 > General > Color
format

negative integer with a
maximum configurable
value of 4094

» ARGB8888
(32-bit)

* RGB888 (32-bit)

* RGB565 (16-bit)

e ARGB1555
(16-bit)

* ARGB4444

RGB565 (16-bit)

offset in pixels of the
graphics layer from the
background layer.

Specify the graphics
layer Input format. If
selecting CLUT formats,
you must write the
CLUT table data before
starting output.
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(16-bit)
e CLUTS8 (8-bit)
e CLUT4 (4-bit)
e CLUT1 (1-bit)

Input > Graphics Layer e Enabled Disabled Select Used if the

1 > General > Line e Disabled framebuffer starts from

descending mode the bottom of the line.

Input > Graphics Layer Value must be between 255 Based on the alpha

1 > Background Color 0 and 255 value, either the

> Alpha graphics Layer 2
(foreground graphics
layer) is blended into
the graphics Layer 1
(background graphics
layer) or the graphics
Layer 1 is blended into
the monochrome
background layer.

Input > Graphics Layer Value must be between 255 Red component of the

1 > Background Color 0 and 255 background color for

> Red layer 1.

Input > Graphics Layer Value must be between 255 Green component of

1 > Background Color 0 and 255 the background color

> Green for layer 1.

Input > Graphics Layer Value must be between 255 Blue component of the

1 > Background Color
> Blue

Input > Graphics Layer
1 > Framebuffer >
Framebuffer name

0 and 255

This property must be
a valid C symbol

fb_background

background color for
layer 1.

Specify the name for
the framebuffer for
Layer 1.

Mar.25.20

Input > Graphics Layer Must be a valid non- 2 Number of

1 > Framebuffer > negative integer with a framebuffers allocated

Number of maximum configurable for Graphics Layer 1.

framebuffers value of 65535

Input > Graphics Layer Manual Entry .bss Specify the section in

1 > Framebuffer > which to allocate the

Section for framebuffer framebuffer.

allocation

Input > Graphics Layer Value must be between 480 Specify the memory

1 > Framebuffer > 16 and 1016 stride for a horizontal

Horizontal stride (in line. This value must be

pixels) specified with the
number of pixels, not
actual bytes.
The horizontal stride
multiplied by the bytes
per pixel must be
divisible by 64.
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Input > Graphics Layer * On Off Select On if the display
1 > Line Repeat > e Off will be repeated from a
Enable smaller section of the
framebuffer.
Input > Graphics Layer Must be a valid non- 0 Specify the number of
1 > Line Repeat > negative integer with a times the image is
Repeat count maximum configurable repeated.
value of 65535 i.e
(vertical size) x (lines
repeat times) must be
equal to the panel
vertical size
Input > Graphics Layer e None None Select the fade
1 > Fading > Mode e Fade-in method.
e Fade-out
Input > Graphics Layer Value must be between 0 Specify the number of
1 > Fading > Speed 0 and 255 frames for the fading
transition to complete.
Input > Graphics Layer e Yes No Specify Used if the
2 > General > Enabled * No graphics layer 2 is
used. If so a
framebuffer will be
automatically
generated based on
the specified height
and horizontal stride.
Input > Graphics Layer Value must be between 480 Specify the number of
2 > General > 16 and 1016 horizontal pixels.
Horizontal size
Input > Graphics Layer Value must be between 272 Specify the number of
2 > General > Vertical 16 and 1020 vertical pixels.
size
Input > Graphics Layer Must be a valid non- 0 Specify the horizontal
2 > General > negative integer with a offset in pixels of the
Horizontal position maximum configurable graphics layer from the
value of 4091 background layer.
Input > Graphics Layer Must be a valid non- 0 Specify the vertical

2 > General > Vertical
position

Input > Graphics Layer
2 > General > Color
format

negative integer with a
maximum configurable
value of 4094

e ARGB8888
(32-bit)

e RGB888 (32-bit)

* RGB565 (16-bit)

RGB565 (16-bit)

offset in pixels of the
graphics layer from the
background layer.

Specify the graphics
layer Input format. If
selecting CLUT formats,
you must write the

e ARGB1555 CLUT table data before
(16-bit) starting output.

e ARGB4444
(16-bit)

e CLUTS8 (8-bit)
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CLUT4 (4-bit)
CLUT1 (1-bit)

Input > Graphics Layer e Enabled Disabled Select Used if the

2 > General > Line e Disabled framebuffer starts from

descending mode the bottom of the line.

Input > Graphics Layer Value must be between 255 Based on the alpha

2 > Background Color 0 and 255 value, either the

> Alpha graphics Layer 2
(foreground graphics
layer) is blended into
the graphics Layer 1
(background graphics
layer) or the graphics
Layer 1 is blended into
the monochrome
background layer.

Input > Graphics Layer Value must be between 255 Red component of the

2 > Background Color 0 and 255 background color for

> Red layer 2.

Input > Graphics Layer Value must be between 255 Green component of

2 > Background Color 0 and 255 the background color

> Green for layer 2.

Input > Graphics Layer Value must be between 255 Blue component of the

2 > Background Color
> Blue

Input > Graphics Layer
2 > Framebuffer >
Framebuffer name

0 and 255

This property must be
a valid C symbol

fb_foreground

background color for
layer 2.

Specify the name for
the framebuffer for
Layer 2.

Mar.25.20

Input > Graphics Layer Must be a valid non- 2 Number of

2 > Framebuffer > negative integer with a framebuffers allocated

Number of maximum configurable for Graphics Layer 2.

framebuffers value of 65535

Input > Graphics Layer Manual Entry .bss Specify the section in

2 > Framebuffer > which to allocate the

Section for framebuffer framebuffer.

allocation

Input > Graphics Layer Value must be between 480 Specify the memory

2 > Framebuffer > 16 and 1016 stride for a horizontal

Horizontal stride (in line. This value must be

pixels) specified with the
number of pixels, not
actual bytes.
The horizontal stride
multiplied by the bytes
per pixel must be
divisible by 64.

Input > Graphics Layer e On Off Select On if the display

2 > Line Repeat > o Off will be repeated from a
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Enable smaller section of the
framebuffer.
Input > Graphics Layer Must be a valid non- 0 Specify the number of
2 > Line Repeat > negative integer with a times the image is
Repeat count maximum configurable repeated.
value of 65535 i.e
(vertical size) x (lines
repeat times) must be
equal to the panel
vertical size
Input > Graphics Layer e None None Select the fade
2 > Fading > Mode e Fade-in method.
e Fade-out
Input > Graphics Layer Value must be between 0 Specify the number of
2 > Fading > Speed 0 and 255 frames for the fading
transition to complete.
Output > Timing > Value must be between 525 Specify the total cycles
Horizontal total cycles 24 and 1024 in a horizontal line. Set
to the number of cycles
defined in the data
sheet of LCD panel
sheet in your system
Output > Timing > Value must be between 480 Specify the number of
Horizontal active video 16 and 1016 active video cycles in a
cycles horizontal line
(including front and
back porch). Set to the
number of cycles
defined in the data
sheet of LCD panel
sheet in your system.
Output > Timing > Value must be between 40 Specify the number of
Horizontal back porch 6 and 1006 back porch cycles in a
cycles horizontal line. Back
porch starts from the
beginning of Hsync
cycles, which means
back porch cycles
contain Hsync cycles.
Set to the number of
cycles defined in the
data sheet of LCD
panel sheet in your
system.
Output > Timing > Value must be between 1 Specify the number of
Horizontal sync signal 0 and 1023 Hsync signal assertion
cycles cycles. Set to the
number of cycles
defined in the data
sheet of LCD panel
sheet in your system.
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Output > Timing >
Horizontal sync signal
polarity

Output > Timing >
Vertical total lines

Output > Timing >
Vertical active video
lines

Output > Timing >
Vertical back porch
lines

Output > Timing >
Vertical sync signal
lines

Output > Timing >
Vertical sync signal
polarity

Output > Timing >
Data Enable Signal
Polarity

Output > Timing >
Sync edge

Output > Format >
Color format

Output > Format >
Color order

Output > Format >
Endian

Output > Background
> Alpha

Output > Background
> Red

Output > Background
> Green

e Low active
e High active

Value must be between
20 and 1024

Value must be between
16 and 1020

Value must be between
3 and 1007

Value must be between
0 and 1023

e Low active
¢ High active

e Low active
e High active

¢ Rising edge
¢ Falling edge

24bits RGB888
18bits RGB666
16bits RGB565
8bits serial

* RGB
e BGR

¢ Little endian
¢ Big endian

Value must be between
0 and 255

Value must be between
0 and 255

Value must be between
0 and 255

Low active

316

272

Low active

High active

Rising edge

16bits RGB565

RGB

Little endian

255

0

0

Select the polarity of
Hsync signal to match
your system.

Specify number of total
lines in a frame
(including front and
back porch).

Specify the number of
active video lines in a
frame.

Specify the number of
back porch lines in a
frame. Back porch
starts from the
beginning of Vsync
lines, which means
back porch lines
contain Vsync lines.

Specify the Vsync
signal assertion lines in
a frame.

Select the polarity of
Vsync signal to match
to your system.

Select the polarity of
Data Enable signal to
match to your system.

Select the polarity of
Sync signals to match
to your system.

Specify the graphics
layer output format to
match to your LCD
panel.

Select data order for
output signal to LCD
panel.

Select data endianness
for output signal to LCD
panel.

Alpha component of
the background color.

Red component of the
background color.

Green component of
the background color.
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Output > Background

Value must be between 0

Blue component of the

> Blue 0 and 255 background color.
CLUT > Enabled e Yes No Specify Used if
* No selecting CLUT formats

for a graphics layer
input format. If used, a
buffer (CLUT buffer)
will be automatically
generated based on
the selected pixel
width.

CLUT > Size Must be a valid non- 256 Specify the number of
negative integer with a entries for the CLUT
maximum configurable source data buffer.
value of 256 Each entry consumes 4

bytes (1 word).

TCON > Hsync pin ¢ Not used LCD_TCONO Select the TCON pin

select e LCD_TCONO used for the Hsync

e LCD TCON1 signal to match to your
e LCD_TCONZ2 system.
e LCD TCON3
TCON > Vsync pin ¢ Not used LCD TCON1 Select TCON pin used
select e LCD TCONO for Vsync signal to
e LCD TCON1 match to your system.
e LCD TCON2
e LCD TCON3
TCON > Data enable e Not used LCD_TCONZ2 Select TCON pin used
(DE) pin select e LCD TCONO for DataEnable signal
e LCD_TCON1 to match to your
e LCD TCONZ2 system.
e LCD TCON3

TCON > Panel clock

¢ |Internal clock

Internal clock

Choose between an

source (GLCDCLK) (GLCDCLK) internal GLCDCLK
e External clock generated from PCLKA
(LCD_EXTCLK) or an external clock

provided to the
LCD_EXTCLK pin.

TCON > Panel clock Refer to the RA 1/24 Select the clock source

division ratio Configuration tool for divider value.

available options.
Color Correction > * Yes No Enable brightness color
Brightness > Enabled * No correction.

Color Correction >
Brightness > Red
channel

Color Correction >
Brightness > Green
channel

Value must be between 512

0 and 1023

Value must be between 512

0 and 1023

Red component of the
brightness calibration.
This value is divided by
512 to determine gain.

Green component of
the brightness
calibration. This value

R11UMO0146EU0100 Revision 1.00
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Color Correction >
Brightness > Blue
channel

Color Correction >
Contrast > Enabled

Color Correction >
Contrast > Red
channel gain

Color Correction >
Contrast > Green
channel gain

Color Correction >
Contrast > Blue
channel gain

Color Correction >
Gamma > Red

Color Correction >
Gamma > Green

Color Correction >
Gamma > Blue

Color Correction >
Process order

Value must be between
0 and 1023

e Yes
e No

Value must be between
0 and 255

Value must be between
0 and 255

Value must be between
0 and 255

. Off

e On
o Off

e On
o Off

e Brightness/cont
rast first
e Gamma first

512

No

128

128

128

Off

Off

Off

Brightness/contrast
first

is divided by 512 to
determine gain.

Blue component of the
brightness calibration.

This value is divided by
512 to determine gain.

Enable contrast color
correction.

Red component of the
contrast calibration.
This value is divided by
128 to determine gain.

Green component of
the contrast
calibration. This value
is divided by 128 to
determine gain.

Blue component of the
contrast calibration.

This value is divided by
128 to determine gain.

Enable gamma color
correction for the red
channel.

Enable gamma color
correction for the green
channel.

Enable gamma color
correction for the blue
channel.

Select the color
correction processing
order.

Mar.25.20

Dithering > Enabled e Yes No Enable dithering to

* No reduce the effect of
color banding.

Dithering > Mode e Truncate Truncate Select the dithering
e Round off mode.
e 2x2 Pattern

Dithering > Pattern A ¢ Pattern 00 Pattern 11 Select the dithering
e Pattern 01 pattern.
e Pattern 10
e Pattern 11

Dithering > Pattern B e Pattern 00 Pattern 11 Select the dithering
e Pattern 01 pattern.
e Pattern 10
e Pattern 11
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Dithering > Pattern C e Pattern 00 Pattern 11 Select the dithering
e Pattern 01 pattern.
e Pattern 10
e Pattern 11

Dithering > Pattern D e Pattern 00 Pattern 11 Select the dithering
e Pattern 01 pattern.

e Pattern 10
e Pattern 11

Clock Configuration

The peripheral clock for this module is PCLKA.

The dot clock is typically generated from the PLL with a maximum output frequency of 54 MHz in
most pixel formats (60MHz for serial RGB). Optionally, a clock signal can be provided to the
LCD_EXTCLK pin for finer framerate control (60MHz maximum input). With either clock source
dividers of 1-9, 12, 16, 24 and 32 may be used. Clocks must be initialized and settled prior to
starting this module.

Pin Configuration

This module controls a variety of pins necessary for LCD data and timing signal output:

Pin Name Function Notes

LCD_EXTCLK External clock signal input The maximum input clock
frequency is 60MHz.

LCD_CLK Dot clock output The maximum output frequency
is 54MHz (60MHz in serial RGB
mode).

LCD_DATAN Pixel data output lines Pin assignment and color order

is based on the output block
configuration. See the RA6M3
User's Manual
(RO1UHO0886EJ0100) section
58.1.4 "Output Control for Data
Format" for details.

LCD_TCONn Panel timing signal output These pins can be configured to
output vertical and horizontal
synchronization and data valid
signals.

Note
There are two banks of pins listed for the GLCDC in the RA6M3 User's Manual (_A and _B). In most casesthe B
bank will be used as_A conflicts with SDRAM pins. In either case, it is generally recommended to only use pins
fromonly one bank at a time as this allows for superior signal routing both inside and outside the package. If _A
and _B pins must be mixed be sure to note the timing precision penalty detailed in Table 60.33 in in the RAGM3
User's Manual.

Usage Notes
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Overview

The GLCDC peripheral is a combination of several sub-peripherals that form a pixel data processing
pipeline. Each block passes pixel data to the next but otherwise they are disconnected from one
another - in other words, changing timing block parameters does not affect the output generation
block configuration and vice versa.

Initial Configuration

During R_GLCDC_Open all configured parameters are set in the GLCDC peripheral fully preparing it
for operation. Once opened, calling R_GLCDC_Start is typically all that is needed for basic operation.
Background generation, timing and output parameters are not configurable at runtime, though layer
control and color correction options can be altered.

Framebuffer Allocation

The framebuffer should be allocated in the highest-speed region available (excluding SRAMHS)
without displacing the stack, heap and other program-critical structures. While the RA6M3 does
contain a relatively large 640K of on-chip SRAM, for many screen sizes and color depths SDRAM will
be required. Regardless of the placement two rules must be followed to ensure correct operation of
the GLCDC:

¢ The framebuffer must be aligned on a 64-byte boundary
e The horizontal stride of the buffer must be a multiple of 64 bytes

Note
Framebuffers allocated through the RA Configuraton tool automatically follow the alignment and size
requirements.

If your framebuffer will be placed into internal SRAM please note the following best practices:

» The framebuffer should ideally not be placed in the SRAMHS block of SRAM as there is no
speed advantage for doing so. In particular, it is important to ensure the framebuffer does
not push the stack or any heaps outside of SRAMHS to preserve CPU performance.

e |t is recommended to not cross the boundary between SRAMO and SRAM1 with a single
framebuffer for performance reasons.

e If double-buffering is desired (and possible within SRAM), place one framebuffer in SRAMO
and the other in SRAM1.

If you are using SRAM for the framebuffer, to ensure correct placement you will need to edit the
linker script to add new sections. Below is an example of the required edits in the GCC and IAR
formats:

GCC Linker
/*

Li nker File for RA6MB MCU
/]

/* Linker script to configure nmenory regions. */

VEMORY
{
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IAR Linker

Note

The IAR linker does not place items correctly when sections overlap. Asaresult, it is advised to place your
framebuffer(s) as high as possible in the SRAM region in the linker script to maximize the RAM available for
everything else. The below is a general case that should be used unedited only if RAM usage (excluding
framebuffers) isless than 128K.
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defi ne synmbol regi on_SDRAM st art = 0x90000000;

define synbol regi on_SDRAM end = Ox91FFFFFF;

define synbol region_QSPI_start = 0x60000000;

define synbol region QSPlI _end = OX63FFFFFF;

[* .. %

define nmenory nemw th size = 4G

define regi on VECT region = mem [fromregi on VECT start to regi on_VECT end];
define regi on ROVREG regi on = mem [fromregi on_ ROVREG start to regi on_ROVREG end];
define region FLASH regi on = mem[fromregi on_FLASH start to

regi on_FLASH end] ;

define regi on RAM regi on = mem [fromregi on_RAM st art to regi on_RAM end];
define region FBO_region = mem[fromregi on_FBO_start to region_FBO end]; /*
Defi ne franebuffer O region */

define regi on FB1 region = mem[fromregi on FB1 start to region FB1 end]; /*
Define franmebuffer 1 region */

define regi on DF_region = mem[fromregi on DF start to region_DF end];
define regi on SDRAM r egi on = mem [fromregi on_SDRAM st art to

regi on_SDRAM end] ;

define regi on QSPlI _region = mem[fromregi on QSPI start to regi on_QSPlI _end];

[* ...
define bl ock START OF RAMw th fixed order { rw section .fsp dtc_vector_table,
bl ock RAM CODE };
place at start of RAMregion { block START OF RAM };
[* Place franebuffer sections first, then the rest of RAM */
place in FBO_region { rw section .fb0 };
place in FB1 region { rw section .fbl };
pl ace in RAMregion { rw
rw section .noinit,
rw section .bss,
rw section .data,
rw secti on HEAP,

rw section .stack };

Graphics Layers and Timing Parameters
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The GLCDC synthesizes graphics data through two configurable graphics layers onto a background
layer. The background is used as a solid-color canvas upon which to composite data from the
graphics layers. The two graphics layers are blended on top of each other (Layer 2 above Layer 1)
and overlaid on the background layer based on their individual configuration. The placement of the
layers (as well as LCD timing parameters) are detailed in Figure 1. The colors of the dimensions
indicate which element of the display_cfg_t struct is being referenced - for example, the width of the
background layer would be [display_cfgl.output.htiming.display_cyc.

Horizontal sync

Timing signals
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Figure 117: GLCDC layers and timing

Note
The data enable signal (if configured) isthe logical AND of the horizontal and vertical data valid signals.
In the GLCDC layers and timing figure, only one graphics layer is shown for simplicity. Additionally, in most
applications the graphics layer(s) will be the same dimensions as the background layer.

Runtime Configuration Options

Note
All runtime configurations detailed below are also automatically configured during R_GLCDC_Open based on the
options selected in the configurator.

Blend processing

Control of layer positioning, alpha blending and fading is possible at runtime via

R_GLCDC_LayerChange. This function takes a display_runtime_cfg_t parameter which contains the
same input and layer elements as the display_cfg_t control block. Refer to the documentation for
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display_runtime_cfg_t as well as the Examples below to see what options are configurable.

Brightness and contrast

Brightness and contrast correction can be controlled through R_GLCDC_ColorCorrection. The
display_correction_t parameter is used to control enabling, disabling and gain values for both
corrections as shown below:

di splay_correction_t correction;

/* Brightness values are 0-1023 with +512 of fset bei ng neutral
correction. brightness.r = 512;
correction. brightness.g = 512;
correction. brightness.b = 512;

/* Contrast values are 0-255 representing gain of 0-2 (128 is gain of 1) */
correction.contrast.r = 128;
correction.contrast.g = 128;
correction.contrast.b = 128;

/* Brightness and contrast correction can be enabl ed or disabl ed i ndependent of one
anot her */
correction. bri ght ness. enable = true;
correction. contrast.enabl e = true;
/* Enabl e correction */

R GLCDC Col or Correction(&g_disp_ctrl, &correction);

Color Look-Up Table (CLUT) Modes

The GLCDC supports 1-, 4- and 8-bit color look-up table (CLUT) formats for input pixel data. By using
these modes the framebuffer size in memory can be reduced significantly, allowing even high-
resolution displays to be buffered in on-chip SRAM. To enable CLUT modes for a layer the color
format must be set to a CLUT mode (either at startup or through R_GLCDC_LayerChange) in addition
to filling the CLUT as appropriate via R_GLCDC_ClutUpdate as shown below:

/* Basic 4-bit (16-color) CLUT definition */
uint32 t clut_4[16] =

{
OxFF000000, /1 Bl ack
OXFFFFFFFF, /[l \Wite
OxFFOOOO0FF, /1 Blue
OxFFOO080FF, [ Turquoi se
OxFFOOFFFF, /1 Cyan
R11UMO146EU0100 Revision 1.00 RLENESAS Page 437/ 1,444

Mar.25.20



Flexible Software Package User’s Manual

API| Reference > Modules > Graphics LCD Controller (r_glcdc)

OxFFOOFF80, /I Mnt Geen
O0xFFOOFFO0O0, [/l G een
OxFF80FFO0O0, /1 Linme G een
OxFFFFFFOO, /1 Yell ow
OxFFFF8000, /1l Orange
OxFFFFO0000, /1 Red
OxFFFFO0080, /1 Pink
OxFFFFOOFF, /1 NMagent a
OxFF8000FF, /1 Purple
0xFF808080, [l Gay
0x00000000 /1l Transpar ent

s
/* Define the CLUT configuration */
display clut cfg t clut cfg =

{
.start = 0,
.size = 16,
.p_base = clut_4
b

/* Update the CLUT in the GLCDC */
R GLCDC _C ut Updat e( &g_di sp_ctrl, &clut _cfg, DI SPLAY FRAVE LAYER 1);

Other Configuration Options

Gamma correction

Gamma correction is performed based on a gain curved defined in the configurator. Each point on
the curve is defined by a threshold and a gain value - each gain value represents a multiplier from
0x-2x (set as 0-2047) that sets the Y-value of the slope of the gain curve, while each threshold
interval sets the X-value respectively. For a more detailed explanation refer to the RA6M3 User's
Manual (RO1UHO0886E)J0100) Figure 58.12 "Calculation of gamma correction value" and the related
description above it.

When setting threshold values three rules must be followed:
e Each threshold value must be greater than the previous value
e Threshold values must be greater than zero and less than 1024

e Threshold values can equal the previous value only if they are 1023 (maximum)

Note
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Gamma correction can only be applied via R_GLCDC_Open.
Dithering

Dithering is a method of pixel blending that allows for smoother transitions between colors when
using a limited palette. A full description of dithering is outside the scope of this document. For more
information on the pattern settings and how to configure them refer to the RA6M3 User's Manual
(RO1UHO0886E)J0100) Figure 58.13 "Configuration of dither correction block" and Figure 58.14
"Addition value selection method for 2x2 pattern dither".

Bus Utilization

Note
The data provided in this section consists of estimates only. Experimentation is necessary to
obtain real-world performance data on any platform.

While the GLCDC is very flexible in size and color depth of displays there are considerations to be
made in the tradeoff between color depth, framerate and bus utilization. Below is a table showing
estimates of the load at various resolutions, framerates and color depths based on a PLL frequency
of 120MHz (default) and an effective SDRAM throughput of 60 MB/sec. Bus utilization percentages
are provided for the following use cases:

e Static image display (GLCDC only): One read

e Redrawing one framebuffer every display frame (minimal redraw): One write, one read

e Blitting one buffer to another then redrawing the entire buffer every display frame (worst
case): Two writes, three reads

Name [Width |Heigh | Input | Fram |[Buffer |SRAM |SRAM |SDRA |[SRAM |SDRA |SRAM |SDRA

t color |erate | size use bus |Mbus | bus |Mbus | bus |M bus
depth | (FPS) | (byte (GLC [ (GLC | (mini | (mini [(wors |(wors
(bits) S) DC DC malr | malr t t

only) | only) |edraw |edraw |case) |case)

) )
HQVG 240 160 8 60 3840 6% 1% 4% 2% 8% 5% 19%

HQVG 240 160 16 60 7680 12% 2% 8% 4% 15% 10% 38%

QVGA 320 240 16 60 1536 23% 4% 15% 8% 31% 19% 77%

00
wQv 400 240 8 60 9600 15% 2% 10% 5% 19% 12% 48%
GA 0

wQv 400 240 16 60 1920 29% 5% 19% 10% 38% 24% 96%
GA 00

HVGA 480 320 16 60 3072 47% 8% 31% 15% 61% 38% 154%

00

VGA 640 480 16 30 6144 — — 31% — 61% — 154%
00

WVG 800 480 8 60 3840 59% 10% 38% 19% 77% 48% 192%
A 00
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WVG
A

WVG
A

FWVG
A

FWVG
A

qHD

Note

800

800

960

960

960

480

480

480

480

540

16

32

16

30

15

30

30

30

7680 — —
00

1536 — —
000

4608 70% 6%
00

9216 — —
00

5184 79% 6%
00

38%

38%

23%

46%

26%

12%

13%

77%

77%

46%

92%

52%

— 192%

— 192%

29% 115%

— 230%

32% 130%

Bus utilization values over 100% indicate that the bandwidth for that bus is exceeded in that scenario and GLCDC
underflow and/or dropped frames may result depending on the bus priority setting. It is recommended to avoid
these scenariosif at all possible by reducing the buffer drawing rate, number of draw/copy operations or the
input color depth. Relaxing vertical timing (increasing total line count) or increasing the clock divider are the
easiest ways to increase the time per frame.

Limitations

Developers should be aware of the following limitations when using the GLCDC API:

Examples

Basic Example

e Due to a limitation of the GLCDC hardware, if the horizontal back porch is less than the
number of pixels in a graphics burst read (64 bytes) for a layer and the layer is positioned
at a negative X-value then the layer X-position will be locked to the nearest 64-byte
boundary, rounded toward zero.

e The GLCDC peripheral offers a chroma-key function that can be used to perform a green-
screen-like color replacement. This functionality is not exposed through the GLCDC API. See
the descriptions for GRn.AB7 through .AB9 in the RA6M3 User's Manual for further details.

This is a basic example showing the minimum code required to initialize and start the GLCDC
module. If the entire display can be drawn within the vertical blanking period no further code may be
necessary.

voi d glcdc_init

{

fsp_err_t err;

/1 Open the GLCDC driver

(void)

err = R GLCDC Open(&g disp_ctrl, &g disp cfg);

/* Handl e any errors.

This function should be defined by the user. */

handl e _error(err);

/1 Start display output
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Layer Transitions

This example demonstrates how to set up and execute both a sliding and fading layer transition. This
is most useful in static image transition scenarios as switching between two actively-drawing
graphics layers may require up to four framebuffers to eliminate tearing.
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/* Move layer 1 out and layer 2 in at a fixed rate of 4 pixels per frame */
for (int32_t x = disp_rt_cfg_in->layer.coordinate.x; x >= 0; x -= 4)
{

/* Wait for a Vsync before starting */
vsync_wait ();

/* Set the X-coordinate of both |ayers then update them */
disp_rt_cfg out->layer.coordinate.x = (intl16_t) (x - DI SPLAY WDTH);
disp rt _cfg_ in->layer.coordinate.x = (intl6 t) Xx;

err = R GLCDC Layer Change(&g_disp_ctrl, disp_rt_cfg_out, D SPLAY_FRAME LAYER 1

|55
handl e _error(err);
err = R GLCDC Layer Change(&g_disp_ctrl, disp_rt_cfg_in, D SPLAY FRAVE LAYER 2
|55
handl e _error(err);
}
}

Double-Buffering

Using a double-buffer allows one to be output to the LCD while the other is being drawn to memory,
eliminating tearing and in some cases reducing bus load. The following is a basic example showing
integration of the line detect (Vsync) interrupt to set the timing for buffer swapping and drawing.
/* User-defined function to draw the current display to a franebuffer */
void display draw (uint8 t * franebuffer)
{

FSP_PARAVETER NOT _USED(franebuffer);

/* Draw buffer here */
}
/* This function is an exanple of a basic doubl e-buffered display thread */
voi d display_thread (void)
{

uint8 t * p franebuffer = NULL;
fsp_err_t err;
/* Initialize and start the R GLCDC nodul e */

glcdc_init();
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Data Structures

struct glcdc_instance_ctrl_t

struct glcdc_extended_cfg_t
Enumerations

enum glcdc_clk src_t

enum glcdc_panel_clk _div_t

enum glcdc_tcon pin_t

enum glcdc_bus_arbitration_t

enum glcdc_correction_proc_order_t

enum glcdc_tcon_signal_select t

enum glcdc_clut_plane_t

enum glcdc_dithering_mode_t

enum glcdc_dithering_pattern_t
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enum

enum

enum

glcdc_input_interface_format_t
glcdc_output_interface format t

glcdc_dithering_output format t

Data Structure Documentation

¢ glcdc_instance _ctrl t

struct glcdc_instance_ctrl_t

Display control block. DO NOT INITIALIZE.

¢ glcdc_extended cfg_ t

struct glcdc_extended _cfg_t

GLCDC hardware specific configuration

Data Fields
glcdc_tcon_pin_t tcon_hsync GLCDC TCON output pin select.
glcdc_tcon_pin_t tcon_vsync GLCDC TCON output pin select.

glcdc_tcon_pin_t

tcon_de

GLCDC TCON output pin select.

glcdc_correction_proc_order _t

correction_proc_order

Correction control route select.

glcdc_clk_src_t

clksrc

Clock Source selection.

glcdc_panel_clk_div_t

clock_div_ratio

Clock divide ratio for dot clock.

glcdc_dithering_mode t

dithering_mode

Dithering mode.

glcdc_dithering_pattern_t

dithering_pattern_A

Dithering pattern A.

glcdc_dithering_pattern_t

dithering_pattern B

Dithering pattern B.

glcdc_dithering_pattern_t

dithering_pattern_C

Dithering pattern C.

glcdc_dithering_pattern_t

dithering_pattern D

Dithering pattern D.

Enumeration Type Documentation

¢ glcdc_clk_src_t

enum glcdc_clk_src_t

Clock source select

Enumerator
GLCDC_CLK SRC_INTERNAL Internal.
GLCDC_CLK SRC_EXTERNAL External.
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¢ glcdc_panel_clk_div_t

enum glcdc_panel_clk_div_t

Clock frequency division ratio

Enumerator

GLCDC_PANEL_CLK_DIVISOR_1

Division Ratio 1/1.

GLCDC_PANEL_CLK_DIVISOR 2

Division Ratio 1/2.

GLCDC_PANEL_CLK_DIVISOR_3

Division Ratio 1/3.

GLCDC_PANEL_CLK_DIVISOR_4

Division Ratio 1/4.

GLCDC_PANEL_CLK_DIVISOR_5

Division Ratio 1/5.

GLCDC_PANEL_CLK_DIVISOR 6

Division Ratio 1/6.

GLCDC_PANEL_CLK_DIVISOR_7

Division Ratio 1/7.

GLCDC_PANEL_CLK_DIVISOR_8

Division Ratio 1/8.

GLCDC_PANEL_CLK_DIVISOR_9

Division Ratio 1/9.

GLCDC_PANEL_CLK_DIVISOR 12

Division Ratio 1/12.

GLCDC_PANEL_CLK_DIVISOR_16

Division Ratio 1/16.

GLCDC_PANEL_CLK_DIVISOR 24

Division Ratio 1/24.

GLCDC_PANEL_CLK_DIVISOR_32

Division Ratio 1/32.
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¢ glcdc_tcon_pin_t

enum glcdc_tcon_pin_t
LCD TCON output pin select
Enumerator
GLCDC_TCON_PIN_NONE No output.
GLCDC _TCON_PIN_2 LCD TCON2.
GLCDC_TCON_PIN_3 LCD TCONS3.
¢ glcdc_bus_arbitration_t
enum glcdc_bus_arbitration_t
Bus Arbitration setting
Enumerator
GLCDC_BUS_ARBITRATION_ROUNDROBIN Round robin.
GLCDC_BUS_ARBITRATION_FIX_PRIORITY Fixed.
¢ glcdc_correction_proc_order_t
enum glcdc_correction_proc_order_t
Correction circuit sequence control
Enumerator

GLCDC_CORRECTION_PROC_ORDER_BRIGHTNES
S_CONTRAST2GAMMA

Brightness -> contrast -> gamma correction.

GLCDC_CORRECTION_PROC_ORDER_GAMMA2BRI
GHTNESS_CONTRAST

Gamma correction -> brightness -> contrast.
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¢ glcdc_tcon_signal_select_t

enum glcdc_tcon_signal_select t
Timing signals for driving the LCD panel

Enumerator
GLCDC_TCON_SIGNAL_SELECT STVA VS STVA/VS.
GLCDC_TCON_SIGNAL SELECT STVB_VE STVB/VE.
GLCDC _TCON_SIGNAL SELECT STHA _HS STH/SP/HS.
GLCDC _TCON_SIGNAL_SELECT STHB_HE STB/LP/HE.
GLCDC_TCON_SIGNAL_SELECT DE DE.

¢ glcdc_clut_plane_t

enum glcdc_clut_plane_t
Clock phase adjustment for serial RGB output
Enumerator
GLCDC_CLUT_PLANE_O GLCDC CLUT plane 0.
GLCDC_CLUT_PLANE_1 GLCDC CLUT plane 1.
¢ glcdc_dithering_mode_t
enum glcdc_dithering_mode_t
Dithering mode
Enumerator

GLCDC_DITHERING_MODE_TRUNCATE No dithering (truncate)

GLCDC_DITHERING_MODE_ROUND_OFF Dithering with round off.

GLCDC_DITHERING_MODE_2X2PATTERN Dithering with 2x2 pattern.
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¢ glcdc_dithering_pattern_t

enum glcdc_dithering_pattern_t
Dithering mode
Enumerator
GLCDC_DITHERING_PATTERN_00 2x2 pattern '00"
GLCDC_DITHERING_PATTERN_01 2x2 pattern '01*
GLCDC _DITHERING_PATTERN_10 2x2 pattern '10"
GLCDC _DITHERING_PATTERN_11 2x2 pattern '11*
¢ glcdc_input_interface_format_t
enum glcdc_input_interface format t
Output interface format
Enumerator
GLCDC_INPUT_INTERFACE_FORMAT RGB565 Input interface format RGB565.
GLCDC_INPUT_INTERFACE_FORMAT_RGB888 Input interface format RGB888.

GLCDC_INPUT_INTERFACE_FORMAT_ARGB1555 Input interface format ARGB1555.

GLCDC_INPUT_INTERFACE_FORMAT_ARGB4444 | |10t interface format ARGBA4444.

GLCDC_INPUT_INTERFACE_FORMAT_ARGB8888 Input interface format ARGB8888.

GLCDC_INPUT_INTERFACE_FORMAT_CLUTS8 Input interface format CLUTS.

GLCDC_INPUT_INTERFACE_FORMAT_CLUT4 Input interface format CLUTA4.

GLCDC_INPUT_INTERFACE_FORMAT_CLUT1 Input interface format CLUT1.

R11UMO0146EU0100 Revision 1.00 .IENESAS Page 449 /1,444
Mar.25.20



Flexible Software Package

API| Reference > Modules > Graphics LCD Controller (r_glcdc)

User’s Manual

¢ glcdc_output_interface_format_t

enum glcdc_output_interface_format_t

Output interface format

Enumerator

GLCDC_OUTPUT_INTERFACE_FORMAT RGB888

Output interface format RGB888.

GLCDC_OUTPUT_INTERFACE_FORMAT RGB666

Output interface format RGB666.

GLCDC_OUTPUT_INTERFACE_FORMAT RGB565

Output interface format RGB565.

GLCDC_OUTPUT_INTERFACE_FORMAT_SERIAL_R
GB

Output interface format Serial RGB.

¢ glcdc_dithering_output_format_t

enum glcdc_dithering_output_format _t

Dithering output format

Enumerator

GLCDC_DITHERING_OUTPUT_FORMAT_RGB888

Dithering output format RGB888.

GLCDC_DITHERING_OUTPUT FORMAT RGB666

Dithering output format RGB666.

GLCDC_DITHERING_OUTPUT FORMAT RGB565

Dithering output format RGB565.

Function Documentation
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4 R_GLCDC Open()

fsp_err t R_GLCDC Open ( display_ctrl_t *const p_api_ctrl, display cfg_t const *const p cfg )

Open GLCDC module. Implements display_api_t::open.

Return values

FSP_SUCCESS

Device was opened successfully.

FSP_ERR_ALREADY OPEN

Device was already open.

FSP_ERR_ASSERTION

Pointer to the control block or the
configuration structure is NULL.

FSP_ERR_CLOCK_GENERATION

Dot clock cannot be generated from clock
source.

FSP_ERR_INVALID_TIMING_SETTING

Invalid panel timing parameter.

FSP_ERR_INVALID_LAYER SETTING

Invalid layer setting found.

FSP_ERR_INVALID_ALIGNMENT

Input buffer alignment invalid.

FSP_ERR_INVALID_GAMMA_SETTING

Invalid gamma correction setting found

FSP_ERR_INVALID_BRIGHTNESS_SETTING

Invalid brightness correction setting found

Note

calling this API.

PCLKA must be supplied to Graphics LCD Controller (GLCDC) and GLCDC pins must be set in IOPORT before

4 R_GLCDC Close()

fsp_err t R_GLCDC Close ( display _ctrl _t *const p_api ctrl)

Close GLCDC module. Implements display_api_t::close.

Return values

FSP_SUCCESS

Device was closed successfully.

FSP_ERR_ASSERTION

Pointer to the control block is NULL.

FSP_ERR_NOT OPEN

The function call is performed when the
driver state is not equal to
DISPLAY STATE_CLOSED.

FSP_ERR_INVALID_UPDATE_TIMING

A function call is performed when the
GLCDC is updating register values

internally.
Note
This API can be called when the driver isnot in DISPLAY_STATE _CLOSED state. It returnsan error if the
register update operation for the background screen generation block is being held.
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& R_GLCDC _Start()

fsp_err t R_GLCDC_Start ( display_ctrl _t *const p_api _ctrl)

Start GLCDC module. Implements display_api_t::start.

Return values

FSP_SUCCESS Device was started successfully.
FSP_ERR_NOT _OPEN GLCDC module has not been opened.
FSP_ERR_ASSERTION Pointer to the control block is NULL.

Note

This API can be called when the driver isnot in DISPLAY_STATE_OPENED status.

¢ R_GLCDC Stop()

fsp_err_t R_GLCDC _Stop ( display_ctrl_t *const p_api_ctrl)

Stop GLCDC module. Implements display_api_t::stop.

Return values

FSP_SUCCESS Device was stopped successfully
FSP_ERR_ASSERTION Pointer to the control block is NULL
FSP_ERR_INVALID_MODE Function call is performed when the driver
state is not DISPLAY_STATE_DISPLAYING.
FSP_ERR_INVALID_UPDATE_TIMING The function call is performed while the
GLCDC is updating register values
internally.
Note
This API can be called when the driver isin the DISPLAY_STATE _DISPLAYING state. It returns an error if the
register update operation for the background screen generation blocks, the graphics data I/F blocks, or the output
control block is being held.
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4 R_GLCDC_LayerChange()

fsp_err t R_GLCDC _LayerChange ( display_ctrl_t const *const p_api ctrl, display_runtime _cfg_t
const *const p_cfg, display frame_layer t layer )

Change layer parameters of GLCDC module at runtime. Implements display_api_t::layerChange.

Return values

FSP_SUCCESS Changed layer parameters of GLCDC
module successfully.

FSP_ERR_ASSERTION Pointer to the control block or the
configuration structure is NULL.

FSP_ERR_INVALID MODE A function call is performed when the driver
state is not DISPLAY_STATE_DISPLAYING.

FSP_ERR_INVALID_UPDATE_TIMING A function call is performed while the
GLCDC is updating register values
internally.

Note
This API can be called when the driver isin DISPLAY_STATE_DISPLAYING state. It returns an error if the
register update operation for the background screen generation blocks or the graphics data I/F block is being held.

4 R_GLCDC_BufferChange()

fsp_err t R_GLCDC_ BufferChange ( display_ctrl_t const *const p_api ctrl, uint8 t *const
framebuffer, display _frame_layer t layer )

Change the framebuffer pointer for a layer. Implements display api_t::bufferChange.

Return values

FSP_SUCCESS Changed layer parameters of GLCDC
module successfully.

FSP_ERR_ASSERTION Pointer to the control block is NULL.
FSP_ERR_INVALID MODE A function call is performed when the driver
state is not DISPLAY_STATE_DISPLAYING.
FSP_ERR_INVALID ALIGNMENT The framebuffer pointer is not 64-byte
aligned.
FSP_ERR_INVALID UPDATE_TIMING A function call is performed while the
GLCDC is updating register values
internally.
Note
This API can be called when the driver isin DISPLAY_STATE_OPENED state or higher. It returnsan error if the
register update operation for the background screen generation blocks or the graphics data I/F block is being held.
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4 R_GLCDC _ColorCorrection()

fsp_err_ t R_GLCDC_ColorCorrection ( display_ctrl_t const *const p_api ctrl, display_correction_t
const *const p_correction )

Perform color correction through the GLCDC module. Implements display_api_t::correction.

Return values

FSP_SUCCESS Color correction by GLCDC module was
performed successfully.

FSP_ERR_ASSERTION Pointer to the control block or the display
correction structure is NULL.

FSP_ERR_INVALID MODE Function call is performed when the driver
state is not DISPLAY_STATE_DISPLAYING.

FSP_ERR_INVALID_UPDATE_TIMING A function call is performed while the

GLCDC is updating registers internally.

FSP_ERR_INVALID BRIGHTNESS SETTING Invalid brightness correction setting found

Note
This API can be called when the driver isin the DISPLAY_STATE_DISPLAYING state. It returnsan error if the
register update operation for the background screen generation blocks or the output control block is being held.

& R_GLCDC_ClutUpdate()

fsp_err t R_GLCDC_ClutUpdate ( display_ctrl_t const *const p_api _ctrl, display_clut_cfg_t const
*const p clut cfg, display_frame_layer t layer )

Update a color look-up table (CLUT) in the GLCDC module. Implements display_api_t::clut.

Return values

FSP_SUCCESS CLUT updated successfully.
FSP_ERR_ASSERTION Pointer to the control block or CLUT source
data is NULL.
FSP_ERR_INVALID CLUT_ACCESS Illegal CLUT entry or size is specified.
Note
This API can be called any time.
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& R_GLCDC_StatusGet()

fsp_err_ t R_GLCDC_ StatusGet ( display_ctrl_t const *const p_api ctrl, display_status_t *const
p_status )

Get status of GLCDC module. Implements display api_t::statusGet.

Return values
FSP_SUCCESS Got status successfully.

FSP_ERR_ASSERTION Pointer to the control block or the status
structure is NULL.

Note
The GLCDC hardware starts the fading processing at the first Vsync after the previous Layer Change() call is held.
Dueto this behavior of the hardware, this APl may not return DISPLAY_FADE_STATUS FADING_UNDERWAY
asthe fading status, if it is called before the first Vsync after Layer Change() is called. In this case, the API returns
DISPLAY FADE_STATUS PENDING, instead of DISPLAY_FADE _STATUS NOT_UNDERWAY.

¢ R_GLCDC VersionGet()

fsp_err_t R_GLCDC VersionGet ( fsp_version_t * p_version)

Get version of R_GLCDC module. Implements display_api_t::versionGet.

Return values

FSP_SUCCESS Got version information successfully.

Note
This function is re-entrant.

5.2.22 General PWM Timer (r_gpt)

Modules

Functions
fsp_err t R _GPT Open (timer_ctrl_t *const p_ctrl, timer_cfg_t const *const

p_cfg)
fsp_err t R_GPT Stop (timer_ctrl_t *const p_ctrl)
fsp_err t R_GPT Start (timer_ctrl_t *const p_ctrl)
fsp_err t R_GPT_Reset (timer_ctrl_t *const p_ctrl)
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fsp_err t R_GPT _Enable (timer_ctrl_t *const p_ctrl)
fsp_err t R_GPT Disable (timer_ctrl_t *const p_ctrl)

fsp_err t R_GPT_PeriodSet (timer_ctrl_t *const p_ctrl, uint32_t const
period_counts)

fsp_err t R_GPT _DutyCycleSet (timer_ctrl_t *const p_ctrl, uint32_t const
duty _cycle_counts, uint32_t const pin)

fsp_err t R_GPT InfoGet (timer_ctrl _t *const p_ctrl, timer_info_t *const p_info)

fsp_err t R_GPT StatusGet (timer_ctrl_t *const p_ctrl, timer_status_t *const
p_status)

fsp_err t R_GPT_CounterSet (timer_ctrl_t *const p_ctrl, uint32_t counter)
fsp_err t R_GPT_OutputEnable (timer_ctrl_t *const p_ctrl, gpt_io_pin_t pin)
fsp_err t R_GPT OutputDisable (timer_ctrl t *const p_ctrl, gpt_io_pin_t pin)

fsp_err t R_GPT _AdcTriggerSet (timer_ctrl_t *const p_ctrl,
gpt_adc_compare_match_t which_compare_match, uint32_t
compare_match_value)

fsp_err t R_GPT Close (timer_ctrl_t *const p_ctrl)

fsp_err t R_GPT VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the GPT32 and GPT16 peripherals on RA MCUs. This module implements the Timer
Interface.

Overview

The GPT module can be used to count events, measure external input signals, generate a periodic
interrupt, or output a periodic or PWM signal to a GTIOC pin.

This module supports the GPT peripherals GPT32EH, GPT32E, GPT32, and GPT16. GPT16 is a 16-bit
timer. The other peripherals (GPT32EH, GPT32E, and GPT32) are 32-bit timers. The 32-bit timers are
all treated the same in this module from the API perspective.

Features

The GPT module has the following features:

e Supports periodic mode, one-shot mode, and PWM mode.
e Supports count source of PCLK, GTETRG pins, GTIOC pins, or ELC events.
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Supports debounce filter on GTIOC pins.

Signal can be output to a pin.

Configurable period (counts per timer cycle).

Configurable duty cycle in PWM mode.

Supports runtime reconfiguration of period.

Supports runtime reconfiguration of duty cycle in PWM mode.

APIs are provided to start, stop, and reset the counter.

APIs are provided to get the current period, source clock frequency, and count direction.
APIs are provided to get the current timer status and counter value.

Supports start, stop, clear, count up, count down, and capture by external sources from
GTETRG pins, GTIOC pins, or ELC events.

Supports symmetric and asymmetric PWM waveform generation.

Supports automatic addition of dead time.

Supports generating ELC events to start an ADC scan at a compare match value (see Event
Link Controller (r_elc)) and updating the compare match value.

Supports linking with a POEG channel to automatically disable GPT output when an error
condition is detected.

Supports setting the counter value while the timer is stopped.

Supports enabling and disabling output pins.

Supports skipping up to seven overflow/underflow (crest/trough) interrupts at a time

Selecting a Timer

RA MCUs have two timer peripherals: the General PWM Timer (GPT) and the Asynchronous General
Purpose Timer (AGT). When selecting between them, consider these factors:

GPT AGT
Low Power Modes The GPT can operate in sleep The AGT can operate in all low
mode. power modes.
Available Channels The number of GPT channels is All MCUs have 2 AGT channels.

device specific. All currently
supported MCUs have at least 7
GPT channels.

Timer Resolution All MCUs have at least one The AGT timers are 16-bit
32-bit GPT timer. timers.
Clock Source The GPT runs off PCLKD with a The AGT runs off PCLKB, LOCO,

configurable divider up to 1024. or subclock.
It can also be configured to

count ELC events or external

pulses.

Configuration

Build Time Configurations for r_gpt

The following build time configurations are defined in fsp_cfg/r_gpt_cfg.h:

Configuration Options Default Description
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Parameter Checking

Pin Output Support

Write Protect Enable

o Default (BSP)
e Enabled
e Disabled

e Disabled

e Enabled

e Enabled with
Extra Features

e Enabled
e Disabled

Default (BSP)

Disabled

Disabled

Configurations for Driver > Timers > Timer Driver on r_gpt

If selected code for
parameter checking is
included in the build.

If selected code for
outputting a waveform
to a pin is included in
the build.

If selected write
protection is applied to
all GPT channels.

This module can be added to the Stacks tab via New Stack > Driver > Timers > Timer Driver on

r_gpt:

Configuration

Options

Default

Description

General > Name

General > Channel

General > Mode

Name must be a valid
C symbol

Channel number must
exist on this MCU

Periodic
One-Shot
PWM
Triangle-Wave
Symmetric
PWM

e Triangle-Wave
Asymmetric
PWM

g_timer0

0

Periodic

Module name.

Specify the hardware
channel.

Mode selection.
Periodic: Generates
periodic interrupts or
square waves.
One-shot: Generate a
single interrupt or a
pulse wave. Note: One-
shot mode is
implemented in
software. ISRs must be
enabled for one-shot
even if callback is
unused.

PWM: Generates basic
PWM waveforms.
Triangle-Wave
Symmetric PWM:
Generates symmetric
PWM waveforms with
duty cycle determined
by compare match set
during a crest interrupt
and updated at the
next trough.
Triangle-Wave
Asymmetric PWM:
Generates asymmetric
PWM waveforms with
duty cycle determined
by compare match set
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General > Period

General > Period Unit

Output > Duty Cycle
Percent (only
applicable in PWM
mode)

Output > Duty Cycle
Range (only applicable
in PWM mode)

Output > GTIOCA
Output Enabled

Output > GTIOCA Stop

Value must be a non-
negative integer less
than or equal to
0x40000000000

Raw Counts
Nanoseconds
Microseconds
Milliseconds
Seconds
Hertz
Kilohertz

Value must be between
0 and 100

e Shortest: 2
PCLK, Longest:
(Period - 1)
PCLK

e Shortest: 1
PCLK, Longest:
(Period - 2)
PCLK

True
False

Pin Level Low

0x100000000

Raw Counts

50

Shortest: 2 PCLK,

Longest: (Period - 1)

PCLK

False

Pin Level Low

during a crest/trough
interrupt and updated
at the next
trough/crest.

Specify the timer
period in units selected
below. Setting the
period to 0x100000000
raw counts results in
the maximum period.
Set the period to
0x100000000 raw
counts for a free
running timer or an
input capture
configuration. The
period can be set up to
0x40000000000, which
will use a divider of
1024 with the
maximum period.

Unit of the period
specified above

Specify the timer duty
cycle percent. Only
used in PWM mode.

Select the duty cycle
range. Due to hardware
limitations, one PCLK
cycle is added before
the output pin toggles
after the duty cycle is
reached. This extra
clock cycle is added to
the ON time (if
Shortest: 2 PCLK is
selected) or the OFF
time (if Shortest: 1
PCLK is selected) based
on this configuration.

Enable the output of
GTIOCA on a pin.

Select the behavior of

Level ¢ Pin Level High the output pin when
¢ Pin Level the timer is stopped.
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Retained

Output > GTIOCB e True False Enable the output of
Output Enabled e False GTIOCB on a pin.

Output > GTIOCB Stop e Pin Level Low Pin Level Low Select the behavior of
Level ¢ Pin Level High the output pin when
¢ Pin Level the timer is stopped.
Retained

Input > Count Up MCU Specific Options Select external source

Source that will increment the
counter. If any count
up source is selected,
the timer will count the
external sources only.
It will not count PCLKD
cycles.

Input > Count Down MCU Specific Options Select external source

Source that will decrement the
counter. If any count
down source is
selected, the timer will
count the external
sources only. It will not
count PCLKD cycles.

Input > Start Source MCU Specific Options Select external source
that will start the timer.

For pulse width
measurement, set the
Start Source and the
Clear Source to the
trigger edge (the edge
to start the
measurement), and set
the Stop Source and
Capture Source (either
A or B) to the opposite
edge (the edge to stop
the measurement).

For pulse period
measurement, set the
Start Source, the Clear
Source, and the
Capture Source (either
A or B) to the trigger
edge (the edge to start
the measurement).

Input > Stop Source MCU Specific Options Select external source
that will stop the timer.

Input > Clear Source MCU Specific Options Select external source
that will clear the
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Input > Capture A
Source

Input > Capture B
Source

Input > GTIOCA Input
Filter

Input > GTIOCB Input
Filter

Interrupts > Callback

Interrupts >
Overflow/Crest
Interrupt Priority

Interrupts > Capture A
Interrupt Priority

Interrupts > Capture B
Interrupt Priority

Interrupts > Trough
Interrupt Priority

Extra Features >
Output Disable > POEG
Link

MCU Specific Options

MCU Specific Options

e No Filter

e Filter PCLKD / 1

e Filter PCLKD / 4

e Filter PCLKD /
16

e Filter PCLKD /
64

e No Filter

e Filter PCLKD / 1

e Filter PCLKD / 4

e Filter PCLKD /
16

e Filter PCLKD /
64

Name must be a valid
C symbol

MCU Specific Options

MCU Specific Options

MCU Specific Options

MCU Specific Options

e POEG Channel
0

e POEG Channel
1

e POEG Channel
2

No Filter

No Filter

NULL

POEG Channel O

timer.

Select external source
that will trigger a
capture A event.

Select external source
that will trigger a
capture B event.

Select the input filter
for GTIOCA.

Select the input filter
for GTIOCB.

A user callback
function can be
specified here. If this
callback function is
provided, it will be
called from the
interrupt service
routine (ISR) each time
the timer period
elapses

Select the overflow
interrupt priority. This
is the crest interrupt
for triangle-wave PWM.

Select the interrupt
priority for capture A.

Select the interrupt
priority for capture B.

Select the interrupt
priority for the trough
interrupt (triangle-
wave PWM only).

Select which POEG to
link this GPT channel
to.
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Extra Features >
Output Disable >
Output Disable POEG
Trigger

Extra Features >
Output Disable >
GTIOCA Disable Setting

Extra Features >
Output Disable >
GTIOCB Disable Setting

Extra Features > ADC
Trigger > Start Event
Trigger (GPTE/GPTEH
only)

e POEG Channel
3

e Dead Time
Error

e GTIOCA and
GTIOCB High
Level

e GTIOCA and
GTIOCB Low
Level

e Disable
Prohibited

e SetHiZ

e Level Low

e Level High

e Disable
Prohibited

e SetHiZ

e Level Low

e Level High

e Trigger Event
A/D Converter
Start Request A
During Up
Counting

e Trigger Event
A/D Converter
Start Request A
During Down
Counting

e Trigger Event
A/D Converter
Start Request B
During Up
Counting

e Trigger Event
A/D Converter
Start Request B
During Down

Disable Prohibited

Disable Prohibited

Select which errors
send an output disable
trigger to POEG. Dead
time error is only
available on GPT32E
and GPT32EH variants.

Select the disable
setting for GTIOCA.

Select the disable
setting for GTIOCB.

Select which A/D
converter start request
interrupts to generate
and at which point in
the cycle to generate
them. This value only
applies to the GPT32E
and GPT32EH variants.

Counting

Extra Features > Dead Must be an integer 0 Select the dead time to

Time > Dead Time greater than or equal apply during up

Count Up (Raw Counts) to O counting. This value
also applies during
down counting for the
GPT32 and GPT16
variants.

Extra Features > Dead Must be an integer 0 Select the dead time to

Time > Dead Time greater than or equal apply during down

Count Down (Raw to 0 counting. This value

Counts) (GPTE/GPTEH only applies to the
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only)

Extra Features > ADC
Trigger (GPTE/GPTEH
only) > ADC A
Compare Match (Raw
Counts)

Extra Features > ADC
Trigger (GPTE/GPTEH
only) > ADCB
Compare Match (Raw
Counts)

Extra Features >
Interrupt Skipping
(GPTE/GPTEH only) >
Interrupt to Count

Extra Features >
Interrupt Skipping
(GPTE/GPTEH only) >
Interrupt Skip Count

Extra Features >
Interrupt Skipping
(GPTE/GPTEH only) >
Skip ADC Events

Must be an integer
greater than or equal
to 0

Must be an integer
greater than or equal
to 0

* None

e Overflow and
Underflow
(sawtooth)

e Crest (triangle)

e Trough
(triangle)

Noups,WNRFO

None

Match

e ADC B Compare
Match

e ADCAandB
Compare Match

None

module.driver.timer.int
e ADC A Compare errupt_skip.adc.none

GPT32E and GPT32EH
variants.

Select the compare
match value that
generates a GPTn AD
TRIG A event. This
value only applies to
the GPT32E and
GPT32EH variants.

Select the compare
match value that
generates a GPTn AD
TRIG B event. This
value only applies to
the GPT32E and
GPT32EH variants.

Select the count source
for interrupt skipping.
The interrupt skip
counter increments
after each source
event. All
crest/overflow and
trough/underflow
interrupts are skipped
when the interrupt skip
counter is non-zero.
This value only applies
to the GPT32E and
GPT32EH variants.

Select the number of
interrupts to skip. This
value only applies to
the GPT32E and
GPT32EH variants.

Select ADC events to
suppress when the
interrupt skip count is
not zero. This value
only applies to the
GPT32E and GPT32EH
variants.

Mar.25.20

Extra Features > e Enabled Disabled Select whether to
Enable Extra Features e Disabled enable extra features
on this channel.
Clock Configuration
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The GPT clock is based on the PCLKD frequency. You can set the PCLKD frequency using the clock
configurator in e2 studio or using the CGC Interface at run-time.

Pin Configuration

This module can use GTETRGA, GTETRGB, GTETRGC, GTETRGD, GTIOCA and GTIOCB pins as count
sources.

This module can use GTIOCA and GTIOCB pins as output pins for periodic or PWM signals.

This module can use GTIOCA and GTIOCB as input pins to measure input signals.

Usage Notes
Maximum Period for GPT32

The RA Configuration tool will automatically calculate the period count value and source clock divider
based on the selected period time, units and clock speed.

When the selected period unit is "Raw counts", the maximum period setting is 0x40000000000 on a
32-bit timer or 0x0x4000000 on a 16-bit timer. This will configure the timer with the maximum
period and a count clock divisor of 128.

Note
When manually changing the timer period counts the maximum value for a 32-bit GPT is 0x100000000. This
number overflows the 32-bit value for timer_cfg_t::period_counts. To configure the timer for the maximum period,
set timer_cfg_t::period_countsto O.

Updating Period and Duty Cycle

The period and duty cycle are updated after the next counter overflow after calling
R_GPT_PeriodSet() or R_GPT_DutyCycleSet(). To force them to update before the next counter
overflow, call R_GPT_Reset() while the counter is running.

One-Shot Mode

The GPT timer does not support one-shot mode natively. One-shot mode is achieved by stopping the
timer in the interrupt service routine before the callback is called. If the interrupt is not serviced
before the timer period expires again, the timer generates more than one event. The callback is only
called once in this case, but multiple events may be generated if the timer is linked to the Data
Transfer Controller (r_dtc).

One-Shot Mode Output

The output waveform in one-shot mode is one PCLKD cycle less than the configured period. The
configured period must be at least 2 counts to generate an output pulse.

Examples of one-shot signals that can be generated by this module are shown below:
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GPT One-Shot Output

— 2,

Time after start | | |
(PCLKD counts) | | |

One-shot mode,
gpt_output_pin_t:stop_level =
GPT_PIN_LEVEL_LOW

One-shot mode,
gpt_output_pin_t::stop_level =
GPT PIN LEVEL HIGH

Figure 118: GPT One-Shot Output

Periodic Output

The GTIOC pin toggles twice each time the timer expires in periodic mode. This is achieved by
defining a PWM wave at a 50 percent duty cycle so that the period of the resulting square wave
(from rising edge to rising edge) matches the period of the GPT timer. Since the periodic output is
actually a PWM output, the time at the stop level is one cycle shorter than the time opposite the stop
level for odd period values.

Examples of periodic signals that can be generated by this module are shown below:

GPT Periodic Output

Time after start |
(PCLKD counts) I

Periodic mode,
gpt_output_pin_t:stop_level =
GPT_PIN_LEVEL_LOW

Periodic maode,
gpt_output_pin_t::stop_level =
GPT PIN LEVEL HIGH

Figure 119: GPT Periodic Output

PWM Output

The PWM output signal is high at the beginning of the cycle and low at the end of the cycle. If
gpt_extended cfg t::shortest pwm_signal is set to GPT_SHORTEST _LEVEL ON, the PWM output signal
is low at the beginning of the cycle and high at the end of the cycle.

Examples of PWM signals that can be generated by this module are shown below:
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GPT PWM Output
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(PCLKD counts) I I | I I

PWM mode,
fimer_on_gpt_cfg_t::shortest_pwm_signal =
GPT_SHORTEST_LEVEL_OFF

PWM mode,
timer_on_gpt_cfg_t::shortest_pwm_signal =
GPT_SHORTEST_LEVEL_ON

Figure 120: GPT PWM Output

Triangle-Wave PWM Output

Examples of PWM signals that can be generated by this module are shown below. The
duty_cycle_counts can be modified using R_GPT_DutyCycleSet() in the crest interrupt and updated at
the following trough for symmetric PWM or modified in both the crest/trough interrupts and updated
at the following trough/crest for asymmetric PWM.
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Time after start ‘
(PCLKD counts) I I 1 I I [ I

Triangle-Wave PWM mode, GTIOCA start
level low

Triangle-Wave PWM mode, GTIOCB start
level high

Figure 121: GPT Triangle-Wave PWM Output

Event Counting

Event counting can be done by selecting up or down counting sources from GTETRG pins, ELC
events, or GTIOC pins. In event counting mode, the GPT counter is not affected by PCLKD.

Note
In event counting mode, the application must call R_GPT_Start() to enable event counting. The counter will not
change after calling R_GPT_Sart() until an event occurs.

Pulse Measurement

If the capture edge occurs before the start edge in pulse measurement, the first capture is invalid
(0).

Controlling GPT with GTETRG Edges
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The GPT timer can be configured to stop, start, clear, count up, or count down when a GTETRG rising
or falling edge occurs.

Note
The GTETRG pins are shared by all GPT channels.
GTETRG pinsrequire POEG to be on (example code for thisis provided in GPT Free Running Counter Example).
If input filtering is required on the GTETRG pins, that must also be handled outside this module.

Controlling GPT with ELC Events

The GPT timer can be configured to stop, start, clear, count up, or count down when an ELC event
occurs.

Note
The configurable ELC GPT sources are shared by all GPT channels.
The event links for the ELC must be configured outside this module.

Triggering ELC Events with GPT

The GPT timer can trigger the start of other peripherals. The Event Link Controller (r_elc) guide
provides a list of all available peripherals.

Enabling External Sources for Start, Stop, Clear, or Capture

R_GPT _Enable() must be called when external sources are used for start, stop, clear, or capture.
Interrupt Skipping

When an interrupt skipping source is selected a hardware counter will increment each time the
selected event occurs. Each interrupt past the first (up to the specified skip count) will be

suppressed. If ADC events are selected for skipping they will also be suppressed except during the
timer period leading to the selected interrupt skipping event (see below diagram).

Timer count
A

Timer period

Skipped interrupt/event

i -I [ i i ri —|_
1 1 1 1 1
Crest interrupt L L . ! 1

Trough interrupt —I -E 3 —l ! :' —l
ADC up-count event H :r; :”: H :r! ;-3 H__
ADC down-count event _J_l H !-; l_l ;-:[ ” I_l
Interrupt skip counter 3 0 1 2 0 1 2 0 C

Figure 122: Crest interrupt skipping in triangle-wave PWM modes (skip count 2)

Examples
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GPT Basic Example

This is a basic example of minimal use of the GPT in an application.

GPT Callback Example

This is an example of a timer callback.

GPT Free Running Counter Example

To use the GPT as a free running counter, select periodic mode and set the the Period to OxFFFFFFFF
for a 32-bit timer or OxFFFF for a 16-bit timer.
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GPT Input Capture Example

This is an example of using the GPT to capture pulse width or pulse period measurements.
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GPT Period Update Example

This an example of updating the period.
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GPT Duty Cycle Update Example

This an example of updating the duty cycle.

GPT A/D Converter Start Request Example
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This is an example of using the GPT to start the ADC at a configurable A/D converter compare match
value.
#if ((1U << GPT_EXAMPLE CHANNEL) & (BSP_FEATURE_GPTEH CHANNEL NASK |
BSP_FEATURE_GPTE_CHANNEL_MASK) )
/* This exanple shows how to configure the GPT to generate an A/D start request at an
A/'D start request conpare
* mat ch value. This exanple can only be used with GPTE or GPTEH variants. */
voi d gpt_adc_start_request _exanple (void)
{
fsp_err_t err = FSP_SUCCESS;
/* Initialize and configure the ELC. */
err = R ELC Open(&g_elc ctrl, & elc cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/* Configure the ELC to start a scan on ADC unit O when GPT channel 0. Note: This is
typically configured in
* g_elc_cfg and already set during R ELC Open. */
err = R ELC LinkSet(&g_elc_ctrl, ELC PERI PHERAL_ADCO, ELC EVENT_GPTO_AD TRI G A);
handl e _error(err);
/* dobally enable ELC events. */
err = R ELC Enabl e(&g_elc_ctrl);
handl e _error(err);
/* Initialize the ADC to start a scan based on an ELC event trigger. Set
adc_cfg t::trigger to
* ADC _TRI GGER_SYNC ELC. */
err = R ADC Open(&g_adcO _ctrl, &g _adcO_cfqQ);
handl e_error(err);
err = R ADC ScanCf g(&g_adcO _ctrl, &g adcO_channel cfg);
handl e_error(err);
/* Enable ELC triggers by calling R ADC ScanStart (). */
(void) R ADC ScanStart (&g _adcO ctrl);
/* Initializes the GPT nodul e. Configure gpt_extended pwmcfg t::adc _trigger to set
when the A/D start request

* |s generated. Set gpt_extended pwmcfg t::adc_a conpare natch to set the desired
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conpare mat ch val ue.

*/

err = R GPT_Open(&g_tiner0 ctrl, &g tiner0 _cfg);

handl e_error(err);

/* Start the tiner